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KIRISH 

Web-saytlarni yaratish va undan foydalanish ta'lim tizimida ham 
muhim ahamiyat kasb etadi. Ta'limda web-saytlardan nafaqat tijorat 
yoki namoyish vositasi sifatida, balki bilim berish maqsadlarida ham 
foydalaniladi . Albatta bunda ta'lim masofadan turib amalga oshiriladi. 
Bunday ta' lim berish jarayoni o'qituvchi va o'quvchi to'g'ridan-to'g'ri 
muloqot qilmasdan olib boriladi. Buning uchun ta' lim beruvchi (oliy 
o'quv yurti. maktab va boshqaJar) o'qitiladigan predmetga tegishli 
ma'lumotlarni web-sahifalarga har xiI kO'rinishlarda (matn, rasm, 
jadval, animatsiya, tovushli ma'lumot va xatto video tasma kO'rinishida) 
joylashi kerak. O'quvchi esa dunyoning xohlagan joyidan turib 
Inte~net orqali bu ma'lumotlardan bilim olishi mumkin. Ta'limning 
bunday ko'rinishi masofaviy ta'lim deb yuritiladi. Bugungi kunda 
masofaviy ta'lim dunyoning ko'plab rivojlangan davlatlarida qo'llanilib 
kelinmoqda. Masofaviy ta'limdan foydalanish natijasida vaqt va pulni 
tejash, ortiqcha ovvoragarchiliklarsiz bilim olish imkoniyatlariga 
ega bo'linadi. Bunday imkoniyatlarni bizga web-sahifalar yaratib 
beradi. Ma'lum predmetga tegishli ma'lumotlarni (matn, rasm, jadval. 
animatsiya va boshqalarni) sahifalarga joylab, ularni doimiy ravishda 
to'ldirib, yangilab borish, o'quvchilarni bilimlarini baholash uchun 
nazorat test savollarini kiritish imkoniyatlari mavjud. Buning natijasida 
o'quvchining olgan bilimini nazorat qilish, baholash imkoniyatlari 
paydo bo'ladi. Bu esa web-texnologiyadan ta'limda foydalanishning eng 

optimal variantlaridan biri hisoblanadi. 
Ushbu qo'l1arunada ana shunday Web-saytlarni yaratishda qo'llani-

ladigan Macromedia Dreamweaver, Macromedia Flash, Corel Draw, 
Adobe PhotoShop dasturlari va HTML - gipermatnlarni belgilash 
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tilidan foydalanish imkoniyatlari haqida ma'lumot berilgan. Professional 
dasturlar qatoriga kiruvchi Dreamweaver dasturi o'zining barcha 
imkoniyatlari bilan har qanday murakkablik va masshtabdagi Web­
sahifalarni yaratish va o'zgartirishga qodir. U vizual loyihalash 
(WYSIWYG) rejimini ta'minlab, dastlabki matnli WEB - hujjatlarning 
juda aniq ishlashi bilan ajralib turadi va katta tarmoqli loyihalarni 
qo' llab-quvvatlovchi ichki qurilgan vositalarga ega. 

Dasturda matnlar hamda obyektlarning obrazlari ustida olib 
boriladigan ishlar bevosita kodlashtirishdan ustun turadigan gipermatnli 
hujjatlar yaratish usulini vizual deb atash qabul qilingan. Dastur 
nafaqat vizual loyihalash vositalarining kuchli bazasiga ega, balki 
web - sah ifalarni deyarli maxsus ko'rib chiqish dasturlari yordamida 
aks ettirishga ham qodir: Microsoft Internet Explorer yoki Netscape 
Navigator. 

Dastur web-dizayn sohasida gipermatnli hujjatlarni to'g'ridan-to'g'ri 
kodlashtirish yordamida yaratishni afzal ko'ruvchi mutaxassislarga 
ham ma'qul keladi. Dreamweaver qobig'iga gipermatnlarni belgiluvchi 
diskreptorlar bilan ishlash uchun zarur ' oarcha uskunalarga ega tp"liq 
funksional HTML tahrirlagichi integratsiya qilingan. 

Dreamweaver dasturi «ochiq arxitektura» prinsiplariga asoslangan. 
Bu amaliy dasturni interfeysi (Application Programming Interface, API) 
to'liq ochiq ekanligini bildiradi. Uning yordamida tashqi dasturchilar 
hamda dasturiy ta'minot hilan shug' ullanuvchi firmalar, dastur va uning 
interfeysiga radikal funksional o'zgartirishlar kiritishi: yangi uskuna 
qo'shish, menyu palitrasi yoki bo'limini yaratish, yangi obyekt yoki 
multimedia roligini dasturlashtirish va hokazolar. 

Dreamweaver ti j~imi tarkibiga multimedia roliklarini qO'yishga 
mo' ljallangan qo'shimcha dastur kiradL shuning uchun Flash -
texnologiyaning interfaol imkoniyatlarini tahrirlagichdan chiqmay tu rib 
ko'rib chiqish mumkin. 

Ta'lim tizimida esa, axborot texnologiyalarini qo'llab, ta'lim­
tarbiya berish va unga tegishli barcha jarayonlarni axborotlashtirish 
bilan ta' lim samaradorligini oshirishga olib kelinadi. Bunda - axborot 
texnologiyalaridan dars jarayonidagi kO'rgazmalilik imkoniyatlari oshib 
o'quvchi.larning mazmunni tushunish darajasi ortadi. O'quvchi dars 
vaqtida biror murakkab jarayonni ko'z oldiga keltirishi qiyin bO'lib, uni 
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laS8vvur qila olmaydi. Ana shunday paytda kompyuterning maxsus 
dasturlari yordamida shu murakkab jarayonni aynan o'zidek qilib 
tasvirlab berish mum kin. Bunda o'quvchilarda ushbu murakkab jarayon 
haqidagi tasawurni bosil qiladi. Bu kabi dasturlar kO'pincha inson ko'zi 
bilan ko'ra olmaydigan (masalan. mashina dvigateli ichidagi harakatlar. 
odam qon aylanis1J tizimi va boshqalar) murakkab jar~'onlarni tasvirlab 
berish uchun xizmat qiladi. Bunday dasturlarga misol qilib Flash 
MX, 3D MAX kabi dasturlarni aytishimiz mumkin. l'shbu dasturlar 
yordamida nafaqat murakkab jarayoniaming tasvirlarin~ balki barcha 
turdagi elektron darsliklarni yaratish imkoniyatlari ham mavjud. 
Ayniqsa animatsiyali ma'lumotlarni kekirisb va bezasbda keng qo'Hash 
mumkin. 

Usbbu qo'lIanmada shuningdek Flash MX dasturini o'rganishga 
bag"ishlangan ma'lumotlar ham berilgan. Qo'lIanmada dastur imko­
niyatlari uning interfeysi., 8asb-4ilmlar. ftasb-saytJar yaratish \"8 

ulardan turli jarayonlarda foydalanish to'g"risidagi ma'lumotlar berilgan. 
Bundan tashqari web dizaynning eng muhim ajralmas qismlaridan 
biri bo'lgan kompyuter gra1ikasi haqida ham ma'lumot beriladi. Bizga 
ma'lumki -web unlbarrirlar saytning asosini yaratishda ishlatilsa 
uni psmlar. grafiklar \'a turli .. illustratsiyalar bilan ~itish ucbun esa 
grafik muharrirtariga murojal qilamiz. Bunda Adobe PbotoShop, Corel 
~. ubi grafik mubarrirlarning o'rni tengsiz. Qo'llanmani yozishda 
ayDan bu dasturlaming tanlab olinisbiga sabab. birinchidan ularning 
professional dasturlar <ptoriga kirishi bo·!sa. illincbidan Adobe 
PbotoShop rastrli grafib bilan. Corel [)rav.- esa veborli gra6ka bilan 
ishlashga nKfljallanganligi uchundir. 
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I-bob. WEB-DIZAYN 

1.1. Web-dizayn. Web-dizayn qo'lIaniladigan dasturlasb vositalar 

Dizayn (ingliz tilidan design injener-konstruktor, lotinchadan 
designare o' lchab ko'rmoq, o' lchab bermoq) - bu ijodiy faoliyat bo·lib. 
uning asosiy maqsadi sanoat buyumlarini formal sifatini belgilaydi. 
Bu sifat shuningdek buyumning tashqi qirralarini o'z ichiga olish bilan 
birga, asosan shu tuzilmaviy va funksional aloqadorlik xaridor hamda 
ishlab chiqaruvchi kO'zi bilan qaraganda buyumni yagona holatga 
keltiradi. Oizayn sanoat ish lab chiqarishi bilan bog'langan insonni o'rab 
turgan atrof-muhitning barcha jabhalarini'Cjurshab oladi [21], [22]. [2~]. 

Dizaynning turlari - dizaynerlik faoliyati loyihalash predmetining 
farqlanishi, loyiha ishining maqsadlari va metodlari hamda uning 
yakuniy natijasi bilan farqlanadi. Dizaynning quyidagi turlari 
mavjud: 

- grafik dizayn, 
- sanoat dizayn, 
- web-dizayn. 
Grafik dizayn 
Grafik dizaynda - informatsion grafika, reklarna va boshqalar 

bilan ishlanadi. Web-dizayn va grafik dizayn nomining o'xshashligiga 
qaramasdan, dizaynning turli yo'nalishlari hisoblanadi. Web-dizayn 
ma' lumotni saytda tasvirlash uchun ishlatiladi. Ammo grafik dizayn 
bilan web-dizayn o'zaro bog'langan. Grafik dizaynda tayyorlangan 
illy ustratsiyalar saytlarni bezashda keng ishlatiladi. Grafik dizayn aslida 
foydalanuvchiga uzatiladigan ma'lumotni qabul qilinishini loyihalashi 
kerak. Grafik dizaynning yo'nalishlari: 

(, 

I. Firma stili. 
2. Shriftlar, 



3. Plakat. 
4. Grafik reklama. 
5. Kitobiy grafika, 
6. Gazeta grafikas~ 
7. Jurnal grafikasl. 
Sa_t d..izaJDi - maishiy buyumlar va asbob-uskunaJarni ishlab 

chiqishda, mashinasozlik obyektJarida, transport \"ositalarida va bosh­
qalarda ishlatiladi. 

Bulardan tashqari diuynning bir qancha ko'rinisblari mavjud. 
Bular: anitektan dizayai, kiyim va aksnsurlar diDy.i. art­
diuya, reldama dizaYDi. 

Web-dizaya (iogliz tilidan olingan bo·lib. web-design - web­
sahifani loyihalash ma'nosini bildiradi) - bu web-sahifani jihoz­
lanishidir. Web dizayn sayt uchun huddi poligrafiya diuyni va qog'ozli 
nashrlar dastgohIari singari muhim rol o'ynaydi. Web-diuyn deganda 
nafaqat web sayt uchun grafikli elementlarni yaratisb, balki uning 
strukturasini Ioyibalash.. unda harakatlanish vositalari, ya'ni butun 
saytni yaratish tushuniladi. Shu sababli ham biz usbbu qO'IIanmada 
nafaqat web muharrirlarnL balki grafik muharrirlar, animator das­
turlarni ham gapirih o·tishni ma'qul ko·rdik. 

~yt qancha ajoyib bezatilgan bo'lmasin., unda qulay va tu­
shunarli barakatlanish chizmasi ma\"jud bo'lmasa, harnmabop ke­
rakli matnlar bo·lmasa. agar sayt yaxshi dasturcbilar tomonidan 
tanor1angan samarali dasturiy vositalarga ega bo'lmasa - bunday 
sayt tezda o'Z foydalamn:cbilarini yo·qotadi \ 'a undagi noqulaylik 
(hanoki u professional \"8 munosib stilda tayyorlangan bo'lsa ham) 

mu\'ofaqiyalsizlikka mahkum bo"ladi. Yaxshi web-diuyn saytning 
sahifalarini hamobanglik bilan birlashtiradi. Boshqacba aytganda, web­
diuyn say-tiling joylashish o"rnini belgilaydi. 

Web-diuynni o"rganishda quyidagi uchta tusbuncha muhim 
ahamiyal kasb etadi: WelHalaifa, WelHa)"1 u Web-sen'u 

WelMahifa - o'zining unikal adresiga ega l)(rlgan va ma.xsus 
ko'rish dasturi yordamida (brauzer) ko'riluvchi hujjatdir. Vnga ma1n. 

grafika, OVoz. yideo yold animatsiya ma'lwnotlar birlashmasi -
mUllimediyali xujjallar. bosbqa hujjatlarga gipermurojaallar kirishi 

mumkin. 



Web-sayt - bir qancha web-sahifalarning mantiqiy birlashmasi. 
Inglizcha «site» (tarjimasi «joy») so'zining o'zbekcha talaffuzi. Umum­
jahon o'rgimchak to'ri ma'lum axborot topish mum kin bo'lgan va 
noyob URL bilan belgilangan virtual joy. Mazkur URL web-saytning 
bosh sahifasi manzilini ko'rsatadi. O'z navbatida, bosh sahifada web­
saytning boshqa sahifalari yoki boshqa saytlarga murojaatlar bo'Jadi. 
Web~sayt sahifaJari HTML, ASP, PHP, JSP, grafik va boshqa fayllardan 
tashkil topgan bO'lishi mumkin. Web-saytni ochish uchun brauzer 
dasturidan foydalaniladi. Web-sayt shaxsiy, tijorat, axborot va boshqa 
ko'rinishlarda bo'lishi mumkin. 

Web-server - tarmoqqa ulangan kompyuter va undagi dastur 
hisoblanib. umumiy resurslarni mijozga taqdim etish yoki ularni 
boshqarish vazifaJarini bajaradi. Web-serverlar ma'lumotlar bazalari 
va multimediyali ma'lumotlarni bir biriga moslashtiradi. Web­
serverda Web-sahifa va Web-saytlar saqJanadi. Web-server - Internet 
yoki Internctga ulangan umumfoydalanishdagi axborot serveri. Unda 
hujjatlar va fayllar - audio, video, grafik va matn fayllari - saqlanib. 
ular foydalanuvchilarga HTTP vositalar ' orqali taqdim etiladi. Web­
server nomi u umumjahon tarmog'ining qismi bo'lgani uchun kelib 
chiqqan . Maxsus dasturiy ta'minotga ega bo'lgan. bir yoki bir necha 
web-sayt fayllarini saqlash va ularga ishlov berish mumkin. Bir necha 
web-sayt bitta kompyuterda ishlaganda, web-server deganda web­
sayt ishlovchi virtual makon (dasturiy ta'minot va kompyuterdagi joy) 
tushuniladi . Shunga ko'ra ko'pchilik uchun «web-server» deganda 
«web-sayt» tushuniladi. Ko'p axborotni saqlovchi web-saytlar bir 
paytning o'zida bir necha kompyuterda saqlanishi va ularga ishlov 
berilishi mumkin. Web-server mijozlarning web-saytga so'roviga javob 
beradi. 

Bu tushunchalarga qo'shimcha web hujjat tushunchasini ham ko'rib 
o·tamiz. 

Odatda, maxsus HTML (Hypertext Markup Language) tiJidagi 
hujjat. Web-hujjat jahon o'rgimchak uyasining asosini tashkil qiladi. 
UJar gipennatndan iborat bo' lib, foydalanuvchiga ajratib ko'rsatilgan 
so'z yoki jumlaga qaratib, ma'lumotlarni o'qish. hujjatning boshqa 
qismiga yoki ayni hujjat bilan giperhavola yordamida bog'langan 
boshqa web-hujjatga o'tish imkonini beradi. Web-hujjat, shuningdek. 
g 



mato, tasvir, tovush, videolarni mujassamlovchi gipermuhit ma'lumotni 
ham o'z ichiga olishi mumkin. Web-hu.ijatni ochish, ularni o'qish yoki 
aks ettirish Internet brauzerlari yordamida amalga oshiriladi. Web­
huijat tushunchasi ~web-sahifalan) va «web-saytlap) tushunchalari 
bilan chambarchas bog'Hq. Odatda «web-sahifa» atamasi web-hu.ijat 
atamasining sinoflimini bildiradi, «web-sayt» atamasi esa yagona mavzu 
ostida birlashtirilgan yoki bina tashkilot, muallif yoki foydalanuvchiga 
tegishli bo'lgan sahifalar majmuasiga tegishlidir. 

Munosib web-dizaynni yaratishda qatnashuvchi quyidagi element­
larni sanab o'tish mumkin: 

Shrift - web sayt ichida imkoni boricba bina shrift, yoki odatda 
ikki-uchta bir-biriga o'xshash (oson qorishadigan) sbriftlami qo'shib 
ishlatish mumkin bo'lgan xususiyatlar va tanlangan fonda o'qish 
mumkin bo'lgan ranglarga ega bo'lishi lozim. 

Abuts - imkoni boricha web saytning barcha sahifalaeida 
matn 'a boshqa vizual materiallarni tekislashning (sozlashning) bie 
kO'rinishlarida bo'lishi maqsadga mu,·ofiq. 

We.,saytDiq rucJi uemasi - sabifaniog oddiy malnilU, havola 
,a tashrif .buyurilgan havolalarni taqdim qilishning uch xii ranglarini 
bel~aydi. Rangli s.xema yqki turli mavzudagi saytning bo-limlari 
UChWl bunday s.xemalarniog bie necbta kO'rinishi saytning hareha 
sahifalarida takrorlanishi Iozim. 

Web-dizayn o'zida belgilangan rangli \"a mantiqiy sxemani bir­
lashtirgan qandaydir grafikli jihozlashni nazarda tutadiki, shuoiog 
ucbun ish bosbida sa~"tni jibozlasbning umumiy konsepsiyasioi o'ylab 
ko' rish kerak bo'ladi, Barcha grafil,; elementlami iUila una sinfga 
a,iratish mumkin; chizilgan va biror real "oqelik fotosuratlari Saytni 
bezash ishlarida bu illi tipni araIashtirib yubormaslik yoki ulami 
\\eb sa~ toing tematik yoki mantiqiy qismlariga to-lrri taqsimlash 
maqsadga muvofiq, Shuni alobida ta'kidlab o"tisb kerakki. ~·tda bar 
~. tipdagi foIo suntJam.i illustnltsiya su-ida isb .. ishdaD oldiIL 
ulami tegishli tarzda qayUl ishIasb (rang \"'a tooda mzlltjsIL k.orre~-a) 

urur. 
Wcb-diaynnillg ~ . ..... - ~ .. tni egasip ~'da (mocidiy. 

m"~-) l.-ekindinn ko"rinishda -.qdim qilisbdan iboraL ~'da ~ .. - -
oopli ~1ami t<fg"ridan-ro-p; sorisb onp.li bo-lishi. shnnio@dek uap 
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qo'shimcha firmalarni, mahsulotlarni reklama orqali yangi mijozlarni 
o'ziga tortish yo'li bilan ham kelishi mumkin. Ta'limda esa bularga 
qO'shimcha o'quv resurslarini yetkazib berish, ta'limni boshqarish 
ishlarini amalga oshirish mumkin. 

Bizga ma' lumki web-dizayner boshqa kasblarga nisbatan yosh 
(yangi) kasb hisoblanadi. Internetga bo'lgan talabning ortishi bilan, 
saytlarning dizayniga bo'lgan talab va web-dizaynerlar soni ham ortib 
bormoqda. 

Endi web loyihalarning asosiy tiplari va ularni har birini vizual 
bezashga qo'yiladigan talablar bilan tanishib chiqarniz. Saytlar tarkibiga 
kO'ra quyidagi asosiy tiplarga bo'linadi: 

Uy sahifasi (/lo.HaUlHRR cmpaHuu,a) tushunchasining bir nechta 
ko'rinishi mavjud: 

I. Alohida shaxsga tegishli web-sayt. Bu saytda shaxs haqidagi 
bir necha mavzudagi ma' lumotlar. matnlar, foto jamlanrnalar berilishi 
mumkin. Odatda bunday saytlarga turli sohalarning (masalan, fan­
texnika, madaniyat, sport va boshqa sohalarda) mashhur kishilari ega 
bo'ladi. 

2. Brauzerda birinchi yuklanadigan web-sahifa. Saytdan foydal!ft1ish 
undan boshlanadi. Odatda, foydalanuvchi o'zining qayerda ekanligi va 
saytning boshqa sahifalarida nimalarni ko'rishi rnurnkinligi haqida uy 
sahifasidan ma'lumot oladi. Brauzer tomonidan dastur yuklangandan 
so'ng terminalda paydo bo'ladigan web-sahifaning, portalning, maj­
muaning birinchi sahifasi. Odatda, prezentatsiya va navigatsiya bo'yicha 
ham asosiy ish bajaradi. 

Prezentatsion sayt - nomidan ko'rinib turibdiki, sayt firma I 
xizmatlar / mahsulotlar haqidagi ma'lurnotlarni taqdirn qiladi. Ma'lurn 
sondagi sahifalarni o'zida birlashtirib. karndan-kam holatda yangilanadi. 
Saytning asosiy vazifasi - taqdim qilinayotgan xizmatlar va uning 
afzalliklarini tashrif buyuruvchilargacha vizual jihozlash yordamida 
maksimal tezlik va samara bilan yetkazib bera olishdan iborat. Bunday 
loyihalar tartib qoidalar bo'yicha aniq, noyob dizayn, grafikli jihozlanish 
matnli ma'lurnotlar oldida ustunlik qiladi. 

Misol sifatida http://www.loyalstudios.com va http://www.de­
signchapel.com saytJarida keltirilgan sahifalarni aytish rnurnkin. 

Korporativ saytlar - tashkilotning (firmalar, korporatsiyalar) inter­
net tarmog'idagi vakolatxonasi hisoblanadi va binobarin, bunday 
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loyihalarda eng asosiy talab ma'lumotni ya'ni grafika yoki matnning 
jihozlanishiga qaratiladi. 

Informntsion resurslar - bu elektron kutubxonalar va gazetalar. 
Bunday tipdagi saytlarda ma' lumotlar bir sutkada bir necha mart a 
yangilanadi. Ma'Jumotlarning hajmi juda ham katta, va bunday saytlarni 
ishlab chiqishda shuni ta'kidlash kerakki, tashrif buyuruvchi saytni 
tomosha qilish uchun emas - ular mazmuni uchun kelishadi. Yangiliklar 
nashri (misol uchun - http://www.cnews.ru) yoki http://si~ht.nmi.ru 
singari rasmlar galereyasida, loyihaning bosh maqsadi - yuqori tezlikda 
ma' lumotni tashrif buyuruvchiga taqdim qilish yoki bu ma'lumotni 
qidirish imkoniyatidan iborat. Har qanday grafikli bezaklar sahifaning 
hajmini oshirib yuboradi - ya'ni sahifaning yuklanish vaqtini oshirib 
yuboradi. Shuning uchun mum kin qadar bunday loyihalarda dizayn 
matnli ko'rinishda ish lab chiqiladi. Kartinkalar, fotografiyalar, grafiklar, 
sxemalar illustratsiyalar hisoblanadi. 

Elektron lijorat - axborot texnologiyalariga asoslangan biznes 
hisoblanadi. Elektron tijorat (ingliz tilidan e-commerce) - internetda 
o'zining sayti va virtual magazini, shuningdek o'zining (firma yoki 
kompaniyaning) boshqaruv tizimi mavjudligi bilan asoslanadi. Elektron 
tijoflOtga quyidagiJar kiradi : ' . 

- elektron ma'lumot almashish (Electronic Data Interchange, EDI), 
- elektron jamg'arma ko'chirish (Electronic Funds Transfer. EFS), 
- elektron savdo (e-trade), 
- elektron karmon (e-cash), 
- elektron marketing (e-marketing), 
- elektron banking (e-banking), 
- elektron sug' urta xizmatlari (e-insurance). 

WelHlizaynda qo'lIaniladigan dasturiy vositalar 

Bugungi kunning talablaridan kelib chiqib to'laqonli web-saytlar 
yaratishda bir qancha turdagi dasturiy vositalardan foydalaniladi. Ularni 
to' rtta katta guruhga ajratish mumkin (l.l-rasm) [11], [12], [13] . 

l!ndan tashqari web muharrirlarning ham turlari juda ko'p. Ular 
o'zining imkoniyati, tezkorligi, interfeysi va boshqa xususiyatlari 
bilan farqlanadi. I-jadvalda shunday dasturlardan asosiylari kel­

tirilgan. 
11 
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N~ dnslUr nomi 

J. Bloknot (Note pad) 

2. HomeSite 4.5 

3. D ItraEdit-32 

4. Web Page Maker 

5. DTM Lome 1.2 
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Web-muharrirlar ro'yxati 

izoh 

J. J -jat/I'u/ • 

Windows operatsion tizimi standart vositala-
ridan bo'lib. undan HTML tilini yaxshi bilgan 
o'rganuvchilar foydalanadi. 

HTML-muharrir. Teglarni ranglar bilan ajratish. 
bir vaqlning o'zida bir nechta faylda qidirish, 
almashtirish va boshqalar. 

Dasturchilar uchun keng imkoniyatli maIn 
muharriri . Bir vaqtning o'zida bir nechta faylni 
tahrirlash imkoniyati mavjud. 

Dastur Software Ine mahsuJoli hisoblanadi . 
Qisqa vagI ichida web-~ahifa yaralish va 
yuklash imkoniyatini beradi . Unda HT~1L tilini 
bilish shart emas. 

Ish boshlovchilar va profess ion a liar uchun 
oddiy. tezkor va qulay HTML-muharrir. 



6. Artisteer.2. 3 .0.1 0943 Dastlabki web-dizaynni avtomatlashtirgan das-
tur. Photoshop, CSS, HTMLlarni bilish talab 
qilinmaydi. 

7. Codelobster Juda qulay PHP, HTML, CSS muharriri 
PHP Edition 3.3 

8. Amaya web-brauzer va HTML-muharrir The World 
Wide Web Consortium (W3C) - tomonidan 
ish lab chiqilgan. 

9. NeonHTML O'zida vizual uskunalarni birlashtirgan HTML 
va CSS muharrir. 

10. Serif WebPlus X2 Professional darajadagi web-saytlar yaratishga 
mo'ljallangan web-dizayn dasturi 

11. PHP Designer 2008 PHP tilida ish boshlayotgan va professional 
Professional 6.2.5.2 foydalanuvchilar uchun dastur PHPdan tash-

qari, dasturda HTML MySQL, XML, CSS, 
JavaScript, VBScript. JAVA, C, Python va 
Rubylarni ham ish latish mumkin. 

12. Dreamweaver ~S4 Murakkab strukturali web-saytlarni loyihalash, 
yaratish va boshqarishga mO'ljallangan profes-

• siO/\al dastur . 

\'" . ". Wap Editor 0.6d Qulay va ko'p funksiyali web-sahifalar yara-
tishga mo'ljallangan dastur. 

14. BestAddress Ko'p funksiyali HTML-muharrir. Dasturda 

HTML Editor 2008 DHTML kodlari yordamida menyu yaratish 
Professional 12.12.0 imkoniyatlari mavjud. 

15. DzSoft PHP Editor PHP - skriptJar yozishga va HTML-sahifalar 

4.2.1 yaratishga mo'ljallangan dastur. 

16. SaveChm 1.2 Rasmli web-sahifalarni tezkorlik bilan CHM 
(Windows-help) formatida saqlovchi dastur. 

17. MenuEditor Web-saytlarda harakatlanish uchun qulay men-

1.0.3.231 yularni yaratishga mo'ljallangan dastur 

18. Quick Page 2008 Web-saytlar yaratishga mO'ljallangan profes-

(3.0.3.254) • sional dasturiy vosita. 

19. AAA Web Album Bu dasturiy vosita web-sahifalar uchun foto 
albomlar yaratish uchun mo·ljallangan. 

\3 



davomi 

20. Multiple File Search Bir vaqtning o'zida web-saytning biT nechta 
and Replace 2.0 fayllari bilan ishlashga mo'ljaIlangan dasturiy 

vosita 

21. Ineomedia Website Foydalanish uehun qulay bo'lgan, tushunarli 
Evolution X5 7.0.9 interfeys va qadamba-qadam yordamehidan 

foydalanib bir neeha minutda web-sayt yaratish 
mumkin 

22. Arachnophilia Java asosida qurilgan HTML-muharrir Sun Mi-
5.3.2177 erosystems mahsuloti hisoblanadi 

23. Web Page Maker Dasturning arxivida bir qaneha tayyor sayt 
v2.5 Rus shablonlari mavjud bO' lib, bir neeha daqiqada 

HTML sahifalar yaratish imkonini beradi 

24. Ineomedia WebSite Shaxsiy web-saytlar yaratishga mo'ljal1angan 
X5 Evolution 7.0 dastur 

25 . AeeHTML Pro Web-saytlar yaratish va ularga xizmat ko;r-
v6.03.0 satuvehi dasturlar paketi 

26. Sothink Web-ustalar uctiun mo' ljalIangan dasturlar "a- ' 
I 

DHTMLMenu 8.3 keti 
build 71210 I 

27. HtmlReader 2.5 html-sahifalarni yaratish, tuzatish va kO'rishga I 

mO'ljallangan dastur. : 

28. PHP Designer 2008 PHP, HTML, XHTML, ess, Perl, e*, jav- I 

Professional v6.0.0 Script, VB, java va SQL muharriri. I 

29. Atani 4.3.4 Rus Web-sahifalar uehun bannerlar yaratishga mo'l-
jallangan dastur 

30. Sothink DHTML menyular yaratishga mo'ljallangan 
DHTMLMenu dastur. Dasturdan foydalanishda DHTML yoki 

JavaSeript bilish talab qilinmaydi 

31. TIGER eMS v1.0 Shaxsiy web-sahifalar yaratishga mo;ljaIlangan 
Lite dastur 

-

Web-dizaynda qo'llaniladigan bir qancha dasturiy vositalar va yana 
ko'plab uskunaviy dasturlar, turli dasturlash tillari mavjud. Eng ko'p 
qo'llaniladigan tillarga misol qilib. HTML-gipermatnlarni belgilash tilL 
PHP, ASP, Java, JavaScript. DHTML va boshqa tillarni aytish mumkin. 
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Mijoz tomonidan 

Web dastu(lash tillari 

Server tomonidan 

1.2-rasm. Web-dasturlash tillarining guruhlarga bo·linishi. 

Web-dasturlash tillari ikki guruhga bo'linadi: mijoz va server tillari. 
Biz yuqorida web-serverga ta'rif berdik. Unga ko'ra server sizning 
saytingiz saqlanadigan, brauzerning so'rovlari qayta ishlanadigan 
qaysidir sahifadagi dasturlar saqlanadi. Undan tashqari serverga 
quyidagicha ta'rif berish mumkin: Server - tarmoq ishini ta'minlovchi 
maxs'us kompyuter. Server disklarida kompyuterlarni birgalikda ishlash . . . 

imkonini beruvchi dasturlar, ' ma'\umotlar omborlari va boshqalar 
saqalanadi. Bundan tashqari serverlar modemli va faksli aloqalarni, 
ma'lumotlarni bosmaga chiqarish ishlarini amalga oshiradi. Serverda 
joylashgan dasturlardan foydalanish doirasi umumiy masalaning 
qo'yilishiga ko'ra cheklangan bo'lishi mumkin. 

Mijoz tomonidagi senariylar 
JnaScript nima? 

Mijoz tillaridan eng ko'p tarqalgani JavaScript tili bo'lib, Netscape 
(Netscape Navigator. www.netscape.com) SunMicrosystems (www.sun. 
corn) kompaniyalari hamkorligida ishlab chiqilgan. JavaScript faol 
HTML-sahifalar uchun senariylar yozishga mo·ljallangan. JavaScript 
avtonom ravishda ishlaydigan ilovalarni yaratishga mo'ljallanmagan. 
JavaScriptdagi dasturlar bevosita HTML-hujjat kodi ichiga quriladi va 
brauzerda sahifani yuklanishi vaqtida faollashadi. Sodda qilib aytganda 
HTMLning cheklangan, sodda imkoniyatlarini kengaytirish va to' laqonli 
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sahifalar yaratishga mo'ljallangan. JavaScript yordam ida odatda 
ma' lumotIi va muloqot oynalarini chiqarish, animatsiyalarni ko' rsatish 
kabi vazifalarni bajarish mumkin. Bundan tashqari, JavaScript­
senariyda ba'zan o'zi ishlab turgan brauzer va platforma tipini aniqlash 
mumkin. JavaScript-senariylar foydalanuvchi tomonidan kiritilayotgan 
ma' lumotlarni to'g'riligini tekshirishda ham qulay hisoblanadi. 

ActionScript nima? 

ActionScript - obyektga yo'naltirilgan dasturlash tili bO'lib, F1ash­
ilovalar tarkibida interfaollik, ma'.\umotlarni qayta ish lash va boshqa 
ko'plab imkoniyatlarni beradigan ECMAScript dialektlaridan biri 
hisoblanadi. 

Silverlight nima? 

Microsoft Silverligbt - bu dasturiy platforma bo'lib, RIA (Rich 
Internet application)ga xos bo'lgan animatsiyalar, vektorli grafika va 
audio-video roliklardan tarkib topgan, ilovalarni yuklash imk~nini 

beradigan brauzer uchun plaginlarni o'z ichiga oladi. Bu esa 
Silverlight barcha brauzerlarda WMY, WMA va MP3 kabi formatlarni 
Windows Media Player singari qO'shimcha komponentlarsiz ijro qilish 
imkoniyatini beradi. Dasturning 2.0 versiyasi 2008 yil oktyabrda ish lab 
chiqilgan ba'lib, unga .NET tilIari bilan ishlash imkoniyati qo·shilgan. 
Bundan tashqari Microsoft kompaniyasi 2009-yil iyulda IDE bilan 
integratsiyalashgan Silverlight 3 va Microsoft Expression Studio 3 
dasturIarini ish lab chiqdi. 

SilverIight platformasi Windows 2000, Windows XP, Windows 
Server 2003, Windows Vista, Windows 7, Mac OS X lOA, Mac OS 
X 10.5, Mac OS X 10.6 operatsion tizimlariga va Internet Explorer 
6.017.0/8.0. MozilIa Firefox \.5/2.013. Safari 3. L Google Chrome 3.0. 
Opera 9.50 brauzeriariga mo' ljallangan. 

VBScript nima? 

VBScript tili Microsoft korporatsiyasi tomonidan yaratilgan bo' lib. 
Visual Basic tilining bir qismi hisoblanadi. VBScript tili Internet 
Explorer va Microsoft Internet Information Server (IIS)lar bilan 
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ishlashga mo'ljallangan tildir. VB Script tilining JavaScript tili bilan 
umumiy qismlari bir nechta. Jumladan, u aynan Microsoft Internet 
Explorer bilan ish lash va uning qo'lIanish sohasin i cheklay olish 
imkoniyatiga ega. VBScript interpretatorli (sbarh lovchi, izohlovchi, 
tushuntirib beruvchi) tiL hisoblanib, Microsoftning Web-texnologiyalari 
(masalan ASP (Active Server Page)) bilan hamkorlikda ishlay 
oladi. Shunga qaramay VBScript klient tomonida ishlovchi senariy 
hisoblanadi, ASP esa server tomonida ishlaydi. 

Server tomonidagi senariylar 

Dasturning ishlashi to'liq sayt joylashtirilgan serverga bog' liq. 
Server tillarini ishlashining muh im jibatlaridan biri bu serverda 
tartiblangan holda saqlanuvchi va xoh lagan paytda chaqirilishi mumkin 
bo' lgan ma' lurnotlarni bevosita rna' lumotlar bazalarini boshqarish 
tizimlari bilan o'zaro bog'langan holda faoliyat yuritadi. Eng ko'p 
ishlatiladigan ma' lumotlar bazasini boshqarish tizimlari quyidagilar: 
Firebird, IBM DB2, IBM DB2 Express-C, Microsoft SQL Server, 
Microsoft SQL Server Express, mSQL, MySQL, Oracle, PostgreSQL 
SQLite, Sybase Adaptive Server Enterprise. 

Server tomonida bajarilishi- kerak bo' lgan senariylar odatda sayt 
papkasining ichidagi maxsus papkaga joylashtiriladi. Foydalanuvchi 
so' roviga asosan server bu senariyni bajaradi. Bajarilgan senariy natijasi 
web-serverga uzatiladi va undan so'ng mijoz (klient)ga uzatiladi. Server 
tomonidagi senariylarni tashkil etish uchun odatda Peel, ASP, PHP, JSP, 
SS} kabi tiltar va texnologiyalardan foydalaniladi. 

Perl nima? 
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kompyuterda Perl-interpretator o'rnatilgan bo'lishi kerak. Bevosita 
Perl-kodning interpretatsiya qilinish jarayoni uning samaradorligini 
pasaytiradi. Bugungi kunda Perlning asosiy yutuqlaridan, uning barcha 
platformalar uchun ish lay olishi va uning barcha resurslari bepul 
tarqatilayotganligidir. Ko'pgina web-serverlar UNIXda ishlaydi. Perl 
interpretator esa bu operatsion tizimning bir qismi hisoblanadi . 

ASP Rima? 

ASP (Active Server Pages) - ma'lumotlar bazalari tashkil etish 
va ular bilan ish lash vazifalarini bajarishda juda moslashuvchan. 
qulay vositadir. ASP vositalari server tomonida ishlaydi va HTML­
kod va senariylar kabi fayllarni qayta ishlaydi. ASP texnologiyasi 
YBScript, Java va JavaScript tillarini qo' lIab quvvatlaydi. ASP­
kod joylashtirilgan Web-sahifalar fayllari kengaytmasi .asp bo'ladi. 
ASP texnologiya Windows NT va Microsoft lIS web-serveriga 
mo'ljaIlangan bo'lib, imkoniyatlari va samaradorligi yuqori bo'lganligi 
bois kO'pgina kompaniyalar o'z vositaklriga ASPni qo'lIab-quvvitlash 
imkoniyatlarini kiritmoqdalar. Ko'pgina HTML-muharrirlar. masalan. 
Adobe GoLive ham ASPni qo'lIab-quvvatlaydi. ASP texnologiyasi 
bir nechta qulayliklarni o'zida jamlagan: HTML-hujjatni dinamik 
generatsiyalaydi, formalarni qO'I1ab-quvvatlaydi, ma' lumotlar bazasiga 
ruxsatni tashkil etadi va u bilan ishlay oladi. ASP - dasturlash tili 
ham, ilova ham emas. u interfaol web-sahifa hosil qilish texnologiyasi 
hisoblanadi . 

PHP nima? 

PHP - bu serverda qayta ishlanuvchi senariylar tilidir. ASP kabi 
PHP kodlar ham bevosita HTML-hujjatni tarkibiga qo'shiladi. Ushbu 
tilning nomi Personal Home Page Tools so'zlarining qisqartmasidan 
olingan. PHPda C va Per! tillarida uchragan bir qator muammolar hal 
etilgan . Bundan tashqari. PHP ma'lumotlar bazasi bilan ish lash uchun 
juda qulay vositadir. Urn urn an olganda Perl, PHP - ochiq tizimli tillar 
hisoblanadi va ularni dasturchilar modernizatsiyalashtira oladi. 

Ko'pgina boshqa dasturlash tillaridan farqli ravishda. PHP qandaydir 
tashkilot yoki kuchli dasturchi tomonidan yaratilgan emas. Uni oddiy 
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foydalanuvchi Rasmus Lerdorf 1994-yili o'zining bosh sahifasini 
interfaol uslubda ko'rsatish uchun yaratgan. Unga Personal Home Page 
(PHP - shaxsiy bosh sahifa) deb nom bergan. 

1995-yili Rasmus PHPni o'zining HTML formalari bilan ishlaydigan 
boshqa dastur bilan umumlashtirib PHP/FI Version 2 (<<Form 
Interpretator») hosil qildi. 1997-yilga borib PHPdan foydaJanuvchi 
saytlar 50 mingdan oshdi. Shundan so'ng web texnologiya ustalari 
PHP g'oyasi asosida mukammal til yaratishga Ziva Suraski va Endi 
Gutmans asoschiligida kirishildi. PHPni samarali deb hisoblanmagani 
uchun deyarli noldan boshlab, mavjud C va Perl tillaridan ibrat olib 
PHP1 talqinini yaratildi. 1999-yilga kelib PHP asosida qurilgan saytlar 
milliondan oshib ketdi. 2000-yilda esa Zend Technologies shirkati yangi 
kO'pgina funksiyalarni qo'shgan holda PHP 4 sharhlovchisini yaratdi. 

PHP - web texnologiya tili. PHP ni o' rganish uchun avval HTML 
va dasturlash tilidan habardor bo'lish talab qilinadi. HTMLlCSS va 
JavaScript tillarini mukammal biladiganlar uchun PHPni o' rganish 
murakkablik tug'dirmaydi. PHP ning vazifasi HTML faylini yaratib 
berish. JavaScript yordamida bajariladigan kO'pgina operatsiyalarni 
PHP orqali ham am alga oshirish mumkin. 

J3¥aScript - mijoz tomonda bajariladi, PHP esa serverda bajariladi. 
PHPda yozilgan kod serverni"ng o'zida bajarilib, klientga HTML 
shaklida etib boradi. Bu havfsizlik jihatdan ancha maqsadga muvofiq. 

JavaScript yordamida kod yozish, ma'lumot uzatish va qabul qilishni 
biroz tezlashtirsa-da, kodni mijoz ko'rish imkoniyatiga ega bo'ladi. 

«PHPda har qanday dasturni bajarsa bo'ladi» - degan edi uning 
yaratuvchisi. Birinchi navbatda PHP tili server tomonidan bajariladigan 
skriptlar yaratish uchun foydalaniladi va aynan shuning uchun u 
yaratilgan. PHP tili ixtiyoriy CGI-skriptlari masalalarini yechishga va 
bundan tashqari html formali ma'lumotlarni qayta ishlashga hamda 
dinamik ravishda html sahifalarni ishlab chiqishga qodir. Biroq PHP tili 
foydalaniladigan boshqa sohalar ham mavjud. Bu sohalarni biz uchta 
asosiy qismga bo'lamiz: 

Birinchi soha - biz yuqorida aytib o'tganimizdek, server tomonidan 
bajariladigan ilovalar (skriptlar) yaratish. PHP tili bunday turdagi 
skriptJarni yaratish uchun juda keng qo'Uaniladi. Bunday ish ko'rsatish 
uchun PHP-skriptlarni qayta ishlovchi va skriptJarni qayta ishlovchi 
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web-server, skript/arni natijasini ko'rish uchun brauzer va albatta php­
kodini yozish uchun qanday bo'lsa ham matn muharriri kerak bo'ladi. 
PHP- skriptlarni qayta ishlovchi CGI-dasturlar ko'rinishida yoki server 
modu11ari ko'rinishida tarqalgan. 

Ikkinchi soba - buyruqlar satrida bajariladigan skriptlarni yara­
tish. Ya'ni PHP tili yordamida biror-bir kompyuterda brauzer va 
web-serverlardan mustaqil ravishda o'zi bajariladigan skriptlarni 
ham yaratish mumkin. Bu ishlarni bajarish uchun hech bo'lmaganda 
PHP-skriptlarni qayta ishlovchi (bu holatda biz uni buyruqlar satri 
interpretatori (ell, command line interpreter) deb ataymiz) talab 
etiladi. Bunday ish lash uslubi turli masalalarni rejalashtirish yordamida 
bajarilishi uchun kerak bo"lgan skriptlar yoki oddiy matnni qayta 
ishlash uchun kerak bo'lgan masalaga o'xshash ishlaydi . 

Uchiochi soha - bu mijoz tomonidan bajariladigan GUI-ilovalarni 
(grafik interfeys) yaratish. Bu soha PHP tilini endigina o' rganayotgan 
foydalanuvchilar uchun uncha muhim bo'lmagan sohadir. 

PHP tilini qo'llanilish sohalari keng va turlichadir. Yuqoridagi 
masalalarni yecha oladigan boshqa turlicha dasturlash ti11ari ,ham 
mavjud. Unda nima uchun PHP tilini o'rganishimiz kerak? U til bizga 
nima beradi? Birinchidan, PHP tili o'rganish uclrun juda qulay. PHP 
tilini sintaksisi asosiy qoidalari va ishlash prinsipi bilan yetarlicha 
tanishib chiqib o'zingizni shaxsiy dasturingizni tuzib ko'rib, so'ngra 
lIni boshqa dasturlash tillarida tllzilgan variantlari bilan solishtirsangiz 
bunga gllvoh bo'lasiz. Ikkinchidan, PHP tili barcha bizga ma'lum 
platformalarda, barcha operatsion tizimlarda hamda turlicha serverlarda 
erkin ish lay oladi. 

PHP dasturlash tilini turli dasturlash tillari o'rtasidagi o'zaro 
aloqasiga diqqatni qaratsak, bunga Java dasturlash tilini aytib o'tish 
lozim. chunki Java dasturlash tili obyektlarini PHP tili o'z obyektlari 
sifatida qaraydi. Obyektlarga murojaat sifatida CORBA kengaytmasidan 
foydalaniladi. 

JSP 

JSP (JavaServerPage) texnologiyasi o'zining funksional imkoniyat­
lariga ko'ra ASPga o'xshashdir. Asosiy farqi shundaki, bunda VBScript 
va JavaScript bilan birga Java tili ham qo'l1anila oladi. Shunga qaramay 
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lSP lavadan oldinroq qo'lIanilgan va ushbu texnologiya mukammal 
Web-i1ovalar yaratish uchun yetarli imkoniyatga ega. 

SSI 

SSI (Server Side Include) HTML-faylni dastlab serverda qayta 
ishlaydi va undan so'ng uni rnijozga uzatadi. Dastlabki qayta ish lash 
vaqtida hujjatga dinamik generatsiya qilingan rna'lumotlar qo'shiladi. 
Masalan joriy vaqt haqidagi ma'lumot. Umuman olganda SSI 
texnologiyasi HTML-faylning tarkibiga qo'shimchalar qO'shishga 
mo'ljallangan HTMLning qismi hisoblanadi. 

DHTML nima? 

DHTML (dinamik HTML) - bu serverga ortiqcha bog'lanishlarsiz 
interfaol Web-sahifalar yaratish imkonini beradigan vositalar to'p­
larnidir. 

DHTML tili HTML va lavaScriptlardan farqli ravishda bir qancha 
qo'shimcha internet texnologiyalariga ega. Dinamik HTML - Netscape 
va Microsoft tornonidan o'ylab topilgan tijorat termini bo'lib, unda 
Web-brauzerlarning dinamik imkoniyatini kengaytirish maqsadida 
kiritilgan. Bu texnologiyalar HTML yordamida Web-sahifa yaratishdagi 
mavjud imkoniyatning cheklanganligi va ana shu cheklo\'dan o·tib 
ketish uchun yaratilgan yoki qo'shilgan hisoblanadi. Chunki bizga 
ma'lumki HTMLning faqatgina o'zidan foydalanib bugungi kunda 
mukammal Web-sahifalar yaratib bo'lmaydi. Boshqacha aytganda 
mavjud Internetda matnli ma'lumotlar va grafik ma'lumotlarga 
mo'ijallangan juda yaxshi texnologiyalar mavjud edi. Ammo multimedia 
imkoniyatlariga ko'nikib qolgan odarnlar esa bunga ko'nika olmadi. Shu 
sababli Internet imkoniyatlarini kengaytirish kerak edi. 

DHTML asosida yaratilgan sahifa serverdagi qo'shimcha ma'­
lumotlarga murojaat qilmasdan turib ham o'zgarish imkoniyatiga ega. 
DHTML o'zida turli xildagi standartlarga (CSS, OOM, lavaScript va 
gipermatnlarni belgilash tillariga) asoslangan kombinatsiyalarni namoyon 
qiladi. Bu standartlarning kombinatsiyasi sizning web-sahifangizni 
interfaolligini oshirish imkonini beradi. Boshqacha aytganda, sahifaga 
tashrif buyurgan foydalanuvchi uning tashqi ko'rinishi va mazmunini 
serverga murojaatlarsiz o'zgartira olish imkoniyatidir. 
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1.2. HTML tHi baqida 

Bizga ma'lumki, har qanday murakkablikdagi web-saytlar HTML 
tiliga asoslangan bO'lib, bu tilni bilmasdan turib to'llKjonli wcb-saytlar 
yaratib bo'lmaydi. Endi HTML tilining asoslari bilan tanishib chiqamiz. 

HTML (Hyper Text Markup Language) - giper matnlarni belgilash 
tili degan ma'noni anglatadi. HTML - web sahifada matn. tasvir va 
boshqa ma'lumotlarni qanday kO'rinishda joylashtirilishini belgilovchi 
vosita. Bu til 1989-yilda Jenevada Tim Berners-Li (Tim Berners-Lee) 
tomonidan yaratilgan. Keyinchalik Tim Berners-Li «Internet otash) 
nomiga sazovor bo' lgan. Til dasturlash tili emas. faqat Web-sahifa 
yaratish uchun mo'ljal\angan. Web-sahifada biror ma'lumotlarni qayta 
ishlash algoritmlarini o'rnatish uchun Java tilida tuzilgan dasturlardan 
foydalan iladi. 

Ushbu ma'lumotlardan foydalanib. ko'zda tutilgan asosiy maqsad 
-HTML haqida as(\siy tushunchalarni misollar yordamida tushuntirib 
berish, HTMLning bir-oz qiyin bo'lgan elementlari hisoblanmish jadval 
tuzish, freymlardan foydalanish va sallifaga tasvirlarni joylashflirish. 
sahifalarni bir-biriga faol havolalar orqali bog'lash usullarini ko'rsatih 
berishdan ibora1. 

Teg tushuDcbasi 

HTML sahifa - bu oddiy matn fayl bo'lib. HTML kengaytmasiga 
ega. HTML sahifani yaratish uchun maxsus dastur shart emas. Har 
qanday matn l11uharriri yordamida HTML sahifa yaratish mumkin. 
Ana shunday matn tahrirlovchi oddiy dasturlardan biri bo' lgan Notepad 
(6noKHoT) standart holatda Windows mo'hitida mavjud. HTML 
sahifaning asosiy elementlaridan biri bo'lgan teglar haqida dastlabki 
tushunchalar bilan tanishib chiqamiz. 

HTML teg 

HTML teg bu HTML hujjatdagi turli elementlarni (matn, tasvir 
va boshqalar) web sahifada qanday ko'rinishda aks etishi lozimligini 
brauzerda ko'rsatuvchi buyruqlar hisoblanadi. Teglar ma'lum o'\cham 
va vazifani bajaruvchi buyruqlardir. 
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Teg quyidagi kO'rinishda bo'ladi: <TEG> hujjat elementi </TEG> 
Ko'rib turganingizdek teglar < > uch burchaksimon qo'shtironoq 

(burchak qavs) ichiga olib yoziladi. lJch burchaksimon qo'shtironoq 
ichiga teg nomi va uning atributlari yoziJadi. 

Quyida teg va uning atribut yozilishiga misol keltirilgan: 
<B> <FONT COLOR=«red»> Hello World! </FONT> </B> 
Misolda keltirilgan teglar HTML hujjatga kiritilgan Hello World! 

jumla qizil rangda, ajratilib yoziladi. Teglar orasida kiritilgan matn, teg 
atributida qanday vazifaJar berilgan bo'lsa, shu vazifaga bo'ysungan 
holda ekranda hosil bo'ladi. Bu misolda Hello World! jumlasiga 
nisbatan ikkita teg ishlatilgan. J - teg <B> va 2 - teg <FONT> Hello 
\Vorld! jumJasidan keyin yana ikki teg </B> va </FONT> yoziJgan. 
Bularning farqi shundaki, birinchi ikkita teg ochuvchi va jumladan 
so'ng yozilgan ikkita teg esa jumJa oldida yozilgan tegJarni davomi 
ya'ni yopuvchi tegdir. Yopuvchi teglarning vazifasi ochilgan teg ta'sir 
maydoni tugaganligini belgilashdan iborat. HTML hujjatda deyarli 
barcha teglarni yopish Jozim. 'I' belgisini qo'yish orqaJi yopuvchi teg 
yasaladi. 

Eslatma: har doim eng oxirgi ochiJgan tegni birinchi navbatda 
yopishni unutmang. TegJarning ochiJishi va yopiJish tartibini almashtirib 
yub'ormang. Aks hoJda xatoliklar kelib chiqishi mumkin. 

Endi e'tiborimizni <FONT COLOR=«red»> ga qaratamiz. FONT 
(shrift) teg nomi, COLOR (rang) - esa tegning tarkibidagi qO'shimcha 
atribut, red (qizil) - rangning belgisi. Bu teg matnni qizil harflar bilan 
yozilishini anglatadi . Ayni misolda ranglarni o'zgartirish uchun red so'zi 
o'rniga boshqa rang nomini kiritish kifoya. Matn shu zahoti siz kiritgan 
rang bilan ifodalanadi. Vshbu teg va uning qO'shimcha atributlari 
qanday yozilishini eslab qoling. Bu sizga keyinchaJik ham as qotadi . 
Teglarning atributi bir nechta bO'lishi mumkin va ularni kiritganda har 
- biri orasida bO'sh katakcha ya'ni probel qoldirishni esdan chiqarmang. 

HTMLda teglarni ishlatish shartlari 

Siz yuqorida teg tushunchasi haqida qisqacha tushunchaga ega 
bo'lgansiz. HTML teglarni ishlatganda ularni to'g'ri yozish muhim 
ahamiyatga ega. Quyida teglarni to'g'ri yozish va ish latish shartlari 
haqida so'z yuritamiz. Bu borada quyidagi qoidalar mavjud: 
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• Barcba teglar ucb burcbakli qo'sbtirnoq icbida yoziladi 
'<TEG>'. 

Ochuvchi teg - uch burchakli qo'shtirnoq, teg nomi va uning 
qo'shimcha atributlari (zarur bo'lgan taqdirda). Yopuvchi teg -
uchburchakli qo'shtirnoq. '/' slesh belgisi va teg nomi . 

• Probel orqali yoziluvchi teglar atributlari. 
Teg nomidan so'ng uning qO'shimcha o'1chamlari bO'lishi mumkin . 

Barcha atributlar probel orqali ajratib yoziladi. Bitta harf hajmidagi 
bo'sh joy qoldirilish HTMLda probelni anglatadi. 

<TEG I - atribut=yuklatilgan vazifa 2 - atribut=yuklatilgan va­
zifa .. . > 

• Qo'shtirnoq ichida yoziluvchi yuklatilgan vazifalar ma'nosi. 
Ma'lum vazifani bajaruvchi buyruqlar tenglik belgisidan 

so'ng qo'shtirnoq « ... » ichida yoziladi. Agar probel ishlatilmagan 
taqdirda qo'shtirnoqni tush irib qoldirish mumkin. <FONT SIZE=2 
FACE=«Times Roman»> Har hit hatoliklar kelib chiqishini oldini CIlish 
uchun qo'shtirnoqlarni ish latish maqsadga muvofiq. 

• Aksariyat teglar yakunlasb buyrug'ini talab qiladi. 
Agar siz tegni yopmagan taqdiringizda aksariyat hollarda hatolik 

kelib chiqmaydi. Ammo ochilgan teg atributlari butun hujjatga ta'sir 
qiladi . Jadval ichida yopilmagan taqdirda bu hatolikni keltirib chiqarishi 
mumkin. Bu haqda jadvallar tuzish bo' limida so'z yuritamiz. 

• Teglarni yopish qoidasi 
Har doim teglarni qat ' iy tartibga rioya qilgan holda yoping. Birinchi 

navbatda eng oxiri ochilgan teg yopiladi va shu tariqa navbati bo'yicha 
barchasi yopiladi . <TEGI> <TEG2> <TEG3> ... </TEG3> <ITEG2> 
</TEGI> 

• Teg harftar yozish shartlari. 
HTML hujjatda teglarni katta yoki kichik harflar bilan yozilishi 

hech qanday ahamiyatga ega emas. Hamma teglarni katta vcki 
kichik harflar bilan yozishingiz mumkin. Hattoki mana bu~day 
<teg></Teg> Sizga maslabatimiz: barcha teglarni bir hil shaklda 
yozgan ma'qul. 

• Teg atributlarini yozisb tartibi qanday bo'lishi abamiyatsiz. 
Teg tarkibidagi atributlar qanday tartibda yozishingiz hech qanday 

o'zgarishlarga sabab bo'lmaydi. Quyidagi ikki variant ham to'g'ri : 
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boshqa foydalanuvchilari bilan muloqot tashkil qilish va uni quvvatlash 
kabi qo'shimcha imkoniyatlarga ega bo'lishi mumkin. Eng ommaviy 
tarqalgan web-brauzerlarga misol qilib Internet Explorer, Opera, Avant 
Brauzer, Mozilla kabi dasturlarni aytishimiz mumkin. 1.2-jadval 
brauzer dasturlarning ro'yxati va imkoniyatiari keltirilgan. 

l.2-jadval 

Brauzer dasturlari ro'yxati 

NQ Brauzer nom i: Imkoniyatlari 

1. Opera 10.63 Opera Software kompaniyasi dasturidir. Bu dastur 
43 tildagi foydalanuvchilar uchun mo'ljallangan 
bo'lib, Windows, Linux va Mac operatsion 
tizimlarida ishlaydi. 

2. Mozilla Firefox Mozilla Firefox - tezkor, ko'p funksiyali brauzer 
dasturi. Firefox dasturida bir oynada bir nechta 
sahifani ochish mum kin . Shuningdek, SIZ 

giper havolalarni shu sahifani (siz ayni p~tda 
ko'rib turgan sahifani) tark etmasdan turib, 
ochish imkoniyatiga ega bo'lasiz. Brauzer web. 
standartlarni juda yaxshi qO'lIab, unda juda qulay , 
interfeys mavjud va o'zida qidiruv paneli (Google ~ 
va boshqalar) joylashgan. I 

3. Google Chrome Google Chrome - bu brauzer. murakkab tex-
nologiyalarni va sodda dizaynni birlashtirgan 
va bu esa Internetda ishlashni tezlashtiradi va 
xavfsizligini oshiradi . 

4. Apple Safari Apple Inc. kompaniyasining brauzer dasturi I 

hisoblanadi. Dastlab dastur Mac OS operatsion 
tizimi uchun ish lab chiqilgan edi . Dasturda ko'p 
oynalik interfeys mavjud bo'lib, unda xavfsizlik 
uskunalari bilan boyitilgan. 

5. Maxthon Internet-brauzer dasturi. Maxthon web-sahifalarni 
ko'p oynaJi rejimda ko'rish imkonini beradi . 
Dasturning asosiy xususiyatlaridan biri ko'p sonli I 

bog'lanishlar imkoniyati mavjud. j 
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6. Avant Browser Bu brauzer ham ko'p oynali rejimda ishlaydi.' 
Ya'ni asosiy oyna ichida kO'plab oynalarni ochish 
imkoniyati mavjud. Avant Browser daslurida I 
sichqoncha tugmasini bir bosish bilan grafiklar, I 

video, tovushlar va Flash animatsiyalami yuk-
lashni taqiqlash yoki aksincha ruxsat berish I 
imkoniyati mavjud. 

7. Netscape Navigator Dastur o'zining oddiy va yengiJ sozlanadigan I 
foydalanuvchi interfeysi bilan va tezkorligi, ish-' 
lashga qulayligi hamda web-sahifalarni kO'rishni i 
boshqarish irnkoniyat/ari kengaytirilgan. 

Bizga ma' lumki yaratilgan web-sahifalarni ishlatib ko'rishda 
o'zimiz bilgan yoki bilmagan holda brauzer dasturiga murojaat qilamiz. 
Ana shu paytda yaratilgan web sahifani ochish uchun uning fayli 
ustida sichqonchaning chap tugmasini ikki marta ketma-ket bosish 
yetarli. Bundan tasbqari avval brauzer dasturini (Internet Explorer) 
ishga tushirib olib, keyin esa File > Open buyrug'ini berish orqali 
ham faylni ishga ~ushirish mumkin. Hammamizga ma'lumki, web 
sahifani yaratish vaqtida uning qanday dizaynda chiqayotganini ko'rish 
uchlll1 biz brauzer dasturlariga-- qayta - qayta murojaat qilamiz. Ayrim 
professional dasturlarda (Dreamweaver va boshqalar) natijani ko'rish 
uchun to'g'ridan-to'g'ri maxsus tugma bosiladi. Bunda to'g'ridan­
to'g'ri belgilangan brauzerda sahifa yuklanadi. Bu haqida Dreamweaver 
dasturida batafsil ma'lumot beramiz. 

HTML ltujjatning asosiy strukturasi 

Siz yaratgan ilk HT~L sahifa asosida HTML huijat asosiy 
strukturasini tahJil qilamiz. KompYuter xotirasiga saqlangan HTML 
hu.ijatni Notepad dasturi yordamida oching. Har qanday HTML huijat 
ichki qismi quyidagilardan tashkil topgan bo'ladi: 

<HT~L> 
bu teg HTML huijatni ochish (boshlash) uchun xizmat qiIadi va u 

HTML bu.ijatning birinchi ochuvcbi va oxirgi yopuvchi teg hisoblanadi. 
Bosbqacha aytgabda web sabifaning boshlanish va tugash cbegarasini 
ifodalaydi. Coing yagooa vazifasi. mazkur huijatni ochayotgao dasturga 
bu f~1 HlML huijatligi haqida axborot berishdan iborat. 
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<HEAD> 
HEAD tegidan so·ng HTML hujjatning tizimli axborotlari haqida 

ma' lumot beradi. Bizning misolimizdagi yagona tizimli axborot -
TITLE tegi hisoblanadi. 

<TITLE> 
Bu teg ochuvchi teg <HEAD> va yopuvchi teg </HEAD> orasida 

yoziladi. Ochuvchi va yopuvchi TITLE orasida kiritilgan axborot siz 
yaratayotgan hujjat nomini anglatadi. Siz kiritgan nom brauzer dasturi 
tomonidan va internetdagi qidiruv tizimlari tomonidan ishlatiladi. Biz 
keltirilgan misolda «Eng sodda ko'rinishdagi HTML sahifa!» matni 
brauzer dasturi yuqori qismida ya'nisarlavha satrida namoyish etiladi. 

<BODY> 
BODY ochuvchi va yopuvchi teglari orasida yozilganlarning 

barchasi sizning HTML hujjatingizning tanasi hisoblanadi. Agar siz 
ushbu teg orasiga matn yozsangiz yoki tasvir kiritsangiz - bularning 
barchasini brauzer ekranda namoyish etadi. 

Har qanday HTML hujjat quyida keltirilgan tartibda yozilishi shart: 
<HTML> HTML h ujj at boshi <HEAD> Hujjat nomlanishi~ng 

boshlanishi <TITLE> ... </TITLE> HTML sahifa nomi (sarlavhasi) 
<HEAD> Hujjat nomlanishining yakunlanishi <BODY BGCO­
LOR = «white»> Hujjat tanasining boshlanishi ... <fBODY> Hujjat 
tanasining yakunlanishi <fHTML> HTML hujjat yakuni. 

HTML sabifaga tasvir joyJashtirish 

Internet bilan ishlovchi dasturlar tasvi rlarni (grafik elementlarni) 
ochish imkoniga ega bo' lishi bilan internetda mavjud sahifalarning 
deyarli barchasi tasvirli axborotlarni nashr eta boshladi. Siz yaratgan 
web-sahifa qiziqarli va chiroyli dizayn asosiga qurilgan bo·lsa uning 
o'quvchilari soni shubhasiz ortadi. Tasvirlar yordamida harakatlanuvchi 
tugmalar va Gif animatsiyalarni kiritish mumkin. Biroq tasvirlar bilan 
ishlashda ularni hajmi va formatiga e'tibor berish kerak. Hozirgi paytda 
internetga joylashtirilayotgan deyarli barcha sahifalardj ishlatiJayotgan 
tasvirlar formati *.JPEG yoki *.GIF ni tashkil etadi. Bunga asosiy 
sabab. bu formatdagi tasvirlar hajmi juda kichik. Bu formatdagi 
tasviriar ishlatilganda web-sahifa hajmi ortib ketmaydi va sizning web 
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sahifangizdan foydalanuvchi sahifani internetda ochilishini uzoq vaqt 
kutmaydi. 

Agar siz boshqa formatdagi tasvirlardan web-sahifani bezashda 
foydalansangiz uning hajmi ortib ketadi va undan foydalanuvchilarga 
sahifani ochishda muammolar keltirib chiqaradi. Web-sahifani 
bezatishda uning dizayniga ·.GIF formatdagi tasvirlardan foydalaning. 
Boshqa maqsadlarda ·.JPEG dan foydalanishingiz mumkin. 

<img> tegini qo'llash qoidalari 

<IMG> tegi bilan bog'iiq bO'lgan, quyida keltirilgan asosiy qoidalar 
bilan tanishib chiqing va o'z sahifangizni yaratishda ushbu qoidalarga 
doim rioya qilishga harakat qiling. 

• Tasvir nomi va joylashgan o'rnini yozganda harflarning bir 
hilda bo'lishini ta'minlash katta ahamiyatga ega. Tasvir joylashgan 
papka nomi va tasvirning nomini kiritganda harflarni bir hilda yozilishi 
shart. Biror bir harfni tushirib qoldirish yoki hato yozilishi tasvirni 
ochishda hatoliklarni keltirib chiqaradi. 

• Tasvir yoki papka nomini kiritganda probel ishlatmang. Web­
sahifani yaratayotganingizda ~ayllar yoki papkalar nomini kiritganda 
probel (bo'sh joy) ishlatmang. Agar siz kiritgan nom ikki yoki undan 
ortiq sO'zlardan iborat bo'lsa, probel o'rnida (pastgi chiziqcha) 
ishlatishingiz mumkin. Masalan: .. '/Chet_elga_sayohat/Ispaniya/Ma­
laga _ Ol.jpeg 

• Internetda ishlatiluvchi tasvir formatlari. Hozirgi paytda 
internetda ikki hi! formatdagi tasvirlar keng qo'llanilib kelinmoqda. Bu 
formatlar : GIF (bu formatdagi tasvirlar ·.gif qisqartmasiga ega) hamda 
JPEG (bu formatdagi tasvirlar esa •. jpg yoki ·.jpeg qisqartmasiga ega). 
Siz ham ushbu formatdagi tasvirlardan foydalaning. Boshqa formatdagi 
tasvirlarni aksariyat brauzerlar ocha olmaydi. 

• Har doim WIDTH n HEIGHT atributlarini kiritishga 
harakat qiling. Bu sizning web-sahifangizni ochilishini tezlashtiradi 
va tasvirlarni as! o'Jchamda bo'lishini ta'minlaydi. 

• Tanir hajmioi suo'iy kichraytirish. WIDTH va HEIGHT orqali 
tasvirning real atribut o'1chamlarini kichraytirish mumkin. Ammo 
bu usuldan iloji boricha kamroq foydalanish kerak. Eng yaxshi usul 
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tasvirni real o'lchamini grafik muharrirlar yordamida kichraytirishdir. 
Bu usul tasvirning ochilish vaqtini kamaytiradi . 

• Tasvir hajmini sun'iy kattalashtirisb. Tasvir o'lchami kat­
talashtirilganda yoki kichraytirilganda uning sifatida o'zgarish 
sodir bo'ladi. Agar siz o'lchamJarni o'zgartirganda bo'yi va enini 
proportsionaIligiga e'tibor bermasangiz, tasvir sifatini buzilishiga 
olib keladi. WIDTH va HEIGHT atributlari orqali tasvir hajmini 
kattalashtirganda, real o'lchamni 2 marta, 3 marta va shu tariqa 
oshishiga erishish kerak. Masalan, tasvirning real o'lchami WIDTH = 
=« 100», HEIGTH = «200» ga teng bo'lsa, uni ikki marta kattalashtir­
ganda WIDTH = «200», HEIGTH=«400» ga teng bo'lishi shart. Bu usuJ 
tasvir sifatidagi salbiy o'zgarishlarni bir oz yumshatadi. Shuningdek, 
ayni holatni tasvir o'lchamini kichraytirishda ham qo'lIash maqsadga 
muvofiq . 

• Har doim ALT atributini qo'lIang. 
Har doim ALTdan so'ng tasvirga aloqador qO'shimcha axborotni 

kiritishga harakat qiling. Buning asosiy sababi, siz joylashtirgan tasvir 
ochilmagan taqdirda, Internetdan foydalanuvchi siz kiritgan r.tsvir 
izohini o'qiydi va minimum axborotga ega bo'ladi. 

Giperhavolalar - web-hujjatlarni bir-biriga bog'lash 

Web-sahifaga tasvir joylashtirishni o'zlashtirib olganingizdan so'ng, 
endigi navbatda havolalar haqida tushuncha olishning ayni mavrudi. 
Havolalar tufayli internet hozirgi mavqeiga erishdi. Havolalar yordamida 
ikki va undan ortiq (cheksiz) web-sahifalarni bir-biriga bog'lashingiz 
mumkin. Havola rus tilida «CCbIJ1Ka» deb ataladi. Havolaga bosish 
orqali siz ikkinchi sahifani ochishingiz mumkin. Havolalar yordamida 
web-sahifangiz uchun menyu tuzishingiz mum kin. Havolalar sizning 
web-sahifangizdan foydalanuvchini sahifa bo'ylab tom ma'noda sayohat 
qilishi imkonini beradi va unga to'g'ri yo'lni kO'rsatib turadi. 

Havolalar 

Havola - bu HTML hu.ijatning boshqa HTML hujjat bilan bog'lovchi 
qismi. Unga kursorni bosishingiz bilan ikkinchi HTML hujjat ekranda 
namoyon bo'ladi. Shuningdek, havoladan (agar siz yaratgan bir sahifada 
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juda ham ko'p matn kiritilgan bo'lsa) bitta sahifa ichida boshqa HTML 
hujjatni ochmasdan turib ham foydalanish mumkin. Sizga masiahatimiz, 
agar bitta sahifaga joylashtirmoqchi bo'lgan matn juda ham ko'p bo'lsa, 
uni iloji boricha turli bo' laklarga bo'lgan holda, bir nechta HTML 
faylga jo)'lashtiring. Shunday qilsangiz, web-sahifadan foydalanish oson 
kechadi. 

;-";avbatdagi sahifalar bilan tanishib chiqqach siz havolalarni ishlatish 
usullarini va havola tuzish uchun qanday HTML teglardan foydalanish 
zarurligini bilib olasiz. 

Havolalar tuzisb usullari 

Havolalarni ta'sir doirasi va ularni qaysi sahifa bilan bog'lash 
vazifasini <A> ochuvchi hamda <lA> yopuvchi teglari orasida bel­
gilanadi. Cshbu teglar orasida uning atributlari va kalit so'z 
joylashtiriladi. 

Ushbu teg orasida nimalarni joylashtirish mumkin? Oeyarli 
hamma narsani. Bu matn, tasvir, jadval va hatto harakatlanuvchi 
tasvir ham bo'Iishi mumkin. Ulardan qaysi birini joylashtirish 
o'zingizga havola. 

Bu bo'limda oldimizga qo'ygan maqsadimiz havolalar tuzish. 
Maqsadga erishishning eng 050n usuli barchasini oddiy misollardan 
bosh lash. Shunga amal qilgan holda sizga havola tuzishning eng oddi)' 
misolini keltiramiz: 

<A HREF=«pictures.html">Bu sahifada mening hayotim bilan 
bog'liq tasvirlar joylashgan.</A> 

Natija mana bunday ko'rinishda bo' ladi: 
Bu sahif(,da mening ha}'otim bi/an bog'/iq tasvirlar joylashgan. 

so'zini bosishingiz bilan pictures.html sahifasi ekranda namoyon 
bo·ladi. <A> tegining qo'shimcha atribut bo'lgan HREF sizni pictures. 
html sahifasiga olib boradi. 

Tasvirlarni havola sifatida namoyon etish uchun <A> va <lA> teglari 
orasida <IMG> tegi yordamida tasvirda qaysi faylni nimani qo'yish va 
u joylashgan papkaga yo'lni ko'rsating. 

<A HREF =' «pictures.HTML»> <IMG SRC = «img/photojpg» 
WIDTH = «lOO» HEIGHT = «lOO» ALT=«Mening foto galereyam»> 
<lA> 
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Havolalar - <A> tegining qo'shimcha atributlari tasnifi 

Boshqa HTML teglari kabi <A> tegining ham qo'shimcha atributi 
mavjud. Quyida ushbu buyruqlarning tasnifi kehirilgan. 

HREF 

Bu atribut yordamida havola qilinishi lozim bo'lgan HTML hujjat 
nomi va uning joylashgan joyi belgilanadi. Bu atribut <IMG> tegining 
SRC atributi kabi bir hil vazifani bajaradi. <IMG> tegining SRC 
atributi yordamida tasvir nomi va u joylashgan papkaga YO'I ko'rsatilsa, 
HREF yordamida HTML hujjat nomi va u joylashgan papkaga yo'l 
tasvirlanadi. 

TARGET 

Bu atribut HTML hujjatni aynan o'sha oynada yoki alohida oynada 
yoki qaysi freymda ochilishini belgiJaydi. TARGET atributining 
qo'shimcha o' lchamlari: _blank - brauzerda siz ish lab turgan oyn'adan 
tashqari yangi oynada ko'rsatilgan hujjatni ochish. 

_top - web sahifada freymlar ishlatilgan bo' lsa, havolada 
ko'rsatilgan hujjatni faol oynada freymlar strukturasini buzgan holda 
ochadi. Ochilgan oynada freym alomatlari mavjud bo'lmaydi. 

_parent - havolada ko' rsatilgan hujjatni avval ochilgan oynada 
ochiladi. 

_self - havola qaysi freym yoki freymdan holi sahifada ishlatilgan 
bO'lsa aynan o'sha sahifada ochadi. 

<A HREF=«pictures.htmi» TARGET = «_blank»>Bu sahifada</A> 
mening hayotim bilan bog'liq tasvirlar joylashgan. <BR> Bu sahifada 
siz <A HREF=«about.html» TARGET=«_top»> men haqimda <lA> 
qiziqarli ma' lumotlarni o'qishingiz mumkin. 

Natija mana bunday ko"rinishda bO'ladi: 
Bu sahifada mening hayotim bilan bog' liq tasvirlar joylashgan. 

Sahifada siz men hagimda qiziqarli ma'lumotlarni o'qishingiz mumkin. 
Ushbu havolalardan biriga bosib, siz havolada belgilangan HTML 
hujjatdagi ma'lumotlarni o'qishingiz mumkin. 
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E-MAIL havola 

E-mail (Elektron pochta) manzillarni faollashtirish llchun havola 
tuzish mumkin . E-mail manzil ko' rsatilgan havolani bosish bilan 
kompyuterga o' rnati Igan elektron pochtalar bi lan ish lovch i dastur 
faollashadi va unda havolada ko'rsat ilgan elektron pochta manzili 
ko'rsatilgan yangi oyna hosil bo' ladi va siz ko'rsatilgan manzilga xat 
jo'natishingiz mumkin. 

E-mail manzilni havola sifatida belgilash uchun HREF atributi 
o'rnida mailto: elektron pochta manzili yoziladi . Misol uchun: 

Mening <A HREF=«mailto: tsamar@mail.ru))> elektron poch­
tamga</A> ushbu o'quv qo'llanma haqidagi fikr - mulohazalaringizni 
yozing! 

Natija mana bunday ko'rinishda bo'ladi: 
Mening e1ektron poshtamga ushbu o'quv qo'l1anma haqidagi fikr­

mulohazalaringizni yozing! 

Havolalar yozishning asosiy qoidalari 

Quyida havola tuzishda bilishingiz lozim bo'lgan oddiy qoidalar 
yozilgan. Ularni diqqat bilan o'qib chiqing va eslab qolishga harakat 
qilinf. Havola tuzishda bu q6idalarga amal qilsangiz. siz tuzgan 
havolalar hatoliklarsiz ishlaydi. 

• Harftarning bir hilda yozish va fayl yoki papka nomini to'g'ri 
ko'rsating. Havola tuzilganda eng katta e'tiborni siz murojaat qilmoqchi 
bO'lgan faylga olib boruvchi yo'l aniq va to'g'ri ko'rsatilishi lozim. 
Bunda papka va fay I nomiga katta e'tibor qarating. Ularning nomida 
arzimagan hatolikka yo'l qo'ysangiz havola ishlamaydi. Aytaylik biror 
bir harfni tushib qolishi yoki bosh harf o'rniga kichik harf bilan yozilsa 
hatolik yuz berishi muqarrar. Shu bois, havola tuzishda aniqlik katta 
ahamiyatga ega. 

• Fayl va papka Domini kiritganda probel ishlatmang. Web­
sahifa yaratish jarayonida fay I va papkalarni nomi ikki va undan ortiq 
so'zdan iborat bo'lsa so'zlar orasida va oxirida probel ishlatmang. 
Probel ishlatilgan fay I yoki papkaga havola murojat qilganda hatolik 
sodir bo·ladi. 

• Kalit so'zlarga havola tuzish. Biror hujjat ichidagi kalit so'zga 
havola tuzganda. eng avvalo kalit sO'zni <A> tegining NAME buyrug'i 
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yordamida belgilab olish lozim. So'ngra shu tegning HREF atributi 
orqali u joylashgan fayl nomi (agar kalit SO"z boshqa faylda joylashgan 
bo'lsa) va kalit so'z manzilini ko'rsating HREF == «fayl nomLHTML# 
kalit so·z». 

• FTP server va E-MAIL uehun maxsus havola. FTP serverda 
joylashgan faylga havola tuzganda 'FTP://' bilan boshlanuvchi manzilni 
yozing. E-MAIL havola tuzganda esa «mailto: e-mail manzihmi 
yozing. 

Matnlarni tahrirlash 

Matn tahrirlashni o'zlashtirib olishingizni osonlashtirish uchun 
uni ikkiga bo'lib tushuntirishni lozim topdik. Ularning har biri matn 
tahrirlashda ishlatiladigan HTML teglarni batafsil tahlili misollar 
yordamida aks ettirilgan. 

• Matnning alohida bo"laklarini tahrirlovchi teglar: 
• Matnning yirik bo'laklarini tahrirlovchi teglar. 

Matnning alohida bo'laklarini tahrirlovehi leglar • 
Quyida tasnifi keltirilgan barcha matn tahrirlash uchun ishlatiluvchi 

teglar ochilgandan so'ng ularni yopish shart. Ochilgan tegning ta'sir 
doirasi u yopilgunga q,adar davom etadi. Agar siz tegni yopishni 
unutsangiz, uning ta'sir doirasi huliat oxirigacha davom etadi. Barcha 
teglash quyidagi tartibda yoziladi: <TEGl><TEG2> Kerakli matn </ 
TEG2> </TEG 1>. Har doim eng oxiri ochilgan tegni birinchi bo'lib 
yopishni unutmang. 

<B> Kerakli maln </B> 
Bu teg orasida yozilgan matn qalin harflar bilan belgilanadi. 
<I>Kerakli matn</l> 
Matn o"ng tomonga egiltirib yoziJadi. 
<BIG>Kerakli matn</BIG> 
Matnni kattalashtirish. Yozilgan matn boshqalariga nisbatan 

kattalashtirilgan harflar bilan belgilanadi. 
<SMALL>Kerakli matn</SMALL> 
Matnni kichraytirish. Yozilgan matn boshqalariga nisbatan ki­

chiklashtirilgan holda belgilanadi. 
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<STRIKE> Kerakli matn</STRIKE> 
Teg orasida yozilgan matn ustidan chiziq tortiladi. 
<STRONG>Kerakli matn</STRONG> 
Matn ichidagi ayrim so'zlarni kuchli ajratib kO'rsatish uchun 

ishlatiladi. 
Kerakli <SUB> </SUB> 

ma:n 

Ko'rinib turganidek bu teg orasida kiritilgan matn, matn chizig'idan 
pastda kichik harflar bilan yoziladi (indeks). 

Kerakli <sup>mal,,</SUP> 

Yuqorida keltirilgan tegning teskari shakldagisi bo' lib, u matnni 
yuqorida kichik harflar bilan yozilishini ta'minlaydi (daraja). 

<U>Kerakli matn</U> 
Yozilgan matn ostida chiziq tortiladi. Su teg yordamida ayrim 

so'zlarni belgilab ko' rsatish mumkin. 
<CE1\TER>Kerakli rnatn</CENTER> 
Su teg kiritilgan matnni sahifa o'rtasida bo'lishini ta'minlaydi. Agar 

bu teg jadval ichida qo'llansa, u holda bu jadval katakchasi ichidagi 
matnga ta'sir etadi. Su tegni jadval ichida qo'Hash usullari haqida 
jadvallar bilan ish lash bo' limida tushuntirib o'tamiz. 

<8R> 
Su teg matn qatorlarini surish uchun xizmat qiladi . Ma'lum 

jumladan so'ng ikkinchi jurnlani yangi qatordan boshlamoqchi 
bo' lsangiz, jumla so' ngida ushbu tegni yozing. 

Endi hech bo'lmaganda bitta qO'shimcha buyruqqa ega bo'lgan 
teglar bilan tanishib chiqamiz. 

<FONT>Kerakli matn</FONT> 
Su teg harfning qO'shirncha atributlarini belgilash uchun ishlatiladi. 

Quyida ushbu tegning eng ko·p qo' lIaniladigan qo'shimcha atributlari 
bilan tanishib chiqamiz: 

SIZE 

Harf o' lchamini belgilashda qo' llaniladi. Matndagi harftar o' lchamini 
1 dan bosh lab xohlagan son bilan belgilash mumkin. 

Masalan: <FONT SIZE=«S»>Salom!</FONT> Su mening web 
sahifam. <FONT SIZE = «:!»>(Izoh)</FONT> 
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Bundan tashqari siz SIZE o'lchamlarini plyus + va minus - bilan 
ham belgilashingiz mumkin. Bu usul qo'llanganda harf o'lchami 
ishlatilayotgan harfga nisbatan katta yoki kichik belgilanadi. Misol 
uchun siz 3 ga teng kattalikdagi harfdan foydalanayotgan bo'lsangiz, 
SIZE = «+2») harf o'lchami SIZE=«5» ga, SIZE=«-I» o' lchami esa 
SIZE=«2» ga teng bo' ladi. 

COLOR 

Bu atributdan so'ng rang nomi yoki rangni belgilovchi olti xonali 
lotin harflari hamda raqamli kod kiritiladi va shu tariqa harf rangi 
belgilanadi. Turli brauzerlar turli rang nomlarini belgilay oladi. Rang 
nomlari ingliz tilida kiritiladi. Rang nomi va kO'rinishini yodlab 
olishingiz uchun ularning har birini nomi o'sha rangda belgilangan. 
Bu ranglarni Netscape Navigator va Internet Explorer brauzerlari 
muammosiz taniydi va o'qiy oladi. 

Rangni belgilovchi lotin alifbosi va raqamli kod '#' simvol bilan 
boshlanadi. Raqamlardan I dan 9 gacha yoki A dan F gacha bo'lgan 
lotin harflarini ishlatish mumkin. Rang Kodi qanday bO'lishidan ~at"iy 
nazar u RGB (RED - qizil, GREEN - yashil, BLUE - ko' k) ranglar 
tizimida aks ettiriladi. Rangni belgilash uchun uchta rangni bir­
biriga qo'shish lozim. Har bir rang ulushini 0 dan 255 gacha bO'lgan 
miqdorda belgilanadi. Misol uchun toza qizil rangni belgilash 
uchun qizil rang miqdorini 255 ga, yashil va kO'k ranglar miqdorini 
esa 0 ga tenglashtirish lozim va bu mana bunday yoziladi <FONT 
COLOR=#FFOOOO>. Olti xonali alifboli - raqamli kodini qO'llash juda 
ham qiyin. Shu bois ranglar kodini belgilab beruvchi jadvalimizdan 
foydalanishingiz mumkin. 

FACE 

Matnni qanday shriftda yozilishini belgilash uchun shrift nomi 
keltiriladi. SHrift nomi kompyuterda o'rnatilgan bO'lishi kerak yoki 
umumiy ishlatiladigan shriftlardan foydalanish mumkin. Agar siz 
qo'llagan shrift foydalanuvchining kompyuterida topilmagan taqdirda 
brauzer standart shriftni tanlaydi . 

Masalan: 
<FONT FACE = «Arial»>Salom!</FONT> 
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xohlagan tarzda namoyish etadi. Teg yopilganidan so'ng kiritilgan matn 
yangi satrdan boshlanadi. 

<BLOCKQUOTE> 
Kerakli matn 
</BLOCKQUOTE> 
Bu leg matndagi paragraf va satrJarni beJgiJash uchun qo'lIanadi. 
<HI>, <H2>, <H3>, <H4>, <H5> va <H6> 
yuqoridagi oltita teg sarlavhalarni belgilash uchun qo' llaniladi. 

Sarlavhalar qalin harflarda yoziladi. Bu teglarning bir-biridan farqi 
ularning o'lchamlarida. 1 dan 6 gacha bo'lgan sonJar sarlavha 
o'lchamlarini katta-kichikligini quyida keltirilgan tartibda belgilaydi: 

Sarlavha HI 
Sarlavha H2 

Sarlavha H6 
<P> 
Kerakli matn 
<JP> • 
Bu leg paragraflarni beJgiJaydi. Paragraf boshi va ohirida bo'sh 

qator qoJdiradi. 

ALIGN 

<P> tegining qo'shimcha atribuli bO'lib u papagraf ichida yozilgan 
matnni tekislash uchun ishlatiladi. Bu atributning qo'shimcha 
o'lchamlari ALIGN - LEFT (matnni chap burchakdan tekislaydi), 
RIGHT (o'ng tomonga tekislaydi), CENTER (sahifa markaziga 
tekislaydi) va JUSTIFY (matnni sahifa eni bo'ylab tekislaydi). JUSTIFY 
ishlatilganda brauzer matnni chap va o'ng tomon bo'ylab bir xilda 
tekislab chiqishga harakat qiladi. Bu jarayonda so'zlar orasi cho'zilib 
ketishi ham mumkin. 

<PRE> 
Kerakli matn 
</PRE> 
Bu teg yordamida siz matnni qanday kiritgan bo'lsangiz shunday 

kO'rinishda bo' lishi ta'minlanadi . Quyida keltirilgan ikki misolda buni 
yaqqol ko'rish mumkin . <PRE> tegidan tashqarida yozilgan matnda 
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probel necha marta ishlatilishidan qat'iy nazar u bittaga hisoblanadi. 
<PRE> tegi tarkibida kiritilgan matn qanday bo'lsa shundayligicha 
ekranda ko'rinadi. 

Hujjat asosiy qismini tahrirlasb 

Bu bo'limda hujjat tanasini belgilab beruvchi <BODY> tegi va 
uning qO'shimcha buyruqlari haqida so'z boradi. <BODY> tegini 
oldingi bo'limlarda qisqacha tanishtirib o'tgan edik. Bu teg bevosita 
HTML hujjatni ekranda ko' rinishi Jozim bo'Jgan matn, tasvir va boshqa 
elementlarni o'z ichiga qamrab oladi. <BODY> ochuvchi hamda </ 
BODY> yopuvchi teglari orasida barcha muhim elementlar joyJashadi. 
Bu tegning qanday qo'shimcha buyruqlarini quyida birgalikda ko'rib 
chiqamiz. 

BGCOLOR 

Sahifaning orqa foni rangini belgilash uchun ishlatiladi. Bunda 
rangning ingliz tilidagi nomi yoki harf va sonlardan iborat kod 
qo'lIaniladi. 

• BACKGROUND 

Sahifaning orqa foni uchun qo'lIaniluvchi tasvir nomi va u 
joylashgan papkaga yo'lni ko'rsatishda qo'lIaniladi. Tasvir joylashgan 
papkaga yo'lni kO'rsatish haqidagi ma'lumotlarni «HTML safifaga tasvir 
joyJashtirish» bo'limida o'qishingiz mumkin. 

TEXT 

Hujjatda yozilgan matn harflarini qanday rangda bo'lishini rang 
kodlarini kiritish orqali belgilab beradi. Agar siz ushbu atribut 
ishlatmagan taqdiringizda matn rangi qora rangda bo'ladi. 

LINK 

Bu atribut qQ'lIanilgan sahifadagi havoJa rangi teg o'lchamJarida 
qaysi rang kodi yoki nomi berilgan bo'lsa, o'sha rangda ekranda 

namoyon bo' ladi. 
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VLL~K 

Bu atribut yordamida ishlatilgan havolalarni belgilab kO'rsatish 
uchun qo' lIaniladi. Siz foydalanuvchilar adashib ketmasligi va havolada 
ko'rsatilgan sahifaga qayta kirmasligi hamda hall qo'lIanilmagan 
havolalarni qO'l1anilgan havolalardan ajratib kO'rsatish uchun ish­
latishingiz mumkin. 

ALINK 

Bu atribut kursor yordamida tanlangan va sichqoncha chap tugmasi 
bosilgan paytda havola rangini o'zgartirish uchun ishlatiladi. 

Siz hozir o'qigan sahifada <BODY> tegining barcha qO'shimcha 
atributlari quyidagi tartibda qo'llaniladi. 

<BODY BGCOLOR=#003399 TEXT=black LINK=blue ALINK= 
=red VLINK=#006666> 

Ro'yxatlar tuzish 

Sahifada matndagi ayrim elementlarni ro'yxatlangan tartibda yozish 
qiyin emas va bundan tashqari o'quvchi.!flatn bilan tanishib chiqi~ida 
qulayliklar yaratib beradi. Siz huddi Microsoft Word matn muharririda 
rO'yxatlarni qanday tuzsangiz huddi shu ko'rinishda HTML hujjatda 
ham maxsus teglar yordamida belgilash imkoniga egasiz. 

Bu bo'limda rO'yxatlangan tartibda matnni kiritish usullari bilan 
tanishib chiqamiz: 

<RO'YXA TNI OCHUVCHI TEG> 
< RO'yxat elementining tegi > Matn 
</ RO'YXA TNI YOPUVCHI TEG > 
Tartiblangan ro'yxat: Tartiblanmagan ro'yxat: 
I. RO'yxat e1ementi 1 • RO'yxat elementi I 
2. RO'yxat e1ementi 2 • RO'yxat e1ementi 2 
3. RO'yxat elementi 3 • Ro'yxat elementi 3 
Matn ro'yxatini belgilovchi teglar tarkibida siz HTMLning boshqa 

matn tahrirlash uchun qo'llaniluvchi teglarini ishlatishingiz mumkin. 

Ro'yxatlar tuzish - ro'yxatni tartiblasb 

Matn bo' laklarini tartiblashda sonlar yoki harflar bilan belgilash 
mumkin. Shuningdek ayni jarayonda simvollardan ham foydalanish 
imkoni mavjud. 
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Matn bO'laklarini tartiblashda <OL> ochuvchi va <IOL> yopuvchi 
teglaridan foydalaniladi. Ushbu teglar ichida tartiblanuvchi matn oldiga 
<U> atributi yoziladi. <OL> tegining yagona qo'shimcha o'lchami 
TYPE bo'lib, u tartiblovchi belgi ko'rinishini aniqlab beradi. 

Arab raqamlari bilan belgilash: 

HTML kodi 

<OL TYPE=» 
<U> Matn 1 
<LI> Matn 2 
<U> Matn 3 
<IOL> 

Natija 

I. Matn ) 
2. Matn 2 
3. Matn 3 

Rim raqamlari bilan belgilash: 

HTML kodi 

<OL TYPE=I> 
<U> Matn 1 
<U> Matn 2 
<U> Matn 3 
-41OL> 

Natija 

I. Matn 1 
H. Matn 2 

III Matn 3 

Rim harftari bilan belgilash: 

HTML kodi 

<OL TYPE=i> 
<U> Matn 1 
<U> Matn 2 
<U> Matn 3 
<IOL> 

Natija 

i. Matn 1 
ii. Matn 2 

iii. Mato 3 

Bosh harfalari bilan belgilash: 

HTML kodi 

<OL TYPE=A> 
<U> Matn 1 
<U> Matn 2 
<U> Matn 3 
<IOL> 

~~ 
A. M~nl 
a M~n2 
C. M~n3 



Kichik harftar bilan belgilash: 

HTML kodi 

<OL TYPE=a> 
<1£> Matn I 
<11> Matn 2 
<11> Matn 3 
</OL> 

Natija 

a. Matn I 
b. Matn 2 
c. Matn 3 

Ro'yxat tuzish - tartiblanmagan ro'yxat 

Tartiblanmagan rO'yxat tuzishda <UL> va <JUL> yopuvchi 
teglaridan foydalaniladi. Ro'yxat ichidagi tartib <11> atributi bilan 
belgilanadi. <UL> tegi uchun ham TYPE o'lchami ishlatiladi. TYPE 
o'lchami 3 xii turdagi ro'yxat kirita oladi: 
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Doirasimon belgi yordamida tartiblash: 

HTML kodi 
<UL TYPE = circle> 
<11> Matn 1 
<11> Matn 2 
<11> Matn 3 
</uL> 

c Matn I 
c"Matn 2 
o Matn 3 

Natija 

Nuqtasimon belgi yordamida tartiblash: 

HTML kodi 
<UL TYPE=disc> 
<11> Matn I 
<1£> Matn 2 
<U> Matn 3 
</UL> 

Natija 
• Matn 1 
• Matn 2 

• Matn 3 

To'g·ri to·rtburchaksimon belgi yordamida tartiblash: 

HTML kodi Natija 
<VL TYPE = square> _ Matn 1 
<U> Matn 1 _ Matn 2 
<LI> Matn 2 _ Matn 3 
<U> Matn 3 
</UL> 

• 



Ro'yxat tuzish - aniqlashtiruvchi ro'yxatlar 

Aniqlashtiruvchi ro'yxat va uning izohidan iborat matnni tartibli 
tuzish uchun bir-necha teglar ishlatiladi. 

Aniqlashtiruvchi ro'yxatni <OL> ochuvchi va </DL> yopuvchi tegi 
yordamida amalr;t oshiriladi. Aniqlashtiruvchi ro'yxat nomi <OT> 
tegidan so'ng yoziladi va uni izohlovchi matn esa <00> tegidan so'ng 
kiritiladi. <OL> tegi qo'shimcha o'lchamlarga ega emas. 

Aniqlashtiruvchi ro'yxat: 
<OL> 
<OT> Aniqlashtiruvchi asosiy so'z yoki jumla 
<OD> lzoh beruvchi maln 
<IOL> 

Jadval tuzish 

Jadval tuzish - HTML bO'yicha o'zlashtirish qiyin bo' lgan bo'tim­
lardan biri . Shu bois bu bo'limni jadval tuzishni eng sodda usullaridan 
boshlaymiz. Web-sahifani mukammal darajada yaratishni xohlasangiz, 
unda jadval tuzishni chuqur o'rganib olishingiz kerak. Qisqa qilib 
aytgaida jadvallar yordamida. sahifani o'zingiz xohlagan tarzda 
boshqara olishingiz mumkin. Jadval ichiga nafaqat matn, balki tasvir va 
boshqa elementlarni tartibli joylashtirish mumkin. 

Jadnl tuzish - umumiy qoidalar 

Jadval tuzishda ishlatiladigan teglarni tasniftashdan avval, oddiy 
jadval tuzish sxemasi bilan tanishib chiqsak. Har qanday jadval 
quyidagi sxema bo'yicha tuziladi: 

<JAOVALNI OCHUVCHI TEG> 
<JAOVAL QATORE\1 OCHUVCHl TEG> 
<JAOVAL BO'LAGINI OCHUVCHJ TEG> 
Matn. tasvir yoki jadval 
</JAOVAL BO'LAGINl YOPUVCHI TEG> 
<!JAOVAL QATORINI YOPUVCHI TEG> 
</JAOVALNI YOPUVCHI TEG> 
Har qanday jadvalda qatorlar va ustunlar mavjud bo'iadi. Jadvalning 

bO'lakchalarida esa axborot kiritilishi mumkin. Yuqorida keltirilgan 
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misoldan ko'rinib turibdiki, bitta ustun, bitta qator va bitta katakchadan 
iborat jadvalni tuzish uchun jadval ochiladi va yopiladi. Bitta ustundan 
iborat va bir nechta qatorni o'z ichiga olgan jadvalni tuzish uchun. 
jadval qatorini ochuvchi va yopuvchi teglar orasiga bir nechta jadval 
katakchalarini ochuvchi va yopuvchi teglarini kiritish lozim. 

Oddiy jadvallar tuzish 

ladval tuzish usullarini tushunib olish uchun dastavval eng oddiy 
jadvalni tuzishni o'rganamiz. Biz tuzmoqchi bo"lgan jadval uchta 
ustundan iborat bo'ladi va har bir ustunda 3 dona katakchalar o'rin 
oladi. ladvalning birinchi ustunini «Mahsulot», ikkinchisini esa -
«Rangi», uchinchisini «Narhi» deb nomlaymiz. Biz tuzgan jadval mana 
bunday ko'rinishda bo"ladi: 

U-jadval 

Mahsulot Rangi Narhi (so'm) 

Qalam Qora 100 

Qalam ochgich 
L ____ QOra ___ 500 • 

--- -- ------ ---

Endi ushbu jadvalni tuzishda qanday HTML teglardan foyda-
lanilganligini ko'rib chiqamiz: 

<TABLE> 
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<TR> 
<TD>Mahsulot<lTD> 
<TD>Rangi</TD> 
<TO>Narhi(co'm.)<ITD> 
<ITR> 
<TR> 
<TO>Qalam<lTO> 
<TO>Qora<ITD> 
<TO> I OO</TO> 
</TR> 
<TR> 
<TO>Qalam ochgichi<ffO> 
<TO>Qora</TO> 



<TO>500<ITO> 
<ITR> 
</TABLE> 
Jadvalni ochuvchi teg 
I - qatorni ochuvchi teg 
1 - ladval bo'lagini ochuvchi va yopuvchi teg 
2 - ladval bO'lagini ochuvchi va yopuvchi teg 
3 - ladval bO'lagini ochuvchi va yopuvchi teg 
1 - qatorni yopuvchi teg 
Jadvalni yopuvchi teg 
Misolda ko'rinib turibdiki, jadvalni <TABLE> va <ITABLE> teg­

lari yordamida ochiladi va yopiladi. Qatorlar uchun <TR> va </TR> 
teglari qO'lIaniladi, <TO> va </TO> teglari esa jadval ustunlarini 
(katakchalarini) belgilash uchun ishlatiladi. 

Jad\'aJ cbizisb - HTML leg o'lcbamlari 

Murakkab jadvallar tllzishni boshlashdan avval <TABLE>. <TR> 
va <TD> teglariga qisqacha tasDif berib o'tamiz. Mazkur uchta teg 
bilan qo'lIaniladigan bir xildagi o'lchamlar mavjud bo'lib, faqatgina 
ularning farqli tomoni, ularning ta'sir doiralarining chegaralanishidadir. . '.' 

BGCOLOR 

Atribut yordamida jadvalning orqa fonida qanday rang qo' llanilishi 
belgilanadi. 

BACKGROUND 

ladvaldagi bo'lakcha foni sifatida berilayotgan tasvirni joylashgan 
joy va uning nomini belgiJash uchun, ishlatiladi. Agar siz bu atributni 
<TABLE> tegidan so'ng qo'lIasangiz, u holda siz tanlagan tasvir 
jadvaldagi har bir kataklar foni sifatida qo'lIaniladi. <TR> tegidan so'ng 
qo'lIanilganda, mazkur qatorda joylashgan hamma katakchalar uchun, 
<TD> tegidan so'ng qO'lIanilganda esa aniq biror katakchagacha fon 
o' rnatiladi. 

WIDTH 

Jadval eni (kengligi)ning o'1chami (umumiy jadval uchun xos). 
Bu o'lcham bilan jadvaldagi ma'lum bir ustuncha yoki bo'lakning 
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kengligini piksel yohud foiz o'lchamida belgilash mum kin. Bu 
o'lcham <TABLE> yoki <TR> tegi bilan qo'lIanilgan taqdirda ham 
bir xii ko'rinishdagi, ya'ni siz bergan o'lchamlarni hisobga olgan 
holda jadval enining kengligini belgilaydi. Shuni doim yodda tutish 
lozimki, siz bu o'lchamdan foydalangan holdajadval enining kengligini 
belgilaganingizda bir xildagi o'lchov turidan foydalanishingiz maqsadga 
muvofiq. Agar siz jadval kengligini piksellarda belgilasangiz (misol 
uchun WIDTH = «100»), boshqa o'lchovlar ham pikselda belgilanishi 
lozim. Agar jadval kengligi foizlar hisobida berilsa (misol uchun 
WIDTH=«50%»), boshqa o'lchovlar ham foiz hisobida berilishi lozim. 
Ayni hollarda brauzer siz yaratgan jadvalni ekranningteng yarmi, ya'ni 
50% ga joylashtiradi. 

HEIGHT 

ladvalning, qator yoki katakchalarning balandligi o'lchovlarini 
piksellar yoki foiz hisobida belgilash uchun qo'llaniladi. 

BORDER- , 
ladval ustuni va qatorlari kesishmalarini belgilovchi chiziqlarni 

qalinligini piksellar hisobida belgilash uchun qo'lIaniladi. Agar jadval 
chiziqlarini nolga teng qilib belgilansa BORDER (BORDER =0) chiziq 
(border) brauzerda ko'rinmaydigan bo'lib qoladi. 

ALIGN 

ladvalning ekranga nisbatan joylashish o'rilini belgilaydi. Agar 
jadval ichida qO'shimcha jadval tuzilgan bo'lsa, u holda ichki jadvalga 
bu atribut kiritilganda, ichki jadval joylashishi o'rni tashqi jadvalga 
nisbatan belgilanadi. ALIGNning quyidagi qO'shimcha o'lchamlari 
mavjud: ALIGN - center (Jadvalni markaz bo'ylab joylashtirish), left 
(chap burchak bo'yJab joyJashtirish) va right (o'ng burchak bo'ylab 
joyJashtirish). 

CELLPADDING 

Katakcha enining kengligini piksellar yordamida kengaytirish yoki 
toraytirish. 
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CELLSPACI~G 

Jadvaldagi katakchalar chegara enining piksellar yordamida ken-
gaytirishi yoki toraytirishi. 

Misol: 

<TABLE BORpER=O WIDTH= 100% CELLSPACING=5 
CELLPADDING = 5 BGCOLOR = blue> 
<TR BGCOLOR = yellow> 
<TD>Mahsulot</TD> 
<TD>Narhi<ITD> 
</TR> 
<TR BGCOLOR = white> 
<TD>Qalam<!TD> 
<TD>\oO sO'm</TD> 
</TR> 
<!TABLE> 

ALIGN 

Jadvaldagi har bir katakchaning ichidagi elementlarni gorizontal 
tarzda tartiblash uchun qo'lIaniladi. Uning mavjud o'1chamlari quyida­
gilardiln iborat: - left (chap temonga tekislash), right (o'ng tomonga 
tekislash) va center (markaz bo'ylab tekislash). 

VALIGN 

Jadvaldagi har bir katakchaning ichidagi elementlarni vertikal tarzda 
tartiblash uchun qo'llaniladi. Uning mavjud o'\Chamlari quyidagilardan 
iborat: - top (katakning yuqori qismiga nisbatan), middle (yuqori va 
quyi qismiga nisbatan markazga tekislash). 

Jadnl tuzisb qoidalari 

Bu sahifada jadval tuzish jarayonida siz amal qilishingiz lozim 
bo'lgan eng asosiy qoida va maslahatlar keltirilgan . 

• <TABLE>, <TR> va <TD> teglarini tartibiga rioya qiling 
Har doim jadval tuzish sxemasini buzmaslikka harakat qiling. Avval 

aytib o·tilgandek eng avvalo jadvalni oching so'ngra jadval qatorlari va 
ustunlarini tuzing va eng oxirida jadvalni yoping. Ushbu tartib buzilgan 
taqdirda turli hatoliklar kelib chiqishi mumkin. 
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• <TABLE> tegini jadval so'ngida yoping 
Agar <TABLE> tegini yopmasangiz kutilmagan hatoliklar vujudga 

keladi. Masalan, Netscape Navigator siz tuzgan jadvalni ekranda 
umuman kO'rsatmaydi. 

• Vstunda joylasbgan qatorlar soni 
Har bir qatorda kataklarning soni bir xilda bo'lishiga e'tibor bering. 

Bu tartibga, agar siz ayrim kataklarga hech qanday axborot kiritmagan 
taqdiringizda ham ularni yaratish lozim. Bunday holatlarda bo'sh 
katakchalarni mana bunday ko'rinishda yozish lozim: <TO>&nbsp;</TO>. 
'&nbsp;' simvoli brauzerga mazkur katakda hech qanday axborot mavjud 
emasligi haqida xabar beradi. Agar ushbu simvol yozilmagan taqdirda 
brauzer bu katakni aks ettirmaydi va <TO> tegida BGCOLOR atribut 
ishlatilgan taqdirda fon rangi ifoda etilmaydi va hatolik yuz beradi. 

• Har bir jadval tegini yangi qatorda yozing 
Jadval tuzishda adashib ketmaslik uchun har bir jadval qatori, ustuni 

va katakchalar belgilanganda ularni bir-biridan ajratib yozishga harakat 
qiling. Quyida ana shu holatga misol keltirilgan. 

<TABLE> • 
<TR> 
<TO> '" </TO> 
<TO> '" </TO> 
<TO> ... </TO> 
</TR> 
<TR> 
<TO> ... </TO> 
<TO> '" </TO> 
<TO> '" </TO> 
</TR> 
</TABLE> 
Ushbu qoidalarga rioya qilsangiz jadval tuzishda turli qiyinchi­

Jiklarga duch kelmaysiz hamda siz tuzgan jadvallarda hatoliklar 
bo'lmaydi. 

Murakkab jadvallar tuzisb 

Oddiy jadval tuzish usullarini o'rganib oldingiz. <TO> tegining hali 
siz bilmagan ba'zi qiziq o'lchamlari mavjud bo'lib ularni qo'shish orqali 
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ajoyib natijalarga erishish mumkin. Aytaylik siz quyida keltirilgan 
jadvalga o'xshash jadval tuzmoqchisiz (1.4-jadval). 

1.4-jadval 

x! . , Mahsulot nom i ,- - <, • H 

. Narhi (so'm) 

1 Qalam . .100 

2 Ruchka r - 150 

3 Daftar 400 

Jami: 650 so' m 
" " ~ 0' -:: 

'. ., '.' . ~"'; . ' .. -- - -_ ._-----

E' tibor bergan bo' lsangiz jadvalning so'ngidagi qator boshqalaridan 
farqli o'laroq bitta katakchadan iborat. Biz avval aytib o'tganimizdek 
jadvaldagi barcha kataklar soni bir xii emas. Bu misolda oxirgi 
qatordagi uchta kataklar bir-biri bilan birlashtirilgan xolos. Buni <TO> 
tegining COLSPAN yordamida amalga oshirish mumkin. 

COLSPAN 

Jadvaldagi bir qator yoki ustundagi bir nechta kataklarni bir­
lashtillldi. Bu atribut o'lchamiga-siz nechta katakchani birlashirmoqchi 
bO'lsangiz, ularning sonini kiritishingiz lozim. Quyida, yuqoridagi 
jadvalda bu usul qanday amalga oshirilganini ko'rsatib beruvchi misol 
keltiramiz. Bu misolda jadvalning aynan COLSPAN atributi qo'llanilgan 
qismigina yozilgan: 

<TR> 
<TO COLSPA?\=3 BGCOLOR=red> 
<FONT COLOR=white>Jami: 650so'm</FONT> 

</TO> 
</TR> 

HTML kodJarga izoh 

HTML kodlarni tahrirlashni oson kechishini ta'minlash uchun turli 
izohlarni kiritish maqsadga muvofiq. Izohlar yordamida siz HTML 
kodlarni qayerda boshlanib. qayerda yakunlanganini muntazam kuzatib 

borasiz va adashib ketmaysiz. 
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Murakkab web-sahifalar tuzganda ishlatiladigan HTML kodlar 
soni cheksiz kO'payib ketishi mumkin. Bunday paytda HTML kodlarni 
qayerdan boshlanib qayerda yakun topganini adashtirib yuborishingiz 
aniq. Shu sababli teg ochilganda va u yopiJganda izoh bilan belgilab 
bOl'ish lozim. Quyidagi misolda izohli HTML kodlar tizimi keltirilgan: 

<BODY BACKGROU~O= img/back.git> 
<!--HTML bujjat boshlanisbi--> 
<TABLE BOROER=O CELLPAOOING=O CELLSPACING=O 

WIDTH = 100%> 
<!-Tasbqi jadval bosblanishi--> 
<TR> 
<TO WIDTH=«l%» VALIGN = «top»> 
<IMG SRC=«imgfp.gif» WIDTH=«160» HEIGHT=«I» ALT= 

=« »><BR> 
<!--Sahifaning cbap ustuni--> 
<FONT COLOR = white>Sayt menyusi:</FONT> 
<!--CHap ustun yakuni--> 
<fTO> 
<TD WIOTH=«2%»><fTO> 
<TO W lOTH = «94%» VALIGN = «toP»> 
<!--Sabifaning markaziy ustuni--> 
web sahitaning asosiy matni. 

• 

<BR><BR><BR> <BR><BR><BR><BR><BR><BR><BR><BR> 
<!--Markaziy ustun yakuni--> 
<fTO> 
<TO WIDTH = «2%»> <fTO> 
<TD WlOTH=«I%» VALIGN = «toP»> 
<IMG SRC=«imgfp.gif» WIDTH = «100» HEIGHT= « b) ALT= 

=« »><BR> 
<!--Sabifaning o'ng ustuni--> 
<TABLE BOROER=«O» CELLPAODING=«\» CELLSPACI;..JG= 

=«0» WIDTH = «100» BGCOLOR=«#336699»> 
<!--O'ng ustundagi reklamali jadval--> 
<TR> 
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<!--Reklama sarlavbasi--> 
<TD><FONT COLOR = «#eOeOff»>Reklama:</FONT><ITO> 
</TR> 



<TR> 
<TD> 

<TABLE BORDER=«O» CELLPADDING=«O» CELLSPACING= 
=«0» WIDTH=«IOO%» BGCOLOR=«#fOfOfO)}> 

<TR> 
<TD BGCOLOR = «#cccc33»> 
<!--Reklama matni--> 
<FONT SIZE=«2»>Reklama matni va tasvirni shu yerga joylash-

tirishingiz mum kin 
</FONT> 
</TD> 
</TR> 
</TABLE> 
</TD> 
</TR> 
</TABLE> 
<!--O'ng ustun yakuni--> 
</TD> 
</TR> 
</TABLE> 
<.6--Tasbqi jadval yakuni-~ 
<fBODY> 
<!--HTML hujjat yakuni--> 
Bu ifodalar sizga jadvalli sahifani oson tahlil qilish imkonini 

beradi hamda turli o'zgarishlar kiritgan taqdiringizda, uni qaysi joyda 
bo'Jishini aniq belgiJay oJasiz. 

Ba'zida o'zingiz ham mana shunday sxemaJarni tuzishingiz mum kin 
va sahifa tayyor bo'lgach, kiritilgan izohJarni o'chirib tashlang. Bunda 
kiritilgan izoh quyidagi tartibda yozilishi lozim: '<!-- izoh -->'. 

Freymlar bilan isblasb imkoniyatlari 

Freym - brauzer oynasidagi mustaqil to'g'ri to'rtburchak shaklidagi 
maydon bO'lib, u o'z ichiga boshqa alohida mustaqil HTML hujjatlarni 
birlashtira oladi. 

Endi siz har bir oynasida alohida mustaqil HTML hujjatlarni ochish 
imkonini beruvchi freymlarni tuzish usullari bilan tanishib chiqasiz. 
Freymlar brauzerdagi yangi oyna emas, balki bu alohida oyna yoki 
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ramka bo'lib, u brauzerning ochilib turgan oynasi ichida aks ettiriladi. 
Bu bo'limda, bir freymdan ikkinchi freymlacni bir-biriga havolalar 
yordamida bog'lash usullarini tahlil qilib chiqamiz. 

Freymlar tuzish 

Siz intemetdan foydalanish jarayonida freymlar ishlatilgan web 
sahifani kO'rgansiz. Aytaylik bu sahifada uchta freymdan foydalanilgan. 

Ko' rib turganingizdek bu sahifa uchta freymdan iborat ustunlarga 
bo'lingan. CHap ustunda joylashgan freymda navigatsion menyu, 
yuqoridan o'ngdagisida reklama va o'ngdan pastdagi freymda esa web 
sahifa asosiy matni o'rin oladi. Chap ustunda joylashgan havolalarga 
bosish bilan, havolalari hujjatning o'ngdan pastida joylashgan freymda 
ochiladi. 

Lishbu freymlar qo'llanilgan sahifaning umumiy tuzilishini ko'rib 
chiqsak: 

<FRAMESET> - freymlar tuzilishini belgilovchi ochuvchi leg 
(freymset) 

<FRAME> - birinchi freym 
<FRAME> - ikkinchi freym 
</FRAMESET> - freymsetni yopuvchi teg 

• 

Sxemada ko·rinib turganidek, har gal <FRAMESET> tegi yor­
damida frey-mlar tuzilishini belgilash lozim. Shundan so'ng bevosita 
freymlar <FRAME> tegiga navbat keladi. Oxirgi navbatda </ 
FRAMESET> freymset yopuvchi teg yoziladi. 

Hozircha bu oddiy sxemani eslab qoling. Murakkab freymlar 
qo'llanilgan sahifalar haqida ushbu bo'limda keyinroq ma'lumot 
beramiz. 

Freymlar - oddiy mOOI 

Xullas, freymlar bilan kO'rsatilgan oddiy misolni ko'rib chiqamiz. 
Ishni boshlashdan old in, oddiy HTML formatida ikkita hujjat yarating. 
Birinchi hujjatga «Freym-h> ikkinchisiga esa «Freym-2» deb yozing va 
ulami freml.HTML va frem2.HTML deb nomlang. Bu ikkita fayllar 
bizning misolimizda ikki freymlar uchun asosiy manba ho'lib xizmat 
qiladi, Endi esa HTML formatida keyingi hujjatni yarating. 
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<HTML> 
<HEAD> 
<TlTLE>freymlar</TlTLE> 
</HEAD> 
<FRAMESET .COLS = «200»,*> 
<FRAME ~AME= left SRC = «frameI.HTMl»> 
<FRAME NAME = right SRC = «frame2.HTML»> 
</FRAMESET> 
<NOFRAMES> 
Sizning brauzeringiz freymlarni tushunmaydi. 
<NOFRAMES> 
</HTML> 
Demak siz ham o'zingizning birinchi sahifangizni freymlar 

yordamida yaratdingiz. Endi shu yaratgan sahifangizni frameset.html 
deb nomlab oldin yaratilgan framel.html va frame2.html fayllar turgan 
papkada saqlang va frameset.html faylini o'z brauzeringizda oching. 

Birinchi navbatda, e'tibor bergan bo'lsangiz HTML formatidagi 
freymlardan iborat sahifada <BODY> tegi mavjud emas. Bu esa juda 
muhimdir. Agar siz <BODY> tegini ishlatsangiz u holda. hamma 
<FR-"MESET> va <FRAME> teglari brauzeringiz tomonidan 
o'chiriiadi. Undan tashqari <NOFRAMES> tegi shunday holatga 
mO'ljallangan-ki, bu holatda sizning brauzeringiz freymlarni qO'lIab­
qu\,vatlamaydi. 

Freymlar - oddiy freym 

Bizning misolimizda <FRAMESET> va <FRA:vtE> teglarini oddiy 
o'lchamlarda ishlatgan edik. Endigi navbatda biz freymlar yordamida 
o'z sahifamizda nimalarni o'zgartira olishimizni ko' rib chiqaylik. 
frameset.html sahifasini brauzerda yoki HTML teglarni tahrirlovchi 
dasturda oching. Foydalanuvchi sizning freymlaringizni o'lchamlarini 
o'zgartira olmaydigan qilishingiz mum kin. Siz hozir freym 
chegaralariga sichqoncha kO'rsatkichini belgilab uning o'lchamlarini 
xohlagan tarzda o'zgartirishingiz mumkin. 

NORESIZE 
<FRAME> tegining parametr ushbu freymni o'zgartirib bo' l-

masligini anglatadi. 
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Misol: 
<FRAME NAME= left SRC = «framel.html» NORESIZE> 
<FRAYiE NAME= right SRC = «frame2.html» NORESIZE> 
Keyingi holatlarda, agar siz freymlar orasidagi chegaralarni 

belgilash uchun siz <FRAMESET> tegining quyidagi atributini ish­
latishingiz zarur. 

BORDER 
<FRAMESET> tegi freymlar chegaralari orasidagi masofani 

piksellarda ifodalaydi . Freym orasidagi chegarani umuman bO'lmasligi 
uchun shu o' Ichamni nolga tenglashtiramiz. 

Misol: 
<FRAMESET COLS = «200» .... BORDER = «0»> 
<FRAME> tegining yana bir muhim atributi 
SCROLLING 
<FRAME> tegi mavjud freymda sahifalash chizig'ini mavjudligi 

yoki mavjud emasligini belgilaydi. Bu parametrning yes, DO va auto 
belgilari bu freymda sahifalash chizig'jni borligini, yo'qligini Vi agar 
kerak bo'lsa ishlatilishini ko'rsatadi. 

Misol: 
<FRAME NAME=«left» SRC = «framel.html» NORESIZE SCROL­

LING =«auto»> 
<FRAME NAME = «right» SRC = «frame2.html» NORESIZE SCROL­

LlNG= «yes»> 
<FRAMESET> tegining quyidagi atributlarini siz bilishingiz za-

rur: 
COLS 
<FRAMESET> tegmmg bu parametri gorizontal freymlarning 

chapdan o'ngga tuzilishini ko'rsatadi. Freymlarning kengligi piksellarda 
yoki foizlarda beriladi va bie-biridan tinish belgisi bilan ajratiladi . 
.... ' simvol shuni ko'rsatadiki, qolgan umumiy maydon shu freymga 
ajratilishini anglatadi. 

Misol: 
<FRAMESET COLS =«200», . , lOO> 
Bu misolda uchta freym mavjud bo' lib, birinchisi-200 pikseL 

oxirgisi -100 piksel, ikkinchisi (o'rtadagi freym) - qolgan maydonning 
hammasi shu freym uchun ajratilgan. 
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<FRAMESET COLS=20%, 100,50, "'> 
Bu misolda esa to'rtta freym bo'lib, birinchisi maydonning 20%nL 

ikkinchisi - J 00 pikselli, uchinchisi - 50 pikselJi, to' rtinchisi esa qolgan 
maydonni tashkil etadi. 

ROWS 

<FRAMESET> tegining bu parametri freymlarning vertikal 
tepadan pastga bo'lgan tuzilishini ko'rsatadi. O'1chami raqamlar bilan 
beriladi. Bu freymlarning balandligi piksellarda yoki foizlarda beriladi 
va bir- biridan tin ish belgisi bilan ajratiladi . '.' simvol shuni ko'rsatadiki 
u umumiy qolgan maydonni shu freymga ajratilishini anglatadi. 

Misol : 
<FRAMESET ROWS = 50%, 50%> 
Balandligi ekranning 50% tashkil qiluvchi ikkita freym. Anglash 

qiyin emaski, bu ifodani ROWS parametrida. simvol orqali quyidagicha 
yozish mum kin 50%, "' . 

Freymlar - murakkab freymlar tuzish 

Ushbu bo' limning boshida siz tanishib chiqqan, freymlarga 
bO'litlgan sahifaga yana bir bor murojaat qilsak (1.3-rasm). Berilgan 
sahifada uchta freym bo'lib. bu freymlar tarkibida gorizontal hamda 
vertikal holatdagi freymlar mavjud. Bu sahifani yaratish uchun biz 
nima qilishimiz kerak? Demak hammasini bir boshdan boshlaymiz. 

:v1urakkab tarkibli freymlarni yaratishimiz uchun. biz jadvallarni 
qanday yo'l bilan yaratgan bo'lsak shu yo'l bilan yaratishimiz 
qulayroqdir. Oq qogo'zga freymlar tuzilishi 
andozasini chizib oling va shu fre~mlarni 

raqamJab chiqing. Bizning misolimizda 
freymlar tuzilishi quyidagicha bo'Jadi: 

FreymJarni quyidagicha raqamlaymiz: 
chapdan o'ngga, tepadan pastga qarab. Endigi 
navbatni yangi sahifani yaratishga bersak. 
Bizning misolimizda yolg'iz <FRAMESET> 
tegi orqali freymlar strukturasini beJ­
gilay oJmaysiz, nega deganda birgina 
<FRAMESET> tegida freymlarni birgalikda 

"n ' ' -i IC= ., -------, 
I I - ' 
" ' I ' 

I 3 

/.3-rasm. FreymJarga 
bO'lingan sahifa. 
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gorizontal (COLS) va vertikal (ROWS) joylashtirishning iloji yo·q. Gap 
shundaki bie nechta <FRAMESET> teglarni quyidagicha ishlatiladi 

<HTML> 
<HEAD> 
<TITLE>freymlar</TITLE> 
</HEAD> 
<FRAMESET COLS = ISO,· BORDER = 0> 
<FRAME SRC = left.html SCROLLl NG = yes ~ORESIZE> 
<FRAMESET ROWS = 70,* BORDER=O> 
<FRAME SRC=top.html SCROLLING=aulo ~AME=top 

NORESIZE> 
<FRAME SRC = content.html SCROLLING =yes NAME = content 

~ORESIZE> 

</FRAMESET> 
<!FRAMESET> 
<~OFRAMES> 

Sizning brauzeringiz bu freymlarni qo'lIab quvvatlamaydi. 
</NOFRAMES> , 
</HTML> 
Birinchi <FRAMESET> tegi ekranni ikkita freymga, ya'ni o·ng va 

chap freymlarga ajratadi. Ikkinchi <FRAMESET> tegi esa o' ng qism 
(o'ng freym)ni yana ikkita tepa va past freymga ajratadi. Ketma-ketlik 
tartibi HTML formatida oldin ko'rsatib o'tilganidek bo'lishi shart. 
Birinchi navbatda birinchi <FRAMESET> tegi. Birinchi freym (o'ng 
freym). Undan keyin ikkinchi freym kelishi kerak edi. Ammo biz 
ikkinchi <FRAMESET> tegi yordamida uni yana ikkiga bo'ldik, ya'ni 
biz ikkinchi freym (chap freym)ga yana ikkita freymni vertikal holda 
(ROWS = 70,*) joylashtirgan bo'lamiz. Keyin ikkita freym keladi va 
ikkala <FRAMESET> teglari yopiladi. Mana endi natija quyidagicha 
bo' ladi, ya'ni chap freymda left.html o'ng tomondagi freymning yuqori 
qismida top.html va undan yuqori qismida content. htm 1 freymlar 
yuklanadi. 

Freymlar - havolalar tuzish 

Belgilangan maxsus freymda HTML hujjatni ochilishi uchun 
havolani qanday tuzish lozim? Bu juda ham oson. Buning uchun, freym 
ishlatiladigan sahifa yaratilganda, freym nomini berib o'tish lozim. 
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NAME 

<FRAME> tegining bu atributi mazkur freym nomini belgilaydi. 
Freym nomlari ushbu freymga boshqa freymdan havola tuzish uchun 
qo' lIanilad i. 

Bizning misolimizda quyidagi kodlar qo'lIanilgan: 
<FRAMESET COLS= 150,· BORDER=O> 
<FRAME SRC = left.html NAME = left SCROLLING = yes NORE­

SIZE> 
<FRAMESET ROWS = 70,· BORDER=O> 
<FRAME SRC=top.html NAME=top SCROLLING=auto NORE-

SIZE> 
<FRAME SRC=content.html NAME = content SCROLLING=yes> 
</FRAMESET> 
</FRAMESET> 
Natijada quyidagi nomlardagi freymlar vujudga keladi: left, top 

va content. Endi chap freymdagi havoladan asosiy freymda hujjatni 
ochilishi uchun <A> tegining TARGET parametrini content teng qilib 
belgilash lozim, ya'ni : 

<A HREF= l.html TARGET=content>I-Punkt <lA> 
~akllar hosil qilish (<I>opM,a) 
SIZ internetda ko'p marta shakllarga duch kelgan bo'lsangiz kerak. 

Bu qog'ozdagi anketaning elektron varianti , o'zida matn kiritish 
maydonlarini, savollarga javob variantlari va boshqa shakl elementlarini 
mujassam qiladi. Shakllar sayt egasi va foydalanuvchilar orasida aloqa 
o'rnatish uchun kerak. 

Shakllar yordamida saytingiz orqali, misol uchun, ovoz berish, 
foydalanuvchilarning ayrim savollar bO'yicha fikrini bilish va shunga 
o'xshash masalalarni hal qilishingiz mumkin. 

Shakllarning umumiy sxemasi 

Quyida har qanday shaklni yaratish umumiy sxemasi berilgan. 
<FORM> 
shakl maydonidagi teglar 
</FORM> 
Ko'rib turganingizdek, ochuvchi <FORM> va yopuvchi</FORM> 

teglari orasiga shakl maydonlari teglarini qo'yish yetarlidir. Keyingi 
sahifada turli shakl maydonlari bilan tanishamiz. 
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Turli shakl maydonlari 

Shakl maydonlari qanday bo'ladi va ular nima ish bajaradi? 
Matn qatori (TYPE = TEXT) 
Bu qator ko'p bo' lmagan simvollardan iborat erkin ko'rinishdagi 

ma'lumotni (matnni) kiritish t1chun foydalaniladi. 
Misol: 
<INPUT TYPE=TEXT NAME=Tekst SJZE=20 VALUE= «Siz­

ning matn»> 
Shunday qilib matn qatori <INPUT> tegi va TYPE=TEXT para­

metrlari yordamida yaratiladi. Shu tegning boshqa parametrlari nimani 
bildiradi? 

NAME 
Serverga jo'natiladigan o'zgaruvchining nomi. Foydalanuvchi ki­

ritgan matn natijada shu nomli o' zgaruvchiga beriladi. HTMLda 
shakllar yaratish serverda dasturlash bilan uzluksiz bog' liq. Serverda 
foydalanuvchilaringizdan ma'lumotlarni shu dastur orqaJi qabul qi­
lishingiz mum kin. • 

SIZE 

Matn qatorining simvol ko'rinishdagi kengligi. Bizning misolda 
bu parametrning ifodasi 20 ga teng. Buning ma'nosi kiritilayotgan 
matnning kengligi 20 simvoldan iborat. Foydalanuvchi undan ko'p 
simvollardan iborat bo'lgan matnni kiritishi mum kin, lekin 20 tadan 
ortiq simvol ko'rinmaydi. Klaviaturadagi YO'naltiruvchi tugmachalar 
yordamida matnni boshi yoki oxiriga o'tish mumkin. 

VALUE 

Bu parametr ifodasi oldindan matn maydoniga kiritilgan bo'ladi. 
Uni o'zgartirish yoki o'chirish mumkin. 

Javob varianti (TYPE = RADIO) 
Foydalanuvchi bir qancha javob variantlari orasidan faqat bitta 

variantni tanlashi mumkin. 
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Misol: 
Jinsi: 

<INPUT TYPE=RADIO NAME=Jins VALUE=«Erkak»>Er. 
<INPUT TYPE = RADIO NAME= Jins VALUE=«Ayoi»>Ay. 





Harakatlanuvchi menyu <SELECT> tegi, menyuning javob \"a­
riantlari esa <OPTION> tegi yordamida yaratiladi. 

NAME 
<SELECT> tegining atributi, o'zgaruvchining nomini ifodalaydi. 

Bu o'zgaruvchiga tanlangan javob variantining ifodasi beriladi. Bizning 
holatda o'zgaruvchining nomi Age. 

VALUE 
<OPTION> tegining atributi, shu variant tanlanganda parametr 

ifodasi o'zgaruvchiga beriladi. Agar bu atribut belgilangan bo'l­
masa (uchinchi <OPTION> tegiga o'xshab), o'zgaruvchining ifodasi 
<OPTION> tegidan keyin kelgan matn bo'ladi. Agar bizning miso­
limizda uchinchi variantni tanlasak Age o'zgaruvchining ifodasi 21 dan 
ko'p, agar birinchi variantni tanlasak ifoda '10' bo'ladi. 

<OPTlON>tegidan so'ng berilgan matn ekranda harakatlanuvchi 
menyu varianti sifatida ko'rinadi. Keyin <OPTION> tegini yopish shart 
emas. 

Matn maydoni (TE.~TAREA) • 
Matn maydoni foydalanuvchi tomonidan ko'p sonli simvolJardan 

iborat matnni kiritish uchun foydalaniladi. 
Misol : 
Sizning mulohazalaringiz: 
<TEXTAREA }'.;AME=Comments COLS=20 ROWS=5> 
O'z mulohazalaringizni kiriting 
</TEXT AREA> 
Natija: 
Sizning mulohazalaringiz: 
Matn maydoni <TEXTAREA> tegi orqali yaratiladi. Ochuvchi va 

yopuvchi teglar orasidagi hamma matnlar shu matn maydoni ichiga 
yoziladi. 

COLS 

Matn maydonining simvol kO'rinishidagi kengligi. 

ROWS 

Matn maydonining qator kO'rinishidagi balandligi. 
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Misol: 
<INPUT TYPE=HIDDEN NAME = Page VALUE=(d sahifa»> 
Ko'rinmas shakl maydoni <INPUT> tegi yordam ida va TYPE = 

= HIDDEN atributini ishlatgan holda yaratiladi. Berilgan misolda 
shaklni jo'natish vaqtida Page o'zgaruvchisiga 'I sahifa' ifodasi 
beriladi. Buning natijasida, agar to'ldiriladigan sahifalaringiz ko'p 
bo'lsa, qaysi sahifadagi shakldan ma'lumot jo'natilganini aniqlashingiz 
mumkin. 

FORM tegining atributlari l'3 sbaklni jo'natish 

Shu bo'lim boshida eslatib o'tganimizdek, shakl yaratish dastur­
lash bilan uzluksiz bog' liq . Boshqacha qilib aytganda shakldagi 
ma'lumotlarni qayta ishlash dasturlashsiz iloji yo'q. Ma'lumotlarni 
qayta ish lash natijasi siz kO'rsatgan email manziJjbo.yichajo.na­
tHadi. 

KeIing. sizning saytingizdagi shakl ma'lumotlari dastur orqali qayta 
ishlanishi uchun nima qilishni ko'rib chiqaylik. Natija siz kO'rsitgan 
email manzili bo'yicha shu formatda jO'natiladi. 

O'zgaruvchi: Kiritilgan ma'lumot 
Buning uchun saytingizda xohlagan shaklni shu ko'rinishda yara-

tishingiz zarur: 
<FORM METHOD = POST ACTION=http://. .... com/mail.php3> 
<INPUT TYPE = H1DDEN NAME = recipient VALUE=EMAIL> 
<INPUT TYPE = HIDDEN NAME = subject VALUE=MAVZU> 
<INPUT TYPE=HIDDEN NAME=type VALUE=TUR> 
<INPUT TYPE = HIDDEN NAME=return VALVE=MANZIL> 
<INPUT TYPE = HIDDEN NAME=alpha VALUE = a> 
Sizning shaklingiz 
</FORM> 
Endi shu HTML kodni o'z sahifangizga ko'chiring va keyingi 

so'zlarni o'zgartiring: 
EMAIL - natija jo'natiladigan email manzil; 
MAVZU - Xat mavzusi (Subject); 
TUR - Sizning pochtangiz turi, HTML deb yozing, agar aniq 

bilmasangiz TEXT deb yozing; 
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MANZIL - foydalanuvchi shaklni to'ldirgandan keyin ko'rishi kerak 
bo'lgan sahifa manzili; 

Keyin, 'Sizning shaklingiz' sO'zini o'rniga o'z shaklingizni qo'ying. 
Dastur qanday ishlashini ko'rish uchun o'zingizni email manzilingizni 
kiriting va 'Tekshiruv' tugmasini bosing. 

HTMLda simvollar jadvali 

Ayrim simvollarni to'g'ridan-to'g'ri yozib bo'lmaydi. Chunki ularni 
brauzer aks ettirib bera olmaydi. Undan tashqari kO'plab simvollar 
klaviaturada mavjud em as. Bu ikki turdagi simvollarni brauzerda 
aks ettirish uchun son \a shriftlar kombinatsiyasidan foydaJaniladi. 
ASCII sirnvollar deb ataluvchi simvollarning son va shriftlardan iborat 
kombinatsiyasi mavjud. 

Sal'olva topshiriqlar: 

1. Web-dizayn nima? 
2. Dizaynning qanday turlari bor? 
3. Web-dizaynda qanday dasturing vositalar ishlatiladi? 
4. NTML nima? Uning asosi~ strukturasi nimalardan iborat? . '. 
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II-bob. DREAMWEAVER DASTURINING IMKONIY ATLARI 

Dreamweaverning MX versiyasi bu nafaqat interfeysning tashqi 
ko'rinishi yangilangani, balki radikal texnologik yangilangan, gi­
permatnli belgilash tili imkoniyatlari kengaygan. Unda Web-sahifa 
maketlarini yaratish uchun yangi ashyolar paydo bo'ldi. Jumladan, 
tizimga Flash obyektlarni qo'yish buyruqlari qo'shilgan va WEB uzellar 
bilan boshqarish va turli jamoaviy ishlarni loyihalashda rivojlanishga 
imkon beradi. Endi Dreamweaver MX bilan batafsil tanishib chiqamiz. 

Belgili kodlar bilan ish lash vositalari sezilarli darajada rivojlandi. 
MX-versiyasi bu ixtiyoriy murakkablikdagi dastlabki matn bilan ish lash 
uchun kuchli bazaga ega bo'lgan giperl1)~tnli dasturlashning to'la'l0nli 
qobig'idir. Asosiy imkoniyatlarini sanab chiqamiz: 

1) Hujjatning oynasi endi har xii rejimlarda ishlashi mumkin. 
Design View (Pe)f(HM n!laHHpoBKH) rejimida. foydalanuvchi HTML 
sahifa maketini taxminan shunday kO'rinishda kO'rish mumkin. 
Code View (Pe)f(HM pa3MeTKH) rejimida esa hujjatning oynasida 
belgili matn sahifasining barcha deskriptoriari , senariylari va 
kommentariyalari tasvirlanadi. Dasturning bu rejimlari orasida kichik 
koordinatsiya mavjud. Kodlarni o'zgartirish maket modifikatsiyasiga, 
vizual rejimda rejalashtirish yoki formatlashga o' zgartirish kiritish 
imkonini beradi; 

2) Dreamweaver tizimi qobig'iga barcha zaruriy qurilmalarga ega 
bo'lgan to' laqonli kodlar tahrirlagichidan iborat dastur integratsiya 
qilingan. Unda HTML hujjatlarining dastlabki matnlari bilan ishlashni 
yengillashtiruvchi vositalar: kiritilgan teglarning sarlavhalari. turli 
kodlarni rangli belgilash, tez qidirib topish vositalari aks etgan. 
Sintaktik noto'g' ri loyihalarni an iqlash, uzun qatorlarni avtomatik 
ko'chirish, avtokorreksiya rejim i YO'lga qo'yilgan. Dastur vositalari 
yordamida nafaqat gipermatnli sahifalarni. balki matnli ko' rinishga ega 

64 



har qanday hu.ijatlarni, dasturlar, senariylar, oddiy matnlar, XML belgili 
hu.ijatlar va boshqalarni tahlil qilish mumkin. 

3) Gipermatnlarni belgilash kodlari bilan ishlashni ma'lumot 
paneli ancha soddalashtiradi. Bu dastur ichiga qurilgan interfaol ma'lu­
motnoma gipermatnli belgilash tilining barcha standart loyihalarini va 
u bilan bog'langan vositalarni: diskreptorlar, atributlar, ierarxik stildagi 
o'ziga xosliklarning deklaratsiyalari (Cascading Style Sheet), Java Script 
tilining sintaktik loyihalarini qisqa va lo'nda shaklda tavsiflaydi. 

Tajribadan ma'lumki xatto eng tajribalL HTML tilini chuqur 
biladigan Web-ustasi ham bu til standartiga kiruvchi yuzlab kodlar va 
atributlarni eslab qolishga qodir emas. Ma'lumotlar paneli deskriptorni 
aniq va ravshan tavsiflab beradi, uning atributlari hamda ko'rib chiqish 
dasturining turli versiyalari bilan mos tushishi haqida ma'lumot beradi. 

4) Java Script senariylar 
Java Script dasturlash tilida yozilgan senariylardagi yashirin xa­

tolarni aniqlash imkoni beriladi. Bu vosita nafaqat hozirgi vaqtda 
WEB-dasturlash sohasida qo'llaniladigan ko'p sonli analizatorlar uchun 
qiyin bo'lmagan, sintaksis xatolarni aniqlashga qodir. Kodlarni tuzatish 
vaqtida dastur ichiga qurilgan nazorat nuqtalari va qadamba-qadam 
bajar~ladigan dastur kO'rsatm~tari hamda o'zgaruvchilarning holatini 
nazorat mexanizmlariga ham ega. 

Doimo sezilarli potentsialga ega bo'lgan vizual loyihalash tah­
rirlagichining uskunalari yana bir vosita bilan boyitildi. Bu gipermatnli 
sahifalarni rejalashtirish va yaratish uchun mo'ljallangan maxsus dastur 
ishchi rejimidir. U sahifani aks ettirishning maxsus rejimi (Layout Viev) 
va ikkita uskuna ko'rinishida amalga oshirilgan bo'lib, ular yordamida 
maket elementlarini chizish mumkin. 

Tahrirlagichning oldingi versiyalari vektorli animatsiyalashgan 
tasvirlar sohasida birinchilar qatorida bo'lgan Flash dasturi bilan juda 
yaxshi o'zaro aloqada bo'lishi bilan ajralib turgan. Dasturning joriy 
versiyasiga animatsiyalashgan obyektlarni generatsiya qilishning 
ikkita asosiy buyrug'i integratsiya qilingan. Endi bevosita dastur 
oynasida interfaol tugma yoki (~onli matn» yaratish mumkin. Bunga 
o'xshash obyektlarni kiritishning texnik tomoni o'ta soddalashtirilgan 
va loyihalashtirishdan ko'ra ko'proq anketalashtirishga o'xshab 
ketadi. Foydalanuvchidan Flash - texnologiya sohasida chuqur 
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bilimlar talab qilinmaydi. U faqat muloqot oynasi sohasini to'ldirishi 
kerak. Zamonaviy dasturlarning ko'pchiligi animatsiyalashgan Flash 
- grafikani aniq aks ettiradi. Bu tipdagi obyektlar a'lo darajada 
masshtablanishi bilan ajralib turadi va tarmoq bo'ylab uzatishda ham, 
diskda saqlashda ham juda kam resurs talab qiladi . Dasturga kiritilgan 
yangiliklarni qisqacha sanab o'tamiz: 

- ierarxik stildagi o'ziga xosliklar (CSS) bilan ish lash vositalari 
sezilarli darajada takomillashtirilgan. 

- Macromedia firmasi tomonidan ish lab chiqilgan Fire \Voks 
grafik muharriri bilan Dreamweaver dasturining integratsiyasi yanada 
rivojlantirildi. 

- yangi Assets (resurslar) palitrasi yaratildi. U dasturda bitta WEB 
- tugunning bir necha sahifasi tomonidan birgalikda ishlatiladigan 
turli xildagi ma'lumotlarning omborxonasi vazifasini bajaradi. Bular 
tasvirlar, animatsiya roliklari, ranglar, senariylar, kutubxonalar va 
boshqalar bo'lishi mumkin . Saqlanayotgan resurslarni turli sahifalarning 
talab qilinadigan sohalarida joyini o'zg.!lrtirish (yoki surish) yo'l~ bilan 
joylashtirish mumkin . 

Site Report (OT'leT 0 caiiTe) buyrug' i loyiha holati haqidagi batafsil 
hisobotni hosil qiladi. Hisobot o'ziga ko'p sonli giperbog'lanishli 
hujjatlarni biriktiradi: 

- tahrirlagichga versiyalarni va dasturiy ta'minotni yangilashni 
boshqarishni nazorat qilishning yetakchi dasturiy vositasi bo' lgan 
Microsoft Source Safe paketli integratsiya vositalari qo'shilgan. Bu 
narsa Dreamweaver tizimini Internet uchun murakkab loyihalarni 
ishlab chiquvchi jamoalar uchun asosiy uskuna sifatida qo'lIanilishiga 
asos bo·iadi. 

- dasturning bu versiyasi WEBDav bayonnomasini to'laqonli 
qo'lIab-quvvatJaydi. Bu versiyalarni boshqarish va taqsimiangan ishni 
tashkii qilish bo'yicha kengaytirilgan imkoniyatlarga ega bo'lgan klassik 
bayonnomasidir. 

- interfeysni standartlashtirish va sayqal berish bo'yicha kat­
ta ish qilindi. Macromedia firmasi kO'pgina dasturlarning tashqi 
ko'rinishi noturg'un palitralarning yagona konsepsiyasiga asoslanadi . 
Muharrirning oxirgi versiyasida palitralarning ko'rinishi standart­
lashtirilgan. lJlarning deyarli hammasi tarkibiy majmuaviy palitralarga 
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birlashish imkoniyatiga ega bo'ldilar. Oldingi versiyalarning ro'yxatga 
olishdagi ba'zi kamchiliklar bartaraf etildi. 

- klaviatura kombinatsiyalari bir shaklga keltirildi. Ular web­
dizayn uchun Macromedia firmasi tomonidan ish lab chiqilgan. bar­
cha dasturlash vositalari uchun umumiy bo'lgan ichki standartga 
moslashtirilgan. ichiga qurilgan boshqaruv tizimi yordamida tugma­
larning har qanday tuzilishini o'zgartirish mum kin. 

Savol vu lopshiriqlar: 

I. Dreamweaver MX dasturi nima maqsadda qO'lIaniladi? 
2. Dasturning qanday yangi imkoniyatlari mavjud? 
3. Dastur avvalgi web-muharrirlaridan nimasi bilan farq qiladi? 

2.1. Dasturni o'rnatish va ishga tushirish 

Tajribali foydalanuvchi dasturni o'rnatish jarayonida o'zi uchun 
hech qanday yangilik ko'rmaydi. Distributiv diskda Dreamweaver MX 
Installer.exe (HHcTamITOp) faylini qidirib topish va ishga tushirish lozim 
(ay to yuklanish bO'lmagan holatda). Windowsning ko' pchilik ilovalari 
kabi tbu dastur ham bir necha. bosqichda o·rnatiladi. Ularning har biri 
alohida muloqot oynasidan iborat. 

Dasturni o'rnatishning asosiy bosqichlarini ketma-ket sanab o'tamiz 
[3], [4]: 

- Extracting Files. Bu bosqichda DREAMWEAVER tizimdagi 
qurilmalar va dasturning instalyatori ishlashi uchun zarur bo'lgan 
fay liar arxivdan ochiladi. Bosqich foydalanuvchining aralashuvini talab 
qilmaydi. 

- Welcome (Xush kelibsiz). O'rnatishning birinchi bosqichi bo·lib. 
unda foydalanuvchi tanlangan dastur va uni installyatsiya qilish 
qoidalari haqida asosiy ma'lumotlarni oladi. 

- License Agrecment (Litsenziya shartnomasi). lkkinchi bosqichda 
litsenziya shartnomasi va muallifning dasturiy mahsulotiga huquqlari 
bilan tanishish taklif etiladi. Foydalanuvchi taklif qilinayotgan 
majburiyatlarni qabul qilishi yoki rad etishi kerak. 

- Macromedia Dreamweaver Serialization (dasturni ro'yxatdan 
o'tkazish). Uchinchi bosqichda muloqot oynasi hosil bo'ladi, uning 
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yordamida foydalanuvchining rekvizitlari va dasturning serial nomerini 
kiritish zarur bo' ladi. 

- Choose Destination Location Uoylashuv). Bu bosqichda dasturni 
o'rnatish uchun disk va papkani olish zarur bo'ladi. Taklif qilinganidan 
farq qiluvchi manzilni ko'rsatish Windows tizimi uchun standart bo'lgan 
faol disk va katalogni tan lash yo'li bilan berish mum kin. Buning uchun 
Browse tugmasini bosish kerak . 

- Default Editor o'rnatishning bu bosqichida Dreamweaver dasturi 
keyin ishlatiladigan asosiy tahrirlash fayllarini tanlashni taklif qiladi. 

- Select Program Folder (Dastur papkasini tan lash). Bunda foy­
dalanuvchi dasturni ishga tushiruvchi )'orliq joylashgan papkani 
ko'rsatish kerak bo'ladi. O'rnatishning keyingi barcha operatsiyalari 
foydalanuvchining aralashuvini talab etrnaydi. Instalyator arxivlarni 
ochadi, kataloglar va kichik kataloglar tizirnini yaratadi. unga ish uchun 
zarur bo'lgan barcha fayllardan nusxa ko'chiradi va ekranga giperrnatnli 
faylni dastur imkoniyatlarining tavsifi, foydali ma' lumotlar manbalari 
haqida qisqacha ma'lumotlar bilan chiqarib beradi. 

• 
Dasturni isbga tusbirish 

Paket o'rnatilgandan keyin Windows bosh menyusiga Drearn­
weaverni yuklash va unga tegishli fayllar maxsus bO'limi qo'shiladi. Har 
qanday holatda ham dasturni yuklash buyrug' i: rIyCK > rIporpaMMbl > 
Macromedia > Drearnweaver MX ko'rinishida bo'ladi. 

Dasturni y uklashni bir nechta universal usullari mavjud. Bu bizga 
oddiy Microsoft Office paketi dasturlaridan ham ma'lurn. 

Savol va topshiriqlar: 

I. Dreamweaver MX dasturini o'rnatish ketrna-ketligini aytib bering? 
2. Dasturni o'zingiz mustaqil ravishda o'rnating? 
3. Dasturni ishga tushirish ketma-ketligini aytib bering? 
4. Dasturni ishga tushirishning yana qanday usullari bor? 

2,2. Interfeys. Dastur oynasi qismlari 

Interfeys deganda inforrnatikada dasturdagi turli komponentlar 
va foydalanuvchi o'rtasidagi o'zaro aloqani ta'minlovchi vositalar va 
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qoidalar yig'indisi tushuniladi, Dreamweaver paketi taklif etadigan 
mllomala usuli zamonaviy foydalanuvchi llchun odatiy bo'lib qolgan 
grafik oynali interfeys prinsiplariga asoslanadi. Dreamweaver paketi 
o'sha sinfdagi boshqa dastllr1ar bilan taqqoslaganda ancha an iq, 
moslashuvchan va shu bilan bir paytda kuchli interfeys hisoblanadi. 
Palitralar, ko'p sonli klaviatura kombinatsiyalari va menyu qatori uning 
asosiy vositalari hisoblanadi . Barcha operatsiyalar to'xtatilgach ekranda 
qoladigan oynalarni palitralari (Palette) yoki panellar (panel) deb atash 
qabul qilingan. Ekranning maxsus ajratilgan pozitsiyalarida emas, balki 
ixtiyoriy joyida joylasha oladigan oynalar ko'chib yuruvchi palitralar 
(floating plette) deb ataladi. Dreamweaver dasturi muloqot oynalarining 
ko'pchiligi kO'chib yuruvchi palitralar kO'rinishida ishlaydi . Palitralar 
va pane liar orasidagi kichik farqlar dastumi tavsiflash uchun sezilarli 
ahamiyatga ega emas. Shuning uchun kelgusida bu atamalarni 
sinonimlar sifatida qo'lIaymiz. 

Deyarli barcha palitralar blr1ashish xususiyatiga ega. Bu har xii 
palitralarni bitta muloqot oynasida joylashtirish mumkinligini bildiradi. 
Birlashtirish amali turli mavzu yoki buyruqlarga tegishli boshqaruv 
vositalariga ega bo'lgan ko' p funksiyali terma palitralarni olish 
imkoniyatini beradi. Birlashish xllsusiyatiga ega bo'lgan palitralarni . -. 
(ular dasturda kO'pchilikni tashkil etadi) modulli (dockable) palitralar 
deb ataymiz. Bir nechta alohida modullardan iborat murakkab palitraLar 
terma (tabbed) palitralar deb ataLadi. 

2.1-rasmda to'rtta ochiq muloqot oynali dasturning tashqi ko' rtnishi 
ko'rsatilgan. Boshqaruvning eng taJab qilinuvchi vositasi sO'zsiz, 
Properties inspector (xossalar nazoratchisi) palitrasi hisoblanadi . Uning 
yordamida HTML sahifalarida obyektlarni formatlash va HT\-lL 
sahifasidagi obyektlarni tahrirlash bo'yicha ko'plab amallar bajariladi. 
Behavieros (rejimlar) palitrasi - bu modul ko'chib yuruvcbi palitraga 
misol bo'ladi. Dreamweaver dasturi turli loyiha masalalarini hal qilishga 
mo' ljallangan obyektlarga ega. 

Rasmda ikkita oddiy 1110dulli Layers va History palitralardan 
iborat bo' lgan terma palitraga misol keltirilgan. Objekts palitrasi 
tashqi obyektLar: rasmlar, jadvallar, qatlamlar, freymlar va boshqa 
obyektlarni qo'y ish uchun mo'ljallangan. Rasmda ko'rsatilgan bosbqa 
barcha boshqaruv elementlari hujjat oynasining ajralmas tashkil etuvcbi 

69 



" .' Unhtled OocumenllUnhtled 11 Oledmwedvel 1IIr-I£I 

"" a;.. 

~[2] 

Gl& 

D!I"amic HTML. Th. Dofini{,v. 
Ref,.ttnc • . ","Utn and cOPYI9'ttf'd b!J 
OiOO" Goodman. is the SO\MC. of 

2. J-rasm. Dastur oynasining ko'rinishi. 

~?~ {I. !fm. 

• 
iE: lz !; ;a....la. .,) 

~I~I-

.!.h iii 

qismi hisoblanadi. Texnik tizimlarning ishonchli ishlashi, dasturiy 
mahsulotlarni interfeyslarining qu\ayligi asosida to'g'ri tashki\ qilingan. 
Dreamweaver paketi formatlash va tahrirlashning deyarU barcha 
asosiy buyruqlari uchun amalga oshirishning bir necha xiI usullarini 
taklif etadi. Keng formatli ekranJarning egalari barcha buyruqlarni 
palitralar va panellar yordamida bajarishJari mumkin. Bundan mahrllID 
foydaJanllvchilarga esa dastur menyu qatori buyruq\arini va klaviatllra 
tugmalari kombinatsiyalaridan foydaJanishadi. 
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Hujjat oynasi 

Hujjat oynasi - bu gipermatnli hujjatlar yaratiladigan ish may­
doni hisoblailadi (2.1-rasm). U HTML sahifasi o'z ichiga olgan 
matnlar. rasmlar. jadvallar, shakllar va boshqa obyektlarni saqlaydi. 
Dreamweaver, WYSIWYG sinfiga kiruvchi tahrirlagich dastur 
hisoblanadi. Su uzun atama inglizcha What you see is what you 
get (siz nimani ko'rayotgan bo'lsangiz shuni olasiz) iborasining bosh 
harflaridan tuzilgan. Su narsa HTML sahifasining hujjat oynasida 
aks ettirilishi uning yanada ommaviyroq ko'rib chiqish dasturlari 
- Microsoft Internet Explorer va Netscape Navigator brauzerlarida 
ifodalanishidan uncha farq qilmasligini bildiradi. HTML kodlari 
bilan to'g'ridan-to'g'ri ishlash yuqori professionallik hisoblanishiga 
qaramay. hatto eng tajribali WES-dizayner ham grafik interfeys va 
WYSIWYG rejimida hujjat yaratishda beradigan qulayliklardan voz 
kecha olmaydi. 

Ko'pchilik Windows i10valaridan farqli ularoq Dreamweaver dasturi 
bitta dastur oynasida bir necha hujjatlar bilan ish lay olmaydi. Tanlab 
olingan parametrlarni o'rnatishdan keJib chiqib yangi hujjat dasturning 
alohida oynasiga joylashtiriJadi yoki joriy oynada avval ochilgan hujjat 
o'rnifti egallaydi. Sunday ish 'rejimida dastur oynasi va hujjat oynasi 
orasida deyarli farq yo'q. Shuning uchun ham biz kelgusida bu nomlarni 
sinonimlar sifatida ishlatamiz. 

Insert Modify lext {;ommands ~ite 

Hie' Unlllled Documenl 

<body> 447)(90 . lK/l sec 

2.2-rasm. Hujjat oynasi. 
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Isb rejimlari 

WYSIWYG rejimida gipermatnli hujjat yaratish oddiy matn mu­
harriri bilan ishlashdan ko'p farq qilmaydi. 

Matnni kiritish va formatlashning bazaviy amallari, obyektlarni 
joylashtirish buyruqlari, navigatsiya va tan lash texnikasining barcha 
amallari Dreamweaver dasturida so'nggi bir necha yil davomida 
vizual muhitda ustunlik qilish usulida amalga oshirib kelinmoqda. 
Foydalanuvchi loyihalash yechimlarini HTML tHi vositalari tomonidan 
qanday yo'lga qO'yilishi haqida o'ylab o'tirmasdan tahrirlash va 
formatlashning odatdagi vositalaridan foydalanib ishlashi mumkin. 
Dreamweaver paketi dastlabki matnni avtomatik ravishda yaratadi, 
unda hujjatning ma'lumot bilan to'ldirilishi va ro'yxatga olinishi bilan 
gipermatnni belgilash tilining kodlari yoziladi. 

Yaratuvchanlik ishining katta qismi WYSIWYG rejimida baja­
rilishi mumkinligiga qaramay ba'zan to'g'ridan-to'g'ri kodlashga 
murojaat qilishga to'g'ri keladi. Buning bir nechta sababi bor. Asosan, 
bu belgilash kodlarini juda ehtiyotkotli.k bilan sozlash zarurliiidir. 
Bundan tashqari HTML tili standartida yuzdan ortiq deskriptorlar 
haqida eslatib o'tiladi. L'larning har biri bir nechta atributlar va 
modifikatorlarga ega bo' lishi mumkin. Gipermatnli belgilashning 
eng ko'p talab qilinadigan vositalari Dreamweaver tizimi interfeysi 
doirasida joylashtirilgan. 

Dreamweaver dasturining hamma versiyalari, birinchisidan bosh lab, 
foydalanuvchiga belgilash kodlarini to'g'ridan-to'g' ri tahrirlash imkonini 
beradi . Bu ish uchun qanday vositalar qo'llaniladi? 

Birinchidan, bu maxsus ichiga qurilgan Code Inspector (kodlar 
inspektori) tahrirlagich bo'lib, u Dreamweaver dasturini eng bi­
rinchi versiyalarida ham mavjud edi va bu oxirgi versiyalarda vaqt 
davomida faqatgina dizayniga o'zgartirishlar kiritildi. lkkinchidan, 
foydalanuvchi HTML tiliga tashqi tahrirlagichlarni ulash imkoniyatiga 
ega. Turii dasturlar: universal vazifali (masalan, Bloknot) oddiy matn 
tahrirlagichlaridan bosh lab, to murakkab gipermatnli hujjatlar bilan 
ishlashga mo'ljallangan (Allaire Home Stile) yuqori darajali dastur 
vositalarigacha bu rolni bajarishi mumkin. Dasturning MX versiyasida 
juda qulay yangHik - hujjat oynasining ish rejimi paydo bo'ladi. Hujjat 
oynasi uchta rejim yoki kO' rinishlardan birida bo'lishi mumkin. 
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2.3-rasm. HqUatning belgili rejimida ko·rinishi . 

2.3-rasm. Belgilash rejimidagi hujjat oynasi Code and View 
(belgilash va reja lashtirish rejimi). Bu aralash rejim bo'lib, unda hujjat 
oynlsi ikkita qismga bo' linadi. -Bir qismda gipermatnli belgilash kodlari 
aks ctadi. boshqasida dastur sahifani barcha obycktlar va format lash 
atributlari bilan rejalashtirishni ko'rsatadi. 2.4-rasmda bo'sh sahifali 
ajratilgan hujjat oynasi ko'rsatilgan. 

Ish rejimini o'zgartirishning bir necha usuli bor. Birinchidan. bu 
menyu qatori buyruqlari: View> Code, View - Design. View - Code 
and Design . Ikkinchidan, uskunalar panelida bir rejimidan boshqasiga 
tez o·tish imkonini beruvchi tugmalar bor. Va nihoyat. Ctrl + Tab 
tugmalar kombinatsiyasi yordamida rejalashtirish rejimidan belgilash 
rejimiga va aksincha, yoki ajratilgan oynaning bir qismidan boshqasiga 
o'tish mum kin. 

Ajratilgan hujjat oynasi qismlarining o'lchamlarini o'zgartirish 
mumkin. Buning uchun ko'rsatkich yordamida ajratuvchi chiziqni 
ko'chirish kerak bo'ladi. Oxirgi paytlarda dasturchilar orasida «dastlabki 
matn» atamasi paydo bo'ldi. Yuqori saviyali dasturlash tilida yozilgan 
dastur ish lab chiqishning dastlabki bosqichlarida shunday deb ataladi. 
Bu atama gipermatnli hujjatning kodli qismi va ko'rinadigan obrazi 
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<head> ~ t 
<tu:le >Unt1tled Document.</title> J 
<me t.a http-eq'.l1v="Content-Type" content="te x t./ html; c 
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<body bgcolor="#FFFFFF" te x t="#OOOOOO" > 

<~ 

2.-I-rasnt. Bo·sh sahifali hujjatning aralash rejimda ko·rinishi . 

o'rtasida mavjud bo'lgan munosabatlafdan tashkil topadi. Hu.ijafning 
HTML tilida yozilishini dastlabki matn deb ataymi~ . 

Menyu qatori 

Menyu qatori - bu Windowsning ixtiyoriy ilovasining zaruriy 
atributidir. U buyruqlar yordamida, muloqot oynalariga, tugmalarga 
yo' l ochadi, ular yordamida hujjat yaratish, dasturni sozlash. 
vizuallashtirish jarayonini boshqarish kabi dasturning barcha 
funksional imkoniyatlarini o'z ichiga olgan samarali ishlar bajariladi. 
Menyu qatorining har bir bandi vazifasi jihatidan bir-biriga yaqin 
kiritilgan menyu va kichik menyular ierarxiyasini hosil qiluvchi 
buyruqlar guruhini birlashtiradi. Bu bandlarning qisqacha tavsifini 
keltiramiz . 

• File menyusi (cI>aHn) fay liar bilan bog'liq buyruqlarni, gipermatnli 
hujjatlar shablonlari bilan ishlash, eksport qilish, ;mport qilish \'a 
brauzer dasturlarida ko'rish buyruqlarini o'z ichiga oladi. 

• Edit (npaBKa) menyusiga tahrirlash va qidirish bilan bog'liq 
buyruqlar kiradi. 
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• View (BI1A) menyusi interfeysning yordamchi elementlarini 
va gipermatnli hujjat obyektlarining ko'rinishlari ustida ishlovchi 
buyruqlarni o'z ichiga oladi. 

• Insert (BcTasKa) menyusiga har-xil obyektlarni impon qilish 
buyruqlari kiradi : rasm lar, jadvallar, shakllar, qatlamlar, maxsus belgilar 
va boshqalar. 

• Modify (.H3MeHI1Tb) menyusi o'z ichiga gipermatnli hujjat 
obyektlari atributlarini o'zgartirish buyruqlarini oladi. 

• Text (TeKcT) menyusi matnli fragmentlarni hosil qilish va ularni 
formatlash bilan bog'liq buyruqlarni o'z ichiga oladi. 

• Commands (KoMaH..lbl) menyusi gipermatnli hujjatlarni avtomatik 
qayta ishlash buyruqlarini o'z ichiga oladi. 

• Menyu qatorining Site (CaHT) bo'limi sayt bilan ishlash vositalari 
va gipermatnli hujjatlar bilan bog'liq murakkab tizimlar vositalarini o'z 
ichiga olgan. 

• Window (OKHO) menyusi dasturga tegishli palitralar, panellar va 
muloqot oynalarini o'rnatish va aksincha olib tashlash bilan bog'liq 
buyruqlarni o'z ichiga oladi. 

• Help (CnpaBKa) menyusida dasturdan foydalanish haqidagi 
inter{aol ma' lumotlarni chaqir~~h, elektron qo'lIanmani chaqirish kabi 
buyruqlar joylashgan. 

Uskunalar paneli 

Uskunalar paneli dasturning asosiy dispetcherlik pUlti vazifasini 
bajaradi (2 .5-rasm). C eng ko'p ishlatiladigan buyruqlar va tahrirlash 
resurslarini chaqirish tugmalarini birlashtiradi. Bu ixchamgina panel 
kiritilgan menyu va kichik menyular tizimi navigatsiyasi bilan bog'liq 
sarf-harajatlarni anchagina qisqartiradi. 

Cnda joylashgan barcha boshqaruv elementlarini sanab o'tamiz 
(chapdan o'ngga): 

• Code View (Pe}!<l1M pa3MeTKI1) - gipermatnli hujjatning faqat 
belgili kodlari tasvirlanadi (dizayni tasvirlanmaydi). 

~ ~ P!I I TiIIe: Untitled Docu~~ 00. o. I 0 ~?~ (J. !IW. 

2.5-rasm. Uskunalar paneli. 
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• Code and Design View (Pe)f(HM paJMeTKH H nnaHHpoBKH). 
Tugmasi bosilganda hujjat oynasi ikki qismga ajraladi: birinchi oynada 
belgili kodlar beriladi, ikkinchi oynada esa gipermatnli sahifaning 
dizayni, ya'ni tashqi kO'rinishi beriladi. 

• Design View (Pe)f(HM nnaHHpoBKH). Dasturda ishlashning vizual 
- WYSIWYG rejimiga o'tish tugmasi. 

• Title (3aronoBoK) - bu matnli maydon hujjatning sarlavhasini 
kiritishga mo'ljallangan. 

• File Management (YnpaBneHHe $aitnaMH) - tarmoqda ma'lumot 
almashish uchun xizmat qiladigan fayllar bilan ishlash buyruqlaridan 
tarkib topgan menyuni ochish tugmasi. 

• Preview/Debug in Browser (npOCMOTpioua.nKa B 6pay3e­
pe) - tugmasi gipermatnli hujjatni ko'rish va undagi Java Script 
kodlarini tanlangan brauzerda ish lash yoki ishlamasligini tekshiruvchi 
buyruqlaridan iborat menyuni ochadi. 

• Refresh Design View (06HOBHTb cTpaHHUY) - bu buyruq beril­
gandan sO'ng. hujjatning belgili matnlarida bo'lgan barcha o'zgarishlar 
loyihalash rejimiga uzatiladi. Ana shu \'aqtda kodlarni interpritat!liyasi 
va sintaksik tekshiruv boshlanadi. Xato fragmentlari sariq rangda 
ko'rsatiladi. To'g' rilari esa sahifada tasvirlanadi. 

• Reference (CnpaBKa) - tugmasi elektron ma'lumotli qo'lIanrnani 
ekranga chiqarib beradi. Bu qo'lIanmada gipermatnli belgilash tili 
deskriptorlari ifodalangan. 

• Code Navigation (HaBHraUHJI no Ko.naM) - tugmasi Java Script 
tilida yozilgan belgili kodlarni tuzatishni boshqaruv buyruqlaridan 
tarkib topgan menyuni ochadi. 

• View Options (napaMeTpbl oToopalKeHlliI) - tugmasi hujjat 
oynasining qO'shimcha elementlari vizualizatsiyasini boshqaruvchi buy­
ruqlar menyusini ochadi. Bu menyuga asosiy menyu qatoridagi View 
menyusining bir necha buyruqlari kiradi. 

Sabifalar o'lchamlarini belgilash 

Virtual to'plam hech qanday tartib-qoidalarga va standartlarga 
bo'ysunmasdan, tarqoq holda rivojlanadi. Bu esa ishlab chiquvchilar 
va dasturchilar uchun ko'p sonli qiyinchiliklar manbai bo'lishi 
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«Internet almashuvi>ming juda tez o'sishi sabablaridan biridir. Aslida 
sahifaga yoki saytni ishlayotganda muallif O'z asarini turli kompyuter 
tizimlarida aks etishi mumkinligini yodda tutishi kerak. Agar u tashrif 
buyuruvchilarini (foydalanuvchiJarini) yo'qotishni istamasa, u holda har 
xiI o'1chamli va har xii texnologiyalarni qo'llovchi (elektron-nur trubka 
bazasida bo'lishi shart emas) monitorlarda hujjatning aniq va qisqa 
ifodalanishi haqida o'ylab ko'rish kerak. 

Onlaynli hujjatlarni kO'rib chiqishda brauzer oynasi o'lchamlarini 
o'zgartirishga majbur qiJuvchi boshqa sabablar ham bor. Har bir savodli 
inson o'qish tezligi boshqa sabablardan tashqari qator uzunligiga ham 
bog'liqligini tushunadi. Agar qatorlar biror me'yordan sezilarli farq qilsa 
o'qilganning qabul qilinishi murakkablashadi. Psixologik tadqiqotlar 
kO'rsatishicha. matn qatorining optimal uzunligi alfavit simvollari 
soni bilan uzviy bog'liq. Qulay o'qish zonasini aniqlash uchun alfavit 
o'1chamini 1,5 dan 2 gacha qiymatni qabul qiladigan koeffitsiyentga 
ko'paytirish kerak. Bu narsa rus tilida matn qatorlari 70 simvoldan 
uzun bO'lmasligini biJdiradi. Ko'p foydalanuvchilar bunday formulaning 
mavjudligi haqida o'~ab ko'rmaydiJar va xaddan tashqari uzun qatorlar 
paydo bo'lishining oldini olish uchun brauzer oynasining o'lchamlarini 
chekltb qo'yadilar. 

Dreamweaver paketini yaratuvchilari dasturni turli o'lchamdagi 
monitorlarda hujjat qanday ko'rinishga ega bO'lishini tasavvur qilish 
imkonini beruvchi maxsus vosita bilan ta'minlab qo'yganlar. 

Holat qatorining o'eta qismida (2.2-rasm) h ujj at oynasining joriy 
o'1chamlari piksellarda chiqariladigan maydon joylashgan. Birinchi 
son-kenglik qiymatini, ikkinchi son balandlikni o'1chamini ifodalaydi. 
Agar maydonning ixtiyoriy nuqtasida sichqoncha tugmasini bosilsa, u 
hold a Windows va Macintosh platformalarida hisoblash tizimlarining 
eng ommaviy konfiguratsiyalari uchun yettita standart o'lchamga 
ega bO'lgan yetti muloqot oynasi chiqadi. O'lchamni belgilash uchun 
oynaning tegishli qatorini tanlash yetarli. 

Menyuning birinchi bandi hujjat sohasining 592 pikselga teng 
bO'lgan kengligini belgiJaydi va sohaning joriy balandligini o'zgarishsiz 
qoldiradi. Edite Sizees (O'1chamlarni to'g'rilash)ning oxirgi bandi 
hujjat oynasining o'1chamlarini tan lash va ularni standartlar ro'yxatiga 
kiritish imkonini beradi. Ekranda Preferences (Sozlashlar) muloqot 
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oynasi paydo bo'ladi, unda Width (kenglik, eni) maydonida kenglik. 
HElGHT (balandlik) maydonda esa soha baland/igi be/gilanadi. 
Yangi standartning matnli tavsifi Description (tavsiya) maydonida 
ko'rsatiladi. 

Barcha o'lchamlar dastur oynasining xizmat element/arini: o' lchov 
chiziqlari va menyu qatorini inobatga olmasdan hisoblab chiqiladi. 
Faqatgina huljat va uning obyekt/ari uchun ajratilgan ishchi soha 
hisobga olinadi. 

Palitra va tez yuklanish paneli 

Tez ishga tushirish palitrasi (Launcher) - bu asosiy muloqot 
oyna/ari va dasturlar panellarini ekranga chiqarish uchun mo'ljallangan 
yordamchi, xizmatchi palitra. Palitrani aks ettirish uchun Windows> 
Launcher buyrug'ini bajarish kerak. Bu buyruqning takroran bajari/ishi 
palitrani ekrandan olib tashlaydi. 

Palitraning Launcher (tez ishga tushirish) tugmasini bosish natija­
sida ekranga shu nomdagi muloqot oynasi chiqadi. Agar oc~ilgan 

palitra ekranning oldingi qavatida joylashgan bo'lsa, buyruq tug~asini 
takroran bosish uni yopilishiga olib keladi. Agar faol palitra hech 
bO'lmaganda qisman boshqa obyektlar bilan to'sitgan bo'lsa, u oldingi 
qavatga o·tadi. 

Palitra yettita eng ko'p talab qilinadigan dastur komponentlarining 
tez ishga tushirish tugmalarini birlashtiradi: 

Site (CaRT) - katta saytlarni boshqarish uchun muloqot oynasi, 
murakkab kesishuvli bog'lanishlarga ega gipermatnli hujjatJar tizim i 
uchun mo'ljallangan. 

• Assets (bH6mtOTeKa) - bu nom harfma-harf tarjimada faollar 
yoki fondJar ma'noJarini beradi. Bu panel dasturda kutubxona rolini 
o'ynaydi. U gipermatnJi hujjatlar dizayniga tegishli elementlarni o'zida 
saqlaydi. Bu elementlarga: tasvirlar, ranglar, tashqi bog'lanishlar, Flash 
- roliklari, shablonlar va boshqalar kiradi. 

• HTML Styles (CTHJlH HTML) - bu palitra matnli qalor va 
abzatslar uchun HTML belgili stillar bilan ishlashga Dlo'ljallangan . 

• CSS Styles (KaCKa.D.Hble JlHCTbl cHmen) - bu palitra stillarni 
kaskadli sahifalar bilan boshqarish uchun xizmat qiladi. Keyinchalik 
bu jumlani «ierarxik stillar spetsifikatsiyasi» ko'rinishida ham 
qo'l\aymiz. 
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• Beha"iors (Pe)l(HMbl) - palitrasi gipermatnli sahifalarni inter­
faolligini boshqarish vositalarini o'zida birlashtirgan. Senariy sahifani 
ko'rish jarayonida ro'y beradigan hodisalar asosida quriladi. Bu 
jarayonning chizmasida ko'plab interfaol effektlar yig'i1adi: oddiy 
animatsiyalashgan tugmalardan tortib ma'lumotlar bazasini qayta 
ishlashning murakkab protseduralarigacha. 

• History (npeilblcTopHR) - palitrasi foydalanuvchining HTML 
hujjatni tahrirlashdagi xatti-harakatlarini yozib boradi va saqlaydi. 
Tahrirlash jarayonidagi operatsiyalarni bekor qilish imkonini beradi va 
ayrim zanjirli ketma-ketliklarni buyruq ko'rinishida saqlaydi. 

• Code Inspector (I1HcneKTop KO;Ia). Dasturning eng muhim 
palitralaridan biri . HTML kodining ichki tahrirlagichi bo' lib Dream­
weaverning graftkli rejimiga o'zaro bog'langan. 

Tez ishga tushirish palitrasining o'ng tomondagi pastki burchagida 
to'g'ri burchakli tugma joylashgan. Bu vosita palitraning YO'nalishini 
o'zgartirishga mo'ljallangan. Tez ishga tushirish palitrasini o'zgartirish 
mumkin. Buning uchun Edit > Preferences buyrug'ini berish kerak. 
Dasturning asosiy sozlashlariga ega bo'lgan muloqot oynasi ochiladi. 
Unda Panels (panellar) kategoriyasini tan lab oling va palitra ichidagi 
Sho~ in Launche (tez ishga tushirish palitrasida kO'rsating) bo'limida 
beriladigan vositalar yordamida o'zgartiring. Holat qatorining o'ng 
qismida (2.2-rasm) joylashgan. 

Kontekstli men~'u 

Kontekstli menyu Windows operatsion t!zlmlOlng boshlovchi 
foydalanuvchilari uchun ham yaxshi tanish. Boshqaruvning bu 
standart usuliushbu operatsion tizimi boshqaruvida ishlovchi 
kO'pchilik ilovalar (dasturlar) tomonidan ko'p qo' llanilad i. Uning 
mohiyati sodda. Sichqonchaning o'ng tugmasini hujjat oynasining 
obyekti ustida bosilsa, ekranga obyekt turiga bog' Jiq bo' lgan 
mazmundagi menyu chiqadi. Bu menyuda shu obyektga tegishli yOkl 
ushbu holatda talab qilinishi ko'proq ehtimolligi bor bo'lgan buyruqJar 
to·plangan. 

Dreamweaver dasturining barcha versiyalarida kontekstli menyu 
mavjud. Kontekstli menyuning o'lchami ya'ni buyruqlari saft kengaydi, 
qO'shimcha darajalarga ega bo'ldi va endi har qanday holatda 
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Par aQr aph Format 

List 

~ 
Font 

Style 

CSS Styles 

Size 

T~es 

Element View 

Edit T&r;j <body> ... 

QIXk T&r;j Editor ..• 

Make I.ilk 

T ar!jet Frame 

Create New Snippet 

• 

Shtt+FS 

chaqirilishi mumkin. 2.6-rasmda oyna 
ixtiyoriy bo'sh nuqtasida sichqonchaning 
o'ng tugmasi bosilsa dastur chiqarib 
beradigan kontekstli menyuga misol 
keltirilgan. 

Property Inspector palitrasi 

Property Inspector (I1HcneKTop 
CBOHCTB) palitrasi - bu dasturning aso­
siy uskunasidir. HTML sahifasida 
joylashgan obyektlar atributlarini o'z­
gartirish ishlarining asosiy qismml 
uning yordamida bajariladi. (2.7-rasm). 

Paste Ctrl+V 

Property Inspector palitrasi ko'chib 
yuruvchi palitradan iborat bo'lib, uning 
tarkibi bajarilayotgan operatsiyaga, tan­
langan obyekt turiga va kursorning 
holatiga 'qarab, mos ravishda o'lgarib 
turadi. Palitrani ekranga chiqarish uchun 
quyidagi Window > Properties (OKHO 
> CBOHCTBa) buyruqni berish yoki 
CTRL+F3 tug malar kombinatsiyasini 
bosish kerak. Bu buyruqni qaytadan 
berish palitrani ekrandan olib tashlaydi. 

Paste Special . .. 

Desq, Notes for Page •.• 

Page Properties ... 

1.6-rasm. Kontekstli menyu. 

~~~;J -~'~hkJ 7 • 9 

--. '-_ .' ... .. - , I J'! ~ i 
II 12 13 14 15 16 

2.7-raslll. Property Inspector palitrasi. 



Palitraning asosiy maydonlari va tugmalarini sanab o'tamiz. 
Palitraning shu boshqaruv elementlari matnni formatlash va gipermatnli 
bog'lanishlarni hosil qilishga tegishli vazifalarni o'z ichiga oladi: 

• Format (cDopMaT) ro'yxati matnning stand art strukturali tiplaridan 
birini tan lash imkonini beradi (1). 

• Link (CC5I.'IKa) ushbu hujjatga tegishli giperbog'lanishlar 
ro'yxatini o'zida saqlaydi. Har bir bog'lanishni bir necha marta qo'llash 
mumkin. Ya'ni bir marta tuzilgan bog'lanishni. boshqa faol hududlarga 
ham takror qo'llash mumkin (2). 

• Matn fragmenti shriftini belgilash imkonini beradi. Bu ro'y­
xatning punktlari shriftlar to'plamidan iborat bo'lib, qo'llanilishiga 
qarab joylashgan (3). 

• Size (PaJMep) ro'yxati shrift o'lchamini tan lash uchun mo'l­
jallangan (4). 

• Standart ranglar palitrasini chaqirish tugmasi. Bu palitra tan­
langan matnli fragment rangini tan lash imkonini beradi (5). 

• Tanlangan rangning kodi tasvirlangan yoki kiritiladigan maydon 
(6). 

• Shriftni holatini tanlash tugmasi. Ko'rinishi va funksiyasi standart 
boshqa dasturlardagidek (7). 

• Matnni tekislash tipini tan lash tugmalari (8). 
• Interfaol yordamni chaqirish tugmasi (9). 
• Marker-ko'rsatkich. Uni tegishli fay I yoki simvolga surish bilan 

gipermatnli bog'lanish hosil qilinadi (10). 
• Select File (Bbl6paTb q,aH11) muloqot oynasini ochish tugmasi. 

Fayllar tizimida harakatlanish va gipermatnli bog'lanishlarni asosi 
bo'lib xizmat qiladigan hujjatni tan lash (11). 

• Target (HaJHaqeHl1e) ro'yxati gipermatnli bog'lanishda ko'r­
satilgan hujjatni ekranda yuklanish usulini tanlash imkonini beradi. Shu 
bo'limda havolali hujjat chiqish oynasi yoki freymni belgilanadi (12). 

• KO'pchilik tahrirlagich dasturlarda standart ko'rinishda, matnli va 
HTML, ro'yxatlarni belgilash va nomerlash tugmasi (13). 

• List Item (Pa31Ie11 cnl1cKa) tugmasi List Properties (CBOHCTBa cnH­
cKa) muloqot oynasini ochish uchun ishlatiladi. Bu oyna barcha tipdagi 
ro'yxatlarni tahrirlashga mo'ljal\angan (14). 

• Ikkita tugma, matnli fragmentlarni gorizontal surilishini bosh-

qaradi (15). 
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2.8-rasm. Obyektlar palitrasi. 

TOB) palitrasi ana shunday tashqi obyektlarni yaratish va qo'yish uchun 
xizmat qiladi. Bu palitrani ekranga chiqarish uchun Window> Objects 
(OKHO > 06beKTbl) buyrug'ini bajarish kerak. Xuddi shu buyruqni 
klaviaturadan CTRL +F2 tugmalar kombinatsiyasini bosish bilan ham 
berish mumkin. Bu buy ruqn i takror berish palitrani ekrandan olib 
tashlaydi. 

P.llitra yettita nomdagi qisrolardan iborat. Bular: Characters, Com­
mon, Forms, Frames, Head, Invisibles, Special. 

• Characters (Cnel..{lfaJlbHble cHMBonbl). Klav iaturada uchramay­
digan maxsus simvollarni qo'yish (savdo markasi, kopirayt va bosh­

qalar). 
• Common (06lI.{He) - bo'limi eng ko'p qo'llaniladigan obyektlarni 

birlashtiradi. Bu jadvallar, rasmlar, gorizontal chizg'ich, joriy ka­
lendardagi sanalar va boshqalar. 

• Forms (<I>oPMbl). Formalar va elementIar, ularning tashkil qiluv­
chilari: yoqib-o'chiruvchilar, rO'yxatlar, matn maydonlari va boshqalar. 

• Frames (~peHMbl). Freymlar tlZlmml yaratish. Har xii 
ko'rinishdagi freymlar qismlaridan tarkib topgan freymlar tizmini hosil 
qilish. Ya'ni yaratilayotgan saytni sahifasini freymlarga bO'lib olish. 

• Head (3aronoBoK) - gipermatnli hujjatning sarlavha qismiga tav­

sif berish. 
• Invisibles (CxpblTble 06'beXTbJ). HTML sahifani brauzer dastur­

larida namoyish qilishda, ko'rinmaydigan yashirin obyektlarni joylash. 
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Bu paiitraning eng kichik qismi bo'lib, u faqat uchta tipdagi obyektlarni 
qo'shib beradi: simvollari. izohlar va senariylar. 

• Special (CneUl1aJlbHble o6beKTbI) - bu bo'lim o'zida maxsus 
obyektlarni qo'yish tugmalarini birlashtiradi. Bularga appletlar, ActiveX 
obyektlari va boshqa tashqi to'ldiruvchilarni (plagins) kiritish mumkin. 

Palitraning pastki qismida ikki gurllhga bo·lingan to'rtta tugma 
joylashgan: Layout (KO'tnOHOBKa) va View (BI1.n). Ular maketlash 
rejimiga o·tish va sahifannig strukturasini tezda yaratishga imkon 
beradi. Bu elementlar bilan qisqacha tanishib o'tamiz: 

• Draw Layout Cell (C03.naHl1e MaKeTHoH jJl.{eHKI1) - maketli ka­
takcha yaratish uskunasini faollashtiradi. 

• Draw Layout Table (C03.!laHl1e MaKeTHoH Ta6.'I1UbI). Maketli 
jadval yaratish uskunasini faollashtiradi. 

• Standard View (CTaH.napTHblu pe)f(I1M). Hujjat bilan ishlashning 
standart rejimiga o'tish. 

• Layout View (Pe)f(I1M MaKeTHpOBaHl1jJ) - Hujjatni maketlash reji­
miga o'tish. 

Ushbu bo'limni nomi palitra sarlavhasi qatori ostida tasvirl8nadi. 
Bo'limni ochish uchun shu nomni sichqoncha chap tugmasi bila!1 
bosing. Ochilgan menyudan foydalanuvchi kerakli qismni tanlashi 
mllmkin. Palitraning ayrim bo'limlarida hamma tugmalar ham 
tasvirlanmaydi. Masalan, Common (06wl1e) bo'limi yigirmaga yaqin 
tugmani o'z ichiga oladi, ularning hammasi ham palitra oynasiga 
sig'maydi. Boshqa tugmalarni ko'rish uchun prokrutkadan foydalanish 
(prokrutkani vazifasini palitraning chetida joylashgan strelkali tugmalar 
bajaradi) yoki muloqot oynasining o'lchamini kattalashtirish kerak. 

Aksariyat hollarda obyektlarni qo'yish uchun qo'shimcha para­
metrlarni kiritishga to'g'ri keladi. Bunday holatlarda ekranda foy­
dalanuvchi tanlashi yoki ma'lumot kiritishi mumkin bo'lgan muloqot 
oynasi paydo bo'ladi. Bu oynaga foydalanuvchi obyektning kerakli 
obyektlarini tanlashi yoki kiritishi kerak. 

Kodlar nazoratchisi bilan ishlash 

Ko'p sonli HTML tahrirlagichlari sinfi orasida Dreamweaver dasturi 
gipermatnli hujjatlar kodlari bilan ish lash imkoniyatlari jihatidan keskin 
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farq qiladi. Foydalanuvchining HTML kodlarni qo'lda tahrirlashdan 
qutilishi eng katta yutuq va tezkorlikni ta'minlab berdi. 

Kodlar bilan to'g'ridan-to'g'ri ish lash, yashirin xatolarni iden­
tifikatsiya qilish, ortiqcha kodni bartaraf etish, gipermatnning 
tanlangan fragmentiga tezkor o'zgartirish kiritish, hujjatning struk­
turasini yoki uning formatlanishini optimallashtirish imkoniyatlari 
mavjud. 

Dreamweaver paketi tarkibida gipermatnli hujjatlarni belgilash 
kodlarini ko'rish va tahrirlashga mo'ljallangan maxsus vositasi rnavjud. 
Bu vosita Code Inspector (HHcneKTop KO)la) deb nornlanadi. Uni 
quyidagi usullar bilan o'rnatish murnkin: birinchidan, Window> Code 
Inspector (OKHO > I1HcneKTop KO)la) buyrug'ini berish yo'li bilan. 
ikkinchidan. bu FIO tugmasini bosish YO'li bilan. Bu buyruqlar takror 
bosilganda Code Inspector yana ish stolidan yo'qoladi. 

2.9-rasrnda Kodlarni nazorat qilish oynasi kO'rsatilgan. Palitrada 
kodlarning belgilanishini tanishtirishni View Options (napaMeTpbI OTO-
6palKeHHJI) tugmasi yordamida ochiladigan buyruqlar boshqaradi. Bu 
buyruqlarni ko'rib chiqarniz: 

. _. _. , 0.. ~~ I 
_ < III LE> Z<IIII LE> ... 11 

</HEAD > 
<body' ba:kgrDund= lFCJ~j JPG> 

<ul> 
<1I*b><ton! fece='"Tlrne., tJew K.orna", erR'" sl;:e=3><~ :,;"t~",ltl ">2 C 

0 3.QOH1-18 l,oIieb-'::I3na</~) <,ltont><!b> 

</11> 
<ul> 

<11><101'11 face="Tlrnes I·,jev. Romen CYR" 5Ize=3><., Iw'l="# 2" >2.1 

npoe" T ~1poBaH~1e <,") <,10nl> 

<ul> 

~ 
<1I><fotl'tace~"Tirnes tJewRornon C'(R" slze=3><" I,I",I="#:;">C 

2.9-rasm. Kodlar nazoratchisi. 

~ 

85 



o Word Wrap (nepeHoc no CJ10BaM). Kod qatorini ko'chirish rejimi. 
Agar u yoqilgan bo'lsa, HTML tili bayonnomasi tahrirlagich oynasining 
o'khamiga yetganda avtomatik ravishda yangi qatorga o'tadi. 

o Line Numbers (HoMepa CTpOK) - nomerlashni o'rnatish buy­
rug'i. Agar bu rejim o'rnatilgan bo'lsa, har bir qator tartib bilan 
nomerlanadi. 

o Highlight Invalid HTML (nOMeTKa HeKoppeKTHblx KO.lOB). Bu 
buyruq sintaktik xatoga ega konstruktsiyalarni Property Inspector 
panelida va hujjatning oynasida sariq rangda ajratish rejimini faol­
lashtiradi. Shundan so'ng Property Inspector xato haqida xabar beradi 
va ayrim hollarda uni tuzatish uchun ko'rsatmalar beradi. 

o Syntax Coloring (PacKpacKa CI1HTaKCI1'ieCKHX KOHCTPYKUHJI). Bu 
rejimda belgili kodlar turli xii ranglarga ajratiladi. Bu esa hujjatning 
kiritiladigan matni va belgili kodlarini tez ajratib olishga imkon 
beradi. Bundan tashqari Dreamweaver dasturi HTML tilining har bir 
deskriptori uchun alohida rang belgilash imkoniyatiga ega. Ranglami 
belgilashning dastur asosiy ko'rsatkichlarini Code Colors (UBeTa KOJl.a) 
bo'limida amalga oshiriladi. • 

o Auto Indent (ABTo~aTI1'fecKHH oTcTyn) buyrug' i kodlar na­
zoratchisi oynasiga kiritilgan belgilash diskreptorlari uchun avtomatik 
joy qoldirish rejimini faollashtiradi. 

Kodlar nazoratchisi oynasining o'ng qismida uchburchak formada 
tugma joylashgan. U hujjatning mavjud matnlariga xizmat qiladigan 
buyruqlardan iborat menyuni chaqiradi. Bu buyruqlarni sanab o'tamiz: 

o Find and Replace (HaHTH H 3aMeHHTb). Qidirish va almashtirish 
vazifasini bajaradi. 

o Find Next (HaHTI1 Jl.aJ1ee). Avval qidirilgan namunani mavjud 
parametr asosida qidirish. Bunda qidirish va almashtirish muloqot 
oynasi chiqmasdan to"g"ridan-to'g'ri amalga oshiriladi. 

o Reference (CnpaBO'iHOe PYKOBOJl.CTBO). HTML, JavaScript va CSS 
manbalari asosidagi ma'lumotli qo'llanmani chaqiradi. 

o Set Breakpoint (BcTaBHTb KOHTPOJ1bHYIO TO'iKY). Matn kursori 
pozitsiyasida nazorat nuqtasini belgilaydi. 

o Remove All Breakpoint (Y.lamtTb Bce KOHTPO,lbHble TO'iKH). 
Hujjatning mavjud matnidan barcha nazorat nuqtalarini olib tashlaydi . 

o Cut (Bblpe3aTb). Tanlangan kodli fragmentni buferga qirqib olish . 
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• Copy (KOnHpOBaTb). Tanlangan kodli fragmentni nusxasini bu­
ferga olish . 

• Paste (BCTaBHTL). Buferga olingan fragmentni qo'yish. 
Kodlar nazoratchisini matn muharriri uchun biroz g'ayri oddiy 

holda muvaffaqiyatli qo'llash mum kin. Dreamweaver dasturi ASCII 
simvoHarini qo'Hash bilan yozilgan fayllarni , masalan oddiy matnli 
fayllarni yoki dasturning dastlabki matnini muvaffaqiyatli o'qiydi. 
Bunday huljatlar Open (OTKPblTb) buyrug'i yordamida ochiladi va kodli 
rejimda ishlaydigan oyna huljatiga yUkJanadi. Bunda dasturning ba'zi 
resurslariga kirish mumkin bo' lmay qoladi. 

Dasturning kutubxonasi 

Kutubxonalar - bu gipermatnli sahifaning dizayniga tegishli ko'p 
marta qo' lIaniladigan elementlarni saqlash vositasidir. Bu elementlarga: 
tasvirlar. bog·lanishlar. matn bO'laklari va boshqalar kiradi . Dream­
weaver dasturida esa kutubxonaning ishlash prinsipi biroz boshqacha. 
Dastlab kutubxonaga saqlashning bitta elementi hisoblangan. 
obyekt yoki obyektlarga tegishli gipermatnJi be1gilash fragmenllari 
saqllmadi. Drearnweaver dasturida kutubxona elementlari maxsus 
Library papkasida saqlanadi. Bu papka saylning asosiy papkasi ichida 
joylashadi. Har bir Web-uzel o'zining standart elementlari va ularni 
saqlash papkasini tashkil qiluvchi shaxsiy kutubxonasiga ega. Dlar bilan 
ishlash uchun palitraning Assets (PecYPcbI) bo'limidan foydalaniladi 
(::! .lO-rasm). Kutubxonalar bilan boshqarish ishlarining asosiy qismml 
palitraning Assets (Pecypcbl) bO'limi buyruqlari yordamida amalga 
oshiriladi. 

Dreamv"'eaverda kutubxonalarning asosiy imkoniyatlarini sanab 

o'tarniz: 
• Kutubxona e1ementi deb <body> deskriptori orasida yotgan har 

qanday fragmentni aytish mumkin; 
• Kutubxona elementlari qo' lIanilishida cheksiz imkoniyatlarga 

ega. Ularni gipermatnli sahifalarga hech qanday tahrirlashsiz qo'yish 

mumkin: 
• Kutubxona elementlariga o'zgartirish kiritilsa, ularni boshqa 

gipermatnli sahifalar va huljatlarda qo'lIashda saqlanib qoladi. 
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LibI.y 

This i5 • bin Libll1', am. . 
To g.t st.rt ... click th. ~ Edit button .ne! Idd cont.nt. 

• 

2. j(J-rasm. Palitraning Assets bo·limi. 

• Sahifalardagi kutubxona namunasi va uning nusxalari orasidagi 
aloqani uzishga ruxsat etiladi. 

• Dastur alohida saytlar o'rtasida kutubxona elementlarini almashish 
buyruqlariga ega. 

• Kutubxonalar dinamik xususiyatga ega bo'lgan obyektlarni 
saqlash xususiyatiga ega. 

• Vaqt diagrammalari (timeline) va stillarning kaskadli sahifalari 
kutubxonada saqlanishi mumkin emas. 

Holat qatori va uni o'rnatish 

Status Bar (CTpoKa COCTORHHJI) bu kichik bo'lim dasturning holat 
qatori ko'rinishi ko'rsatkichlarini belgilaydi (2.11-rasm). Bu element 
hujjat oynasining pastki qismida joylashgan. Odatda bu qatorda 
joriy oyna o"lchami haqidagi ma'lumotlar va uning yuklanishi uchun 
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Status Bar 

~indow Sizes: I Width I .. eight I -.:-:::IPb?::. .. I ~J 
600 ---
760 
795 
955 
544 378 
I I 

!;;onnection Speed: ra8~ Kilobits pe' Second 

Launcher: P Show l.auncher i'I Status Bar 

2. I I -ramI . Status Bar bo' limi. 

J 

ketadigan vaqt ko'rsatiladi. Undan tashqari holat qatorining o'ng qismini 
tez yuklanish paneli egallaydi: 

Window Sizes (Pa3Mepbl oKHa). Gipermatnli sahifalar har xii 
o'1chamdagi oynalarda tasvirlanishi mumkin. Window Sizes (Pa3-
Mepbl· oKHa) paneli standart u'lchamlar ro'yxatini to'ldirish uchun 
mo'ljallangan. Barcha tahrirlash amaIJari klaviaturadan shu panelning 
tegishli maydonlariga kiritish yordamida bajariladi. 

Connection Speed Kilobits Per Second (CKOPOCTb COe,llHHeHHJI, 
KOHT/c). Bu maydonga server bilan bog'lanishning taxminiy tezligi 
kiritiladi . Bu joriy sahifani taxminiy yuklanish vaqtini belgilaydi. 
Odatda 28.8 Kbit/s tezlik o'rnatilgan bo'ladi. 

• Show Launcher in Status Bar (naHeJIb 6blcTporo 3anycKa B 

CTpoKe COCTOJlHHJI) bu bayroqcha tez yuklanish panelini holat qatorida 
chiqishini boshqaradi. 

Savol va topshiriqlar: 

I. Dreamweaver dasturida kodlar bilan ishlashning qanday imkoniyatlari 
bor? 

2. Kodlar nazoratchisini o'rnatish usullarini sanab bering? 
3. Kodlar nazoratchisi nima va uning vazifalari nimalardan iborat? 
4. Dasturning kutubxonasi nima? 
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2.3. Fayllar bilan ishlash 

Dasturning fayIlarni ochish texnikasi Windows tizimida ishlaydigan 
boshqa dasturlardan farqi yo'q. Buning uchun File > Open (<!laM,' 
> OTKPbITb) buyrug'ini berish kerak. Bu buyruqni klaviaturadan 
CTRL+O tugmalar kombinatsiyasini bosish bilan ham bajarish mumkin. 
Bundan tashqari dasturda fayIlarni ochishning surib kelish usuli ham 
mavjud. HTML fay I belgisini sichqoncha yordamida surib kelib, hujjat 
oynasining ixtiyoriy yeriga tashlansa fayl ochiladi. Dasturda bir vaqtda 
bir nechta oyna bilan ish lash imkoniyati faqatgina kompyuterning bo'sh 
xotirasi bilan mos ravishda cheklanadi. Agar dasturda bo'sh sahifa bilan 
ish boshlangan bo'lsa, u holda yangi fayl har qanday holatda uni o'rnini 
egaIlaydi. 

Dreamweaver dasturi ochiladigan HTML sahifalarida sintaktik 
xatolarni tekshiradi. Dastur stand art HTML gipermatnli belgilash 
tili asosida yozilgan barcha kengaytmali fayl\arni ocha oladi. Ularga 
quyidagilar kiradi : .HTM, .HTML, .ASP, .CFM, .CFML, .TXT, .SHTM, 
.SHTML, .STM, .LASSO, XML. .CSS::PHP. ' 

Fayllarni saqlash 

Dreamweaverda fayUarni saqlash ham Windows tizimining boshqa 
standart dasturlaridagi singari amalga oshiriladi. Buning uchun: File 
> Save (<1>aH,' > CoxpaHHTb) yoki File> Save as (<1>aH.l1 > CoxpaHHTb 
KaK) buyruqlarini berish kerak. Birinchi buyruqni CTRL +S tugmalar 
kombinatsiyasini bosish bilan ham bajarish mumkin. Bu buyruq 
shu nomdagi muloqot oynasini hosil qiladi. Oynada foydalanuvchi 
tomonidan faylning nomi, tipi va saqlash joyi belgilanadi. 

Gipermatnli hujjatlar fay\lari Windows operatsion tizimida .htm 
kengaytma oladi, Macintosh platformasida esa .html kengaytma oladi. 
Ammo bu kengaytmadagi fayl\arni dasturlarda ochish 'la saqlash 
buyruqlari bajarilishi teng kuchli. Dasturda ochilishi mumkin bo'lgan 
barcha tipdagi fay liar, xuddi shu dasturda saqlanadi ham. 

Tabiiy sharoitda yoki ilmiy laboratoriyalarda o'tadigan ko'pgina fizik 
jarayonlar qaytmas hisoblanadi. Bu tabiatshunoslikda olamning butun 
i1miy manzarasini shakllantiruvchi fundamental qoidalaridan biridir. 
Zamonaviy hisoblash mashinalari insonni bu falsafiy kategoriyadan 
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qisman qutqarishga qodir. Ko'pchilik zamonaviy dasturlar qoniqarsiz 
natijani bekor qilishga imkon beradi. Ya'ni huljatning avvalgi bolatiga 
qaytish. qabul qilingan qarorJarni qadamba-qadam orqaga qaytarish 
imkonini beradi . 

Dreamweaver dasturida buning uchun Edit> Undo (flpaBKa > 01-­
MeHa) buyrug' ini bajarish yoki CTRL+Z tugmaLar kombinatsiyasini 
bosish yetarli. 

Dastur bekor qilisbni bir necbta o'zaro bog'langan ketma-ket 
qadamda amalga oshiradi. Bu ketma-ketlik qadamlarining soni 
dasturning tegishli ko' rsatkichida ifodalangan songa teng; odatda bu 
son 100 ga teng. 

Bu sonni quyidagicha o'zgartirish mumkin: 
1. Edit>Preferences (npaBKa>HacTpoHKH) - buyrug'ini bering; 
2. General (06wHe) kategoriyasini oching; 
3. Maximum Number of History Steps (MaKcHMIL1LHoe '1HC.'lO 

3anHceH JKYPHaJIa) maydoniga o'zingiz saqlamoqchi bo'lgan ketma­
ketliklar maksimal sonini kiriting. 

Tahrirlash ishlari va buyruqlarini yozish va saqlash foydalanuv­
ch idan qo·shimcha hisobLash manbalarini talab qiladi. 

V.do (OTMeHa) buyrug'i .. «eng mubim izlami» bekor qilish 
imkoniyatini beradi. Ammo bu usul bilan jarayonni bir necha bor 
bajarib «bekor qilish» buyrug'idan yaxshi natija olib bo'lmaydi. Chunki 
uning yordamida faqatgina eng muhim izlarni bekor qilish mum kin 
xolos. Bundan tashqari, ayrim buyruqlarni bu usul bilan bekor qilib 
bo·lmaydi. Bekor qilib bo'lmaydigan buyruqlarni orqaga qaytarish 
yoki ancha oldin bajarilgan operatsiyalarni qaytarish uchun File > 
Revert (<DaMn > BePHYThC8 K coxpaHeHHoMY) buyrug'idan foydalanish 
mumkin. Bu buyruq huljatni oxirgi saqlangan hoLatini tiklab beradi. 

Buyruqni ishlatish yo'li oddiy. Qaytarib bo'Lmaydigan buyruqlar 
mavjud ketma-ketlikni tiklashga berishdan oldin huljatni diskka saq\ab 
olish kerak. Agar ish yaxshi natija bermasa, u holda Revert (cI>aiiJI > Bep­
H)"ThC8 K coxpaHeHHoMY) buyrug'i huljatni o'sha holatida tiklab beradi. 

Dasturda bajarUgan operatsiyalarni takrorlash ham mumkin. 
Edit > Redo (flpaBKa > TIOBTOpHTb) buyrug' i oxirgj buyruqni yoki 
tahrirlash isblarini takroran bajaradi. Bu buyruqni CTRL+Y tugmalar 
kombinatsiyasi yordamida ham berish mumkin. 

91 



Shuni esda tutish kerakki, dasturning ish bayonnomasiga faqatgina 
natijaviy operatsiyalar yoziladi, masalan: simvollarni kiritish va 
o'chirish, obyektlarni qo'yish, formatlash buyruqlari va boshqalar. 
Faqat shunday holatlarni bekor qilish yoki takrorlash mumkin. Ko'plab 
yordamchi tipdagi buyruqlarni bekor qilib yoki takrorlab bo'lmaydi. 
Kursorni sur ish, obyektlarni belgilash, hujjatni saqlash va boshqalar 
shular jumlasidan. 

Savol va topishir;qlar: 

I. Dasturda fayllarni ochish yo'lIarini sanab bering? 
1. Dastur yordamida qanday kengaytmali fayllarni ochish mumkin? 
3. Dasturning fayllarni saqlash usullarini aytib bering? 
4. Dasturning bekor qilish va takrorlash imkoniyatlarini sanab bering? 

2.4. Web-uzel yaratish 

lahon o'rgimchak uyasining (World Wide Web) barcha informatsion 
manbalarini ikkita katta sinfga bO'lisb. qabul qilingan: sahifal~ va 
uzellar yoki saytlar. Biz yuqorida web - sahifalar ta'rifi bilan tanishdik. 

Web-uzellar ya'ni saytlar - deganda o'ziga sahifalarni birlashtirgan 
tizim tushuniladi. Boshqacha aytganda uzel deganda minglab hujjatlarni 
o'zida birlashtirgan. kO'psonli bog'lanishga ega, multimediali murakkab 
tizim tushuniladi . 

Dreamweaver paketi - bu ko'p qirrali dastur. Uni alohida sahifalar 
yaratish uchun oddiy gipermatnli hujjatlar tahrirlagichi sifatida ham 
ish latish rnumkin. Bundan tashqari dastur har qanday murakkablikdagi 
Web-uzellarni ham yarata oladi. 

Chiziqli struktura 

Kompyuter paydo bo'lgunga qadar barcha chop etiladigan: badiiy 
kitoblar, qo'llanmalar, ma' lumotnomalar, texnik kO'rsatmalar chiziqli 
strukturaga misol bo'la olar edi. Bugungi kunga kelib bularni multimediali 
qo' lIanmalar va e1ektron kO'rsatmalar ko'rinishida qo' llanmoqda. 
Chiziqli zanjir elektron magazinda buyurtma berishni rasmiylashtirish 
qadamlari, ayrim tarmoq manbalariga kirish uchun ro'yxatdan o' tish yoki 
rasmiylashtirish ketma-ketliklarini tushunish mumkin. 
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---7 

:! 12-rasm. Chiziqii struktura. 

Chiziqli strukturaga kirish nuqtasi bo"lib birinchi sahifaxizmat 
qiladi. Bu bosh sahifa odatda index.htm yoki main.htm deb nomlanadi. 
Bu esa kitob yoki jurnallardagi muqova rolini bajaradi. Bu sahifa bir 
vaqtning o"zida ham namoyish bob, ham tanishtiruv sahifasi, ham 
ma"lumotli sahifa bo"lmog"i lozim. Qidiruv mashinalari har bir sahifani 
alohida indekslaydi . Shuning uchun barcha ichki sahifalarni bosh 
sahifaga o"tkazadigan harakatlanish tugmalari bilan to' ldirish kerak. 

Iyerarxik struktura 

Saytlar yaratishning zanjirli prinsipi sahifalar joylashuviga va ular 
orasi<lagi bir-biriga o'tishlarga qafiy cheklashlar qo"yishga asoslanadi. 

/l-, 
~ /; ; l-

i ~ l 

l-l-l-l-
2.J3-rasm. lyerarxik slruktura. 
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Iyerarxik bO'ysunish prinsipi bo'yicha qurilgan tugunlar ancha katta 
moslashuvehanlikka ega. Ko'plab korxonalar, tashkilotlar Jyerarxik 
struktura ehizmasi asosida qurilgan. Bu esa Iyerarxik strukturaning 
kamehiliklari va yutuqlari yaxshi o' rganilganidan darak beradi. Bu 
strukturani ba'zan daraxtsimon struktura ham deyilib, bitta bosh o'zak 
(but un saytga kirish nuqtasi hisoblangan) sahifaga ega bo'ladi. 

Har qanday ichki sahifa informatsion manba hisoblanib bosh sahifa 
bilan mantiqiy bog'langan bo'ladi. 

Ko'p bog'lanishli struktura 

Ko'p bog'lanishli strukturada heeh qanday cheklanishlar bo' lmaydi. 
Ya'ni har bir sahifa boshqa bare ha sahifalar bilan bog' langan bo' lishi 
kerak. Katta saytlarda tashrif buyuruvehilarning mo'ljal olishi uehun 
maxsus indeksatsiya tizimlari yoki saytning aylanish kartasi ifodalanishi 
kerak. 

l-l­
/\ 

l--l--l--l-
2 . /~-rasm . Ko'p bog·lanishli struktura. 

Materialning taqsimoti 

• 

Materialning Web-uzelda bo'limlar bo'yicha taqsimoti mantiqiy 
ravishda amalga oshirilishi kerak. Har bir sahifaga faqat belgilangan 
predmet yoki mavzudagi material joylanishi kerak. Tanlangan 
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gipermatn ostida aynan shu mavzudagi hujjat borligi foydalanuvchining 
ishonchini yanada orttiradi. Ayrim hollarda buning aksini, ya'ni 
tanlangan gipermatnga xos bO'lmagan hujjatning ochilishini ham kO'rish 
mum kin. 

Saytni qismlarga bo'lishda ham ma'lumotning katta-kichikligiga, 
ma'lum mavzu yoki predmetga xosligiga qarab bo'lish ham maqsadga 
muvofiqdir. Yuqorida aytilgandek biror sahifada bir predmet yoki 
mavzuga xos bO'lgan matnlar bilan birga, rasmlar, jadvallar, ani­
matsiyalar va boshqa ko'rinishdagi materiallarning ham shu bO'limga 
xosligi katta ahamiyatga ega. Ma'lumotlarning mos kelmasligi foyda­
lanuvchilarning ishonchini yo'qotib, ularning sonini keskin kamaytirib 
yuboradi. Bunday holatga tushib qolmaslik uchun Web-dizaynerdan 
qunt bilan ishlashni talab qiladi. Agarda tayyorlanayotgan saytdagi 
materiallar Web-dizaynerga notanish mavzuda bO'lsa, u hold a o'sha 
sohadagi biror yetuk mutaxassis bilan hamkorlikda ishlashga to'g'ri 
keladi. 

Web-saytlarni internetga joylash uchun manul berish 

Saytlarga internetda manzil berish uchun URL (Uniform Resource 
Locat8r) deb nomlanadigan ii5{)ra qo·lIaniladi. URL-internetga mu­
rojaat qilishning eng oddiy usuli bo'lib, u manzilni ifodalaydi. URL 
manzilidan ixtiyoriy sondagi foydalanuvchi bir vaqtning o'zida 
foydalanishi mumkin. URL manzili qat'iy format asosida yoziladi (2.15-
rasm). 

IIporoKoJI: / / xocr :nopr / nyrh / ~aHJI #~parMeHT 

2.15-rasm. URL manzili strukturasi. 

Manzilni to'liqroq tushunish uchun quyidagi misolni ko'rib chi­
qamiz: 

hnp://www.pedagog.uz/index.php 

bu URL manzili tarkibiy qismlari quyidagicha: 
http - resursdan foydalanishda gipermatn bayonnomasi ishlati­

layotganini bildiradi. 
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www.pedagog.uz - ma'Jumotlar joylashgan Internet sayt nomini 
bildiradi. 

Index.php - faylning kompyuterdagi to'la nomini bildiradi. 
Manzilning asosiy tashkil qiluvchilarini kO'rib chiqamiz: 
• llPOTOKOJl - bayonnoma. Internet - mijozlari va serverlarining 

bog'lanishi usulini tavsiflovchi qism. Odatda http (HyperText Transfer 
Protocol) gipermatnli uzatish maxsus bayonnomasidan foydaJaniladi . 
Manzil kichik lotin harflari bilan yoziladi (http://). 

• OMII cepBepa, Bunda joylanadigan ma'lumotlarni saqlaydigan 
hisoblash tizimining (bu hisoblash tizimini server deb nom lash qabul 
qilingan) nomi kO'rsatiladi. Serverga berilgan ta'rifda ham - tarmoq 
ishini nazorat qiluvchi kompyuter deb aytilganligi bejiz emas. Server 
nomi domen nomi kabi www bilan yoki usiz yozilishi mum kin. 
Masalan, www.macromedia.com. Boshqacha usulda nomni IP - adres 
ko'rinishida ifodalash mumkin. Masalan, 199.227.52.143. 

• llOPT, Port raqamini ko'rsatish bitta server ichidagi jarayonni 
adresatsiya qilish uchun talab etiladi. Biroz vaqtdan keyin port 
ishlatiladi va uning raqamini tushirib qoldirish mumkin. • 

• llyn nOHCKa, Kataloglar va ostki kataloglar zanjiri, faylning 
joyJashgan o'rnini belgilaydi. Bu zanjirning elementlari «/» simvoli 
bilan ajratiladi. 

• (J)aHJI. Faylning nomi uning kengaytmasi bilan birga yoziladi 
(faqat kengaytma so'ralgan platformada). Agarda faylning nomi tushirib 
qoldirilgan bo'lsa, u holda Web-brauzer ko'rsatiladigan faylni qidiradi. 
Brauzer reaksiyasi va uning keyingi harakatlari faylning nomini 
kengaytirishga bog'Jiq bo'ladi. Masalan, grafik fayllari GIF yoki JPG . 
ko'rish dasturiga tasvirlarning yuklanishini boshlab beradi. Arxiv 
fay liar (ZIP, RAR va boshqalar) bilan uyg'unlashgan kengaytmalar -
mijoz kompyuterida faylning saqlanishini bosh lab beradi. 

• (J)parMeRT. URL adresining fakultativ qismi. U # tpanjara) 
maxsus simvoli bilan boshlanadi. Bu belgi gipermatnli hujjatning 
lavhasini ajratib kO'rsatuvchi maxsus belgidir. Tarkibga qo'shib qO'yish 
simvoli nomining kiritilishi butun sahifaga emas, balki uning ma' lum 
bir qismiga murojaat qilish imkonini beradi. 

http bayonnomasi bo'yicha bog'lanish Internet tarmog'ida eng ko'p 
tarqalgan usul. Internetdagi obyektlarning manzillari, aloqaning boshqa 
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uslublarini va bayonnomalarini o'z ichiga olishi mumkin. Ulardan bir 
nechtasini sanab o'tamiz. 

2.1-jadval 

Bayonnoma Vozish 
Qo'lIanish sohasi nomi qoidasi 

FTP ftp:// Fayllarni uzatish bayonnomasi. FTR-serveri bilan 
bog'lanish uchun qo'lIaniladi 

File file: // Kompyuter yoki lokal tarmoqda berilgan fayl-
larga bog'lanish bayonnomasi 

Gopher gopher:!/ Gopher serveriga bog'lanish bayonnomasi 

JavaScript javascript: JavaScript tilida yozilgan dasturni chaqirish 

Mailto mailto: Elektron pochta manzili 

Newt news: Telekonferensiyalarga bog·lanish bayonnomasi 

Telnet telnet: kompyuterga bog' lanish bayonnomasi 
--

Internetning bugungi ommaviyligini tushuntiruvchi sabablardan 
biri HTTP bayonnomasi imkoniyatlarining kengligidir. O·zidan avvalgi 
avlodlarining ba'zi bayonnomalarini u butunlay yutib yuboradi. 
Ba·zilarini esa shunchaki siqib chiqaradi va ko'rgazmali grafik inter­
feys yordamida qo'llab-quvvatlash yo'li bilan yaxshiroq imkoniyat 
yaratadi. 

Lokal uzel yaratish. Uzel kartasi 

Dreamweaver dasturida saytlar va sahifalar yaratishning har 
xii yo'llari bor. Bulardan saytlarni yaratish bO'yicha eng mashhur 
texnologiyani ko'rib chiqamiz. Buning uchun quyidagi ketma-ketlikni 
bajaramiz: 

• saytning lokal versiyasini yaratish; 
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• lobi "ersiyani IJIlemet tarmog"iga ~.Iash.. 
lobi uzel - bu foydalanuvchi yolU foydaJaouvchilaming ~.u­

terida joylashgan haqjqiy , ·irtual W~uzelning versiyasidir. Lokal uzel 
tarmoqdan ko·rinmaydi. unga faqat mualliftarjg~ rogalana oIishlari 
mumkin. 

lokal uzelning ma"lumotlari diskdagi belgiJanpo katalog icbida 
saqlanadi. Bu katalog vazifasini diskdagi bar 'landa)' katalog t.jarisbi 
mumkin. Yangi &obl uzel hosil qilisb ucbuo quyidagi ketm.a-ketliklami 
bajaring: 

1. Site > New Site (CaiiT > CO:l.J81'1o) buyrug"ini bering.. Ekranda 
2.16-rasmda ko"rsatilgan Site oetmition (Onpe;xe..leHHe caiiTa) muloqot 
oynasi hosil bo"ladi. 

2. ~naning chap qismidan local info (H~~ 0 .10Ka..1W1O!W 

p.le) bo"limini tanlang. Ma)'donning qiymatini kiriting. 
3. Remote lnfo (CBe.leHHS 06 pa.leKHOM cepsepe) kategoriyaMga 

sayt saqlana)otgan ~n'er baqidagi ma'lumodarni kiriting. 
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4. Muloqot oynasmmg yuqorida sanalgan maydonlar to'ldirilishi 
shart. Site Map Layout (nJ1aHHpOBKa KapTbI Y3.'1a), Design Notes 
(KoMMeHTapHH pa3pa60T'mKa) va File View Columns (KOHOHKH OTO-
6pa)l(eHJHI !jlaHJ10BbIX aTpH6YTOB) maydonlari to'ldirilishi shart emas 
(foydalanuvchi o'z xohishiga qarab to'ldirishi mumkin). 

5. Barcha kerakli ma'lumotlar kiritilgach OK tugmasini sichqoncha 
yordarnida bosing yoki ENTER tugmasini bosing. 

Uzel kartasi 

Vzel kartasi - lokal uzel yaratishning qulay interfaol vositasi 
hisoblanib, unda ko'plab texnik qiyinchiliklarga ega bO'lgan topshiriqlar 
grafikli ko'rinishda yengillik bilan amalga oshiriladi. Bu rejimda 
saytning kartasi tasvirlanadi. Uzel dispetcheri oynasi ikki qismga 
bo·lingan. Chap tomonda uzelning kartasi kiritiladi (Kartada - sahifa 
belgilari HTML fayllarni ifodalaydi). Hujjatlar orasidagi gipermatnli 
bog'lanishlarni strelkalar ifodalaydi. 

O'ng tomonda esa uzelning fayllar va kataloglar ro'yxati beriladi. 
Kartaning ko'rinishi organizatsion diagrammani eslatib yuboradi. Kartada 
ikki darajani ko'rish mumkin. Yuqori darajani uzelning asosiy sahifasi 
egalla,di. QlIyi darajada esa unga-tegishli va o'zaro giperbog'lanishga ega 
sahifalar tushuniladi. Uzelning gipermatnli hujjatlaridagi bog'lanishlar 
ko'k rangda tasvirlanadi. Agar bog'Ianishda kO'rsatiIgan fayl kengaytmasi 
.HTM, .HTML va boshqa shu formatdagiJardan farq qilsa u holda yashil 
rangda tasvirlanadi. Agar bog'lanishda qo'pol xatoliklar bo'lsa, 1I holda 
bog'lanish qizil rangda ifodalanadi. Tashqi fay liar, boshqa fayllarda 
joylashgan fay liar va maxsus bog'lanishlar (masalan, mailto: yoki 
javascript:) globus ko'rinishidagi maxsus belgi oladi. Bulardan tashqari 
agar ko'k rangli belgi qo'yiJgan bo'lsa - bu fayl foydalanuvchining o'zi 
tomonidan taqiqlanganini bildiradi. Qulf belgisi ostidagi belgi faqat 
o'qish uchun mo'ljallangan fayllarni bildiradi. 

Savol vu topshiriqlar: 

I. Loka! uze! nima? 
2. Lokal uze! hosil qilish ketma-ketligini aytib bering? 
3. Uzel kartasi nima? 
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2.5. Hujjatlarga bavolalar o'roatisb va olib tasblasb 

Tegishli hujjatga havola o'rnatish unchalik murakkab em as. Bun­
da foydalanuvchini chalkashtiradigan eng asosiy muammo - bu ope­
ratsiyani bajarish usul va uslublarining ko'pligidir. Qachonki biror 
hujjatga yoki sahifaga havola o'rnatmoqchi bo'lsangiz. buning uchun 
quyidagi uch holatdan birini belgilash kerak. Ular bir-biridan faylning 
holati va yuklanish texnikasi bilan farq qiladi. 

• Havola uchun kO' rsatilgan hujjat uzelning hisobidagi obyekt 
sanaladi. Ya'ni faylning nomi fayllar va papkalar ro'yxatidan iborat 
uzelning kartasi va panelida ifodalanadi. Bunday faylga havola o'rnatish 
uchun asosiy hujjatni tanlash, sichqoncha yordamida marker ko'rsat­
kich bog'lab olib, uni tegishli hujjatga olib o'tish lozim. Marker­
ko'rsatkich - bu havola o'rnatish uchun maxsus interfaol vosita hi­
soblanadi. Markerni uzel dispetcherining har qanday paneliga (kartaga 
yoki fay liar ro'yxatiga) surib kelish mumkin. 

• Butun hujjat saytning tarkibiga kiradi, ammo uning ro'y­
xatidan o'tmagan. Ya'ni uning nomi O'11g paneldagi fayllar rO'Ykatida 
mavjud, ammo u uzel kartasida yo'q. Bunday holatlarda marker ko'r­
satkichni o'ng panel ustiga surish va uni fayl nomi ustiga tashlash 
kerak. 

• Butun hujjat saytga kirmagan. Bunday holatda marker-ko'rsat­
kichini surishni teskari yo'nalishini qo'llash kerak. 

Havolani o'zgartirisb 

Havolalarni o'zgartirish uchun eski bog'lanishga tegishli ko'rsat­
kichlarni o'chirib tashlab. yangi faylga tegishli ko'rsatkichlarni kiritish 
mumkin. Ammo Dreamweaverda buni o·zgartirish uchun maxsus 
vositalar mavjud: 

I. Uzel kartasidan hujjat belgisini tanlang; 
2. Lizel dispetcheri oynasidan Site > Change Link (Caih > 113-

MeHHTb CCblllKY) buyrug'ini bering. Xuddi shu buyruqni - CTRL-L 
tugmalar kombinatsiyasi yordamida ham berish mumkin; 

3. Select HTML Files (Bbl6op rHnepTeKCTOBblX <t>aHJlOB) muloqot 
oynasi ochiladi. Unda yangi faylning nomi va joylashgan katalogini 
ko'rsatish kerak: 
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tNnge AI LR.s To: 

..:J 
IntoLR.. To: 

..:J 

2 F-rasm. Bog'lanishni yangilash. 

OK I 
tancell 
Help 

4. Fayl tanlangandan keyin. Dreamwea,,·er dasturi C"pdate Files 
(06ROB.leHHe 1j»aA.'1OB) muloqot oynasi ocbiladi. Bareha o'zgarishlarni 
qo'shish uchun Update (06H08HTb) tugmasini bosing. 

Agar bir nechta huijatlar bilan bitta hujjat o'rtasida bog'Ianish 
o'rnatmoqchi bo'lsangiz buning uehun ma..xsus buyruq mavjud. Bu 
buyruq yordamida barcha obyektlardagi havolalarni global tarzda 
o'zgartirish mumkin. 'U bareha gipermatnli havolalardagi kO'rsatilgan 
faylni nomini o'zgartirib ehiqad~._ 

I. \'zel dispetcheri oynasini oching; 
2. O"zgartirilishi kerak bo'lgan huijatni oling: 
3. Site > Change link Sitewide (Cam> H3MeHHTb eBJl3H no BCe\l} 

caJhy) buyrug'ini bering. Shu nomdagi muloqot oynasi oehiladi (2.18-

rasm). 

. ~ , 

thange AI Lib To: 

~ 

lrto LR.s To: 

...:..J 

2. J8-rasm Ha,·oIani global o· zganirish.. 

QK I 
~I 

Help I 
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1. Tanlangan faylning nomi Change All Links To (H3MeHHTb Bce 
CCbI.'1KH Ha) maydonida ifodalanadi. Yangi faylning nomini Into Links 
To (Ha CCbWKH Ha) maydoniga kiritish yoki standart protseduralar 
yordamida tan lash mumkin. 

2. OK tugmasini (KHonKa) basing yoki ENTER (KJlaBHllla) tug­
masini bosing. 

3. Update Files (06HOBJleHHe cpaHnoB) muloqot oynasi ochiladi, 
bunda bog'lanishga ega va ayni vaqtda yangilanishni talab etadigan, 
fay liar nomi aks etadi. Fay lIarn i tanlang va ularga tegishli havolani 
o'rnating. 

Change Link Sitewide (H3MeHHTb CBH3H no BceMY canTY) buyrug'i 
ham havolalarni ommaviy almashtirish uchun juda qulay. Masalan, 
bunday almashtirishlarni ko'pincha saytning barcha sahifalaridagi 
elektron pochta adresini almashtirish uchun qo'lIash mumkin. 

1. Change All Links To (H3MeHHTb Bce CCblJlKH Ha) maydoniga 
o'zgartirilishi kerak bo'lgan havolani to'liq kiriting. 

2. Into Links To (Ha CCblJlKH) rnaydoniga to'liq yangi h\volani 
kiriting. 

3. OK tugmasini bosing. 

Havolani olib tashlash 

Havolani olib tashlashni bir nechta usullari mavjud. Masalan, 
havolaga tegishli, ya'ni manba hisoblangan hujjat faylini ochish va 
uni oddiy yo'l bilan o'chirib tashlash mum kin. Bu usul balki noqulay 
tuyulishi mumkin, ammo maksimal aniqlikda bo'ladi. Uzel dispetcheri 
orqali amalga oshiriladigan bog'lanishni olib tashlash usulini kO'rib 
chiqamiz: 

1. Uzel dispetcheri oynasini aching; 
2. Uzel kartasidan bog'lanishni kO'rsatuvchi hujjat belgisini oling; 
3. Site> Remove Link (CanT> Y.aaJlHTb CCbI,lKY) buyrug'ini bering. 

Bu buyruqning klaviaturada ikkita ekvivalenti bor: CTRL +SHIFT +L 
tugmalar kombinatsiyasi yordamida ham berish mumkin. 

Sarlavhani o'zgartirish 

Dreamweaver dasturi HTML hujjatining sarlavhasini uzel dis­
petcheri oynasida almashtirish (o'zgartirish) imkonini beradi. Shuni esa 
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tutish kerakki gipermatnli hujjatning sarlavhasini <title> deskriptori 
belgilaydi. Bu matn qatori hujjatning nomi hisoblanadi va qidiruv 
tizimlarida hujjatni indeksatsiyalashda muhim rol o'ynaydi. Eng 
mashhur Internet Explorer va Netscape Navigator brauzerlar sarlavhani 
dastur oynasining, sarlavha qatoriga chiqarib beradi. 

Sarlavhani o'zgartirish uchun quyidagilarni amalga oshirish kerak: 
1. Uzel dispetcherini oching (AL T +F8). 
2. View> Show Page Titles (BH.LJ. > I1oKa3aTh 3aronOBKH cTpa­

HHI..\) buyrug'ini bering. Bu buyruqni CTRL +SHIFTr T tugmalar 
kombinatsiyasi yordamida ham berish mumkin. Natijada uzel kartasida 
gipermatnli fayllar nomi o'rnida ularning sarlavhasi beriladi. 

3. Hujjatni tanlang va File > Rename (<baHn > IlepeHMeHoBaTb) 
buyrug'ini bering yoki klaviaturadan F2 tugmasini bosing. 

4. Yangi sarlavhani kiriting va ENTER tugmasini bosing. 

Savol va lopshir;qlar: 

I. Giperhavola nima: 
2. Gipermatn nim21? 
3. Ixtiyoriy hujjatga havola o'rnatish tartibini aytib bering? 
4~ Havolani o'zgartirish ketm;;-ketligini aytib bering? 

2.6. Dasturning HTML hilan ishlash imkoniyatlari 

Dreamweaver dasturining foydalanuvchilari gipermatnli hujjatlar­
ning ko'plab tahrirlash operatsiyalarini to'g'ridan-to'g'ri HTML 
deskriptorlari yordamida bajarishi mumkin. HTML tili haqida 
biz yuqorida batafsil ma'lumot oldik. Bu tilning elementlarini 
deskriptorlar yoki teglar deb nom lash qabul qilingan. Ingliz tilidan 
tag (yorliq, belgi va boshqa ma'nolarni beradi). Deskriptorlarni 
saqlash uchun ASCII belgilari qo'lIaniladi. Shuning lIchun har 
qanday gipermatnli hujjatni belgilashni har qanday oddi) maln 
muharrirIarida bajarish mumkin. Buning lIchun xatto DJ10K­

HOT dasturi ham yetarIi. HTML tilining kodlari hujjatning matnli 

massivlari qismi nisoblanadi. 
Endi deskriptorlar bilan tanishib chiqamiz. Deskriptorlar ikki xiI 

bo·ladi. Yakka va juft deskriptorlar. Juft deskriptorlar ayrim xollarda 
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konteynerlar deyiladi. Hujjatga tegishli matnlar va uning belgili 
kodlarini ajratish uchun, HTML tili kodlari burchakli qavslarda 
yoziladi. Masalan, <br> yoki <p>. Juft deskriptorlar (konteynerlar) 
o'z ichiga deskriptorlar juftliginL ochiladigan (boshlang'ich) va 
yopiladigan (oxirgi) deskriptorlarni oladi. Bu juftliklar <tag> </tag> 
ko"rinishida yozilib, o'z qiymatini juftlik orasidagi hujjat fragmentiga 
o'tkazadi. Boshqacha aytganda konteyner juftliklari orasiga hujjat 
fragmenti yoziladi. Deskriptorlar ana shu fragment uchun ishlaydi 
xolos. Yakka deskriptorlarda yopiladigan teg bo'lmaydi. Masalan, 
<hr> deskriptori gorizontal chiziq hosil qiladi, <br> - esa matnli 
qatorni ifodaJaydi, eng muhim yakka deskriptorlardan biri <img> 
maxsus kodi hisobalanadi. U rasmlarni qo'yiladigan holatini va 
joylashuvini belgilaydi. 

Endi Dreamweaver dasturida shablon asosida yangi hujjat hosil 
qilamiz. Yangi hujjatning bo'sh (to'ldirilmagan) bo'lishi hammamizga 
ma"lum. Quyida bunday sahifaning Dreamweaver dasturidagi 
gipermatnli belgilari keltirilgan: 

<html> • 
<head> 
<title>Untitled Document</title> 
<meta http-equiv-»Content-Type» content-»text/html; charset = iso-

8859-1»> 
</head> 
<body bgcolor= «#FFFFFF»> 
</body> </html> 

Bundagi deskriptorlarning vazifalari bilan HTMLda tanishib 
chiqdik. Undan tashqari <meta> deskriptorining charset atributi 
internetda tanlangan simvollarni namoyishini ta'minlovchi kodirovkani 
ifodalaydi. Odatda yangi shablondagi (iso-8859-1) kodli to'plam kiril 
simvollarini ifodalay olmaydi. 

Deskriptorlarni kiritish qoidalari 

Belgilash kodlarini to'g'ridan-to'g'ri kiritish bujjatning faqat max­
sus rejimida am alga oshiriladi. Bu rejimga o'tishning bir nechta 
imkoniyatlari bor. Ulardan ayrimlarini ko'rib chiqamiz: 
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• Window> Code Inspector buyrug'ini bering. Xuddi shu buyruqni 
FIO tugmachasini bosish yordamida ham berish mumkin; 

• Uskunalar panelining chap qismida joylashgan Code View (Pe­
)l(HM pa3MeTKH) tugmasini bosib kodlarni tasv irlash rejimiga o'tish 
mumkin: 

• Uskunalar panelidagi chapdan ikkinchi Code and Design View 
(Pe)f(H!\1 pa3MeTKH H nJlaHHpoBKH) tugmani bosish bilan huijat oynasini 
ikki qismga bo'lish mumkin. 

Kodlar nazoratchisida joriy huijatning kodlari tasvirlanadi. Bel­
gilashda qo' llaniladigan ko'pchilik deskriptorlar alohida rangda 
tasvirlanadi . Deskriptorlarning ranglari dasturning asosiy ko'rsat­
kichlariga kiradi. Ranglarni foydalanuvchining xohishiga qarab 
o'zgartirish mumkin. Agar foydalanuvchi hujjat ustida biror tahrirlash 
ishlarini oIib bormoqchi bo'lsa u holda F5 tugmasini bosish yoki View 
> Design View (BHJl. > 06HOOHTb) buyrug"ini berish kerak. Bu buyruq 
hujjatning kodlarni beIgilash rejimidan tahrirlash rejimiga o'tkazadi. 
Tahrirlash rejimidagi obyektlarni qo'yish, formatlash buyruqlari va 
har qanday o'zgarishlar darhol kodlar inspektoriga ko'chadi. Agar 
tahrirlash . rejimida biror obyekt yoki fragmentni belgilasangiz, 
kodlarni belgilash rejimida ham shu obyekt yoki fragmentga tegishli 
kodl~r belgilanadi. Bu esa dasturda ikki yoqlama ishlash imkoniyatini 
ta'minlab beradi. 

Kodlardan nusxa olish 

Dreamweaverda boshqa HTML tahrirlagichlari bilan gipermatnli 
belgilashdagi kodlarni almashish imkoniyati mavjud. Buning uchun 
Windows ope rats ion tizimining ko'pchilik dasturlarida mavjud bo'l­
gan, belgilangan fragrnentdan nusxa olish va qo'yishning stand art 
buyruqlaridan foydalaniladi. Aytaylik HomeSite dasturida ochilgan 
gipermatnli hujjatning belgilash kodlaridan nusxa olishimiz kerak: 

Nusxa olish uchun Edit > Copy (llpasKa > KomfpooaTb) yoki 
CTRL+C tugmalar kombinatsiyasidan foydalanamiz; 

Buferga olingan nusxani qo'yish uchun Edit > Paste (llpaoKa > 
BCTaoHTb) yoki CTRL +V tugmalar kombinatsiyasidan foydalanamiz. 

Matn muharrirlarida tanlangan fragmentni sichqon yordamida sur ish 
yo"li bilan ko'paytirish imkoniyati mavjud. Bu imkoniyat Dreamweaver 
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dasturida ham ishlaydi. Buning uchun CTRL tugmasini bosgan holda 
belgilangan fragmentni sichqon ko'rsatkichi bilan kerakli joyga surib 
ko'paytirish mumkin. 

Savol va topshiriqlar: 

\. HTML so'zining lug'aviy ma'nosi qanday? 
2. Deskriptorlar nima? 
3. Deskriptorlarning qanday ko'rinishlari mavjud? 
4. Deskriptorlarni kiritishni tushuntirib bering? 

2.7. Hujjatning o'lchamlarini belgilash 

Dasturda yaratilgan har qanday yangi h ujj at bo'm-bo'sh oq 
rangdagi fonli sahifadan iborat bo'ladi. Hujjatda ish boshlashdan oldin 
uning bir qancha muhim parametrlarini kiritib olish kerak. Bular ish 
maydonining o'lchami, fon rangi, hujjat sarlavhasi, havola ranglaridir. 
Bu parametrlarni ish jarayonining ixtiyoriy vaqtida ham o'zgartirish 
mum kin. Sanalgan barcha parametrlarni-yagona Page Properties (tBoH­
CTBa CTpaHHLJ.bI) muloqot oynasi yordamida kiritiladi (2.19-rasm). Bu 
muloqot oynasini bir necha yo'lIar bilan ochish mumkin: 

• Dastur menyu qatoridan Modify> Page Properties (H3MeHHTb > 
CBoHcTBa cTpamu.\bI) buyrug'ini berish bilan; 

• CTRL+J tugmalar kombinatsiyasini bosish bilan; 
• Kontekstli menyudan Page Properties (H3MeHHTb > CBOHCTBa 

CTpaHHLJ.bI) buyrug'ini berish bilan. 
Endi Page Properties (CBOHCTBa CrpaHHLJ.bI) muloqot oynasining 

boshqaruv elementIari bilan tanishib chiqamiz: 
• Title (3arOJIOBoK). Sahifaning sarlavhasini kiritish uchun xizmat 

qiladi. 
• Background Image (<l>OHOBbIH PHCYHOK). Hujjatga fon sifatida 

qo'yiladigan rasm ko'rsatiladi. 
• Background (~OHOBbIH LJ.BeT). Sahifaning fon rangini tan lash 

imkoniyatini beradi. 
• Text (TeKcr). Shriftning rangini tan lash imkoniyatini beradi. 
• Links (CCbIJIKH). Bu bO'limda giperhavolalar rangi va grafikli 

havolalar ramkasi rangi belgilanadi. 
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• 

Iitle: I I [ OK I 
Back"ound Image: Ilj", //lCI/S""k l lFON .JPG 

BackgOU'ld ~] I 
a rowse... ~ I 

Cancel I 
Tp!; ::Jf 

\,WIk.: ~:J P'"I -­

Left Me/gin: I 
T 012 Margin: I 

,rlSiled Lds' ~ I1 ~I . _~ 

Aclr.e Ln.: .=] , 
Margin~dh: ,.., ---

MarCli!Heqt:1 

~ocument Encodng: I C~.~II~c r",/indows·1251 ) :::1 BeIoad 

T r~ Image: I BrQWSe. . 

Image Transparency J 100% 
, , , • • • t t • , 

T ransparert Opaque 

Document Folder: C:\W1NDOWS\Par»Ht cron\ 

S~e Folder: C:\\¥INDOW'S\Pa60'H4 cron\ 

2./9-rasm . Page Properties muloqot oynasi. 

'j 

Help 

• Visited Links (npOCMoTpeHHble CCbIJIKH). Brauzerda ko'rilgan 
havolalar rangini tan lash. 

• Active Links (AKTHBHble CCbIJIKH). Faol havola rangini belgilash. 
• Left Margin (neBoe nO.'le). Sahifaning chap tomonidan qol­

diriladigan maydonni pikselda belgilaydi. 
• Top Margin (BepxHee no, le). Sahifaning yuqori qismidan qol­

diriladigan maydonni pikselda belgilaydi. 
• Margin Width (lllHpHHa noneii). Sahifa maydoni enini bel­

gilaydi. 
• Margin Height (BblcoTa no,leH). Sahifa maydoni bO'yini bel­

gilaydi. 
• Document Encoding (KO)lHpOBKa JlOKYMeHTa). Kiril simvol­

laridan iborat sahifalar tuzish uchun juda muhim kO'rsatkich. Chunki 
uning yordamida qanday simvollarni brauzer dasturlarida tasvirlab 
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berish ko'rsatiladi. Rus alifbosini faqat quyidagi to'rtta kodirovka 
tasvirlab bera oladi xolos ISO-8859-5, MacCyrillic. KOI8-R va 

W indows-1251. 
• Reload (OoBTopHaR 3arpY3Ka). Tugmasi yordamida hujjatning 

grafik tahrirlash ishlari bilan bog'liq oxirgi saqlangan ko'rinishni tiklash 

imkonini beradi. 
• Tracing Image (Tpa<l>apeTHoe H306pa)l{eHHe). Sahifaning dizayni 

bilan ishlashda namuna sifatida ishlatiladigan tasvirlarni ifodalaydi. Bu 
tasvirlar sahifani ko'rish rejimida kO'rinmaydi. 

• Image Transparency (Op03pa'lHOCTb H306pa)l{eHHR). Iz qoldirish 
uchun tanlab olingan rasmning shaffoflik darajasi belgilanadi. 

• Document Folder (OanKa ,UoKYMeHTa). Hujjatning qaysi katalogda 
joylashganini ko'rsatib turadi. 

• Site Folder (KopHeBaR f1aflKa pna). Tegishli Web-uzelning o'zak 

katalogiga to'liq yo'l ko'rsatadi. 
Yuqoridagi ko'rsatkichlar tanlangandan so'ng, barcha o'zgarishlarni 

saqlab. ularni ko'rish uchun File > Prev.i~w in Browser (ct»aH.1 > Qpo­
CMOTP B 6pay3epe) buyrug'i beriladi. 

Gorizontal va vertikal chizg'ich 

Gorizontal va vertical chizgich hujjat bilan ishlashda 0' Ichash va 
eta Ion vazifalarini bajaradi. Chizg'ichga qarab obyektlarning o'lchamini 
boshqa obyektlarga nisbatan joylashuvini ko'rish mumkin. Boshqaruvda 
chizg'ichlar maxsus buyruq yordamida o'rnatiladi. Buning uchun View 
> Rulers (BH,U > flHHeHKH) buyrug'ini berish kerak. Bu menyuning 
punktlarini sanab o'tamiz. 

• Show (OoKa3aTb) buyrug'i chizg'ichni o'rnatib beradi. Bu 
buyruqni - CTRL+ALT+R tugmalar kombinatsiyasi yordamida ham 
bajarish mumkin. Buyruqni takror berish chizg'ichni ekrandan olib 
tashlaydi. 

• Pixels (OHKce.'lbl), Inches ()])OHMbl), Centimeter.s (CaHTHMeTpbl) 
- buyruqlari o'lcham birligini tan lash imkonini beradi. 

• Reset Origin (BoccTaHoBHTb Ha'laJIO Koop,UHHaT). Koordinatalar 
boshini sahifaning ixtiyoriy nuqtasi bilan bog'lash mumkin. Buning 
uchun chiziqlar kesishuvida joylashgan krest shaklidagi markerni 
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Savol va lopshiriqlar: 

I. Hujjat o'lchamlarini belgilash uchun qaysi buyruqdan foydalaniladi? 
Bu buyruqning mos kombinatsion tugmalarini ayting? 

2. Page Properties muloqot oynasi qismlari vazifalarini aytib bering? 
3. Chizg'ich va uning vazifalari nimalardan iborat? 
4. Montaj to'ri nima va uning vazifalari nimalardan iborat? 

2.8. Dreamweaverning ro'yxatlar bilan ishlash imkoniyatlari 

Ro'yxatlarni nomerlash deb - bo'lim yoki qismlar ketma-ketligini 
tartibga soluvchi va ularning har biri navbatdagi yangi son bilan 
tartiblanishini tushunish mumkin. HTML tilida ro'yxatlarni hosil 
qilish bilan biz yuqorida batafsil tanishib chiqdik. Bundan tashqari 
tartiblangan ro'yxatlar asosida murakkab iyerarxik rO'yxatni tuzish 
mumkin. Bunda murakkab ro'yxatning qismlari bo'lib quyi (oddiy) 
rO'yxatlar olinadi. 

Nomerlangan rO'yxatlar quyidagi yo'l bilan hosil qilinadi. 
I. Hujjatning bir nechta tizimli bo'lag1ni oling. Bunday bo'lakllrga 

abzatslar, har qanday standart sarlavhalar yoki bo~hqa rO'yxatlarning 
bo'limlarini kiritish mumkin. 

2. Dreamweaver 
3. Homesite 
4. Hotmetal Pro 
Text> List> Ordered List (TeKcT > CnHcoK > HYMepoBaHHhIH cm1-

COK) buyrug'ini bering. Bu buyruqni CTRL+F3 tugmalar kombinatsiyasi 
yordamida ham berish mumkin. 

Belgili ro'yutlarni yaratish 

Belgili ro'yxatlar deb - ma'lurn belgi ostida ketrna-ket bo'limlarni 
san ash tushuniladi. Bunday rO'yxatlarni HTMLda hosil qilish bilan biz 
yuqorida tanishib chiqdik. 

Brauzerlarning oxirgi versiyalarida rO'yxatlarni belgilash uchun 
type atributi bor. Bu atributni quyidagi qiyrnatlarini qo'Hash murn­
kin: circle (aylana), disk (disk), square (kvadrat). Ya'ni ro'yxatning 
har bir bO'limi shu belgilar bilan belgilanadi. Bundan tashqari kichik 
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~..=J Font List: 

[oonel New. [oUllel. mono 
GeOlQld. Times New Roman. Times. selif 
Veuiana. AII~I . HelvellcCl. SCll'ls'Sef~ 
Times Uzb Roman 
GenevCl. Allal. Helvellca. sa.,s·sel~ 
Add lonl S In 1,,1 below 

Chosen FonIs: 

o 
AV8llabie Fonts: 

AIICIf 
AlialBlad 
AII"IN,,"ow 
Ali~ Unicode MS 
Balang 

m 

~..:J [ Or. · 1 
A GoceQ 

y 

A 

.., 

CH~l 

2.2/-rasm. Shriftiar to'plamini tahrirlash muloqol oynasi. 

I. Text> Font> Edit Font List (TeKcT > WPI1<pT > Pen,aKTl1pOBaTb 
Cnl1COK WpHq>TOB) buyrug'ini bering. Bu buyruqni CTRL +F3 tu~alar 
kombinatsiyasini bosish bilan ham bajarish mumkin. Buyruqni berish 
natijasida Edit Font List muloqot oynasi hosil bo'ladi. 

2. Bu oyna yordamida foydalanuvchi o'ziga kerakli shriftlar ro'y­
xatini qaytadan tuzib olishi mumkin. 

3. Ishni tugallashdan oldin muloqot oynasida OK tugmasi bosiladi. 
• Muloqot oynasining tugma va maydonlari bilan tanishib chi­

qamiz: 
• Font List (CnHcoK WPH<pTOB). Muloqot oynasining bu bo'limida 

ayni vaqtdagi ro'yxatga tcgishli shriftlar berilgan. Endi qo'shiladigan 
shriftlar esa ro'yxatning eng oxiriga joylashadi. 

• Chosen Font (Bbl6paHHble wPI1<pTbI). Tanlangan shriftlar nomi. 
• Available Fonts (HaJIH'-IHble rnpl1<pTbI). Ushbu hisoblash tizimida 

o'rnatilgan shriftlar rO'yxati. Bu shriftlardan birortasini tanlangan 
shriftlar to'plamiga qO'shish uchun, oynadagi chapni ko'rsatish YO'nalish 
tugmasini bosish kerak. 

• TO'plamdagi tanlangan shriftni o'chirish uchun «-» belgili 
tugmani, to'plamga yangi shrift qo'shish uchun «+» belgili tugmani 
bosish kerak. 

112 



• Yuqoriga va pastga qaragan strelkalar esa tanlangan shriftni 
ro'yxatdagi holatini o'zgartirish, ya'ni yuqoriga va pastga yurish im­
konini beradi. 

Matn o'lchamini belgilash 

HTMLda matn o'1chamini qanday belgilash bilan tanishib chi­
qamiz. Buning uchun <font> deskriptorida size atributi qo'lIaniladi. 
Masalan, <font size = «4»> O'1chamni belgilashning absolyut tizimi </ 
font>. Bundan tashqari <body> deskriptori yordamida ham <base font 
size = «qiymaf»> shriftni belgilash mumkin. Bunda sizening qiy­
matiga birdan to yettigacha bo'lgan har qanday qiymatni qO'yish 
mumkin. 

Kattalashadigan o'1chamlarda esa size atributi qiymati oldiga + 
(kattalashtirish) yoki - (kichiklashtirish) belgisi qo'yiladi. Nisbiy ti­
zimda shriftni o'1chamini o'zgartirishga misol keItiramiz: 

<font size = «+I»>Nisbiy tizimda o'1cham</font> 
Shrift o'lchamini quyidagi yo'l bilan o'zgartirish mum kin: 
I. Matnni belgilang yoki kiritiladigan joyga kursorni qo'ying. 
2. Absolyut o'lchamni belgilash uchun Text> Size (TeKcT > PaJ­

Mep) euyrug'ini bering yoki nisoiy tizimida o'lchamni berish uchun Text 
> Size Change (TeKcT > HJMeHHTb paJMep) buyrug'ini bering. Ikkala 
buyruqni ham Property Inspector (HHcneKTop CBOHCTB) palitrasidan 
berish mumkin. Palitraning Size (PaJMep) ro'yxatida shrift o'1chamini 
o'zgartirishning barcha imkoniyatlari ko'rsatilgan. 

3. Absolyut yoki o'sish o'1chamini tanlang. 

Matnlarga rang berish 

Agar matnga biror rang berilmagan bO'lsa, u holda Windows 
operatsion tizimidagi yoki brauzerda tanlangan rang tasvirlanadi. 
Ko'pincha bu rang qora rang bo'ladi. Butun massivning simvollariga 
rang hujjatning asosiy kO'rsatkichlarida belgilanadi. KO'pincha hujjat 
yaratib olingach. bu kabi ko'rsatkichlar kiritilib olinadi. Buning uchun 
yuqorida ko'rganimizdek Modify > Page Properties (H3MeHHTb > 
CBOHCTBa CTpaHHQbl) buyrug'ini berish kerak (CTRL+J). Har qanday 
simvollar to'plamiga alohida rang berish mumkin. Ranglarni saqlash 
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uchun <font> desknptorida color atributi ishlatiladl. Masalan, yashjl­
ko'k rangini belgilovchi kod quyidagicha yoziladi: 

<font color=((#66FFFF»>bu moviy rangning kodi</font> 
Shuni esda tutish kerakki HTML tilida rang o'n oltilik sanoq tizimi 

kodlari yordamida belgilanadi. Palitraning ayrim elementlari o'zining 
nomiga ega. masalan green (ko·k). red (qiziJ) va boshqalar. 

Dasturda ranglarni tanlashni Property Inspector (HHcneKTop 
CSOHCTS) palitrasidan foydalanib ham uskunaviy yo'l bilan belgilash 
mumkin. Bu jarayon xuddi boshqa matn muharrirlarida bajarilgandek 
boradi. 

Matnli maydonlar 

Matn maydoni - sahifaning asosiy qismi hisoblanadi. Chunki har 
qanday Web-sahifaning asosiy belgilovchi qismi matnlar hisoblanadi. 

Matnli maydonlar uch xii ko'rinishda bo'ladi (2.22-rasm): 
• Single line (O.1HOCTpO'lHoe). Qisqa xabar yoki javoblarni kiritish 

uchun xizmat qiladi. • 
• Multi line (MHorOCTpOl.lHoe). Ixtiyoriy uzunlikdagi xabarni 

kiritish uchun mo'ljaUangan. 
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• Password (DapOJlb). Parolni kiritish uchun mo'ljallangan. 
Matnning uchala ko'rinishi ham bitta buyruq yordamida qo'yiladi. 

Ularni tiplarga ajratish esa Property Inspector (HHCneKTOp CBOHCTB) 
palitrasi yordamida am alga oshiriladi. Buning uchun shu nomlardagi 
uchta qayta ulagich xizmat qiladi. 

Single line matn maydoni 

Bitta qatordan tarkib topgan oddiy matn maydoni. U <input> 
deskriptori yordamida belgilanadi. Quyidagi misolda shunday obyektni 
ifodalovchi belgili kod qatori keltirilgan: 

<input type = «text» name = «maydon_nomi»> 

bu yerda type atributi maydonning tipini bildiradi, name atributi esa 
obyektning nomini bildiradi. 

Oddiy matn maydoni bilan bog'liq ko'rsatkichlar bilan tanishib 
chiqamiz: 

• Text Field (TeKcToBoe no.le). Palitraning bu bo'limi matn may­
donining nomini belgilaydi. Bu yerda maxslls belgilardan foydalanish, 
bir nomni takrorlash va maydonni bo'sh qoldirish ham mllmkin emas. 

• Char Width (WHpHHa B CHMBOJlax). Matn maydonining enini 
simvdlllar soni bO'yicha belgilash. Odatda bll o'lcham 20 ta simvolni 
tashkil qiladi . 

• Max Chars (MaKCHMaJlbHblH oObeM). Matn maydoniga kiriti­
ladigan simvollarning maksimal soni. 

• Tnit Val (HaQaJlbHOe 3HaQeHHe). Bu maydonga qarab ko'rish 
dasturi sahifani birinchi yuklashdan keyin olib chiqadigan matn 
qatorini kiritish mumkin. 

Password matn maydoni 

Kiritilgan simvollarning oynada aks etmasligini ta"minlash maq­
sadga mU\'ofiq bo'lgan holatlar ham mavjud. Ko'pincha bunday zarurat 
maxfiy axborotlarni, masalan, parollar yoki kalit so'zlarni kiritishda 
yuzaga keladi. 

Password (DapOJlb) matn maydoniga kiritilgan ma'lumot faqat 
yulduzchalar ko'rinishida tasvirlanadi. Matn maydoni bunday xususiyati 
bilan boshqa tipdagi matn maydonlaridan keskin farq qilib turadi. 
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Multi Line matn maydoni 

Katta hajmdagi matnli ma'lumotlarni kiritish uchun Multi Line 
(MHorocTpo'fHoe) tipidagi maydonlar ishlati lad i. Bunday tipdagi 
obyektlarni yaratish uchun, sahifaga matn maydoni qo'yish kerak, 
masalan Insert> Form Objects> Text Field (BCTaBKa > 06beKTbl cI>OPM 
> TeKcToBoe nOHe) bllyrug'i yordamida. Xossalar paneli ochish va bu 
palitradan Multi Line (MHorocTpo'fHoe) qayta ulagichni oling. Natijada, 
bir qatorli matn maydoni ko'p qatorli matn maydoniga aylanadi. Uning 
uzunligi 18 simvoldan, balandligi esa 3 qatordan iborat. 

Bu tipdagi obyektlar ishlash uchun yana Property Inspector (I1H­
cneKTop CBOHCTB) palitrasiga murojat qilamiz: 

• Text Field (TeKcToBoe nO:Ie) - kO'pqatorli maydonning nomi. 
• Char Width (lllHpHHa B CHMBO.'1ax) - matn maydonining simvol­

larda belgilanadigan kengligi. 
• Num Lines (1.JHCJ10 CTpOK) - matn maydonining qatorlar soni. 
• Int Val (Ha'laJIbHOe 3Ha'feHHe) - maydonining boshlang'ich qiy-

mati. • 
• Wrap (I1epeHoc no C;10BOM) - ko'p qatorli matnmaydonida 

matnni yangi qatorga ko'chirish imkoniyatlarini belgilaydi. 

Savol va topshiriqlar: 

I. Matnlarni formatlash jarayonida shriftni belgilash uchun qaysi 
deskriptordan foydalaniladi? 

2. ShriftIar rO'yxatini tahrirlash ketma-keligini aytib bering? 
3. Matn o"lchamini belgilash uchun qaysi deskriptordan foydaJaniladi? 
4. Matnlarga rang berish ketma-ketligini aytib bering? 

2.10. Grafikli formatdagi fayllar bilan ishlash 

Grafik tasvirlar ishtirokisiz tuziladigan hujjatlar juda kamchilikni 
tashkil qiladi. Ayniqsa Web - sahifalarini rasmlar, logmiplarsiz tasavvur 
ham qilib bo'lmaydi. Bu kabi grafikli ma'lumotlarning turlari juda ham 
ko'p. U1arni faqat formati bo'yicha ajratish mumkin. Masalan, birgina 
rasm degan ma'lumot ostida har xiI formatdagi fay liar yotadi. Faylning 
formati deganda ma'llImotni yozish va saqlash uchun belgilangan 
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standart qoidalar to'plami tushuniladi. Hozirda o'nlab grafikli formatlar 
mavjudki, ular turli tizimlarda har xii maqsadda qo'llaniladi. Grafikli 
formatlar uchta sinfga bo'linadi. Bular: rastrli, vektorli, metafaylli. Bu 
formatlar haqida keyingi boblarda batafsil ma'lumot berilgan. 

Dasturning rasmlarni qo'yish imkoniyatlari 

Rasm lar Web-sahifalarga jilo beruvchi vositalar hisoblanadi. 
Rasmlarni qo'yish - bu oddiy texnik operatsiya hisoblanadi. Dasturda 
rasmlarni qo'yishning bir nechta yo'llari bor. Avval rasmni qo'yish 
buyruqlaridan birini tanlaymiz: 

• Objects (06beKTbl) palitrasini oching, Common (06Ul\1e) bo'li­
miga o'ting, palitraning yuqori - chap qismida joylashgan Insert Image 
(BcTaBKa H306pa)KeHHJI) tugmasini bosing. 

• Insert> Image (BCTaBKa > I-ho6pa)l{eHHe) buyrug'ini bering. 
• CTRL+ALT+I tugmalar kombinatsiyasidan foydalaning. 
• Tasvirni Assets (<l>oHllbI) palitrasidan hujjat oynasining kerakli 

qismiga ko'chiring. 
• Saytning dispetcheri oynasidan rasmning belgisini olib hujjatning 

oynasiga tashlang. 
• .Rasmni ish stolidan hujjat-oynasining kerakli joyiga tashlang. 
HTML tilida esa bu vazifalarni <img> deskriptori bajaradi. Bu 

deskriptor rasmning barcha ko'rsatkichlarini belgilaydigan bir nechta 
atributlarni o'z ichiga oladi. Quyidagi misolda deskriptor o'ziga to·q­

qizta atributni bog'lagan: 
<img src = «Temp/animl.gif» width=«170» height=«180» alt= 

=«Tushuncha» border=«l» name=«ins» align=«right» vspace=«SO» 

hspace = «60»> 
Shuningdek qo'yilgan rasmga ramka ham qo'yish mum kin: 
<img src = « lOjpg» border =« 1 »> 
Bu misolda border atributi ramkaning qalinligini bildiradi. 

Rasmni ron sifatida qo'yish 

Biz yuqorida gipermatnli hujjatning parametrlarida fonga rang 
tan lash, fonga rasm qo'yish bilan tanishib chiqdik. Endi rasmlarni fon 
sifatida qo'yish bilan batafsil tanishib chiqamiz: 
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1. Modify > Page Properties (113MeHHTb > CBoikTB8 cTpaHHubl) 
buyrug'ini bering. 

2. Background Image (<l>OHOBbIH PHCYHOK) maydonida rasm faylini 
ko'rsating. 

Xuddi shu vazifani HTML tilida <body> deskriptori yordamida 
bajariladi. Masalan. <body background = «image.jpg»> bunda rasm huj­
jat saqJangan katalogda joyJashgan. 

<body background = «www.images.com/source/back.gif»> fragmenti 
esa internetning ko'rsatilgan manzilidagi rasmni fon sifatida qO'yib 
beradi. 

Interfaol rasmlar 

Hozirgi kunga kelib rasmlar va animatsiyalarsiz sahifalarni 
uchratish juda qiyin. Aksariyat Web-sahifalar animatsiyalar. animatsion 
tugmalar yoki harakatlanish tugmalari. rasmlar, interfaol rasmlar bilan 
boyitilgan. 

Interfaol rasmlar sO'zi «roIlover image» iborasidan olingan bo'lib 
sO'zma-so'z tarjimada «tasvirni ko'clHrib o'tkazish» ma'nosinP bil­
diradi. Agar Web-sahifada biror rasm ustiga sichqon kO'rsatkichini 
olib borganingizda boshqa rasm paydo bo'lsa bilingki u rasm 
interfaol rasmdir. Interfaol rasmlarni qo'yish quyidagi yo"1 bilan 
bajariladi: 

l. Matn kursorini rasm qO'yiladigan joyga qo'ying. 
2. Insert> Interactive Image> RoIlover Image (BcTaBKa > D:HHa­

MHlJ.eCKHe H306pa)f(eHHa > I1HTepaKTHBHoe H306pa)f(eHHe) buyrug'ini 
bering. 2.23-rasmda kO'rsatilgan muloqot oynasi hosil bo'ladi. 

3. Bu muloqot oynasining tegishli maydonlarini to'ldiring: 
o Image Name (I1Ma H300pa)l{eHHa) maydonda rasmning nomi 

ko'rsatiladi. 
o Original Image (l1cxo.a.Hoe H306pa)l{eHHe). Joriy holatda ko'­

rinadigan rasmning nomi ko'rsatiladi. 
o Rollover Image (I1HTepaKTHBHoe H300pa)f(eHHe): Sichqon ko'rsat­

kichi kelishi bilan almashinadigan rasmni nomini ifodalaydi. 
o Preload Rollover Image (npe.nBapHTellbHaa 3arpY3Ka) - bu 

bayroqcha rasmni ko'rish dasturlarida yuklash rejimini ishga tu­
shiradi. 
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Image Name: __ 

Orighallmage: Browse ... I 
• 

RoIover Image: Browse .1 
P Preload RoIoYer Image 

When Cicked. Go To URL: Browse . . 1 

2. 23-rasm. InteTfaol rasmni qo'yish oynasi . 

c When Clicked Go To t;RL (nepexo..1 no an.pecy) - bu yerda 
gipermatnli o'tish buyrug'i saqlanadi. 

4. Tegishli kO' rsatkichlar kiritilgandan so'ng OK tugmachasini 
bosing yoki klaviaturadan ENTER tugmasini bosing. 

Dreamweaver dasturi rasmlarning dinamik almashinuvini ko' rsat­
mayd~ Bu jarayonni faqat brauz.er dasturlarida kO'rish mumkin. Brauzer 
dasturlarini chaqirishning eng qisqa YO'Ji FI2 tugmasini bosishdir. 

Savol va topshiriqlar: 

I. Rastrli formatlar nima? 
2. Vektorli formatJar nima? 
3. ~etafayllar nima? 
4. Sahifaga rasm qo'yish ketma-ketligini aytib bering? 

2.11. JadvaUar qo'yisb va utar bilan isblasb 

Jadvallar - matnli va grafikli ma' lumotlarni saqlash uchun tanor 

forma hisoblanadi. Bundan tashqari sahifalarda rasmlarni birlashtirish 
uchun, matn ostip rasm qo"yish uchun ham jadval kataklaridan 
foydalanish mumkin. Qatordagi ikkita yonma-yon joyJashgan katak­
chalardan kolonka sifatida foydalansa bo·ladi. Bir katakli jadvaldan 
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tortib to murakkab jadvalgacha - bularning barchasi qator, ustun, 
katakchalarning oddiy kombinatsiyasidan tuzilgan. 

HTML tilida jadvalga tegishli barcha amallar yoki ma'lumotlar 
<table> <Itable> deskriptorlar juftligi orqali ifodalanadi. Bu deskrip­
torning kO'plab atributlari mavjud. Bu atributlar yordamida jadvalning 
eni. foni rangi. chegarasi. tekislash, maydon, kataklar orasidagi masofa 
va boshqa ko'rsatkichlarni belgilash mumkin. Biz yuqorida HTMLda 
jadvallarni qO'yishning barcha imkoniyatlari bilan tanishib chiqdik. 
Endi esa Dreamweaverda jadval qo'yish bilan tanishib chiqamiz. 

Jadval qo'yish 

ladval qo'yish - bu uncha qiyin bo' lmagan texnik jarayondir. 
Dreamweaverda jadval qo'yish uchun quyidagi ketma-ketlik bajariladi: 

I. Jadval quyilishi kerak bO'lgan joyga kursorni qo'ying. 
2. Insert > Table (BcTaBKa > Ta61IHua) buyrug'ini bering. Bu 

buyruqni bajarishning alternativ variantlari ham bor: 
o CTRL+ALT+T tugmalar kombinatsiyasi; 
o Object (06beKTbI) palitrasidagi Common (06wHe) bo'li~ning 

Insert Table (BCTaBHTb Ta6mfUY) tugmasini bosish bilan; 
3. Insert Table (BcTaBKa Ta6J1HUbI) muloqot oynasi maydonlarini 

to'ldiring (2.24-rasm). Bu oynaning boshqaruv elementlarini ko'rib 
chiqamiz: 

Rows: _ CenPadding: r- OK I 
Cancel I 

Columns: rr-- CeA Spacing: r-
Help I 

Width: ps-- I Percent 3 
BOlder: ,,---

2. 24-rasm. Insert Table muloqOI oynasi. 
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o Rows (CTpOKH). Jadvalning qatorlari soni. 
o Colurns (CTOJ16ubl). Jadvalning ustunlari soni. 
o Width (lllHpHHa). Jadvalning eni. 
o Border (PaMKa). Har bir katakchaning va butun jadvalning 

chegara ramkalari eni. PikselIarda beriladi. 
o Cell Padding (IloJIJI Jl1.feHKH). Katakcha chegarasi va ichidagi 

ma'lumot orasidagi maydon kattaligi. 
o Cell Spacing (PacCTOJlHHe Me)l(,A)' JI'IeHKBMH). Kataklar orasidagi 

masofa. 
4. OK tugmasini bosing. 
Ixtiyoriy kO'rsatkichli jadval qo'yilgandan keyin, uni to'ldirish 

vaqtida yoki undan keyin ham o'zgartirish mumkin. 

Jadvalli ma'lumotlarni import qilish 

Dreamweaver dasturida tashqi matnli fayllarni o'qish va undagi 
jadvallarni o'girib olish uchun maxsus buyruqlar mavjud. Jadvalli 
ma'lumotlarni import qilish quyidagicha amalga oshiriladi: 

1. File> Import> Import Tabular Data (cI>aHJI > I1MnopT > I1MnopT 
Ta6,lH1.fHhIX .!laHHhlx) buyrug'ini bering. 

~. Import Table Data (I1MnopT Ta6JlH1.fHbIX ,lIaHHblx) muloqot oynasi 
hosil bo'ladi (2.26-rasm). Bu muloqot oynasining asosiy boshqaruv 
elementlari bilan tanishib chiqamiz: 

o Data File (cI>aHJI ,lIaHHblx). Bu maydonga jadvalli ma'lumot 
joylashgan faylni qidirish uchun to'liq yo'l ko'rsatiladi. 

o Delimiter (Pa3,l1eJIHTeJIb). Bu rO'yxatda matnli fayldagi jadvalni 
bo'luvchisi kiritiladi. RO'yxat O'Z ichiga quyidagi bandlarni oladi: Tab 
(CHMBOJI Ta6YJuUHH), Comma (3amlTu), Semicolon (To'lK3 c 3anJl­
TOH), Colon (.llBoeTO'lHe), Other (.llpyroH). 

o Fit to Data (Ilo116HpaeTcJI no ,lIaHHbIM). Agar bu qayta ulagich 
o'rnatilgan bo'lsa, jadval kengiligi har bir ustunda eng uzun qator 
o'lchami bO'yicha tan lab olinadi. 

o Set (PaBHa). Agar bu qayta ulagich o'rnatilgan bo'lsa, u holda 
jadvalning enini oldindan belgilash mumkin bo'ladi. 

o Cell Padding (IloJU JI'IeHKH). Katakcha tashkil etuvchilari va 
chegarasi orasidagi masofani belgiJaydi. 
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2.25-rasm. Property Inspector palitrasi. 

1"'1"--. 

Date File: !Wel / /Cl/Book/Chapter 2i l Wm [BWW$e .. ! 

Deliniler. ~ .:J 

T able Width: .. Fit to Data 

r Set: I ~cent::J 

FOImat Top Row: CeU Paddi"og I 

CeI Spacing I Bordel: r 

2.26-rasm. Jad,·all i ma·lumotlarni import qilish. 

Q.u 
.... 

x 

~ I 
Cancel I 
H~ I ' 

I 

• 

o Cell Spacing (PacCTOJlHHe Me)K,lly JlqeHKaMH). Jadvalning yonma­
yon turgan kataklari orasidagi masofani belgilaydi. 

o Format Top Row (cl>opMaTHpoBaHHe BepxHeH CTpOKH). Jad­
valning birinchi qatorini formatlash uchun to'rua variantni taklif qi­
ladi. 

o Border (PaMKa). Bu yerda jadvalning chegaraviy ramkasining 
qalinligi belgilanadi. Agar ramka zarur bo'lmasa u holda bu maydonda 
nol ko·rsatish kerak. 

3. OK tugmasini bosing. 
Agar muloqot oynasida kO'rsatilganjadval tashkil qiluvchilari matnli 

fayldagi jadval tashkil qiluvchilariga to"g'ri kelmasa, u holda jadvalni 
import qilish noto'g'ri bajariladi. Aniqroq aytganda jadval buzilgan 
holda ko'chadi. 
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Savol va tOPJhiriqlar: 

I. ladvallar bilan ishlashda qaysi deskriptorlardan foydalaniladi? 
2. Jadval qO'yish ketma-ketligini aytib bering? 
3. ladvalli ma'lumotlarni import qilish qanday amalga oshiriladi? 
4. ladvalga qatpr yoki ustun qO'shish va ularni o'chirish qanday amalga 

oshiriladi? 

2.12. Sabifalarni brauzerlarda ko'risb 

Dreamweaver HT~L - sahifalarni vizual tahrirlash dasturlari sin­
figa kiradi. Dreamweaver dasturi HTML sahifalarni maxsus dasturlar 
yordamida tabiiy tasvirlarga yaqin ko'rinishda kO'rsata oladi. Bunday 
dasturlar brauzer dasturlari deb yuritiladi. Biz bu dasturlar haqida 
yuqorida batafsil ma'lumot bergan edik. Brauzerlarda ko'rish ketma­
ketligi bilan tanishib chiqamiz: 

I . Sahifani brauzerda kO'rish uchun File > Preview in Browser 
(<1>aH.1 > npOCMOTP B 6pay3epe) buyrug'ini bering; 

2. Ochilgan oynadan brauzerni tanlang; 
Bu buyruq hu.ijat oynasida ham, uzel dispetcheri oynasida ham 

mavjud. Asosiy brauzerni yuklash uchun Fl2 tugmasi xizmat qiladi . 
Aso~' va yordamchi brauzerlarni tan lash quyidagicha: 

1. File> Preview in Browser> Edit Browsers List (<1>a11,' > npo­
CMOTP B opay3epe > lohMeHuTb CIlHCOK 6pay3epoB) yoki Edit > 
Preferences (HpaBKa > HacTpolli<u) buyrug'ini bering. Qaysi buyruqni 
berishdan qat'iy nazar, ekranda Preferences (HacTpoHKU) muloqot oynasi 
hosil bo' ladi: 

2. Bu muloqot oynasida barcha tegishli kO'rsatkichlarni kiriting va 
ularni o'rnatilishi uchun OK tugmasini bosing. 

• - belgisi ostidagi tugma, hisobga olingan ko'rish dasturlari 
ro'yxatiga yangi brauzerni qO'shadi; 

• - belgisi ostidagi tugma tanlangan brauzerni rO'yxatdan o'chi­
radi ; 

• Edit (H3MeHuTb) tugmasi rO'yxatga olingan brauzer parametrlarini 
o'zgartirishga imkon beradi; 

• Primary Browser (nepBH'fHbIH 6pay3ep) bayroqchasi rO'yxatda 
tanlangan dasturni birinchi darajali brauzerga aylantiradi (birinchi 
darajali brauzerni chaqirish uchun Fl2 tugmasini bosish kerak): 
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• Secondary Browser (BTOPHqHbIH 6pay3ep) bayroqchasi ikkin­
chi darajali brauzerni tanlaydi. Bu vazifa CTRL+FI2 tugmalar 
kombinatsiyasi yordamida bajariladi: 

• Preview Using Local Server (ITpoCMoTP HeJlOKaJlbHOM cepBe­
pe) bayroqcha yordamida lokal server yordamida sahifalarni ko'rish 
rejimini o'rnatish yoki olib tashlash mumkin. Barcha serverga tegishli 
dasturiy ta'minot lokal kompyuterga oldindan o'rnatilgan bo'Jishi lozim. 

Dasturning bunday imkoniyatlari web-sahifani tayyorlash ja­
rayonining o'zida ko'rish uchun qulaylik yaratib beradi. Bunda 
foydalanuvchi nafaqat bitta, balki bir nechta brauzerdan bittasini tan lash 
imkoniyatiga ega bo'ladi. Brauzerlar sahifani bir xii kO'rsatsada, ammo 
ulardan foydalanish, boshqarish va interfeys har xiI bo'ladi. Shuning 
uchun ham foydalanuvchi o'zi xohlagan brauzerni tanlash imkoniyatiga 
ega bo'ladi. 

124 

Sallo/ IIa lopshiriq/ar: 

I. Sahifani brauzer dasturida ko'rish uchun qanday buyruq beriladi? 
2. Asosiy va yordamchi brauzerlarni·tanlash ketma-ketligini ay tit be­

ring? 
3. Preferences (HaCTpoAKH) muloqot oynasi tuzilishini tushuntirib 

bering? 



Ill-bob. KOMPYUTER GRAFIKASI VA DIZAYN 

3.1. Kompyuter grafikasi va dizayn 

Bizga ma'lumki web dizaynning ajralmas qismi bu kompyuter 
grafikasi hisoblanadi. Boshqacha aytganda kompyuter grafikasi 
yordamida saytlarni dizayni mukamallashtiriladi. Saytlarni be­
zash uchun turli xiI illustratsiyalar (rasmlar. grafiklar, roliklar, 
animatsiyalar. bannerlar va boshqalar) yaratishda va tayyor grafik 
formatdagi ma'lumotlarni o'zgartirishda kompyuter grafikasidan 
keng foydalaniladi. Kompyuter grafikasi va uning tarkibiy qismi 
bO'lgan grafik va turli tasvirlar axborot texnologiyasida muhim o'rinni 
egallaydi. Pedagogika oUy ta'lim muassasalarida ta'Um olayotgan 
talabtrlarga kompyuter grafika va dizayn fanlarini o'rganisl" 
IIlarga grafik axborot texnolog(valari haqidagi bilimlarni beradi va 
professional faoliyatida IIlardan samarali fo)'da/anishga tayyorlaydi. 
Boshqacha aytganda har qanday bo'lajak o'qitllvchi, kelajakda 
o'zining fani bo'yicha elektron o'quv resurslar;ni yarata olish; 
kerak. Bu bilan esa ta'Um samaradorlig;ga erishiladi. O'qituvchi 
dasturlash texnologiyasidan yaxshi xabardor bo'lishi lozim. Ammo 
11 yaratgan resurslari talabalarni o'ziga tortadigan dizayn bi/an 
boyitilmagan bo'lsa, u holda har qanday dasturiy mahsulotning 
o'qitish jarayonidagi samaradorligi past bo'ladi. Shuning uchun 
ham dasturlash bilan birga kompyuter grafikasini ham mukammal 
o'rganish talab qilinadi. 

Kompyuter grafikasi va dizayn fanidagi materallarni o'rganish 

natijasida quyidagilarni bajara olish mumkin: 
- rasmlar bilan ishlash: 
- ko'p bO'g'inli statik rasmlar bilan ishlash: 
- grafik muharrirlar imkoniyatlaridan foyda\anish: 
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- turli maqsadlardagi grafikli paketlarni qo"lIagan holda rang­

barang grafik obyektlarni yaratish; 
- nashrga tasvirlarni tayyorlash. 
Kompyuter grafikasi fani asosan elektron rasm va tasvirlar bilan 

ishlashni o'rgatadi. Hozirgi kunda grafik dasturlar soni juda ko'p 
bo'lib ular ishlash prinsipiga ko'ra har xiI grafikada ishlashi mumkin. 
Masalan: Rastrli grafika bilan ishlovchi dasturlar Paint, Adobe 
Pbotosbop. CorelPhotoPaint va boshqalar (grafik muharrirlarning 

umumiy ro'yxati 3.l-jadval). 

3.1-Jadval 

Grafik mubarrirlar ro'yxati 

Ng Grafik muharrir Izoh 

I. Adobe Photos hop Rastrli grafikani qayta ishJash uchun 
mo' Ijallangan 

2. TwistedBrush Pro Studio Tasvirlarni chizish va tahrirlashga 
' . . 

15.74 mo"ljalIangan grafik muharrir 

3. CorelDraw Graphics Suite X4 Vektorli grafika bilan ishlashga mo'l-
jalIangan grafik muharrir 

4. CorelDraw Graphics Suite X4 3D-modellashtirish, animatsiya va vi-
zualizatsiya uchun mo'ljalIangan 

5. Adobe Flash CS3 Professional Professional animatsiyali FIash-fayl-
larni yaratish uchun mo' ljalIangan 
dastur. 

6. Paint.NET Grafik muharrir (standart Paint das-
turini o'rnini bosuvchi) 

7. AutoCAD 2010 Eng murakkab loyihalarni chizishga 
mo'ljalIangan dastur 

8. Adobe II1ustrator CS3 Har qanday murakkablikdagi vektorli 
tasvirlarni yaratishga mo'ljalIangan 

9. Adobe Creative Suite 5 Loyihalarni chizish va qayta ishlashga 
Master Collection mo' ljallangan dastur 

_I 
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10. ZBrush 3.0 Ikki va uch o'lchamli loyihalashga 
mo'ljallangan grafik muharrir 

11. The GIMP Rastrli grafik muharrir 

12. Adobe InDeiign CS3 Har qanday dizayndagi chop etiladigan 
va Internet nashrlarini loyihalashga 
mo'ljallangan professional dastur 

13. Xara Xtreme Pro rastrli va vektorli grafikani qo'lIagan 
holda professional web-grafikani 
yaratish uchun mo'ljallangan grafik 
muharrir 

14. Adobe Fireworks CS3 Web-saytlar uchun grafikani tayyor-
lashga va mo'ljallangan grafik mu-
harrir 

15. Corel Painter 11 IlIyustratsiyalar chizish va tan·or-
lashga mo'ljallangan dastur 

Rastrli grafik muharrirlarida har bir tasvir nuqta ya'ni piksel asosida 
qurilldi. Bu dasturlar yordamida yaratilgan fay liar *.bmp, *.jpg, *.psd, 
*.tif va boshqa formatlarda saqlanishi mumkin. Bu turdagi fayllar 
ranglari yorqinligining juda sifatliligi bilan ajralib turadi, ularning 
kamchiligi sifatida esa tasvirni kattalashtirish bilan uning sifati yo'qolib 
borishini va xotiradan ko'p joy egal\ashligini aytib o'tish lozim. Shuning 
uchun ko'pincha ulardan tayyor rasmlarni qayta ishlashda foydalanish 
tavsiya qilinadi. 

3.2. Axborot va uni taqdim etisbning turli ko'rinisblari 

Hozirgi kunda inson faoliyatining turli sohalari ichida o'zining 
muhimligi bilan ajralib turuvchi soha - bu tashkiliy, ya'ni ish lab 
chiqarish va xo'jalik hamda ijtimoiy jarayonlarni boshqaruv sohasidir. 
Busiz barcha sohalarda faoliyat yuritib bo'lmaydi. Boshqaruv axboroti 
jarayon hisoblanib,"tizimlar holatini qanday o'zgarishiga qarab qo'yilgan 
maqsadga erishish uchun yetakchi yo'nalishdir. Har qanday tizim to'g'ri 
va teskari aloqa tamoyilidan iborat. 
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Ma'lumki, insonlar bir-biriga axborotlarni uzatish jarayonida matn, 
jadval, tovush va tasvir ko'rinishdagi signallardan foydalanadi. 

Axborotlarni uzatish turli xiI usullarda, ya'ni xabarchi yordamida, 
pochta orqali, transport vositalari yordamida, aloqa tarmog'idan uzoq 
masofaga uzatish yordamida amalga oshiriladi. Aloqa tarmog'i bO'yicha 
uzoq masofaga uzatish usulida ma'lumotlarni uzatish vaqtini sezilarli 
darajada kamaytiradi. Buning uchun maxsus texnika vositalari mavjud. 
Axborotlarni yig'ish va hisobga olishni texnik vositalari ish joyida 
o'rnatilgan datchiklar yordamida axborotlarni avtomatik ravishda 
yig'adi, hamda kompyuterga uzatadi. 

Matn ko'rinishda berilgan axborotlarni qayta ishlash teuologiyalari 

Ma'lumki, eng ko'p tarqalgan kompyuter texnologiyalari quyi-
dagilardan iborat: 

- matnli ma'lumotlarni tahrir qilish: 
- jadval va grafik ko'rinishdagi ma'lumotlarga ishlov berish. 
Matnlar bilan ishlash uchun matn. muharrirlaridan foydaJanjladi. 

Hozirgi paytda ko'plab matn muharrirlari ishlab chiqilgan. Umuman 
ularning vazifasi bitta am mo, beradigan imkoniyatlari va ularni 
amalga oshirish vositalari turlicha. Bu grafik muharrirlari va elektron 
jadvallarga ham tegishlidir. 

Formatlash vositasining yordamidan foydalanib hu.ijatni tashqi 
ko'rinishini yaratish, stilini o'zgartirish, tagiga chizish, kursiv harflarini 
ajratish, simvollar o'lchamlarini o'zgartirish, satr boshini ajratishi, 
ularni o'ng, chap tomonlari va markazga nisbatan tekislash va ramka 
(hoshiya) ichiga olish mumkin. 

Jadval ko'rinishda berilgan u:borotlarni qayta ishlash texnologiyalari 

ladval ko'rinishidagi hujjatlar har qanday korxonada hu.ijat 
aylanishining katta qismini tashkil qiladi. Elektron jadval kompyuter 
xotirasida joylashgan ikki o'lchamli massivning satrlari va ustunlarini 
o'zida ifodalaydi. 

ladval muharrirlari ko'plab moliyaviy va ma'muriy masalalarni 
yechish imkonini beradi. Masalan, oylik maoshni hisoblash va boshqa 
hisobga olish masalalari: sotuv hajmini, bozor o'sishini, daromadlarni 
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tahlil qi&isb.; foiz stavkalari va soliqlarini tahlil qilish; moliyaviy 
deklaratsiyalar va balans jadvalarini tayyorlash; sot ish hajmini va 
strukturasini hisobga olish uchun bisobchi daftarini yuritisb; smeta 
kalkulyatsiyasi; pul cheklarini hisobga olish; budjetga va statistikaga 
oid hisoblashlar. 

Tasrir ko·ri.is ..... baiIp_ uborodarai qay1a ilia ... ~ri 

Ixtiyoriy maID yoki hujjatda grafikJar, diagrammalar. chizmalar. 
rasmlar. yorliqlarini kiritish ~oji grafik muharrirlarini yandisb 
zarur~lini hosil qiladi. Grait lIlIlbarrirlar quroI vosilaIardan iborat 

• ba·lib. War o'zip mos axborot texoologiyalardan foydaJanib grafik 
obrazlarini yararish~ .. o'zgartirish imkoo.iyadarini beradi 

Axborot texoologiyalarida grafik mubarrirlar quyidagi tm"lardan 
~'dalanadi: 

- tijorti grafibst 
- tas\-'iriy grafib; 
- ilm~' grafib. 
r ...... crMbsjei~ 

usnmIi gistopamma.ar, CIl.lZlGJ 
,,. q o'lcbamli !fdk l:o·.ri:nli. 
ma"1umodar bazalarida \"a .J.loh.i6 
n.~i etraap ahlantiradi 

- ~'Ianma diagrammalar. 
bo5hqa tipdagi ill.i 

iIIUbarrirtarid 
~.~~ 

~ cnAb--' 1rX~-.si turli m mamIi bujj;Idar uchu.n 
J"e21I.h.... ,.. --....... !itr1.IknIn kD"rin;.tedari iMld wychining 

- - £-..~ ... ~ .-

rasmlan (piksd gni.bsi) ~-iriai ~ ___ ~..a.riai bcrad:i 
~-.sini amaIp osIUnM::Iti .... iD lac 
. qaIib'iri \"a ~ paIiIra cp'-mas:i, maIDD..i yozish 
)..-.:.ilpa ~ ~ a.III5II uchua W5ila 

~~ taJitwpi. ~ miIIIai o·cIIirtita.. qirqisb \'3 

. bir~" beer .. S1IrisIU it lie.A.mo, ranirtarwi 
\'a aIIni ;c. ... a- njimicA ko'"rim 

_ (CordI>rIM:. ~~ lDSnKiiBMAX \'a 

~ iBir=ze.ir=!Jdl. 'C'ID.~"" __ 
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,1\.. 1- q IIostIqa b-w..i o"Z idHp ... di ~. 
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Kompyuter grafikasi qo'llaniladigan asosiy sohalarni kO'rsatib 
o'tamiz: 

I) Grafiklarni chizish; 
2) Kartografik-geografik, tabiiy yoki iqtisodiy hodisalarni o' zaro 

chegaradosh mamlakatlar, viloyatlar, o'lkalar va shu kabilarni aniq 
tasviri; 

3) Chizma va konstruktorlik ishlarini avtomatlashtirish: 
4) Modellashtirish va multiplikatsiya: 
5) Turli texnologik jarayonlarni boshqarish - real dunyo massh­

tabid a interfaol rejimda ishlash. Texnologik jarayonni eng kerakli 
nuqtalariga o'rnatilgan dastlabki axborot manbai bo' lgan datchiklardan 
kelayotgan axborotlar qiymatini vizual idrok qilish; 

6) Nashr ishlarini avtomatlashtirish va chop etishni elektron usuli . 
Reklama va san'at - qandaydir fikrni ifodalash va estetik yoqimli 
tasvirlar orqali jamoani diqqatini tort ish. 

Tasvir ko'rinishda berilgan axborotlarni qayfa ishlashning 
umumiy masalalari • 

Tasvir kO'rinishida berilgan axborotlarni kompyuterda qayta ish lash 
texnologiyasi xilma-xil bo'lib, juda ko'p amaliy masalalarni ha! qilishga 
tatbiq etiladi. Axborotlarni qayta ishlashning bu sohasini quy idagi uch 
yo'nalishga ajratiladi: 

t. Kompyuter grafikasi (COMPUTER GRAPHICS); 
2. Tasvirlarni qayta ish lash (IMAGE PROCESSING); 
3. Tasvirlarni tanib olish (COMPUTER VISION). 
Tasvir ko'rinishga ega bo' lmagan axborotlarni vizuallashtirish (ya'ni 

tasvirni yaratish) masalalari bilan kompyuter grafikasi (COMPUTER 
GRAPHICS) shug'ullanadi. 

VizualIashtirish tasvirlanishi zarur bo"lgan obyektning tasnifi 
(modeli) asosida bajariladi. Hozirgi paytda vizuallashtirish usullari va 
algoritmlari juda ko'p bo'lib, ular nimani va qanday qilib aks ettirish 
bilan bir-biridan farq qiladi. 

Vizuallashtirishga misollar (murakkablashib borish tartibida) sifatida 
quyidagilarni ko'rsatish mumkin : 

- funksiyalar grafigi: 
- diagrammalari; 
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- geografik xaritalar; 
- animatsiyalar. 
Shuni takidlab o'tish kerakki, grafiklar vaqtga nisbatan o'zgarmas 

(statik) bo'ladi. 
Tasvirlarni qayta ish lash (IMAGE PROCESSING) - bu tasvir­

larni almashtirish bilan bog'liq masalalar. Tasvirlarni qayta ishlash 
algoritmlari uchun boshlang'ich ma"lumotlar ham tasvirlar, natija ham 
tasvirlar husoblanadi. 

Grafik ma'lumotlarni tasvirlash 

1. Kompyuter grajikas; turlar; 
Kompyuter grafikasi tasvirlarni shakllantirish usullariga bog'liq 

holda 3 turga bo'linadi: 
I. Rastrli grajika: 
2. Vektorli grajika: 
3. Fraktal grafika. 
Dlar bir-birlaridan tasvir ko'rinishdagi axborotlarni hosil qilish va 

qayta ish lash texnologiyalari bilan farq qiladi . 
Rastrli grafika vositasida shakllangan tasvir asosan elektron va 

polilrafiya nashriyotlarida qo'Uaniladi. Rastrli tasvir ikki o'lchovli 
massiv (matritsa) ko'rinishdagi nuqtalar to'plamidan iborat bo'lib, ular 
piksellar deb ataladi. Rastrli tasvirning eng kichik elementi peksildan 
iborat (3.I-rasm). 0 

Dning atributlari boshqa piksellarning 
atributlari bilan bog'liq emas. Komp­
yuterda qo'lIaniladigan ope rats ion tizim­
larning imkonitiyaga ko'ra, 480x640, 
800x600, 1024x768 va undan ko'proq 
pikselga ega bo'lgan tasvirlar joylashishi 
mumkin. Tasvirning o'lchamiga ko'ra 
uning imkoniyati ham oshib boradi. 
Ekranning imkoniyati parametrik bo'lib, 
bir dyuymdagi nuqtalar soni bilan bel­
gilanadi. Rastrli grafik vositalari bilan 
bajariJgan (tayyorlangan) tasvirlar juda 

3.I-rasm. Rastrli grafikada 
piksellarning ko'rinishi. 
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kam hollardagina kompyuter dasturlaridan foydalanib ish lab chiqiladi. 
Bu maqsadda professional rassom chizgan rasm yoki fotografiya texnik 
vositalar yordamida kompyuterga kiritiladi. 

Oxirgi paytda rastrli tasvirlarni kompyuterga kiritish uchun 
raqamli foto va videokameralardan foydalanilmoqda. Shu sababli rastr 
grafikasini asosiy maqsadi tasvirni yaratish emas, balki mavjud tasvirni 
qayta ishlashdir. 

Rastrli grafikning ijobiy tomonlari sifatida quyidagilarni kO'rsatish 
mumkin: 

o universalligi (bu formada har qanday tasvirni taqdim etish 
mumkin); 

o shakllantirishning soddaligi; 
o rang jilolarini berish aniqligining yuqoriligi. 
Ushbu usulning salbiy tomonlari sifatida quyidagilarni kO'rsatish 

mumkin: 
o rastrli grafik bloklar hajmining juda kattaligi; 
o ularning masshtabi o·zgarganda tasvir sifatining pasayishi. 
Rastrli grafikada har bir tasvirni kodlash va saqlash uchun latta 

hajmdagi xotira talab etiladi. Tasvirdagi juda kichik obyektlarni ko'rish 
uchun uning masshtabini kattalashtirib bo'lmaydi. Bu rastrli tasvirlarni 
qayta ishlash jarayonida ba'zi bir muammolarni paydo bo'lishiga olib 
keladi. 

Rastrli tasvirlar quyidagi tiplarga bo'\inadi: binar, kulrang, palitrali, 
to'liq kulrang. Bunda tasvirning elementlari faqat ikki qiymatni (O-yoki 
I) qabul qilish mumkin. Bu tasvirlar turlicha paydo bo'lishi mumkin. 
Ammo ko'p hollarda kulrang, palitrali va turli rangli tasvirlarni 
o'zgarmas yoki adektiv chegaraviy son bilan binar tasvirga almashtirish 
natijasida paydo bo'ladi. Binar tasvirlarni saqlash uchun juda ham 
katta joy tal ab qilinadi. Ularning har bir elementi uchun 1 bit joy kerak 
bo'ladi. Kulrang tasvirning elementlari ma'lum bir rang intensivligining 
turli xii qiymatlarini qabul qiladi. Odatda bu tasvirlarning har bir 
elementini saqlash uchun 8 bit ishlatiladi. Kulrang ~svirlar turli xii 
amaliy masalalarni hat qilishda eng ko'p qo'llaniladigan tasvirlardan 
biri hisoblanadi. 

Palitrali tasvirlarning har bir elementiga ranglar xaritasining bir 
katakchasidagi rang mos qo·yiladi. Palitra - bu ikki o'lchovli massiv 
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bo'lib, uning qatorlariga turli ranglar, har bir ustunlariga esa ma'lum bir 
Tangning intensivligi joylashtiriladi. 

To'Jiq rangli tasvirlar elementlari rangni tashkil etuvchi yorqinliklari 
haqidagi axborotni o'zini saqlaydi. Shu bilan u palitrali tasvirlardan 
farq qiladi. Amaliy masalalar yechishda qaysi tipdagi tasvirni tanlash 
masalasining o'.ziga xos xususiyatlaridan bog' lab, tasvirdagi zarur 
axborotni qanchalik to' Jiq ifodalanishi bilan xarakterlanadi. 

Vektorli grafika vositasida shakllangan tasvir sodda grafik 
obyektlar to'plarnidan tuzilgan bo'lib, uning tipik elernentiga rnos 
keladi. Vektorli tasvirning asosiy elementi chiziq bo'lib hisoblanadi. 

Kornpyuter xotirasida bu chiziq juda katta joy egallarnaydi. 
chunki xotirada chiziqni faqat pararnetrlari ko'rsatiladi. Unda 
sodda obyektlar rnurakkab obyektlarga birlashtiriladi, shu sababli 
vektor grafikasini obyektga yO'naltirilgan grafika deb ham aytiladi . 
Kornpyuter xotirasida vektor grafikasi chiziqlar sifatida saqlanib 
turishiga qararnasdan, tasvir ekranga nuqtalar sifatida chiqariladi. 
Tasvirni ekranga chiqarishdan oldin har bir pararnetrni hisoblab 
chiqadi. Shu sababli vektor grafikasini hisoblanuvchi grafika deb 
aytiladi . Vektor g(afikasi yordarnida sodda turdagi bezash ishlarini 
olib borish mum kin. 

\'ektorli grafik tizirnning muhirn tavsifi bo'lib, uning sodda grafik 
elernentlarining tarkibi xizrnat qiladi. Sodda grafik elernentlariga bir 
nechta misol keltirarniz: 

- Koordinatasi ko'rsatilgan nuqtalar boshlanuvchi ma' lurn bir 
burchak ostida yo' nalgan va berilgan uzunlikka ega bo' lgan chiziq: 

- Markaziy koordinatalari ko'rsatilgan nuqtada joylashuvchi. yarirn 
o"qlarining uzunligi, chiziqning rang va qalinligi, harnda uni bO'yash 

rangi berilgan ellips: 
- Chap tornondagi yuqori burcbagiga joylashgan nuqtaning koor­

dinatalari, tornonlar uzunligi, chiziq qalinligi va rangi kO'rsatilgan 

to'g'ri to·rtburchak. 
Vektorli tasvirni kO'rsatayotganda sodda elementlarning chiziqli 

geometrik atributlari, uning boshlang'ich va zarur o'lchamlari 
o'rtasidagi rnunQsabatni, harnda chiqarish qurilrnalarida (monitorlar. 
chop etish qurilrnasi) ruxsat berilgan xatolikni hisobga olgan holda 
hisoblab chiqadi. Bunday usul rnasshtablashtirish irnkoniyatini sezilarli 
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darajada oshiradi. Tasvir o'\chamini qancha ko'paytirsa ham, uning 
sifati o·zgarmaydi. Tasvirning o'\Chamlarini juda kichiklashtirib 
yuborganda. sodda elemenlarning chiziqlari ustma-ust tushib qolishi va 
xatolarni ixchamlash hisobiga u o'zgarishi (buzilishi) mumkin. 

Fraktal grafika vositasida shakllangan tasvirlar ham xuddi vektorli 
grafika kabi matematik hisoblarga asoslangan. Ammo kompyuter 
xotirasida he ch qanday obyektni saqlamasligi bilan undan farq qiladi. 
Tasvir tenglama (yoki tenglamalar tizimi) bO'yicha quriladi. Shuning 
uchun formulalardan boshqa hech narsani saqlash kerak emas. 

«Fraktal» atamasi lotincha Fractus so'zidan olingan va u «qis­
mlardan tuzilgan» ma'nosini anglatadi. Frantsuz matematigi Benua 
Mandelbrot 1975-yilda «The fractal geometry of Nature» kitobini nashr 
qildi va fraktal so'zi eng ko'p tarqalgan atamalardan biriga aylandi. 

Eng sodda fraktal obyekt sifatida qor uchqunlarini yoki 
paporotnik bargini keltirish mumkin. Shuning uchun ham fraktal 
obyekt chizish yoki bezash asosida emas, balki programmalashtirish 
asosida hosil bo'ladi. Kompyuterda tashkil qilingan turli 
o'yinlarda ham fraktal grafikasidan foydalaniladi. Fraktal grafibsi 
kompyuter xotirasida saqlanib turmaydi. Har bir tasvir tenglama 
yoki tenglamalar sistemasi asosida quriladi . fraktal grafikadagi 
tenglamaning biror koeffitsiyentini o'zgartirish orqali butunlay 
boshqa tasvirni bosil qilish mumkin. 

Sanab o'tilgan kompyuter grafikasi turlarini tashkil qilish va ularni 
boshqarish uchun bir qator dasturiy vositalar ish lab chiqilgan. 

Rastrli tasvirlar va ularning asosiy xarakteristikalari 

Rastr - bu juda kichik yuzaga ega bo'lgan geometrik figuralar 
(piksellardan), masalan kvadratchalardan tuzilgan matritsa. Har bir 
piksel o'z rangiga ega bo'lishi mumkin. Turli ranglarga ega bo'lgan 
rastrlar to'plami tasv irni tashkil etadi. Tasvir kO'rsatilayotgan sirtda 
piksellarni joylashishiga nisbatan rastrlar turli tiplarga bo'linadi: 
kvadrat, to'rt burchak. doira va shu kabilar. Piksellar joylashishini 
tasvirlash uchun turli xii koordinata tizimlaridan foydalaniladi . Bu 
tizimlarni hammasi uchun umumiy bo'lgan xossa, ularda piksel 
koordinatalarining diskret qiymatlar qatoridan (butun son bo'lmasligi 
mumkin) tashkil topgandir. Ko'p hollarda butun sonlar koordinatasidan 
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foydalaniladi. Bunda piksellarning boshlang'ich koordinatasi chap 
tomondagi yuqori burchakdan boshlanadi. 

Rastning geomelrik xarakteristika/ari quyidagilardan iborat: 
o Ruxsat berilgan xatolik; 
o O'lcham; 
o Piksel shaklf. 
Rastrda ruxsal berilgan xatolik o'zaro qo'shni (yonma-yon) joy­

lashgan piksellar orasidagi masofa bilan xarakterlanadi. Ruxsat berilgan 
xatolik bir birlik uzunlikdagi pikselJar soni bilan o'lchanadi. Eng ko'p 
tarqalgan o'lchov birligi bo'lib, dpi (dots per inch) xizmat qiladi. lJ bir 
dyuyrn (25,4 mm) uzunlikdagi piksellar soni. 

Rastrning o'/cham; odatda gorizontal va vertikal o'qlar bo'yicha 
joylashgan piksellar soni bilan aniqlanadi. Shuni ta' kidlab aytish 
mumkinki, har ikki o'qlar uchun bir xii qadamli (ya'ni, dpiX =dpiY) 
rastr kompyuter grafikasi uchun juda qulay. Bu ayniqsa grafik 
obyektlarni chiqarish algoritmlari uchun qUlay. Aks holda muammo 
paydo bo'ladi. 

Rastr piksellarining shakli tasvirni chiqarish qurilmasining xu­
susiyatlari bilan aniqlanadi. Masalan. piksellar quyidagi shakllarda 

bO'lis~i mumkin: ' . 
I. Kvadrat (yoki to'g'ri to'rtburchak shaklidagi piksellar). Ular 

o'1chami bo'yicha rastr qadamiga teng (suyuq kristaHi displeyda); 
2. Doira shaklidagi piksellar. Ular o'lchami bO'yicha rastr qadamiga 

teng bo'lmasligi mum kin (printerlar). 
Rang/ar soni (rang chuqurligi) ham rastrning eng muhim xa­

rakteristikalaridan biri. Ranglar soni faqat rastrli tasvir uchun emas. 
Balki har qanday tasvir uchun ham muhim xarakteristika hisoblanadi. 

Savol vu lopshiriqlar: 

I. Kompyuter grafikasi nima? 
2. Qanday grafik muharrirlar bor? 
3. Grafikaning qanday turlari bor? 
4. Kompyuter grafikasi qanday turlari bor? 
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IV-bob. ADOBE PHOTOSHOP DASTURI 

4.1. Adobe Pbotoshop dasturi haqida 

Adobe Photoshop Windows muhitida ishlovchi elektron ko'ri­
nishdagi foto tasvirlarni tahrir qiluvchi dasturdir. Adobe Photoshop 
dasturi Adobe System, lnc kompaniyasi tomonidan ishlab chiqarilgan 
bo'lib, ishlatishdagi alohida qulayliklari bilan mashhur hisoblanadi. 

Adobe Photoshop grafik muharriri yordamida fotosuratlarga qo'­
shimchalar kiritish, fotosuratdagi dog'larni o'chirish va eski rasmlarni 
qayta ishlash va tiklash, rasmlarga matn kiritish, qo'shimcha mlxsus 
effektlar bilan boyitish. bir fotosuratdagi elementlami ikkinchi 
fotosuratga olib o'tish, ranglarni o'zgartirish, almashtirish mum kin. 
Adobe Photoshop imkoniyatlari keng qamrovli bO'lib. u gazeta va 
jurnallarni turli tu man rasmlar bilan boyitishda juda kana qulayliklar 
yaratadi. 

Adobe Photoshop ayniqsa dizaynerlar, rassomlarning ijodiy im­
koniyatlarini to'la amalga oshirishlarida yordam beradi. lurnalistika va 
bevosita matbuot yoki nashriyot sohasiga aloqador bo'lgan shaxslarning 
mazkur dastur bilan ishlashni bilishi ular uchun qO'shimcha 
imkoniyatlarni yaratib beradi. Adobe Photoshop juda murakkab 
dasturdir. Foydalanuvchilar uning asosiy imkoniyatlaridangina foy­
dalanadilar xolos. 

Dasturni ishga tushirish ketma-ketligi quyidagicha: Windows 
95, 98, ME, 2000. XR yoki NI operatsion tizimlarida Start (nYCK) 
tugmasi ustida sichqoncha chap tugmasini bosing Proirams (nporpaM­
Mbl) bo'limiga kiring so'ngra Adobe Photoshop elementi ustiga yana 
sichqoncha chap tugmasini bilan bosing. Bundan tashqari ish stolid a 
mavjud Adobe Photoshop uchun maxsus belgida «sichqoncha»ning 
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chap tugmasi ikki marta bosish yo'Ji bilan ham dasturni ishga tushirish 
mumkin. 

Adobe Photoshop dasturidan chiqish uchun quyidagi usullarniog 
biridan foydalanish mum kin: 

Alt + F4 tugmalarini bosish. 
<DaH.l menyusining BhIXO,::J; buyrug'ini tanlash. 
Ekranning yuqori qismi o'ng burchagida joylashgan X belgili 

tugmachani bosish yoki <l>afuI > 3aKphITh buyrug' ini berish; 
Dasturning har bir versiyasi o'zida yangi elementlarni mu­

jassamlantirgan. Bu o'zgarishlar Photoshop 7.0 versiyasida ham ku­
zatiladi. 

4.2. Adobe Photoshop dasturi oynasi qismlari 

Adobe Photoshop dasturi ishga tushirilgandan so'ng ekranda Adobe 
Photoshop tasvir tahrir qiluvchi oynasi hosil bo' ladi. 

Adobe Photoshop oynasining yuqori qismida sarlavha satri 
va Windowsga xos elementlar joylashadi. Sarlavha satridan so'ng 
menyu satri joylashadi. !\ttenyudagi kerakli buyruqlarni tanlashingiz 
mumtin. 

Adobe Photoshop dasturi menyusi 9 banddan iborat. Har bir menyu 
tarkibida ochiladigan menyu bandlari mavjud. Ularni ko'rish kursor 
yordamida amalga oshiriladi. Dasturning barcha buyruqlari uchun 
Asosiy menyu (LlaBHoe MeHlo) mavjuddir: 

<l>aH.rr (File) menyusi quydagi holatlarda ishlatiladi: yaratish (C03-
,ilaTh), ochish (OTKPblTb). joylashtirish (pa3MecTHTb), yopish (3a­
KpblTh). saqlash (coxpaHHTb). skanerlash (oTcKaHepOBaTh). import 
va eksport. qog'ozga chiqarish (Hane'faTaTb H306plUKeHHe), faylni 
tarmoq orqali uzatish (nepe,aaTh «paH.1 no ceTH), bir nechta Opsiyalarni 
avtomatlashtirish uchun va albatta Photoshop dasturidan chiqish uchun. 

npaBKa (Edit) menyusida, tasvirni tahrirlash ya'ni sozlash uchun 
buyruqlar: nusxalash (KonHpOBaHHJI), o'zgartirish (TpaHc«p0pMaUH"), 
joylashtirish va tasvir ranglarini tusini va muyqalam qalinligi va turini 
tan lash mumkin. 

Pe*HM (Mode) menyusi orqali Image (11306plUKeHHe) menyusi, 
tasvir sakkiz turdagi tasvir urinishlarini tanlash mumkin. 
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CnoH (Layer) menyusida joylashgan buyruqlar, bir necha qat­
lamlarda joylashgan tasvir ustidagi amallar ya'ni: qatlamlararo 
bog'lanishni qatlamlar ketma-ketligini va qatlamlarni umumiy qatlamga 
birlashtirish imkoniyatini beradi. 

BblllemlTb (Select) menyusida joylashgan buyruqlar - kerakli 
qatlamlarni tanlashda (belgilasbda) ishlatiladi. 

<l>>>J1TP (Filter) menyusi o'zida tasvirlarni birlashtirish va umumiy 
holga keltirish uchun kerakli bo' lgan filtrlari mavjuddir. 

BUll (View) menyusidagi buyruqlar, ekrandagi tasvirni ko' ri­
nishlarini va dastur oynasi qismlarini nazorat qiladi. 

OKHO (Window) menyusi buyruqlari, ekrandagi boshqa tasvirlarni 
aks ettiradi va ulardan kerakli bo' lgan paytda foydalanish imkonini 
beradi. 

IJOMOIT{b (Help) menyusidagi buyruqlar foydalanuvchi uchun kerakli 
bo'lgan maslahatlar orqali ko'mak va hozirda bajarish mumkin bo' lgan 
imkoniyatlar bilan tanishtiradi hamda Photoshop yaratuvchilari rasmiy 
saytiga murojat qilish imkoniyatini beradi. 

. 4.1-jadval 

Dastur menyuJari va ulardagi buyruqlar 

c]>aH.'l (File) menyusi buyruqJari 

HOBbIH (Ctr+N) Yangi fay I yaratish 

OTKPhlTh (Ctrl+O) Bu buyruq yordamida diskda mavjud fay liar 
ochiladi 

OTKPhlTh KaK (Alt+Ctri+O) Faylni qanday ko' rinishda ochishni tan lash 

CoxpaHHTh (Ctrl+S) Faylni xotiraga mavjud formatda yozish 

CoxpaHHTh KaK Shift+Ctrl+S Faylni xotiraga boshqa nom bilan yoz-
ish. Ushbu buyruq fayl nomi, format 
va joylasbgan papkasi kabi atributlarini 
o'zgartirishda foydalaniladi 

CoxpaHHTh KOI1H1O Tasvir nusxasini xotiraga yozish 
CA It+Ctrl+S) 

, n 

, ' '.' -
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BepHYn. Tasvirning dastlabki holatiga qaytish 

flOMeCTliTl> Boshqa mustaqil fayl bilan birlashtirish 

I1MnopT Boshqa papkada joylashgan faylni Adobe 
Photoshop dasturiga olib kirish 

3KcnopT Tasvimi boshqa papkaga jo'natish 

<l>aRll HH<p0pMaUHlI Fayl haqidagi ma'lumotlami kiritish 
I 

, 

YCTaHOBKa cTpaHHllM Tasvirni printer yordamida chop etishga 
(Shift+Ctrh-P) tayyorlash, qog'oz shaklini tan lash 

flellan (Ctrl-+-P) Tasvirni printerga jo'natish 

flpe,'lnOllTeHHlI Adobe Photoshop dasturini kerakli tartibda 
sozlash 

HacTpoHKa uaeTa Tasvir ranglarini sozlash 

Adobe on line Internet bilan bog'lanish 

BblXOll (Ctrl+Q) Adobe Photoshop dasturidan chiqish 
-

nPABKA (Edit) menyusi 

6epH (Ctrl+Z) Tasvir ustida bajarilgan oxirgi amalni bekor, 
qilish I 

Pe'3an (Ctrl-+-X) Tasvirning ajratilgan qismini buferga (xo-
tiraga) olish 

KonHpoBaTb (Ctrl+C) Nusxa olish 

BCTasHTb (Ctrl+V) Buferdan (muvaqqat xotiradan) kursor ko'r-
satgan joyga qo'yish 

BCTaBHTb (Shift-+-Ctrl+V) Buferdan (muvaqqat xotiradan) belgilangan 
joyga qo'yish 

OllHCTHTb Tasvirda belgilangan maydonni tozalash, 

o'chirish. Bunda o'chirilgan maydon fon 

rangiga bo·yaladi. 
-
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davomi 
--

3aJIHTL WTPHX Tasvir yuzini asosiy rang bilan bo'yash 

TpaHc!jl0pMauHR (Ctrl-+T) Tasvirda belgilangan maydonni shtrixlab I 

ko'rsatish 
! 

TpaHc!jlopM Tasvir shaklini o'zgartirish. Tasvir shaklini I 

turli kO'rinishlarda o'zgartirish 
I 

OqHCTKa «I1CToPHII» darchasida tasvir olib borilgan I 

o'zgartirish amallarini butunlay o'chirish. Bu I 

amal bajarilgandan so·ng o·zgartirishlarni, 
ortga qaytarish mumkin emas 

I 
-

IB06PA'}J(EHHE (Image) menyusi 

Pe)f(HM Rang mod~narni o'zgartirish 
• 

HaCTpoAl<a Tasvir ranglarini sozlash 

,ny6JlHKar Tasvirdan nusxa olish 

HaJlO)f(HTb H30fipa)f(eHHe Tasvirni qO'shimcha ranglar bilan boyitish 

BblQHCJIeHHe Tasvirdagi ranglar kanallarini o'chirish 

Pa3Mep H30fipa)f(eHHII Tasvir shaklini va o' lchamlarini o'zgartirish 

Pa3Mep XOJlCTa Tasvir ramkasi o' lchamlarini o'zgartirish 

06pe3aHHe Belgilangan maydondagi tasvirni kesib olish 

nepeBepHYTb XOJlCT Soat strelkasi bO'ylab yoki soat strelkasiga 
qarshi 180°, 90° burish 

rHCTorpaMMa Tasvirdagi ranglar miqdori haqidagi ma'-
lumotlar darchasi 
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CJloi1 (Layer) menyusi 
- . 

HOBhln • yangi qatlamni hosil qilish 

.[.ly6i1UKaTh cnoll qatlam nusxasini hosil qilish 

Y.na.'llfTb CJlOM mavjud qatlamni muvaqqat xotiradan 
o'chirish 

3cpcpeKTbl qatlamga turli effektlarni qo'shish i 

fpynna c npellbIllYWilM 
(Ctrl+G) 

qatlamlarni bir-biriga birlasbtirish 
I 

Pa3rpyn n pOBaTh qatlamlarni bir-biridan ajratish 
(Shi ft-rCtrl+G) 

CKlleTb Bce C.101l mavjud barcha qatlamlarni birlashtirish 

-. BhIliOP (Select) menyusi . ~ 

Bee (Ctrl.;.A) tasvirni belgilash ~ 

Y6paTb BhlD.enel:UJe (Ctrl+D) tasvirning belgilangan qismini muvaqqat 
xotiradan o·chirisb 

BbI.'le.luTb 3aHOBO qaytadan belgilash 

06paTHo Sift-CtrH) so"nggi bajarilgan amalni qaytarisb 

lI.BeToBol1 pR..'1 (Shift-Ctrl-D) tasvirdagi ranglar asosida belgilash 
maydonini aniqlash 

MO.'ll1<illHwpoBaTb belgilash ehizig'ini piksellarda kengaytirish 

YBeml'UJTb belgilash maydonini kengaytirish 

llpeo6pa30BaTb BbJ,Je.leHlle belgilangan maydon shaklini o·zgartirish 

C oxpaHHTb BhI,Je!1eHl1e belgilangan maydon shakJinj xotiraga 
joylashtirisb 
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<DHJThTP 

IIocJleJlHlfl:!: IPHJIbTP Foydalanuvcbi tomonidan obirgi ishlatilgan filtrn i 
qo'Hash. 

3aTO'JKa > 
~ 

IlInccerrJ.f > " 

lliTHO > O'rnatiladigan filtrlar rO'yxati 

Cnum > .. 
lllYM > . 
APyroe > Bosbqa filtrlar 

-

BUll: (View) menyusi 

HOBLrH BHJl Asosiy tasvimi yangi darchada ochish 

YBeJlH'HlTb (Crtl++) Tasvirning ekran.dagi ko'rinishini kattalashtiriih 

OKHO (Window) 
v ... 

.LJ:oKYMeHTbI > I OtmnraH >.:)')I0KaTJlap (paCMJlap) pfHXaTJ.f 

Pa60'Jee npocTpaHcTBo, J1HcTpYMeHTbl, Orrwm, 
Epay3ep IPaHJla, HasJ.fTaTop, MHIPOpMaUJillI, 
QBeT, 06pa3'1HKH, CHum, J1CTOPHlI, .LJ:eHCTBHlI, 

Dastur oynasi qismlari IIpeJlycTauoBKJ.f RHcTpYMeHTa, CJlOJ.f, KaHaIrbI, 
IIYHf, KHCTH, CHMBOJI. TlaparpaIP, CTpoKa co-
CTOllHHlI 

~ 

nOMOll(h (Help) 

IIo~1Omb Photoshop Photoshop dasturi bO'yicha yordam ma'lumot olish 
Ft 

o nporpaMMe Photoshop dasturi haqida ma'lumot olish. Unda 
Photoshop dasturning nomi versiyasi ish lab chiquvchilar ha-

qida ma' lumot beriladi. 
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3J1J1BDTB'IeCK811 06J18CTb: Tasvirda doira shaklidagi maydonni 
belgilab olish uehun qo·llaniladi. Bu uskuna yordamida tasvirdagi 
alohida maydonni belgilab olingandan keyin tasvirga kiritilgan bareha 
o'zgarishlar faqat belgilangan maydon ichiga ta'sir etadi. 

CTpOKa DBKceneA: Tasvirda gorizontal shakldagi chiziqni 
belgilaydi. Amalda bu uskuna juda kam qo'llaniladi. 

CToJl6eQ DHKCeJleil: Tasvir yuzida vertikal chiziqni belgilaydi. 
Amalda bu uskuna ham juda kam qo'llaniladi. 

KailpBpoBaoBe: Ushbu uskuna, asosan, tasvir ehetlarini va 
keraksiz qismlarini kesib tashlash uehun qo'llaniladi. Bu buyruq 
faollashtirilganda tasvir yuzidato'g'ri to'rtburchak shaklidagi ramka 
hosil bo'ladi. Ramkaning ehetlari kiehik kvadratehalardan iborat bo'lib, 
bu kvadratehalar yordamida ramka hajmi o·zgartiriladi. Tasvir ramka 
ostiga olingandan so'ng Enter klavishi bosilsa, ramka tashqarisida 
qolgan ortiqeha bo'laklar kesib tashlanadi. Ushbu buyruqni Esc 
klavishini bosib rad etish mum kin. 

nepeMe~eHoe: Ushbu uskuna tasvirdagi belgilangan maydonni 
yoki qatlamni siljitish va kesib olish uchun xizmat qiladi. Ba'zan JIepe­
MemeHHe buyrug'ini bajaradigan ayni jarayonni boshqa ayrim uskunalar 
(masalan, Bonwe6HaR nan04Ka uskunasi) yordamida ham amalga 
oshirish mum kin. 

JIacco: tasvirdagi turli shakldagi obyektlarni belgilash uehun ish­
latiladi. 

MHoroyroJlbooe J1acco: Asosan tasvirdagi to'g'ri ehiziqlardan 
iborat obyektlarni belgilashda ishlatiladi. AIt klavishi bilan 
qo'llanilganda oddiy JIaceo uskunasi vazifasini bajaradi. 

MaroHTHoe J1acco: Bu uskuna ishlatilganda Adobe Photoshop 
dasturi tasvirdagi obyekt ehegaralarini o'zi belgilaydi. Ammo bu 
uskuna piksellardagi ranglarni o'zgarishiga bog'liq tarzda ehegaralarni 
aniqlashi bois kam qo'lIaniladi. 

BOJlme6oaR DaJlOlfKa: Bir-biriga yaqin bo'lgan rangdagi piksellar 
joylashgan maydonni belgilaydi. Shift bilan birgalikda qo'llansa, 
belgilangan maydon hajmi ortadi. AIt bilan ishlatilganda esa belgilangan 
maydon hajmi kamayadi . 

A3porpat: Tasvirni bo'yashda ishlatiladi. Aerografni bir joyda 
ushlab turish siyohni tasvir bo'ylab yoyilib ketish effektini beradi. 
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ry6Ka: Tasvir ustida harakatiantirilganda, tasvirdagi ranglar 
miqdori pasayadi. Gubka bir joyda ko' p harakatlantirilsa, tasvirning 
o'sha joyi kul rang tus oladi. 

nepo: Peroni tasvir ustida harakatlantirilganda, nuqtalar hosil 
bo'ladi. Ushbu nuqtalar yordamida chizilgan tasvirni o'zgartirish 

mum kin. 
MarHHTHoe nepo: Bu uskuna xuddi MarHHTHoe .Tlacco kabi 

harakatlanadi. Biror-bir tasvirdagi obyekt atrofida harakatiantirilganda, 
Adobe Photoshop dasturining o'zi obyekt chetlarini belgilab chiqadi. 

npOH1Bo.lbHoe nepo: Juda qulay uskuna bo'lib, xohlagan shakldagi 
tasvirni u yordamida ifodalash mumkin. 

BCTaBHTb TO .. KY: Bu uskuna Pero yordamida chizilgan chiziq 
ustiga qo'shimcha nuqtalarni qO'shadi. 

Ylla ~lHTb TO .. KY: Pero yordamida chizilgan chiziq ustidagi ortiqcha 
bo'!gan nuqtalarni o'chiradi. 

Henocpe;lCTBeuHoe Bbllle.1eHHe: U yoki bu pero bilan chizilgan 
chiziqlarni tahrir qilish uchun x i Z}!l at qiladi. Uning yordtmida 
chiziqdagi nuqtalarni yakka tartibda harakatlantirish va kerakli joyga 
siljitish mumkin. 

llpeo6paJoBaTb TO"lKy: Tasvir ustida chizilgan chiziqchalarda 
o' rnatilgan har bir nuqta. burchak yoki yo)' vazifasini bajaradi. Ushbu 
uskuna yordamida nuqtalarning vazifalarini o'zgartirish, ya'ni yoyni 
burchakka va burchakni yoyga almashtirish mumkin. BlIning uchun 
kursorni nuqta ustiga olib borib sichqonchaning chap tugmasi bir marta 
bosiladi. 

TeKCT: Ushbu uskuna yordamida tasvirga turli matnlarni kiritish 
mumkin. TeKcT uskunasi faollashtirib, kursor tasvir ustida bosilsa, matn 
kiritish uchun alohida darcha hosil bo'ladi. Bu darchada harf o' lchami, 
turi. rangi va boshqa ko'rsatkichlari kiritiladi. Bu uskuna yordamida 
kiritilgan matnni qayta tahrir qilish imkoni mavjud emas. 

TeKCT-Mao:a: «TeKCT» uskunasi kabi bu uskuna faollashtirilib, 
matn ustida bir marta bosilganda. «TeKcToBbIH HHcTPYMeHT» darchasi 
hosil bo' ladi . Lekin bu matn oddiy matndan tubdan farq qiladi. 
Harfiarning cheti xuddi ;lacco uskunasida belgilash kabi ko'rinisbga ega 
bo' ladi. Harfiarni turli ranglarga bo' yash va «nepeMellleHHe» uskunasi 
yordamida o'rnidan siljitish yoki boshqa rasmga olib o'tish mumkin. 
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~epTBKa.TfLHLli TeKCT: Agar tasvirga pastdan yuqoriga shaklda 
(vertlkal shaklda) matn kiritmoqchi bo' lsangiz ushbu usku d 
+: d I . h· . na an 
10Y a ams mglz mum kin. 

BepTBKa.lbBaa TeKCT-MaCKa: Xuddi TeKcT-MacKa uskunasi kabi 
bir xii vazifani bajaradi. Ammo bu uskuna qo'lIanganida harftar ustma­
ust ustun kabi joylashtiriladi. 

U1MepHTeJ1b: Tasvirda turli o'lchovlarni bajarish llchun ishlatiladi. 
Bu uskuna bilan bir nuqtadan ikkinchi nuqtaga kursor olib borilishi 
kifoya. Shundan so'ng dastur avtomatik tarzda ikki nuqta orasidagi 
masofani o'lchaydi. 

rpa/lBeHT: Bu uskuna ishlatilganda, tasvirdagi belgilangan may­
donda ranglar kombinatsiyasi hosil bo'ladi. Asosiy rangning tasvir 
foniga sizib o'tish effekti hosil bo'ladi. 

KOBW: Ushbu uskunadan asosan, tasvirni yoki tasvirdagi ajratib 
olingan hududni bo'yashda foydalaniladi. Ranglarni qo'shimcha 
buyruqlarni bajarish orqali tanlanadi. Bu uskunani faollashtirish uchun 
K klavishi bosiladi. 

nBneTKa: Tasvirdagi asosiy yoki tasvir foni rangini o·zgartiradi. 
nHneTKa tasvir ustidagi biror nuqtada bosish bilan o'sha nuqtadagi, 
ya'ni pikseldagi rang asosiy (faol) rang sifatida tanlanadi. Agar 
ayni ·jarayonga AIt klavishasi· ·qo'shilsa, tanlangan rang tasvir fonini 
o'zgartirishiga olib keladi. 

Bbl60pKa QBeTOB: Ushbu uskuna tasvirdagi ranglar haqida axborot 
olishga xizmat qiladi . Info darchasida belgi qo'yilgan nuqtada necha 
foiz qizil, ko'k va qora ranglar mavjudligi haqidagi axborot hosil 
bo'ladi. 

PyKa: Tasvirning ko'zga tashlanmay turgan qismlarini ko'rsatadi. 
Buning uchun ushbu uskuna faoIlashtirilib tasvir ustida sichqonchaning 
chap tugmasini bosgan holda kerakli tomonga harakatlantiriladi. Ayni 
jarayonni Adobe Photoshop dasturi darchasidagi Navigator yordamida 
ham amalga oshirish mum kin. 

MacwTa6: Tasvirni kattalashtirish yoki kichraytirib ko' rsatish 
uchun xizmat qiladi. Agar ushbu uskuna bilan birgalikda Alt klavishi 
ishlatilsa, tasvir kichrayadi. Kursor ushbu uskuna faolIashtirilgandan 
so'ng o'z shaklini o'zgartiradi va lupa ko'rinishini oladi. Kursor 
tasvirning qaysi nuqtasida bosilsa, Adobe Photoshop dasturi 
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avtomatik tarzda o'sha nuqtani ekranga yaqinlashtiradi. Masshtab 
uskunasini faollashtirib. Enter klavishi bosilsa, OnUlUl Mac1IlTa6H­
pOBaHHji darchasi ochiladi. Bu darchada maxslls to'rtburchak ichiga 
belgi qo'yilsa, tasvir o'lchamlari o'zgartirilganda tasvir darchasi ham 
mos tarzda o·zgaradi. Har safar tasvir o'lchamlarini kattalashtirish 
yoki kichraytirish uchun MaclIlTa6 uskunasini faollashtirish zarur 
emas. Boshqa uskuna bilan ish lash paytida Ctrl..:..Probel bosilsa. 
ishlatilayotgan uskuna vaqtinchalik MaclIlTa6 uskunasi vazifasini 
bajaradi va tasvir kattalashadi. Ctrl + Probe I o'rnida Alt+Probel 
qo'lIanilsa, tasvir o'\chami kichrayadi. Shuningdek, tasvir o'lchamini 
Ctrl -+ «+)) (plyus) klavishlari yordamida kattalashtirish yoki Ctrl+ 
«-)) (minus) yordamida kichraytirish mumkin. Adobe Photoshop 
dasturi darchasi ostida «CTpOKa COCTOjiHHji)) satrida tasvir o'\Chamlari 
haqida axborot beruvchi maxsus darcha mavjud. Bu darchada tasvir 
o'\chamlari sonlarda ifodalangan. Ushbu sonlarni o'zgartirish orqali 
tasvirning aniq o'\chamlari kiritiladi. 

OCHOBHOii UBeT: Ushbu uskuna ustida kursor ikki marta ketma-ket 
bosilganda Adobe Photoshop dasturining yangi darchasi (BbJ60p u'BeTa) 
hosil bo·ladi. Bu darchada kerakli rang tanlanib. OK yoki Enter tugmasi 
bosiladi va tanlangan rangni KapaH.llallJ, KHCTb, A3porpacp, rpa.J.H­
eHT kabi uskunalari yordamida qo'lIash mum kin. llBeT cpoHa: Ushbu 
tugma ustida kursor (sichqoncha chap tugmasi) ikki marta ketma-ket 
bosilganda Adobe Photoshop dasturining yangi darchasi (Color Picker) 
hosil bo'ladi. Bu darchada tasvir fonining rangi aniqlanadi. Tasvir 
fonidagi rang JIacTO"lKa va rpaIlHeHT uskunalari uchun qo'llaniladi. 

nepeKJUO"leHHe UBeTOB: Ushbu belgi ustida kursorni bosish bilan 
asosiy rang bilan tasvir foni ranglari o'rni almashtiriladi. 

UBeTa DO YMO.'JllaHBIO: Bu be\gi ustida kursorni bir marta bosish 
bilan asosiy rang qoraga va tasvir foni ranglari oqqa aylanadi. 

MapwHPYIOUlHe MypaBbR: Bu tugma yordamida Adobe Photoshop 
dastllrida tez niqoblash holati bekor qilinadi. Ekranda belgilash 
chegaralari chllmolilar harakatini eslatuvchi punktir chiziq yordamida 
aks ettiriladi. Bu Adobe Photoshop dasturida odatda standart holat deb 
ataladi. 

IiblcTpaR MaCKa: Ushbu tugma ustida kursor bir marta bosilishi 
bilan Adobe Photoshop dasturi tez niqoblash holatiga o·tadi va 
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natijada tasvirdagi niqoblanmagan xudud qizil rang bilan bo·yaladi. 
Ushbu uskuna tasvirdagi turli obyektlarni aniq niqoblashda 
ishlatiladi. K"CT uskunasi yordamida niqobga ishlov berish mum kin. 
BlInda qora rang bilan tasvir niqoblanadi, oq rang bilan tasvirdagi 
niqob o·chiriladi. 

CTaHilapTBoe OIll:BO: Uskuna faollashtirilganda tasvir standart 
holatda bo' ladi. 

nOJlBbll JlII:paH C MeHIO: Bu holat tasvir kompyuter ekraniga sig'­
magan holda ishlatiladi. Ushbu uskuna faollashtirilganda ekranda 
faqatgina menYll satri hamda uskunalar paneli qoladi . 

nOJlBLII JlII:paH: Ekranda faqat tasvir va uskunalar paneli hamda 
menyu satri qora fonda qoladi. 

Tasvir o'lchami 

Adobe Photoshop dasturida ekranda tasvirning barcha qismini yoki 
tasvirdagi kichik detallarni ko'rish uchun xohlagancha kattalashtirish 
yoki kichraytirish mumkin. Masalan, 100% - bu tasvirdagi piksellar 
soniga ekrandagi piksellar soni tengligini anglatadi. Ya'ni 1:1. 200% 
ga tasvir kattalashtirilganda ekrandagi bir pikselga katta miqdordaga 
piks,lIar miqdorini to'g'ri kela},ptganligidan dalolat beradi. 

Tasvirning haqiqiy o'lchami 

Adobe Photoshop dasturida 100% li o·lcham tasvirning real o'lchami 
deyiladi. 100% li o' lchamda tasvir aniq va ravshan ko'rinadi. 

Tasvirning real o' lchami quyidagi amallarni bajarish orqali o'rna­

tiladi: 
o Menyular satrida Blill menyusida PeaJlhHhlH pa3Mep buyrug' ini 

tanlang; 
o Ctrl+ Alt+ 0 (nol) tugmalarini birgalikda bosish orqali; 
o Uskunalar panelidagi MacwTa6 tugma ustida sichqoncha tug­

masini ikki marta ketma-ket bosish orqali. 

To'liq ekranli rejim 

Adobe Photoshop dasturi tasvirni birinchi marta ochganda uni 
maksimal o·lchamda ochadi. Tasvir bilan ishlash jarayonida uning 
o'lchamini bir necha marta kattalashtirish yoki kichraytirishga to·g' ri 
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keladi. Ana shunday holatlarda tasvirni xohlagan paytda dastlabki 
nO.1BolKpaHHb1H pe)l(HM holatiga qaytarish mumkin. BlIning uchun 
quyidagi amallarni bajarish lozim: 

o Menyular satrida BHZ! menyusidagi no pa3MepaM 3KpaHa 
buyrug"ini tanlash: 

o Ctrl+ 0 (nol) tugmalarini birgalikda bosing; 
o Uskunalar panelidagi PYKa tugmasi ustida sichqoncha chap 

tugmasini ikki marta ketma-ket bosing. 

Tasvirning bosma sbakldagi o'lchami (PalMep ne .. aTH) 

Adobe Photoshop dasturi tasvirning printerda chop qilingandagi 
ko'rinishini chop qilmasdan avval ekranda ko'rish imkonini beradi. 
Buning uchun Menyular satrida J'i306pa)l(eHHe menyusi tarkibidagi 
Pa3Mep H306pa)l(eHHll buyrug'ini tanlanadi. Ammo, hamma vaqt ham 
tasvirning ekrandagi ko'rinishi bilan chop etilgandagi o'lchamlari 
aynan mos tushavermaydi. Tasvir kattaliklari 0,2% dan 16000% miqdor 
o"rtasidagi sonlar bilan belgilanadi. , 

Navigator darchasi bilan ishla~h 

Adobe Photoshop dasturida tasvirdagi mayda detallar bilan 
ish lash jarayonida tasvirni bir necha marta kattalashtirishga to'g'ri 
keladi. Tasvirga kiritilgan o"zgartirishlar sifatli chiqishi uchun 
l\:avigator darchasida amal bajariladi. Navigator darchasi asosan 
tasvir o'lchamlarini o'zgartirish va tasvirni boshqarish uchun xizmat 
qiladi. Agar Navigator darchasi Adobe Photoshop dasturi ishga 
tushirilganda ekranda mavjud bo'lmasa, uni faollashtirish uchun 
menyular satrida OKHO menyusidagi nOKa3aTb HaBHraTop buyrug'ini 
bering. 

Action darchasi bilan isblash 

Action darchasi Adobe Photoshop dasturida ishlashni yanada 
tezlashtiradi va bir nechta tasvir ustida am alga oshiriladigan bir 
xii amallarni har safar takrorlashga zaruriyat qoldirmaydi. Adobe 
Photoshop dasturidagi Action darchasi bilan ishlashni bilsangiz, qisqa 
fursat ichida ko'p miqdordagi tasvirni tahrir qilishingiz mumkin. 
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Buning uchun Action darchasida yangi Action ochiladi. Uni kerakli 
nom bilan nomlagandan so'ng Record tugmasi bosiladi. Shu daqiqadan 
bosh lab Adobe PhotoShop dasturi sizning tasvir ustida bajargan barcha 
amallaringizni kompyuter xotirasiga ketma-ket joylashtiradi. Tasvir 
lIstida barcha amallar yakunlangandan so'ng Action darchasidagi 
Stop tugmasi bosiladi. Adobe PhotoShop dasturi sizning barcha 
amallaringizni tartibli ravishda Action darchasida joylashtiradi. Boshqa 
tasvirlarga ushbu amallarni qo'Hash uchun yangi tasvir ochilgandan 
so'ng Action darchasidagi BhInO,lHeHHe buyrug'ini ishga tushirish 
lozim. Adobe PhotoShop dasturi avtomatik tarzda yangi ochilgan 
tasvirda ham siz am alga oshirgan vazifalarni hech bir o'zgarishlarsiz 
bajaradi. 

Yaogi tasvir yaratish, dublikat olish va tasvirni 
doimiy xotiraga joylashtirish 

Adobe PhotoShop dasturida ishlashdan avval yangi fay I tuziladi 
yoki kompyuter xotirasida mavjud bo'lgan tasvir ochiladi. Yangi fay I 
tuzish va avvaldan mavjud bo'lgan fayllarni ochishning quyidagi 
yo'lIari mavjud: 

d ~aj:L'1 > HOBbIH. Menyu' satrida <1>aH.'1 menyusini ochib HOBblH 
buyrug'ini tanlang yoki Ctri+N tugmalari kombinatsiyasidan foydaJanib. 
yangi fay I yarating. Yuqoridagi amal bajarilganidan sO'ng Adobe 
PhotoShop dasturi yangi faylni tashkil etish uchun uning o'lchamlari 
haqidagi ma'lumotlar bitilgan yangi darchani hosil qiladi. Bunda 
yangi tuzilayotgan fayl nomi, uning o'lchamlari kiritilishi talab etiladi. 
Kerakli o'lchamlar kiritilganidan so'ng OK tugmasini bosish lozim . 
Adobe PhotoShop dasturi oq rangdagi (bo'sh) yangi tasvirni tuzadi. 
Bu tasvirga xohlagan o'zgartirish kiritish yoki boshqa tasvirlardan 
ayrim detallarni ko'chirib o'tkazib. umuman yangi tasvirni ijod qilish 
mumkin. 

o <1>a":I > OTKpblTb: Menyu satrida <1>aH.'1 menyusini ochib OTK­
pblTb buyrug'ini tanlang yoki Ctrl+O tugmalari kombinatsiyasidan 
foydalanib kompyuter xotirasida mavjud bo'lgan faylni oching. 
Juda kam hollarda <I>aH.'1 - OTKPblTb Kak (Ctrl+Alt+O) buyrug'i 

tanlanadi. 
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Tasvir formatlari 

Adobe PhotoShop dasturi 20 dan ortiq formatdagi fay liar bilan 
ish lash imkoniga ega. Eng ko'p qo'llaniladigan formallar: 

BMP (Windows Bitmap) - Windows muhitida ishlovchi kompyu­
terlarda ekran osti tasvirlarini qo'lIovchi dastur Microsoft Paintda keng 
qo'llaniladi . 

JPEG (Joint Phonographic Experts Group) - hozirgi kunda eng ko'p 
qo'llaniladigan formatlardan biri bo'lib, uning asosiy afzalliklaridan 
biri maxsus dastur yordamida fayl hajmini yetarlicha siqish imkonining 
mavjudligidir. Ammo faylni siqib hajmini kichraytirish jarayonida 
tasvir sifatida o'zgarish bo'ladi. Fayl kuchli siqilganda tasvir sifati 
yomonlashishi mumkin. Ushbu formatdagi fayllar kompyuter xotirasida 
ko'p joy egallarnaydi. Hajrn jihatidan kichikligi sababli mazkur 
forrnatdagi tasvirlar bilan ishlashni ancha osonlashtiradi. Aksariyat 
raqamli fotokameralar, videokameralar va skanerlar yordamida olingan 
rasmlar JPEG formatida saqlanadi. 

nrr (Tagged Image File Format) -15u formatdagi fay lIar ham \eng 
qo'lIaniladi . Lekin nFF formatidagi fay lIar kornpyuter xotirasida ko'p 
joyni egallaydi. Adobe PhotoShop dasturida ushbu formatdagi tasvirlar 
bilan ishlashda dasturning ish lash tezligi sezilarli ravishda pasayishi 
mumkin. 

GIF (Graphics Interchage Format) - ushbu formatdagi tasvirlar 256 
turdagi rang bilan tasvirlanadi. Bu formatdagi tasvirlar asosan Internet 
tizirnida keng qo'llaniladi. 

Ranglar bilao ishlash 

Adobe PhotoShop dasturida uskunalar panelida ranglar bilan ishlash 
uchun to'rtta uskuna ajratilgan: 

o OCHOBHOH UBeT. Ushbu uskunada qanday' rang kO'rsatilgan 
OO' lsa, KOBW, nHHHJI, KapaHllaw, KHCTb, A3porpaq> v~ shuningdek Alt 
klavishi bilan birgalikda qo'llanganda Ila.leQ uskunalari uchun o'sha 
rang asosiy hisoblanadi. OCHOBHOH QBeT uskunasidagi rang IlHneTKa 
yoki ushbu uskuna ustida sichqoncha chap tugmasini ikki marta ketma­
ket bosish orqali o'zgartiriladi. 
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o l...{BeT <pOHa. Ko'rsatilgan rang naCTHK uskunasi ·bilan ishlaganda 
qo'lIaniladi. UBeT <pOHa uskunasidagi rang OCHOBHOH ~BeT uskunasida 
rangni o'zgartirish uchun qanday amal bajarilgan bo'lsa, bunda ham 
xuddi o'sha amalga rioya qilish lozim yoki nl-meTKa uskunasi bilan Alt 
klavishini birgalikda bosish orqali rangni almashtirish mumkin. 

o I1epeKmO'leHHe ~BeTOB. Kursorni ushbu tugma ustida bir marta 
bosish orqali asosiy rang va fon rangi o' rin almashadi. 

o CTaHJlapTHblH ~BeT. Kursorni ushbu tugma ustida bir marta 
bosish asosiy rang va fon rangini stand art ranglar - qora va oq rangga 
almashtiradi. 

Ranglarni tanlashda Adobe PhotoShop dasturida Color yoki 
Swatches darchalaridan ham foydalanish mumkin. 

RGB (Red, Green. Blue-qizil, kO'k, yashil) moduli tasvirni ekranda 
tahrir qilish nuqtai nazaridan kelib chiqqan holda juda qulay va u 24 
razryadli ranglar platasi yordamida deyarli barcha 16 million ranglarni 
monitorda aks ettiradi. RGB ranglar majmuasi bilan ishlangan barcha 
tasvirlarni xohlagan formatda diskka yozish mumkin. RGB ranglar 
majmuasidagi ayrim ranglar umuman tabiatda uchramaydi. 

CMYB-tabiatda mavjud bo' lgan ranglar majmuasi, quyosh 
nurla·ri inson ko'zlari ajrata '6ladigan barcha ranglarni o'zida mu­
jassamlashtirgan. Quyosh nurlari biror bir jismga tushganda uning ta'siri 
ostida inson ko'zlari jism shakli va rangini idrok etadi. Misol uchun 
binolarning o't o'chirish burchaklariga osib qo'yilgan o't o'chirgichlar 
to'q ko'k va zangori ranglar bilan bo'yalgan bo'lishiga qaramay, bizning 
ko'zimizga to'q qizil rangda ko'rinadi. Ranglarni bir-biriga qo'shilishi 
natijasi boshqa ranglar hosil qilinadi: 

S - havo rang: M - binafsha rang; Y - sariq rang; B - qora rang. 
Bosma mashinalari va bosmaxonalarda tasvirlar yuqorida keltirilgan 

ranglarning kombinatsiyasidan foydalangan holda to'la tasvirni 
ifodalaydi. 

RGB ranglar majmuasida oq rang uchala ranglarning maksimal 
aralashmasidan hosil qilinadi. Qora rang esa buning aksi ularoq olinadi. 

CMYB ranglar majmuasi bilan ishlaganda qora va oq ranglarni 
hosil qilish uchun buning aksini bajarish lozim. Ya'ni to·rt rangning 
minimal qo'shilishida oq rang hosil bo'ladi. Qora rang esa alohida 
kanalda mavjud. 
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RGB ranglar majmui keng ko'lamdagi ranglarni taklif etadi. 
Lekin ularning ko'p qismi (ayniqsa, yorqinlari) tasvirni chop 
etganda monitordagi bilan keskin farq qiladi. Shu bois ham ko'plab 
mutaxassislar tasvirni chop etishdan avval uni CMYB tizimiga 
o'tkazadilar. Ayrim mutaxassislar esa tasvir bilan CMYB tizimida 
ishlashni maslahat beradilar. Ammo bu tasvir bilan ish lash turli 
qiyinchiliklarni tug'diradi. Ana shunday qiyinchiliklardan biri­
kompyuter juda sekin ishlaydi. Bunga asosiy sabab Adobe PhotoShop 
dasturi RGB tizimiga sozlangan bo'lib, har bir buyruqni bajarib, uni 
RGB tizimidan CMYB tizimiga almashtirgunga qadar kompyuter 
qO'shimcha vaqt talab qiladi. Bundan tashqari, skaner va monitor 
RGB tizimida ishlashga mo'ljallangan. Ranglar bilan ishlovchi barcha 
uskunalar (rangli printerdan tashqari) RGB tizimida ishlaydi. Shuning 
uchun yaxshisi tasvirni chop etishdan avval CMYB tizimiga o'tkazib 
olish maqsadga muvofiq. Tasvir ustida bare ha amallarni poyoniga 
yetkazib, menyular satrida lii306pa)f(eHHe - HacTpoHKa tarkibidagi 
CMYB buyrug'ini tanlang. 

• 
History darcbasi bilan ishlasb 

Adobe PhotoShop dasturi ishga tushirilganda ekranda History 
darchasi mavjud bo'lmasa, OKHO menyusida nOKa3aTh History 
buyrug'ini tanlang. History darehasida tasvirga kiritilgan sO'nggi 
o'zgartirishlar haqidagi ma'lumotlar joylashadi. Tasvir ustida bajarilgan 
har bir muhim amallar History darehasida ro'yxatga olinadi. Xohlagan 
paytda yoqmagan amallarni History darchasi orqali rad etish mumkin. 
Buning uehun kursor bajarilgan sO'nggi amaldan oldingi buyrug'i 
ustida bosiladi yoki Ctrl+Alt,7 klavishlari bosiladi. Adobe PhotoShop 
dasturi bajarilgan so'nggi 20 amalni ro'yxatga oladi, yigirma birinchi 
amal bajarilganda Adobe PhotoShop dasturi avvalgi amallarni 
o'chiradi. 

Qatlamlar bilan isblash 

Adobe PhotoShop dasturi tasvirdagi biror obyekt npJlMoyro.lb­
HaJl o6.TJaeTb, 3JL1HTlTHl{eCKaJl 06JIaCTb, ]laceo, BO.illIIe6HaSl TlaJIol{­
Ka, ObleTpaSl MacKa yordamida tasvirdagi detallar belgilanib ularning 
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nusxalari olinganda Adobe PhotoShop dasturi yangi qat lam hosil 
qiladi. Bu qatlam alohida obyekt bo'lib, uni tahrir qilish ham alohida 
tarzda bo' ladi. Bir nechta tasvirlardagi ayrim detallarni yagona 
tasvirga jamlanganda Adobe PhotoShop dasturi ko'chirib o' tilgan 
tasvir bo' laklarni qatlamlarga ajratadi . Ayni jarayon tasvir detallarini 
joylashtirish uchun juda qUlay. Bir necha qatlamlar bilan ishlaganda 
ularni boshqarish qiyinlashadi. Adobe PhotoShop dasturi bajarilganda 
yangi darcha hosil bo'ladi. Bu darchada tasvirdagi yangi qatlamlar 
haqidagi axborotlar joylashadi. Yangi qatlam hosil qilinganda Adobe 
PhotoShop dasturi uni C10H darchasida rO'yxatga oladi. Bu darchada 
qatlamlar tartibli tarzda joylashtiriladi. Shuningdek, qadamlarning 
o'rRlRl almashtirish yoki vaqtincha o'chirib qo'yish mumkin. 
Qatlamlarni o'chirish uchun avval kerakli qatlam CnoH darchasida 
belgilab olinadi va menyular satrida C10H menyusi tarkibidagi Y.lla­
nHTb C10H buyrug' i tanlanadi. Qatlamlarni bir-biriga birlashtirish 
imkoniyati ham mavjud. 

Filtrlar bilan ishlash 

A~obe PhotoShop dasturidC! tasvirni qo'shimcha effektlar bilan 
boyitish uchun filtrlardan foydalanish mumkin . Buning uchun menyular 
satrida «I>HJ1Tpbl buyrug'i tarkibidagi filtrlardan foydalanishingiz 
mumkin. 

Photoshop va ImageReady dasturlariga tasvirni tez ko'rib chi­
qish moduli kiritilgan. Oldingi vaqtlarda bu ishni amalga oshirish 
uchun tashqi dastur (utilit)lar ishlatilar edi. Masalan ACDSee yoki 
ThumbsPlus. Cho'ntak kompyuterlari uchun rasmni importi va eksporti 
WBMP formatli filtrlari kiritilgan. Kompyuterning ish lash chegarasi 
doirasida avtomatik tarzda rasmning sifatini buzmagan holda moslashuv 
(optimizatsiya)ni bajaradi. 

Photoshop 7.0 dasturiga guruh (rpynnoBoH) bo'Jib ishlash 
uchun qO'shimcha imkoniyatlar kiritildi. Bu bir kompyuterda turli 
foydalanuvchilar tomonidan Adobe dasturida ishlash imkoniyatini 
beradigan AfterCast kengaytgich qo'shildi. Agar bir foydalanuvchi 
tasvirga o'zgartirish kiritsa bir vaqtning o'zida hamma foydalanuvchilar 
kuzata oladi. Ammo AfterCast sozlashni faqat administrator boshqara 
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oladi, lekin bu shaxsiy kompyuterlarda Photoshop dasturida ishlovchi 
foydalanuvchilar bu muammoga duch kelmaydilar. Biz yuqorida 
faqatgina Photoshopning 7-versiyasini asosiy imkoniyatlarini sanab 

chiqdik. 

Uskunalar paneli 

Ekranda turgan dastur uskunalarini ishga tushirish uchun sichqoncha 
bilan uni ustiga bosing va ekranda kO'rinayotgan piktogrammani ustiga 
bosing. Bir xii piktogrammalar yonida kichik ko·rsatkich (strelkacha) 
lar mavjud. Agar uni ustiga bosilsa tasvirga to'g' ri keluvchi oynalar 
ko'rsatiladi . U yerdan siz kerakli uskunalarni tanlashingiz mumkin. 
Har bir uskuna uchun o'zining o"lchamlari ekran tepasida joylashgan 
Opsiyalar panelida mavjuddir (masalan, pe)l(HM CMeWHBaHHR, 3HaqeHHe 
Henp03paQHOcTH). 

Opsiyalar paneli 

Opsiyalar paneli har bir uskunani-ng parametrlarini sozlashluchun 
ishlatiladi (masalan, shaffoflik darajasi yoki tasv irni aralashtirish 
rejimini) (4.I-rasm). Opsiyalar panelining o'ng tomonida maxsus 
ranglarni saqlovchi bo' lim mavjuddir. Parametrlarni ko"rsatilishi qaysi 
rasmni tanlanganiga bog' liq (4.1-4.6-rasm). Foydalanuvchi tomonidan 
kiritilgan tasvir ko' rinishi boshqa o' zgartirishlar kiritilgunga qadar 
saqlanadi. Palitra va Opsiyalar panelini ham ekranning istalgan joyiga 
siljitish mumkin. 

1[2EJ Brush: ~ ~: INormo' ::J Op.cily : ~ Flow: ~ ~ 

4.1· ,.asm. Brush uskunasi uchun Opsiyalar pandi. 

I8J :.J L2J I? a Feather: ro;:-- r ' ." .. Style (Norm;! 3 

-l.2·rasm. Rectangular Marquee llskunasi uchlln Op>iyalar paneli . 

IL~I ~ ::l D Mod.: INorma' 3 Opacity : I!Q.Qill 

-l.3·rasm. Gradient uskunasi uchun Opsiyalar paneli. 
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lIE] :..:::I . ~ . S'.....J ..J :.; J '\. ..1'" W Auto Addll>eltte ---I 

4.4-rasm. Pto uskunasi uchun Opsiyalar paneli . 

II-iFl :...::.:x J ~ S··..J ·.J .;; J '\. . ...j .. -I 

4.5-rasrn. Rtctanglt uskunasi uchull Opsiyalar paneli . 

jHel ' .~;,:' -- ~ 1M.4JOJm i.J :rP2 r' ~ la ~.p :!1 

4.6-rasm. Ture uskunasi uchun Opsiyalar paneli. 

Opsiyalar panelining o'ng tOl11onida faol uskuna piktogrammasi 
ko'rsatilgan. Agar piktogramma yonidagi strelka ustiga bosilsa, 
kO'rinmay turgan menyu ochiladi, unda boshqa kerakli bo'lgan 
uskunani tan lash mumkin. Bu jadvalga o'zgartirishlar kiritish mumkin. 
ya'ni kam ishlatilayotgan uskunalarni olib tashlab o'rniga kerakli 
bO' lgan uskunalarni joy lash mum kin. Har bir Opsiyalar paneliga 
kiriti~an o'zgartirishlar avtom~!ik tarzda saqlanib qolinadi. Tugmalarni 
qayta tiklash va joylashtirish ishlari paydo bo'luvchi paneldan amalga 

oshiriladi. 

Yordarnchi maslahatlar 

Istalgan piktogramma ustida sichqonchani chap tugmasini bos­
masdan olib boring shunda siz ishlatmoqchi bo'lgan uskunaning nomi 
va uni klaviatura orqali ishga tushiradigan tugmachalar ko'rsatiladi. 
Shu bilan bir qatorda ishlatilayotgan Opsiyalar oynasi va uning vazifasi 
haqida qisqacha ma'lumot olish mum kin. Edit> Preferences> General 
(npaBKa > YCTaHoBKH > 06WHe) oynasidagi yordamchi maslahatlar 
oynasini ishlatish uchun Show Tool Tips oynasi ustiga bayroqchani 
o'rnating (nOKa3blBaTb Bcn.lblBalOWHe nO.llCKa3KH). 

Istalgan tasvirni xohlagan paytda o'zgartirishlar kiritish imkonini va 
12 turdagi Photosnop kengaytmalarida saqlash imkonini beradi. Ammo 
odatda kO'pincha quyidagi Photoshop formatlari ishlatiladi: TIFF. GIF, 

JPEG, EPS. 
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Photoshop dasturida ko'pgina operatsiyalar asosan palitralar orqali 
bajariladi. Ekranda ko'p joy egallamasligi uchun palitralar o'zaro 
guruhlarga biriktirilgan: Navigator / Info (Boshqaruv / Ma'lumot). 
Color / Swatches / Styles (Rang / Namuna / Uslublar), History / 
Actions / Tool Presets (Tarixi / harakatlar / Uskunalar tan lash), Layers 
/ Channels / Paths (Qatlamlar / Kanallar / Konturlar) va Character / 

Paragraph (Shrift / Abzats). 

Palitralar 

Photoshop dasturida ko'p operatsiyalar palitralar orqali bajariladi. 
Ularni o'zaro aralashtirish ham mumkin. Istalgan palitrani ochish uchun 
esa Window (OKHO) menyu buyruqlari yordamida amalga oshiriladi. 
Belgilangan palitra boshqa shu guruhga kiruvchi palitralardan eng 
yuqorida avtomatik tarzda joylashadi. 

Photoshop dasturidan chiqish: Windows operatsion tizimida bu 
dastur oynasini yopish uchun File> Exit (<l>aH.'l > BbIXOll.) buyrug'ini 
bering yoki (Ctrl+Q) tugmalar kombin.a.tsiyasini bosing. • 

Savol va topshiriqlar: 

1. Adobe Photos hop dasturi qanday ishga tushiriladi? 
2. Adobe Photoshop dasturining asosiy menyusi nimalardan tashkil 

topgan? 
3. Opsiyalar paneli nima uchun ishlatiladi? 
4. Palitra operatsiyalari orqali nima bajarish mumkin? 

4.3. Adobe Photoshop dasturida tasvir va rasm bilan ishlash 

Adobe Photoshop Windows muhitida ishlovchi elektron ko'ri­
nishdagi foto tasvirlarini tahrirlovchi dasturdir. Adobe Photoshop 
dasturi Adobe System Inc kompaniyasi tomonidan ishlab chiqarilgan 
bo'lib, ishlatishdagi alohida qulayliklari bilan mashhur hisoblanadi. 

Adobe Photoshop grafik muharriri yordamida fotosuratlarga 
qO'shimchalar kiritish, fotosuratdagi dog'larni o'chirish, eski rasmlarni 
qayta ish lash va tiklash ishlarini am alga oshirish mumkin. Rasmlarga 
matn kiritish qo'shimcha maxsus effektlar bilan boyitish, bir foto­
suratdagi elementlarni ikkinchi fotosuratga olib o'tish. suratdagi 
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ranglarni o'zgartirish. almashtirish mum kin. Adobe Photoshop im­
koniyatlari keng qamrovli bo'lib, u gazeta va jurnallarni turli tuman 
rasmlar hilan boyitishda juda katta qulayliklar yaratadi. 

Adobe Photoshop ayniqsa jurnalistlarning, rassomlarning ijodiy 
imkoniyatlarini tl)'la am alga oshirishlarida yordam beradi. jurnalistika 
va bevosita matbuot yoki nashriyot sohasiga aloqador bo'lgan shaxs­
larning mazkur dastur bilan ishlashni bilishi uchun qo'shimcha 
imkoniyatlarni yaratib beradi. 

Adobe Photoshop grafik muharriri juda murakkab dasturdir. 
Foydalanuvchilar uning asosiy imkoniyatlaridangina foydalanadilar 
xolos. Opsiyalar panelida Brush muyqalamni tanlash uchun strelkasi 
ustiga bosing. Har bir piktogramma ustidagi raqamlar muyqalamni 
qalinligini piksellarda ko'rsatadi. Agar siz istalgan muyqalam ustiga 
olib borsangiz shu muyqalamning qalinligi va turi haqida ma'lumot 
chiqadi. Boshqa turdagi muyqalamlarni tan lash uchun muyqalamlar 
kutubxonasini yuklash kerak. Muyqalam panelini yopish uchun 
paneldan tashqaridagi ekranning istalgan joyga bosing va avtomatik 
tarzida panel yopiJadi. Mode (Pe)J(HM cMeWHSaHHJI) bo'limini tanlang, 
hamda Opacity (HenpOJpa4HocTb) bo'limini foiz kO'rsatkichida Brush 
(KHC'rb) uskunasi uchun tanlifng (4.7-rasm). Agar ko'rsatilgan qism 
parametri 100% ni tashkil qilsa muyqalam shtrixi pastki piksellarni 
mutloq qoplaydi. 

Eslatma: Faqatgina shafof bo'lmagan qatlamlaroing rangini o'z­
gartirish uchun Layers (C10H) palitrasidagi Lock transparent pixels 
(3a(IJHJ(cHpOOaTb np03pa4.Hble T04KH) llstiga bayroqchani o'rnating. 

Photoshop 7.0 dasturi yordamida siz bir qancha stand art muy­
qalamlar yoki o'zingiz o'lchamlari va ko'rinishini kiritgan holda juda 
qiziqarli rassomchilik ishlarini amalga oshirishingiz mum kin. 

Rasmlar bilan ishlash uchun dasturning yangi versiyalari o'ta 
qiziqarli bo'lgan rasmlarni yaratish imkonini beradi. Photoshop 7.0 
dasturida standart va avvaldan foydalanuvchi kiritgan rasmlarni 

Mode: Jr·jeornHI 3 Op~i~y: Il¥% El 

./ 7-rasm. Opacity param.:trini belgilash. 
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nusxalab unga sayqal berish shu bilan birga tasvirga nam va quruq 
muyqalam usullarida bezak berish mum kin. Muyqalam paketiga barg 
va o'tlarni tasvirini yaratadigan maxsus effekt muyqalamlari kiritildi. 
Maxsus original tasvirlarni yaratish uchun skanerdan o'tkazilgan 
rasm va matnlarni orqa fon sifatida shaffof ko'rinishda tasvirga 
kiritish mumkin. Photoshop 7.0 dasturida faqat yangi tasvir yaratish 
imkoniyatlari bilan cheklanib qolmay balki, boshqaruvni soddalashtirish 
ham e'tiborga olingan. 

Mavjud bo'lgan muyqalamni o'zgartirish 

Photoshop dasturiga qo'shimcha sifatida muyqalamlar bazasi ham 
beriladi va siz u yerdan istalgan muyqalamni tan lab uni xohishingizga 
ko'ra o'zgartirishingiz mum kin. 

I. Opsiyalar panelidan Brushes (KHCTb) tugmasiga bosing undagi 
menyudan Brush Tip Shape bo' limini tanlang. 

2. Diameter (~HaMeTp) effektni kerakli joygacha cho'zing yoki 
muyqalam diametirini kiriting (l dan 99.9 pikselgacha). • 

3. Muyqalam izi shaffofsizligini belgilovchi Hardness ()KecTKocTb) 
koeffitsentini tanlang yoki uni ham foiz miqdorda kiriting (0-100% 
gacha). 

4. Muyqalam qoldirgan izlari oralig' ini Spacing (I1HTepBan) orqali 
belgilanadi (0-99%). Foiz miqdorini oshirilgan sari shtrixlar orasidagi 
masofa kattalashib boradi. Shuningdek bu vazifani kursor yoki 
muyqalam ham bajarishi mum kin. Buning uchun Spacing (I1HTepBan) 
tugmasidan bayroqni olib tashlashni o'zi kifoya. Qanchalik kursorni tez 
harakatlantirsangiz shuncha oraliq kattalashadi va aksincha. Ko'pgina 
standart o'rnatilgan muyqalamlar uchun asosan Spacing va Diameter 
bo'limlarini o'zgartirish mumkin. 

5. Muyqalam izini doira yoki boshqa ellips ko'rinishlarini belgilash 
uchun Angle (Yron) bo' limidan (-180° dan +180° gacha) qiymatlarni 
ko'rsating yoki ekranning chap tarafidagi rasmdagi strelkani xohishga 
kO'ra joylashtiring. 

6. Muyqalamni tiniqlashtirish uchun Roundness (OKpymocTb) 
(0-100%) parametrlarini bering. Foiz miqdori ortgani sari nuqta izi 
tiniqlashadi. 
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Yangi muyqalamni yaratish 

Brush (muyqalam) menyusidan New Brush (Yangi muyqalam) 
buyrug'ini tanlang. 

1. Mavjud muyqalamni o'zgartirish (H3MeHeHHe cYlIlecTBYlOlIleH 
KHCTH) bo'limidan 2 dan 8 gacha bo'lgan buyruqlarni tanlang. Create 
New Brush (Yangi muyqalamni yaratish) bo'limiga bir marta bosing 
va kerakli o'lchamlarni bering. Agar siz ushbu tayyor muyqalamni 
saqlab qolmoqchi bo'lsangiz, uni nomini kiriting va OK tugmasini 
bosing. Saqlangan muyqalam piktogrammasi tan lash panelining oxirida 
joylashadi. 

Tasvirdan iborat bo'lgan muyqalamni yaratish uchun quyidagi 
ketma-ketlik bajariladi: 

I. Rectangular Marquee (npHMoyronbHaH o6nacTb) uskunasini 
faollashtirish uchun klaviaturadan M tugmasini yoki Shift+M tug­
malarini bosing, 

2. Berilgan figuralar joylashgan oq fondagi tasvirni chegarasini 
belgilang (maksimum lOOOxlOOO pikselgacha). 

3. Edit> Define Brush (Pravka > Onpe)l.eneHHe KHcTa) buyrug'ini 
tanlang. 

4.- Yuqorida aytib o'tilgande"k ushbu yangi muyqalam nomini kiri­
ting va OK tugmasini bosing. Bu muyqalamdan Brush (KI1CTb) menyusi 
bilan ishlayotganda foydalanish mumkin. Paydo bo'luvchi muyqalam 
o'lchamlarini, Spacing (HHTepBan) tugmasidan shtrixlar orasidagi 
masofani aniqlashtiring (1-99%). 

5. Belgilangan hududni qaytib o'z holiga keltirish uchun Ctrl+D 
tugmalarini birgalikda bosing. 

Muyqalamni o'chirish 

Muyqalam tanlash panelini oching: 
Birinchi usul: Alt tugmasini bosib turib o'chirmoqchi bo'lgan 

muyqalamni belgilang. Bu harakatni orqaga qaytarish (oTMeHlfTb) 

mum kin emas. 
Ikkinchi usul: Keraksiz bo'lgan muyqalamni ko'rsating va Delete 

Brush (Muyqalamni o'chirish) buyrug'ini tanlang. 
Background Eraser va Magic Eraser uskunalarini ishlatilishi. 
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Magic Eraser menyusi sichqoncha tugmasi hilan o'chirish imkonini 
beradi. U siz kO'rsatgan rangga yaqin bo'lgan piksellarni o'chiradi. Buni 
aksini esa Paint Bucket (8e.upo C KpacKoi:f) uskunasi hajaradi. Agar siz 
shaffofsizlikni 100%dan pastrog'ini tanlagan bo' lsangiz unda Magic 
Eraser uskunasi orqali kerakli joylarni shaffof ko"rinishga keltirishingiz 
mumkin. 

Background Eraser uskunasi bu fondagi keraksiz joylarni o'chiradi 
yoki kerakli ranga bo'yaydi. Bu uskunaning ustunligi shundaki u 
bilan aralash fonlarni yakdil holatga va o'chirilayotgan maydonni yoki 
chegaralarni hamohangligini nazorat qiladi. 

I. Xohlagan qatlamni tanlang. Eraser (o"chirgich) uskunasi yor­
damida qatlamdagi keraksiz joylarni o'chirmoqchi bo"lsangiz unda 
Lock transparent pixels (3a<i>HKcHpoBaTb np03pa'lHble TO"lKH) 
bo'limiga bayroqchani o'rnating. Shunda o·chirilayotgan qatlam undan 
oldingi qatlam foniga ega bo'ladi. Agar Lock transparent pixels (3a­
<i>I1KcHpOBaTb npO ~pa'lHble TO'lKH) bo'limidagi bayroqcha olib tashlansa 
unda o'chirilgan qism shaffof holatga o'tadi. 

2. Eraser (o·chirgich) uskunasini· E tugmasi yoki Shift+E fugma­
larini birga bosib uni ishga tushiring. 

3. Opsiyalar panelidan Brush (KHCTb) bo'limiga kiring va kerakli 
bo'lgan muyqalamni tanlang. 

Mode (Pe>KHM) bo"limidan kerakli rejimni tanlang: u yerda Brush 
(KHCTb), Pencil (KapaH)J.aw) yoki Block (b.l0K)ni tanlang. Xo"1 bo'yoqni 
akslantiruvchi Brush (KHCTb) effektini tanlang. Opacity parametrlarini 
ko'rsating. 

Avtomatik tozalash rejimi 

Auto Erase (ABToJlacTHK) o'z-o'zidan avtomatik tarzda ishlashga 
mo'ljallangandir. Agar siz uni o'z xohishingizga ko'ra ishlatmoqchi 
bo'lsangiz quydagilarni bajarishingiz shart: 

1. Kerakli bo'lgan fon rangini tanlang. 8unda Eyedropper (nHneT­
Ka) uskunasidan rang tanlashda foydalanishingiz mum kin; 

2. Kerakli bo'lgan qatlamni belgilang; 
3. Pencil (KapaH)J.allJ) uskunasini faollashtiring, buning uchun V 

tugmasi yoki Shift+B tugmalarini birgalikda bosing; 
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4. Opsiyalar panelidan Auto Erase (ABTo:lacTHK) uskunasi ustiga 
bayroqni o'rnating; 

5. Tasvirga shtrixlarni chizing. Asosiy pikseldan boshlab kerakli 
hududgacha kursorni tortib boring. 

Savol va lopshiriqlar: 

1. Brush uskunasi imkoniyatlarini sanab bering? 
2. Background Eraser buyrug'i nima uchun ishlatiladi? 
3. Obyekt rangi qanday o'zgartiriladi? 

4.4. Matnlar bilan ishlash 

Adobe PhotoShop dasturi tasvirlar ustiga matnlarni kiritish 
uchun yana bir keng imkoniyatni ochib beradi. Tasvir ustiga matn 
kiritish uchun uskunalar panelida maxsus TeKcT uskunasi mavjud. Bu 
uskuna, asosan, tasvirga turli matnlarni kiritish uchun xizmat qiladi. 
TeKcT uskunasi tarkibida TeKCT-MaCKa, BepTHKallbHbli1 TeKCT kabi 
uskunalar yashiringan. Bu uskunalar faolIashtirilib, kursor tasvir 
ustidf biT marta bosishi bilan y'angi TeKcToBblH HHcTpYMeHT darchasi 
hosil bo'ladi. Bu uskunalar faqat matnlarni tuzish uchun xizmat 
qiladi. Uning yordamida mavjud matnlarni tahrir qilishning imkoni 
yo'q. 

Photoshop 7.0 dasturida matn vektor ko'rinishiga ega. Dasturda matn 
o'zining aniq chegara va konturlariga ega. Chunki dastur matnlarni 
ishlatayotganda vektor konturini qo·1Jaydi. Shu bilan bir qatorda matn 
ham rasm sifatlarini o'zida mujassamlashtirgan. Bu matn printerdan 
chiqarilishiga qaramay u PDF yoki EPS formatlarida saqlanishida o'z 
tiniqligini saqlab qoladi. 

Photoshop dasturi faqatgina matnlarni kiritibgina qolmasdan, balki 
ularni yozilayotgan vaqtida va yozilgandan sO'ng ham ularni tusini, 
rangini, ko'rinishini hamda yo'nalishini o'zgartirish mumkin. 

Matnni kiritish 

Photoshop dasturida matn yozish uchun TeKcT tugmasi tanlanadi 
va avtomatik tarzda kerakli joyda o'z maxsus qatlamiga ega bo'lgan 
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fonda yozila boshlaydi. Istalgan paytda uning ko'rinishini o'zgartirish 
mumkin masalan: shrift. uslub, kegl, rang, kerning, treking, oraliqdagi 
interval, to'g'irlash, chiziqlarni hajmi. Bundan tashqari bir tekstni o'ziga 
bir qancha atributlarni kiritish mumkin. 

Shu bilan bir qatorda matnning ma'nosini mexanik tarzda 
o'zgartirish unga har xii effektlar qo'lIash va u joylashgan qatlam 
ustida bir qancha imkoniyatlarni qo'Hash mum kin. Matn qatlami 
ustida qanday amaHar qo'Hash mumkin? Unga filtrni qo'Hash, matndan 
tozalash mumkin. Bu amaHarni bajarish uchun eng avvalo matn 
qatlamini Layer> Rasterize > Ture (CnoH > TIpeo6pa30BaTb B pac­
TPOBblH lPOPMaT > TeKcT) uskunasi orqali belgilab undagi buyruqni 
tan lash kerak. 

Eslatma, Bitmap, Indexed Color va Multichannel rejimida yaratilgan 
matn o'z qatlamiga ega bo'lmaydi va to'g'ridan-to'g'ri ekran foniga 
tushadi hamda uni tahrirlash imkoniyati yo'qoladi. 

Turli xildagi matnlar (tahrirlanadigan va tahrirlanmaydigan) ko'­
rinishlari Ture (TeKcT), Layer (CJlOH), Character (lllpl1ltn). Paragraph 
(A63au) uskunalari va Opsiyalar paneJi.-orqali yaratiladi. • 

Tabrirlanadigan mato qatlamini yaratish: 

1. Eng avvalo Ture (TeKcT) uskunasini T tugmasini bosish bilan 
faol\ashtiring. 

2. So'ngra matnni joylashtirish kerak bo'lgan ekrandagi qismning 
o'lchamlarini sichqoncha orqali belgilang (so'zlar va matnlar bir-biriga 
to'qnashib ketmasligi kerak). Yaxshisi har bir so'zni alohida qatlamga 
yozing shunda ularni bir-biridan mustaqil ravishda siIjitish imkonini 
qo'lga kiritasiz. 

3. Opsiyalar panelida quyidagi amallarni bajaring: 
o Thre tugmasiga bosing va matnning YO'naIishini kO'rsating (go­

rizontal, vertikal): 
o Shrift va uning o'lchamini tanlang; 
o Shuningdek Anti-aliased (Moslashtirish) menyusidan matn 

qatlam chegarasini kO'rsating: Sharp (Tiniq) Crisp (qattiq), Strong 
(kuchli) yoki Smooth (yumshoq). Bu matnni soyasi ko'rinishlarini 
tubdan o'zgartiradi va tasvirga moslaydi. Alignment (BblKJIto4-
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Ka) tugmalaridan biriga bosing va kerakli bo'lgan matnni yozilish 
chegarasini ko'rsating (o'ngdan, chapdan, o·rtadan). 

Opsiyalar panelidan matnni rangini ko'rsating. Bundan tashqari 
matn rangini Swatches (06pa3QbI) va Colors (UBeTa) palitralaridan 
ham belgilash mumkin. 

4. Ekrandagi oynada matnni kiriting. 
5. Yangi matn qatlamini yaratish uchun Enter tugmasini bosing. 

Agar sizga boshqa qatlam kerak bo'lmasa Esc tugmasini bosing. 
Eslatma: Agar siz matnlar bilan ishlayotganda kompyuter 

to'xtab qolaversa yoki tezl igi pasaysa unda och ilgan qolgan kerak 
bo'lmagan oynalarni yoping. Shunda dastur tezligi o'z holiga 
keladi. 

Eslatma: Har sa far matn yozishda yangi qatlamdan foydalan­
ganingiz ma'qul va xatolikka ega bo'lgan qatlamlarni o'chirib tash­
lang. 

Matnni tahrirlash. Matnni o'zgartirishdan oldin uni faollashtiring 
va matndagi so·z. jumla va harfni belgilab o'zgartirish kiriting. 
Shuningdek matnni belgilash uchun uning ramkasini ustiga bosish 
kifoya . 

• 
Matnni masshtablash 

Horizontal Scale (MacllJTa6 no rOpI130HTaJIH) va Vertical Scale 
(MaCllJTa6 no BepTI1Karll1) buyruqlaridan matnni joylashish shaklini 
o'zgartirish uchun foydalaning. Bir xiI to'g'ri kO'rinishdagi masshtablash 
uchun quydagi amallarga rioya qiling: 

Matn uchun maxsus efTektIar 

Eng avvalo quyidagilarni eslab qoling. Agar siz matnni ram­
kasini masshtabini, hajmini va tuzilishini o'zgartirish uchun uni 
tahrirlanadigan ko'rinishda bajarishingiz kerak bo'lsa va sO'ngra matnga 
maxsus effektlar qO'shish uchun uni rasm sifatiga keltirib undan keyin 

effektlarni qo'lIashingiz mum kin. 
V tugmasi orqali ishga tushiriluvchi Move uskunasi orqali matnni 

trasformatsiya qilish mumkin. 
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Show Bounding Box (nOKa3aTb ra6apHTHYlO paMKY) uskunasiga 
bayroqchani o'rnating Layen (CnoH) uskunasi orqali kerakli qatlamni 
belgilang. Ekranda matn qatJami aks etadi. 

Yakka holda kiritilgan jumla va so'zlarni quyidagicha o'zgartirish 

mumkin: 
• Layers (CJJOH) oynasiga jumlani kiriting va Edit (npaB­

Ka) menyusidan Free Transform (npOH3BO!lbHaJl TpaHc$opMaUHJI) 
buyrug'ini tanlang; 

• Sichqoncha bilan matn oynasini kerakli shaklni olguncha 
surib boring. Bu vazifani boshqa uskunalar yordamida ham bajarish 
mumkin. 

Matnni rasmli qatlam ustiga joylashtirish: 

I. Matnli qatlamni yarating. 
2. Shu matn qatlamidan nusxa oling va uni saqlab qo'ying. 
3. Matn nusxasini belgilang va Layer> Type> Convert to Shape 

(CnoH > TeKcT > l1peo6pa30BaTb B $Hrypy) buyrug'ini bering. Matn 
qatlami avtomatik rasmga aylanadi va oni tahrirlash endi mumkiIllemas. 

4. Layer > Change Layer Content> Levels (Cl0H > 113MeHHTb 
COnep)l(l1MOe C,10R > YpOBHl1) buyrug'ini bering. Yozilgan qatlam siz 
boshqa qatlamni kiritmaguningizga qadar buferda qoladi va faol bO'lib 
turadi . 

5. Yozilgan matn boshqa tasvirlar bilan hamohangligini jigarrang 
tusga ega bo' lgan piktogramma Input (B80.o1) ustiga bosing va matn 
rangini ochartiring yoki to'qlashtiring; 

6. OK tugmasini bosing. Ekran fonining bir qismiga bosing. 

Ko ' rinmaydigan matnlar yaratish: 

I . Matn kiriting va uni qatlamini faol holatda qoldiring. 
2. Layers oynasining pastki qismidan Add a mask (Ao6aBHTb 

MacKY) tugmasini bosing. Belgilangan joy yonida kichik belgi (MacKa) 
paydo bo' ladi. 

3. G klavishasini yoki Sbift+G tugmalar kombinatsiyasini bosgan 
holda Gradient (fpanHeHT) uskunasini ishga tushiring. 

4. Gradient uskunasi yonidagi strelkani bosing va kerakli rangni 
tanlang. Linear gradient (JIHHeHHbIH rp~HeHT) tugmasiga bosing va 
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Normal (HopMaJ1bHbIH) rejimini tanlang shaffofsizlik qiymatini bering 
(I % dan 100% gacha). 

5. Matnni ustiga kerakli bo'lgan hududni ramka sifatida sichqoncha 
bilan belgilang va shu qismlar ocharadi yoki to'qlashadi. 

Matnni effekt bilan ko'chirish uchun u joylashgan qatlamni 
faollashtiring va Move (nepeMememle) uskunasini ishga tushiring. 

Agar siz effektni o'zgartirmoqchi bo'lsangiz matn joylashgan qatlam 
ustiga bosing shunda Layer Style muloqot oynasi paydo bo'ladi . Undan 
boshqa effektlarni tanlashingiz mumkin. 

Matn qatlamini chegaralarini o'rash: 

I. Blending Options (OnQHH cMelllHBaHHSI) oynasidan Layers 
(C'10H) buyrug' ini tanlang. 

2. Style (CTH,lb C.'10R) oynasining chap tarafida joylashgan Stroke 
(OoBOiJ,Ka) buyrug' i ustigabosing va Preview (npe.LJ:BapHTeJ1bHbly. 
npocMoTp) uskunasiga bayroqcha o' rnatilganligini tekshiring. U yerdan 
quyidagi bo'limlarni ko'rib chiqing va kerakli o'lchamlarni bering: 
Structure (CTpYKTypa) Size (Pa3Mep), Position (Joylashish holati) 
(ular tashqaridan va ichkaridan bO'lishi mum kin Outside (CHapY)lm). 
Inside (BHYTPH) yoki Center (markaz», Blend Mode (Pe)l(HM CMe­
lllHBilHHR), Opacity (Shaffofsiz'lik), Fill Type (bo'yash usuli) va Color 

(rang). 
OK tugmasini bosing (yoki Enter tugmasini bosing). 

Savol va lopshiriq/ar: 

1. Dasturda matn konturini o'zgartirish uchun qaysi buyruqlardan foy­
dalaniladi? 

2. Qaysi uskuna yordamida Photoshop dasturida matnlarni yaratish 
mumkin? 

3. Gradient (rpaD.HeHT) uskunasi qaysi tug malar yordamida ishga tu-

shiriladi? 

4.5. Adobe Pbotoshop dasturida tasvirga isblov berish. Qatlamlar 

Qatlamlar xuddi oyna qatlamlariga o'xshagan bo'lib, faqat tasvir 
bo'lgan joylarigina ko'rinishga egadir. Har bir qat lam uchun o'zining 
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shaffoftik darajasi bo'lib undan oldingi va keyingi turgan qatlamlar 
bilan hamohangligini moslash mumkin. Qatlamlarni joylashish o'rnini 
almashtirish yoki ularni yagona qatlamga birlashtirish mumkin . Bir 
vaqtni o'zida har xii qatlamlarda turgan tasvirni birgalikda o'zgartirish 
va bir qatlamda turgan rasmni faqat bir qismini o'zgartirish mumkin 
emas. 

Layers (CJlOH) oynasida qatlamlar ustida turgan qatlamdan eng 
tagidagi qatlamgacha aks ettirilgan. Bunda fon qatlami oxirida 
joylashadi. Hozirda belgilangan qadam faol bo'lib ko'rinadi va faqat shu 
qatlam ustida amallar bajarish mumkin. 

lstalgan qatlamni faollashtirish uchun Layers oynasidan kerakli 
qatlam ustiga bosish kerak. Faol bo'lgan qatlam nomi dastur nomi 
yonida akslanib turadi . 

Eslatma: Katta hajmdagi tasvirlar bilan ishlayotganda bajarilib 
bo'lgan qatlamlarni birlashtirish yoki o'chirib tashlagan ma'qul. Shunda 
dastur ish lash tezlik unumdorligi oshadi va tasvir hajmi kamayadi . 

Yangi qatiam hosil qilish • 
1. Eng avvalo 100% shaffof qatJarn hosil qilish uchun Create New 

Layer tugmasi ustiga bosing. 
2. Agar qatlamni o' lchamlarini o'zingiz bermoqchi bO'lsangiz unda 

Alt tugmasini bosib turgan holda Create New Layer tugmasini bosing; 
3. Name (HM.II) bo'limida qatlamni nomini kiriting Group With 

Previous Layer (CrpynnHpoBaTb C npeAbl.J.ywH~ c.loeM) bo' limiga 
bayroqchani o'mating; 

4. Layers (CIIOH) palitrasidan ko'z va muyqalam kO'rinishidagi 
piktogrammalarga bayroqchani o'mating; 

Mode (Pejf(HM cMeWHBaHH.II) va Opacity (Henp03paI{HOcTb) 
parametrlaridan tasvir uchun yangi parametrlarini bering (keyinchalik 
bu parametrlar o'zgartirilishi mumkin). 

5. OK tugmasini bosing. Yangi qatlam ishlatilayotgan qatlam ustida 
paydo bo'ladi. 

Eslatma: Tasvir hajmini kamaytirish uchun Layers (C.'10H) 
menyusidan Palette Options (OmUfH naIIHTpbl) buyrug'ini tanlang va 
shu tasvirga to'g'ri keladigan eng kichik hajmni tanlang. 
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Belgilangan qismni qatlamga aylantirish 

1. Belgilangan qismni hosil qiling; 
"') Layer > New> Layer Via Soru (CnoH > HOBbJH > IIocpe.ll­

CTBOM KonHpOBaHHJI) menyusidan buyruqni bering (Ctrl+J tugmaJari). 
3. Tasvirni belgilangan qismini qirqib olib tashJash uchun Layer 

> New> Layer Via Cut (CnoH > HOBbIH > I1ocpe.n,cTBoM BbJpe3amUI.) 
buyrug'ini bering (Ctrl+ SbifHJ tugmalari). 

Qatlamni siljitish 

l. Layers (CllOIf) oynasida o'zgartirish kiritmoqchi bo' lgan qatlamni 
belgilang; 

2. Mon (I1epeMemeHHe) uskunasini faollashtiring (V klavishasi); 
3. QatJamni kursorni ushlab turgan holatda siljiting. 
Eslatma: Auto Select Layer (ABToBhl.llenelU1e cnojl) bo'limida 

bayroqcha turgan bO'Jsa Move (I1epeMern.eHHe) uskunasi yordamida 
tezda qatlamni siljitish mumkin, ammo bu siljitish shaffoftigi 50% dan 
kam bo'lgan qatlamlar uchun ishlamaydi. 

Qatlamlar bilan ishJash uchun uskunalar 

B:rcha uskunalar qatlamlai-' bilan ishlaydi. Lekin bu bilan qat­
lamning shaffofsizIigiga katta tasir o' tkazadi. Shuning uctun qadam 
shaffofsizligini doimo nazorat qilib turing. 

Qatlamni o'chirish 

Qatlamni uchirishdan oldin uni nomini faolligini tekshiring va uni 
belgilab o'chirib tashlang. 

Qatlamga effektlar qo'Hash 

Qatlamga quyidagi maxsus effektlarni qo' Hash mumkin: Drop 
Shadow (Or6pOCIfTb TeHb), Inner Shadow (BHyrpeHHJIJI reHb), Outer 
Glow (BHeU1Hee CBeqeHlfe), Inner Glow (BHYTpeHHee CBeqeHHe), Bevel 
and Emboss (CKOC H pe.'1be<ll), Satin (ATJIac), Color Overlay (Hano­
)l(eHHe usera), Gradient Overlay (HanO)l(eHlfe r~HeHTa) vs Pattern 
O,'erlay (HanmKeHHe y30pa). Effektlarni istalgan paytda istalgancha 
xohJagan qatLamga qo'lIash mumkin. 
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Eslatma: Vslublar va effektlaroi bir-biri bilan chalkashtirib 
yubormang. Uslub (Cnmb) - bu bir qancha qat lam effektlarini ha­

mohangligidir. 
Effektlarni qo'yish Layer Style (CTHJlb CJlOJl) m~loqot oynasi orqali 

amalga oshiriladi. 
Effekt yonidagi belgi bu effekt shu qatlamga qo'lIanilganini 

ko'rsatadi . Qatlam effektlarini asosiy fon uchun qo' lIash mumkin emas. 

Hamma qatlamlarni birgalikda ish latish 

Agar Opsiyalar panelida quyidagi uskunalar ishlatilayotgan bo'lsa: 
Blur (Pa3MbITHe), Sharpen (Pe3KocTb), Smudge (TIa..'1ell), Paint Bucket 
(Be)l.po c KpacKoH), Magic Eraser (BOJIIlle6HhlH JlaCTHK) yoki Magic 
Wand (BoJlwe6HaJl naJlO'lKa) unda Use All Layers (l1cnOJlb30BaTb 
Bce cnoH) bo'limiga bayroqchani o'roating shunda rang va boshqa 
o'lchamlar olinayotganda mavjud bo' lgan ranglarga yaqin bo'lgan 
tuslar birinchi navbatta ko'rinadi. Faqat faol bo'lgan qatlamda ranglar 
o'zgaradi. • 

Ikki qatlamni birlashtirish 

I. Birlashtirmoqchi bo' lgan ikki qatlamdan qaysi birisi oldinroq 
bo"lsa uni belgilang. 

2. Layers (CnoH) menyusidan Merge Down (CnHTb c HH)I(­
HHM) buyrug'ini bering yoki Ctrl+E tugmalarini birgalikda bosing. 
Faol qatlam o'zidan pastda turgan qatlam bilan birlashadi. Bir qancha 
belgilangan qatlamlarni birlashtirish uchun Merge Layer Set (C.IJHTb 
Ha60p cnoeB) buyrug'ini bering. 

Qatlamlami birlashtirish 

Eslatma: Flatten Image (fT.IJOCKOe 10f306pa)l(eHHe) buyrug"i qat­
lamlarni pastdan boshlab birlashtiradi va yashirilgan qatlamlarni 
avtomatik tarzda o'chiradi. 

Hamma qatlamlar ko'rinib turganligiga amin bo'ling va qaysi 
qatlam faol bo'lishi muhim emas. Layers (Cno") menyusidan Flatten 
Image (fTnocKoe J.i306pa)l(eHHe) buyrug'ini bering. Agar dasturda 
bekitilgan qatlamlar bo' lsa unda ogohlantirish beriladi va OK tugmasini 
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bosing va birlashtirishni davom ettmng. Agarda pastki qatlamlarda 
ko'rinmaydigan nuqtalar bo' lsa ular oq ranga kiradi. 

Layers (CJ10H) menyusidan keraksiz qatlam nomini tanlang. So'ngra 
Trash (Kop3HHa) tugmasini bosilgandan keyin Yes (,ua) tugmasini ham 
bosing. 

Qatlamni o'chirishni yana bir usuli keraksiz qatlam nomi ustiga 
olib borib sichqonchani o'ng tugmasini bosing va menyudan Delete 
Layer (Y.llaJIHTb C.l0H) buyrug' ini tanlang hamda Yes tugmasini 
bosing. 

Savol va topslt;riqlar: 

l. Qanday usulda qatlarnlar hosil qilinadi? 
2. Qatlamlarga qanday effektlar qo'lIash mumkin? 
3. Ajratilgan qismda yangi qatlarnni hosil qilishni kO'rsatib bering . 

• 

171 



V-bob. COREL DRAW DASTURI 

5.1. COREL DRAW dasturi bilan tanishuv 

Kanadaning Corel nomi bilan ataluvchi firmasi dasturiy ta'minot 
bilan shug'ullanuvchi peshqadamlardan biri hisoblanadi. Corel 
firmasining dasturiy ta'minoti asosini tashkil etuvchi CorelDRAW 
11 2002-yilning avgustida ish lab chiqarildi. U reklama mahsulotlarini 
ish lab chiqarishda, nashrlarni tayyorlashda, hamda Web-sahifalari 
uchun tasvirlarni yaratishda katta imkoniyatga ega. 

Corel DRAW - bu grafikli dastur bo'lib, uning yordamida vektorli 
tasvirlarni, grafikli matnlarni, hamda si2ning tassavvuringizdagi IJIlrcha 
ijodiy g'oyalaringizni amalga oshirishga yordarn beradi. 

Corel DRAW dasturi ishlaydigan barcha tasvirlar ikki sinfga 
bo'linadi: nuqtali va vektorli. Vektorli grafikada tasvirning asosiy 
elernenti sifatida chiziq qaraladi . Rastrli grafikada bunday chiziqlar 
nuqtalar (piksellar) yordamida yaratilsa, vektorli grafikada esa 
tasvirlar yaratishda nuqtaga nisbatan umumiyroq bo'lgan chiziqlardan 
foydalaniladi va shuning hisobiga tasvirlar aniqroq bo'ladi. 

Vektorli grafikaning ixtiyoriy tasvlfI chiziqlardan tashkil 
topadi va oddiy chiziqlardan rnurakkablari hosil qilinadi . Vektorli 
grafikaning matematik asosini geometrik figuralarning xossasini 
o'rganish tashkil qiladi . Vektorli tasvirlarni kornpyuter xotirasida 
ifodalanishi nuqtaliga qaraganda rnurakkabroq. Nuqtali tasvirning 
kamchiligi - kornpyuter xotirasida ularni saqlash katta joy talab 
etiladi. Nuqtali tasvirlar bilan yuqori aniqlikda ishlashda. ularga rnos 
fayllarning o'lchami yuzlab megabaytlarni tashkil etadi. Ko·pincha. 
bunday katta obyektlar bilan ishlaganda zarnonaviy kompyuterlarning 
tezligi yetmay qoladi . Vektorli tasvir bilan ish lash juda ham oson . 
Uni katta yoki kichik qilish uchun, faqat uni boshqaradigan tasyir 
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parametrini o'zgartirish mumkin. Bunda vektorli tasvir faylining 
o'lchami bir baytga ham oshmaydi. 

Y1a'lumotlar tasvirlar orqali berilganda ularni tahlil qilish va 
qabul qilish tezligi, ma'lumotni eshitish kanallari orqali berilgan 
ma'lumotlardan ko'ra ancha yuqori bo'ladi. Shuning uchun ham 
tasvirdan iborat birgina reklama plakati (osongina kerakli ta'sirni bera 
oladigan) tomosha qilayotgan odamga bir necha qator e'londan ko'ra 
kuchli ta'sir kO'rsatadi. 

Har qanday hajmdagi ma'lurnot ko'rish kanali orqali uzatilsa odarn 
tornonidan yaxshi qabul qilinadi (bolalarga rasrnlardan iborat kitoblar 
yoqadi). Boshqa formatda esa bunday rna'lurnotni qabul qilib bo'lrnaydi 
(birjalardagi jadvallar). Shu sababli ham grafikli ma' lurnotlarga bo'lgan 
ehtiyoj kundan kunga ortib borrnoqda. 

Bunday grafiklar va tasvirlar bilan ishlashga rno'ljallangan dasturiy 
vositalar juda ham ko'p va xilrna-xil. Ana shunday dasturlardan biri 
CorelDRAW dasturidir. 

CorelDRAWning 12 versiyasi o'zida zarnonaviy imkoniyatlarni 
birlashtirgan bo'Jib 2004-yilda ish lab chiqarilgan. Bu dastur sanoat 
diza~nida , reklama mahsulotlarini ish lab chiqishda, nashriyot tizirn­
laricfa \'a web sahifalar uchun turli tasvirlar yaratishda ishlatiladi. 
Corel DRAW dasturi paket dastllr hisoblanib o'z ichiga bir nechta qism 
dasturlarni oladi. Bu dasturlar o'zaro ma'lurnot almashishning yengil 
kechishini ta'minlaydi. 

Paketning yaxlitligi uning tarkibiga kiruvchi dasturlarning rna'­
lumotlarni yengil almashinishi yoki shu rna'lumotlar ustida ketrna-ket 
turli xiI vazifalarni bajarishi bilan belgilanadi. 

«Obyektga ),o'naitirilgan» - atamasi tasvirlarni yaratish va o'zgar­
tirish jarayonidagi barcha operatsiyalar, rasmning o'zi yoki uni tashkil 
qilgan piksellar bilan emas balki tasvirni tashkil qilgan semantik 
belgilangan elementlar ustida boradi. Standart obyektlarni qo'l1agan 
hold a (aylana, to'g'ri to'rtburchak, matn va boshqalar) foydalanuvchi 
rnurakkab obyektlar qurishi va ularni birlashtirib yagona butun obyekt 
sifatida qarashi mumkin. Shu tarzda, rasm iyerarxik tuzilishga ega 
bo'lib, eng yuqorisida butun vektorli tasvir bo'lgan, eng quyida esa 
stand art obyektlardan iborat bo' ladi. 
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Paket obyektga yo'naltirilishining yana bir afzalligi har bir 
obyektlarning stand art sinfiga boshqaruv parametrlari yoki atributlar 
o'rnatiladi. Masalan, to'rtburchak balandligi 200 mm va eni 300 mm, 
ko'k rang bilan to' ldirilgan, qalinligi 3 punkt bo' lgan sariq rangdagi 
chiziq bilan chegaralangan. Joylashuvi vertikal bo'y icha 150 mm, 
gorizontal bo'yicha 250 mm, 32 gradusga burilgan kabi boshqaruv 
parametrlariga ega. 

Paketning obyektga YO'naltirilishining uchinchi afzalligi obyekt­
larning har bir standart sinfiga stand art operatsiyalar rO'yxati bel­
gilangan. Masalan, yuqoridagi . to'rtburchakni bur ish, o' lchamlarini 
o'zgartirish, burchaklarini o'zgartirish, boshqa sinf obyektlariga 
aylantirish kabi amallar. CorelDRAWning obyektga yo'naltirilganligi 
foydalanuvchiga ish vaqtida obyektlar ustida cheksiz o'zgaruvchanlik 
amallarini bajarish imkonini beradi. Agar buyurtmachi ishning oxirgi 
bosqichida o'z fikrini o' zgartirsa va reklama plakatidagi olma o'rniga 
anorni tasvirlashni xohlab qoldi, bunday holatda ishni boshidan 
bosh lash shart emas. Buning uchun ayrim obyektlarni almashtirish 
kifoya. Bunday holatda bir marta qurilgan obyektni saqlab qo'yib 
keyingi yangi ishlarda foydalanish mumkin. 

CorelDRAW paketi quyidagi dasturlardan iborat: Corel CAPTURE, 
Corel BARCODE WIZARD, CoreIDRAW, Corel Photo-PAINT, Corel 
OCR-TRACE, CoreITRACE, Corel VENTURA, Corel SCRIPT Editor, 
Corel SCRIPT Dialog Editor. 

Corel CAPTURE dasturi CorelDRAW dasturi oynasi va uning 
qismlarini rasmga olish uchun ishlatiladi. Uning yordamida dastur 
oynasi ayni kO'rinishini to'liq yoki menyu ko'rinishini hamda biror 
qismni to'rtburchak shaklda, aylana yoki ellips shaklida va ixtiyoriy 
shaklda aylantirib belgilab olish mum kin. 

[~ q "l~ 100% v 

~:~ Corel CAPTURE 

[J!l]) Corel BAR CODE WIZARD 

~.1 CorelDRAW 

§) Corel PHOTO'PAINT 
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Corel BARCODE WIZARD das-
turi esa shtrix-kod bilan ishlashga 
mo' ljallangan. Unda berilgan standart­
lardan birini tanlab~ so'ng keltiri Igan 
namuna bo'yicha raqarn va xarflarni 
kiritamiz. 

Corel Photo-PAINT dasturi esa 
rasm lar chizishga mo'ljallangan. 



5.1-jadval 

Dastur paketininl versiyalari bO'yicha tarkibi 

Dastur nomi I.x 2 .x 3.0 4.0 5.0 6.0 
6.0 

7.0 
7.0 

8.0 9.0 
9.0 

10.0 11 .0 12.0 X3 X4 X5 
(rus) (rus) Office 

CorelDRAW ./ .I ./ .I .I .I .I .I ./ ./ .I .I ./ .I ./' ./ ./ ./ 

Corel 
PHOTO- ./ ./ .I .I .I .I .I .I .I ./ .I ./ .I .I 

PAINT 

CorelOCR-
TRACE 

./ ./ 

CorelTRACE ./ ./ ./ 

Corel 
CAPTURE 

./ ./ ./ ./ .I .I ./ ./ .I ./ ..,( .I .I 

Corel 
.I 

VENTURA 

Corel SCRIPT 
.I .I ./ ./ .I .I .I .I ./ ./ 

Editor 

Corel SCRIPT 
./ .I .I .I .I .I 

Dialog Editor 



CorelDRAWni isbga tusbirish. Corel DRAW 12 grafik muharririni 
ishga tushirish uchun nYCK > nporpaMMhI > Corel DRAW 12 buyrug' i 
beriladi yoki Windows XP ish stolida uning yorlig'i ustida sichqoncha 

chap tugmasi ikki marta bosi ladi. 
CorelDRAW dasturini ishga tushirish Windowsning standart 

usullari singari: asosiy menyu orqali (unda paketni o'rnatganda 
CorelDRAWni yuklash buyrug'ini o'z ichiga olgan yangi buyruqlar 
guruhi paydo bo'ladi) yoki ish stolida joylashgan yorliq yordamida 
hamda CorelDRAW dasturida yaratilgan fayllar ustida sichqoncha 
chap tugmasini ikki marta bosish yo'li bilan ishga tushiriladi . Bunday 
fayllarni biz albalta uning kengaytmasidan bilib olamiz. CorelDRAW 
dasturida yaratilgan fayllar .CDR .. CMX, WMF kabi kengaytmalarini 

oladi. 
Kengaytmalar haqida S.2-jadvaldan batafsil ma'lumot olishingiz 

mumkin. 

5.2-jadval 

CorelDRAW dasturida kenpytmalarning ro'yxati • 

N!! Kengaytma Izoh 

l. CDR CorelDRAW 

2. CDT CoreIDRAW shabloni 

3. CGM Kompyuter grafikasi metafayli 

4. CMX Corel Presentation Exchange 5.0. 

5. CMX Corel Presentation Exchange 

6. CSL Corel simvollari kutubxonasi 

7. DES Corcl DESIGNER 

8. DWG AutoCAD 

9. DXF AutoCAD 

10. EMF Kengaytirilgan Windows metafayli 

11. FMV Vektorli freym metafayli 

12. GEM GEM fayli 
--
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13. PAT Uzor fayli 

14. PCT Macintosh PICT rasmlari 

15. PLT HPGL plotter fayli 

16. SVG Masshtablanadigan vektor grafikasi 

17. SVGZ Siqi SVG 

18. WMF Windows metafayli , 

19. WPG Corel WordPerfect grafikasi fayli 

20. CLK Core! R.A.VE. 

Dastur yuklangandan so' ng ekranda foydalanuvchi interfeysining 
asosiy elementlaridan iborat CorelDRAW oynasi paydo bo' ladi (5.1-
rasm). 
Meoyu qator i Standart uskunalar paneli Atributlar paneli 

lOG' 01_ In' 'P ... -

t/))..... .. f"a t ..:~ -trI ' . : 
• .:,\"n'f"!I . 'a, ~.f.:..-.n "U"IIU~"s • n ~tl '... 0 0 ... ~ 1"""~ " __ 

IiJ :.1. • • t<. zr ~ ~ ..... ,_ 
' 'I" T If !rili' ......... , ~" -4 

I 
Ish qog'ozi 

I 
I!!I.H--+ Uskunalar to' plami 

• 

(eo.Xl. un.]I) ; Ht 

Ish maydooi 

~
::;;: . 
lI"" . 

-. - . 
o 

.J 

J :J h~ 1 
'!) .. .I. , ..... 

CJ ~""" ... I'q 

• \t', 

:;. 

/ -­.., .I.(~~co 

'"od 

' l ~tod ... U ... -Sahifadan-sahifaga o·tish Holat qatori Palitra 

5.1-rasm. CorelDRAW oynasining ko'rinishi. 
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CoreIDRAWda ishchi muhitni sozlash mexanizmi juda rivojlangan. 
Windows standartidan farqli oynaning sarlavha satri ostida menyu 
qatori joylashgan. 

5.2. Corel DRAW dasturi oynasi qismlari 

o Sarlavha satri . Bu yerda: Corel DRAW 12 - dasturning nomi. 
[Risunok I] - hujjatning formal nomi. Ish yakunida formal nomga 

real (haqiqiy) nom beriladi. 
o Menyu satri. 
Windov.s standartlariga mos bO'lgan menyu satri. CorelDRAWda 

menyu satri murakkab bo' lib. qism menyu va ularga mos buyruqlardan 
ibOl·at. Boshqa dasturlardagi kabi bu menyu ham Corel Drawning 
kO'pchilik funksiyalariga kirishni ta'minlaydi. Lekin ko'pchilik ha­
rakatlar u siz ham bajarilishi mumkin. Menyuni sozlashning 
chegaralanmagan imkoniyatlari foydalanuvchini chalkashtirib yuboradi . 
Foydalanuvchi xohlagan vaqtda CorelDRAWning har qanday buyruq 
va uskunalarini boshqa menyuga ko'chirish mumkin. Shuning' uchun 
keyingi paragraflarda birinchi navbatda menyusiz ish lash yoli(larini, 
zarur bo'lganda uning buyruqlariga murojat qilishni o·rganamiz. 
Menyu satri 1 I ta menyudan iborat. Har bir menyu o'ziga xos buyruqlar 
to'plamidan tashkil topgan. Corel DRAW menyusi murakkab tuzilgan 
bo'lib. har bir menyuda bir necha ichki menyular bo'lishi mumkin. 

Standart uskunalar paneli 

Menyu satrining ostida Stand art uskunalar paneli joylashgan. Bu 
satrda eng ko'p bajariladigan buyruqlarga mos boshqarish elementlari 
joylashgan. Masalan, OTKPblTb (ochish), 3aKpblTb (yopish), CoxpaHHTb . 
(saqlash) buyruqlari, tizimli almashtirish buferining operatsiyalari , 
rasmlarni ko'rish holati uskunalari joylashgan. 

.. . ~ - ~" . . ~. , 

!T T t 'T I' f t l' I ,- i I' f 100% ~."Tb' • J 
1 2 3 4 5 6 7 8 9 10 11 12 13 14 

Standart uskunalar paneli tugmachalarining vazifalari : 

- yangi hujjat yaratish: 2 - maljud hujjatni ochish: 3 - hujjatni saqla!>h; 4 -
hu.ijatni chop qilish: 5 - qirqish; 6 - nusxa olish: 7 - qO'yish: 8 - oxirgi harakatni 
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hekor qilish; 9 - oxirgi harakatni takrorlash; 10 - import (bir hujjatni ikkinchisiga 
ulash): 11 - eksport (fayllarni jO'natish); 12 - i10vani yuklanish moduli; 13 - Corel 
DRAWning saytiga kirish; 14 - masshtabni kattalashtirish darajasi. 

o Atributlar paneli. 
Standart uskupalar panelining ostida «atributlar paneli» (naHeJIb 

aTpH6YTOB) satri joylashgan. U belgilangan obyektning parametrlarini 
o'zgartiradigan boshqarish elementlari to'plamidan iborat. Atributlar 
paneli ichidagi elementlar belgilangan obyektning shakliga qarab 
o'zgarib turadi. Bu panel foydalanuvchining asosiy ish paneli deb 
ataladi. 

'(: 8'3,~3... ""'" :7,698. 
f: 16).~... '11.691 .. ", 

1,,)),0 '; &; 

100.0 '\ 
6) .J.O ,_) ~ IC,. n,2111111 

Ranglar palitrasi. Oynaning o'ng chegarasi bo'ylab «DaJIHTpa IJ.Be­
TOB» (ranglar palitrasi) paneli joylashgan. U rangni to'ldirish va rasmli 
obyektlarning atrofini himoyalash, aylantirib bo'yash uchun qo'lIaniladi. 

Uskunalar paneli. Ish maydonining chap qismida uskunalar to'plami 
(toolbox) oynasi joylashgan. Undagi kerakli uskunani tan lash uchun 
uning ustida sichqoncha chap tugmasi bosiladi. Kerakli uskunani 
tanlast bilan foydalanuvchinlng tasvir ustida barcha harakatlari 
boshlanadi. 

3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 

L'skunalar panelidagi asosiy uskunalar va ularning vazifalari: 

_ YKalaTe.lb \ko'rsatkich). tasvirni belgilaydi: 2 - (fl0pMa (shakl) uskunasi: 3 -
Bblpe3aTb (Qirqib olish): 4 - MacIDTa6 (o·lcham). Obyektni ko'rinishini o'zgartiradi 
(kattalashtiradi va kichiklashtiradi); 5 - CBo6o.lHall pyKa. Ixtiyoriy shakldagi 
chiziqlarni chizadi: 6 - ABTOpncoBaHHe uskunasi. Erkin chiziqlarni hosil qilaui: 7 -
ITPAMO)TO,lbHHK uskunasi. TO'rtburchaklar sinfini hosil qiladi; 8 - Aylana \'a uning 
sinfiga tegishli obyektlarni chizadi; 9 - MHOroyrO.lbHHK (ko'pburchak) uskunasi. 
KO'pburchaklarni chizadi: 10 - ITpocTble !jIOPMbl (oddiy formalar); 11 - TeKcT 
(matn) uskunasi: 12 - Ta6.1Hua. ladval uskunasi: 13 - l1HTepaKTHBHoe nepeTeKaHHe 
uskunasi: 14 - ITHneTKa uskunasi; 15 - KOHTYP uskunasi: 16 - 3a:IHBKa uskunasi; 
17 -l1HTepaKTHBHaA 3aJlHBKa uskunasi. 
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~,.. :~~~ x :: 
5.2-rasm Fill uskunasining yoyilgan paneli. 

Uskunalar panelidagi ayrim tugmalarning pastki o'ng burchagida 
uchburchak shakli berilgan. Bu ko'rsatkich tugmachaga aslida bilta 
em as balki bir nechta uskuna o'rnatilganligini bildiradi. Tugmaga 
tegishli boshqa uskunalarni birga ko'rish uchun uni sichqoncha chap 
tugmasi yordamida bosamiz. 

5.2-rasmda Fill (3aJUlBKa) uskuna tugmasi ostida joylashgan panel 
kO'rsatilgan . 

Ochilgan paneldan zarur tugmani tan lash va bosish yo'li bilan turli 
vazifalar bajariladi. 

CorelDRAW oynasining pastki qismida holat qatori joylashgan 
(status bar). Unda ish jarayonida p.e1gilangan obyekt haqid,gi va 
dasturning ish rejimi haqidagi boshqa yordamchi ma'lumotlar beriladi. 
Holat qatorini ish stolining ixtiyoriy joyiga ko'chirish mumkin. Ammo 
tajribalarning kO'rsatishicha holat qatorini ish stolining pastki qismiga 
joylashtirgan ma'qul. 

CorelDRAW ish maydonining asosiy qismida hujjatlar oynasi 
(drawing windows) joylashtirilgan. CorelDRAW yangi hujjat yaratish 
buyrug'i berilgandan so'ng illyustratsiya joylashtiriladigan sahifa paydo 
bo'ladi. Sahifaning chegaralari ramka ko'rinishida joylashtirilgan bo'lib 
ular tasvirning elementlari hisoblanmaydi. Bo'lajak illyustratsiyani. 
tashkil qiluvchi obyektlari ana shu ramkalar ichida joylashgan bo'lishi 
lozim. Illyustratsiya oynasining qolgan maydoni ish stoli deb nomlanib. 
ulardan obyektlarni vaqtincha saqlash maqsadlarida foydalaniladi. 
Core1DRAW ish stoli o' lchami uning ekranda ko'rinib turgan qismidan 
ko'ra juda ham katta. Oynaning ko'rinmaydigan qismini ko'rish uchun 
o'ng va pastki tomonda ikkita prokrutkalar joylashgan. Gorizontal 
prokrutkadan chapda ko'p betli hujjatlarning alohida betlariga o'tish 
imkonini beruvchi (harakatlanish) tugma va yorliqlardan (betning nomi 
berilgan) iborat boshqaruv elementlar~ joylashgan. Ularni birgalikda 
navigator deb ataladi . 
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5.3-rasm. Open Drawing rriuloqot oynasi. 

ekanligini bilib olish uchun imkon beradi. CorelDRAW hujjatlarini 
saqlashda berilgan kalit sO'zlar yoki eslatmalar Keywords (K.llO'leSble 
cJ1osa) va Notes (3aMe1.faHHJI) maydonida paydo bo'ladi. 

Hujjatlarni yopish uchun esa File > Close buyrug' ini berish yoki 
ekranning yuqori o'ng burchagida joylashgan Close tugmasini bosish 
kerak. Shundan so'ng agar hujjat yaratilgandan keyin unda biror 
o'zgarish bo'lgan bo'lsa u holda hujjatni saqlash . yoki saqlamaslik 
haqida oyna chiqadi. Agar bu oynada )la tugmasi bosilsa, Save 
muloqot oynasi (hujjatni saqlash oynasi) paydo bo'ladi. Aks holda, HeT 
bosilsa, u holda hujjatdagi barcha o'zgarishlar saqlanmasdan o'chib 
ketadi. Bu ogohlantirish oynasida ikki tugma bilan birga uchinchi 
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tugma Cancel ham mavjud. Ayrim hollarda hujjatni bekitishga buyruq 
berilgandan so'ng muloqot oynasi avtomatik holda chiqqandan keyin, 
foydalanuvchining fikri o'zgarib yuqoridagi ikki holatdan birini 
emas, balki uchinchi holat. ya'ni hujjatga qaytib, ishni davom ettirishi 
mumkin. Buning uchun Cancel tugmasini bosish kerak. 

Hujjatni saqlash 

CorelDRAW hujjatini saqlash standart uskunalar panelidan Save 
(CoxpaHHTb) buyrug' ini berish orqali bajariladi. Agar avval bu hujjat 
saqlanmagan bo'lsa, ekranda 5.4-rasmda berilgan Save Drawing (Co­
xpaHHTh aOKYMeHT) muloqot oynasi paydo bo'ladi. 

Hujjatni saqlash uchun File name (HMJI $aHna) maydoniga fay I 
nomini kiritish, fay I saqlanishi kerak bO'lgan papkani tan lash va 
Save (CoxpaHHTb) tugmasini bosish kerak. Shuningdek Save (Co-

Qwl(a: ~ MoH 401(y"'~'fbl 

",~I 

0.1 .. 

-,' 00-

acIv .... od ... 

yorslan: 
Vf1s"on 12.0 .. 

T~: 

tor. (c;okw) 

":/tel> ...... -
~f""'.UIII'4T.-ll'M) 

5.4-rasm. Save Drawing muloqot oynasi. 

..!!.I 
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XpaHHTb) tugmasini bosishdan oldin muloqot oynasidagi Keywords 
va ~otes maydonchalariga kalit so'zlar v .. eslatmalami kiritib saqla.c;h 
ham mumkin (yuqorida aytilganidek ~'lIami ochish ~1ida bu 
ma'lumotlardan foydalanisb mumkin). 

Endi diqqatingizni ochiluvchi Versioa (aepcH_) ro'yxatiga qarating. 
Bu ro)'xatdan siz faylni CorelDRAWning avvalgi versiyalarida 
saqlamoqchi bo' lsangiz, u holda bu ro'yxatdan o'zingizga kerakli 
alternativ' v'ersiyani tanlashingiz kerak OO'ladi, Agar fayl anal 
saqlangan OO' lsa, u holda diskda tatuori) saqlashda S.,,'e Dn"'ing (Co­
XpaHHTb .J.oKy~eHT) muloqot oynasi ochilmasdan amalga oshiriladi. 
Agar faylning nusxasini olishingiz kerak bo"lsa, u holda uni boshqa 
papkaga saqlang. Options tugmasi saqlash rejirnining ikkinchi darajali 
funksiyalaridan iOOrat boshqaruv elementlarini ochish yoki yopish 
imkonini beradi. 

5.4. Sabifaning parametrlarini o'zgartirisb 

Yangi hujjat yaratilgandan sO'ng" gohida uning o'lchamin' o"z­
gartirishga to'g'ri keladi. Buning uchun atrib~tlar panelining ele­
mentiariga murojat qilinadi. Rasmda birorta ham obyekt bel­
gilanrnagan bo'lsa, u holda atributlar panelida sahifaning o'lcham­
larini o'zgartirishga imkon beruvchi elementlar paydo bo'ladi (5.5-
rasm). 

Qog'OZ fonnati Sagifa oriyentatsiyasi Ko'p qatorli huijst rejimi 

Sahifa o'lchami 
O' lchov birligi 

L\Ltl 1 1~ iH;fM:ftlbffl !lI:' I Flc: ' t~~-~I~ !J 
.. tf Z97.0mm .... n Ill! 

___ . III 210.0 mm ..... L:;J le;;::) II1:II lbts: mllh~ters .. 
r"'--- _ .. .. , ~ -~-

A4 

. ,2,54 mm ~ : ... M 6.3'5 mm 
. . .. . J , .y 6.35 mm ... .. ill ij) i ~[i ti T ci'~ q B= 

5.5.rasm. 8elgilangan obyektlar bo'lmagan holda atributlar panelining ko'rinishi . 

184 



Hujjatning chop etiladigan sahifa o'lchami atributlar panelining 
eng chap qismida joylashgan Paper Type/Size (THn/q,opMaT oYMa­
rH) bekiladigan ro'yxatdan tanlanadi. Chop etiladigan sahifaning 
o'lchami illyustratsiya chop etiladigan qog'ozning formatiga mos 
kelishi shart emas. Faqatgina illustratsiya qog'ozning o'lchamidan 
ortib ketmasa bo' ldi . Agar chop etiladigan sahifa o'lchami 
qog'ozning o'lchamidan kichik bo'lsa, u holda qog'ozning chetida 
toza bO'sh joy qoladi. Shuning uchun chop etiladigan sahifaning 
o'lcham ini bo' lajak illyustratsiya o' lchamidan (stand art qog'ozning 
o'lchamlaridan emas) kelib chiqib oldindan belgiJab olinadi. Agarda 
illyustratsiyaning o'lchami kichik bo'lsa, u holda bitta qog'ozga bir 
nechta nusxani joylashtirib chop etish maqsadga muvofiq. Bunga 
misol qilib, kichik taklifnomalar, tashrif qog'ozlarini aytish mumkin. 
Nostandart o'lchamda chop etiladigan sahifani yaratish uchun uning 
o"lchamlarini qog'oz formatlari rO'yxatidan o'ngda joylashgan Paper 
Width and Height (illHpHHa H BhlCOTa nJ-fCTa) maydoniga kiritiladi. 
Undan yana o'ngda esa chop etiladigan sahifaning orientatsiyasini 
(kitob yoki albom ko'rinishi) belgilashda ishlatiladigan Portrait 
(KHH)KHaSl) va Landscape (A.lbOOMHU) tugmasi joylashgan. Bu 
tugntalarda standart A4 qog'.Ozning tasviri nomiga mos ravishda 
vertikal va gorizontal kO'rinishda joylashtirilgan. Shuningdek 
Drawing Units (E..lHHHUbl H3MepeHHSI) ochiladigan ro'yxatdan 
CorelDRAWda koordinatani va o' lchamlarni aniqlash uchun o'lchov 
birligini o'zgartirish mum kin. 

5.5. CorelDRAWda oddiy shakllarni chizish imkoniyatlari 

To' g' riburchaklar chizish 

Yuqorida aytilganidek CorelDRAWda tasvirlar bilan ishlashning 
asosini obyektlar tashkil qiladi. Buni quyidagilarda ham ko'rish 
mum kin: bu dasturda foydalanuvchi tomonidan bajarishi lozim bo' lgan 
barcha grafikli obyektlarni ikkita kategoriyaga ajratish mumkin -
chiziqlar va belgilar (matnlardan tashqari). 

Berilgan obyektlardan eng chapda - «K.1aCCHK» to'g'ri burchak. 
To'g'riburchaklar yaratilgandan keyin aynan shunday namoyon bo' ladi. 
Ikkinchi obyekt esa yaratilganidan keyin 45° ga burilgan ko'rinishi. 
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5.6-rasm. TO'g'riburchaklilar sinfi elementlari. 

Uehinchi obyektda esa yaratilgandan key in, to'rttadan uehta burchagi 

dumaloqlangan. 
Agarda sizda biror chizilgan obyektning qaysi tipga tegishliligiga 

shubha o·yg'onsa. u holda o'sha obyektni siehqoneha yordamida 
belgilang va holat qatoriga qarang. Holat qatorida Rectangle on 
Layer 1 (rIpSlMoyrolIbHHK Ha elIoe 1) xabari paydo bo'lsa, u holda 
uning to'g'riburehaklar sinfiga tegishli ekanligiga heeh qanday shubha 
qolmaydi. CorelDRAWda barcha primitivlar tegishli uskl.8lalar 
yordamida quriladi. Yuqorida biz uskunalar paneli bilan tanishib 
chiqdik. Shuningdek uskunalar orasida Rectangle (ITpSlMoyrOJIbHHK) 
tugmasini ham ko'rib o'tdik. Endi shu uskuna yordamida birinehi 

obyektimizni quramiz. 

To'g'riburehak ehizish 

Ushbu mashqni bajarish bilan biz to'g'riburchak qurishning asosiy 
imkoniyatlari va shu bilan birga CorelDRAW 12 ish muhitining 
qO'shimeha elementlari bilan tanishamiz. 

1. Yangi hujjat yarating. Bu mashqni bajarish uehun ixtiyoriy 
o'\Chamdagi sahifa qog'ozini olish mumkin. 

2. Uskunalar panelidan Rectangle (ITpSlMoyrollbHHK) uskuna tug­
masini bosing. Shundan keyin sichqon ko'rsatkichi ekranda krest 
shakliga o'tib, uning oldida to'g'riburchak ham paydo bO'ladi (S.7-rasm). 
Bu esa ayni vaqtda to'g'riburehak chizish uskunasi faolligini bildiradi. 

Rectangle (ITpSlMOyroJIbHHK) uskunasini boshqa yo'l bilan ham 
faollashtirish mumkin, masalan, sahifaning bo'sh joyida sichqonehaning 
o'ng tugmasini bosish va kontekstli menyudan F6 buyrug'ini oling. 
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Ramkali belgilash markerlari 

I ,- ~ ~ 
a ~ 

. : 
Obyekt markazidagi marker 

Icr----+I.-

• • ·1 Obyekt uzeli 

-' Rectangle uskunasi uchun 
'0 sichqoncha kO'rsatkichi 

Rectangle on Layer I 

5. 7-rasm. Belgilangan to'g'riburchak \la holat qatoridagi xabar. 

'ro'g'riburchak chizishda °diqqatingizni holat qatoriga qaratsangiz, 
u yerda chizilayotgan to'g'riburchakning bo'yi va eni o'lchamlari 
(pikselda) ko'rsatiladi. Ekranda e!>a chizilayotgan to'g 'riburchakning 
doimiy o'zgarib borayotgan ko'rinishi tasvirlanadi. Holat qatorida 
esa yuqorida aytilganidek uning o'lchamlari to' x.tovsiz o'zgarib 
borayotganini ko'rishingiz mum kin. Chizilayotgan to'g'ri burchak 
foydalanuvchi xohlagandek yuzaga ega bo'lganda sichqoncha tugmasi 
qo'yib yuboriladi. Bunda esa to'g'riburchak shu ox.irgi o-lchamdagi 
holatda ekranda paydo bo'ladi. Sichqoncha tugmaslnl qo'yib 
yuborgunga qadar to'g'riburchak bo'yi va enini o'zingiz xohlagandek 
o'lchamga yaqinroq qilib chizib olishingiz mumkin. 

Ellips uskunasi (Ellipse) 

Ellips uskunasi ellipslar va aylanalac chizish uchun mo'ljal\angan. 
Ellips o'ziga tashqi chizilgan to'rtburchak bucchaklaridan bosh lab 

chiziladi. Ellipsni chizish uchun markazda <Shift> tugmasi, aylana 
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uchun <Ctrl> bosilishi lozim. Obyekt xossalari paneli yordamida ellips 
parametrlarini o'zgartirish mumkin. Ellips tugmachasining yuqori 
qismidagi belgi orqali ellipsning tipini tan lash mumkin. Ellips, Sektor, 
Yoy tugmalari xossalari uskunalar qatorida qaytariladi. 

Uchta uskuna, kO'pburchak (MHoroyro.'1bHHK), Spiral (CnH­
paJlb), Koordinata sahifasi (Pa3J1HHoBaHHaR 6YMara), obyekt guruhiga 
yig'ilgan bo'lib uskunalar panelidan alohida panel ko'rinishida ajratish 
mumkin. 

Spiral uskunasi 

Spirallar yaratish uchun mo'ljallangan yoki uzluksiz egri chi­
ziqlar shaklidagi geometrik shakllarni chizish mumkin. Spiral 
chizish jarayoni to'rtburchak chizish jarayoni bilan bir xiI. Faqatgina 
foydalanuvchi semetrik va logorifmik tugmalar orqali spiral turini 
tan lash mumkin. Muntazam spiral yaratish uchun Ctrl tugmasini bosib 
turish kerak. Spiral parametrlarini atributlar panelidan o'zgartirish 
mumkin. • 

Savol va topshiriqlar: 

I. Dasturda kvadrat chizish uchun qaysi stand art tugma bosiladi? 
2. To'g'ri to'rtburchak uskunasi yordamida nimalar chizish mumkin? 
3. Dasturda geometrik figuralar qanday yaratiladi? 
4. Kontur va tayanch nuqtalar haqida ma'lumot bering? 

5.6. COREL DRAW dasturida murakkab cbiziqlar va shakllar 

Egri chiziqlar guruhi uskunalari (Curve) 

rj(rII!'F~ Egri chiziqlar guruhi usku-
II f l Ilfl W I' I'd 'd' k na an pane I a qUYI agl us u-~ '< ~ ~ ~ nalar bm: Chizish (Freehand), Bez', 

(Vezier), Pero (Natural Pen). Chiziq 
o'lchami (Dimension), Bog'lovchi chiziq (Connector Line) va Bog'lovchi 
(Connector). 
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KO'pburchak uskunasi (MHoroyroJIbHHK) 

KO'pburchakni kerakli tomonlarga ega bo'lgan geometrik obyekt 
sifatida tushunish mumkin . KO'pburchakning bir varianti sifatida 
yulduzchani olish mumkin. Bunda ichki chizilgan kO'pburchakni 
maydonini kesib o·tadi. KO'pburchakni yoki yulduzchani chizish 
to'rtburchak chizishdan farqi yo'q. Ctrl tugmasini bosib turgan holda 
muntazam kO'pburchak chiziladi. Ko'pburchak parametrlarini atributlar 
paneli orqali o'zgartirish mumkin. 

KO'pburchak belgisini tan lab atributlar panelida uning qirralar 
sOllini kiritish mumkin. Qirralar o'tkirligi maydonida shartli birliklarda 
qirraning o'tkirlik darajasini kiritish mumkin. 

Koordinata qog'ozli uskunasi (Pa3.1HHOBaHHaJI 6YMara) 

Kordinata qog'ozli uskuna berilgan parametrli panjara yaratish 
imkonini beradi. Bunday panjarani grafiklar yoki diagrammalar uchun 
koordinatali asos qilib olish mumkin. Bu instrument parametrlarini, 
parametrlar muloqot oynasida koordinatali qog'oz bo'limida o'zgartirish 
mum kin. Katakchalar soni maydonida eniga (Number of cells wide) 
bo't'iga (Number of cells high.) ko'ra katakchalar miqdorini o'zgartirish 
mumkin. Kvadrat katakchaIi panjaralarni tayyorlash uchun <Ctrl> 
tugmasini bosib turish kerak. 

Chizish uskunalari (Freehand) 

Chizish uskunalari istalgan chiziqlarni chizish uchun mo'ljallangan. 
Bu uskuna ishi natijasida vektorli kontur hosil bo'lib, bu kontur tayanch 
nuqtalari dastur yordamida avtomatik qo'yiladi. Bu konturlar ustida 
erkin tahrirlash imkoni mavjud. Bu uskunalarda chizayotgan paytda 
chiziqlar qalinligi va rangini o'zgartirish mumkin. 

Chizib bo'lingan chiziqni istalgan paytda davom ettirish mumkin. 
Buning uchun kursorni uning oxirgi nuqtasiga olib kelib (kursorning 
egri chiziqlari ko'rsatkichga aylanadi), sichqoncha chap tugmasini 
bosgan holda chiziqni davom ettirish hamda chizish uskunalari 
yordamida to'g'fi chiziq chizish mumkin. 

lie3be uskunasi yordamida maksimal aniqlik va maksimal rat­
sionallik bilan ixtiyoriy konturni yaratish mumkin. Bu uskuna 
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foydalanuvchini grafik dizaynda barcha narsani ha) qiluvchi Forma 
yaratuvchisiga aylanishiga imkon beradi. 

To'g'ri chiziqli segmentiar tuzish 

To'g'ri chiziq yaratish uchun lielbe uskunasi qulay keladi. Buning 
uchun lie3be uskunasini tan lash kerak. Kursorni boshlang'ich nuqtaga 
olib kelish va sichqonchaning chap tugmasini bosish kerak. Tugma 
bosilgan joyda segmentning boshlang'ich tayanch nuqtasini ifodalovchi 
qora nuqta paydo bo·ladi. U keyingi nuqta yaratilgunga qadar faol bo' lib 
turadi. So'ng kursorni keyingi nuqta joylashadigan yangi joyga olib 
o'tish kerak. Ikki nuqta to'g'ri chiziq bilan tutashadi. 

Tayanch nuqtalarning turlari 

Bir necha segmentlarning tutashishida tayanch nuqtalari Corel Draw 
dasturida uch tipli bo'lishi mumkin: 

1. Ikki egri chiziqni «bukilishda» tutashtiruvchi tayanch nuqtasi 
- burchak tayanch nuqtasi deyiladi. Bunday tayanch nuqtasida boshqa­
ruvchi chiziqlar ham yo'nalishi ham uzui11igi bO'yicha mustaqildir. • 

2. Ikki egri chiziqni sinishsiz tutashtiruvchi tayanch nuqtasi - silliq 
tayanch nuqtasi deyiladi. Bunday tayanch nuqtalarda boshqaruvchi 
chiziqlar bir-biridan faqat o'lchami bilangina mustaqil, yo'nalishi 
bO'yicha esa umumiy tutashuvchi to'g'ri chiziqni tashkil qiladi. 
Boshqaruvchi chiziqlardan birining o'rin almashishi ikkinchisining ham 
o'rin almashishiga olib keladi. 

3. Sinishsiz va bir xii qiyalik bilan tutashgan tayanch nuqtasi 
simmetrik tayanch nuqtasi deyiJadi. Bunday tayanch nuqtalarda 
boshqaruvchi chiziqlar bir-biriga YO'nalishi bilan bog'liq bo'ladi. 

Savol va topshiriqlar: 

I. Egri chiziqlar guruhi uskunalari panelida qanday uskunalar bor? 
2. Dasturda kO'pburchaklar qanday yaratiladi? 
3. Koordinata qog'ozli uskunasi (Graph Paper)ning imkoniyatlari? 

S.7. COREL DRAW dasturida rang)ar bilan isblasb 

Imitatsiya uskunasi nuqtali grafika dasturlarida ko'proq ishlatiladi. 
Shunga qaramay vektorli dastur ham bu uskunani taqdim etadi. Bu 
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uskuna orqali Peroda chizish o'rnini bosa oladi, shu bilan birga bezakli 
shtamp o'rnini ham bosadi. Bu uskunaning ajoyibligi shundaki u asosiy 
konturni chizib. bu kontur bO'ylab turli obyektlar joylashib manzarali 
va grafik effektlarni beradi. 

!\'amuna rejimida shunday obyektlarni yaratish mumkinki, bunda 
bu obyektlar tayyor namunalarga qarab o'z shaklini o'zgartiradi. Bu 
rejimda shaklli chiziqlarni ishlatish mumkin. 

Muyqalam rejimi (Brusb) - bu rejimda murakkab tuzilishga ega 
bo"lgan bezakli shakllarni yaratish mumkin. 

Purkagicb rejimi (Object Sprayer) kontur trayektoriyalari bo'ylab 
turli grafik obyektlarni joylashtiradi. Bu rejim murakkab ramkalar. 
bezakli qatorlarni yaratish uchun mo'ljallangan. 

Kalligra6ya rejimi (Calligrapbic) - bu rejimda qalin pero yoki 
enli muyqalam egri chiziqlarini chizish mumkin. 

Rgessure rejimi - bu rejimda shunday chiziqlarni chizish mum­
kinki bu chiziqlarni klaviatura orqali boshqarish mumkin. 

Xossalar uskunalar qatorida bu rejim tanlansa quyidagi para­
metrlarga ega bo'lamiz: tekislash maydoni (Freehand Smoothing) asosiy 
chiziqni 0 dan 100 diapazonigacha tekislash imkoniyati (rasmda 1 
raqcllni bilan ko'rsatilgan). 

O'lcham maydoni (Size) (2 raqam) bezakli shtrixlarning o"lchamini 
foizlar hisobida o'zgartish imkonini beradi I dan 99% gacha. 

Obyektlar ro'yxati maydoni (3 raqam) - bu rO'yxatda turli for­
matdagi purkaladigan obyektlarning namunalari keltirilgan. 

Save tugmachasi (4 raqam) muyqalam rejimida ish yuritish bilan bir 
xiI. 

O"chirish tugmachasi (Delete) rO'yxatdagi xohlagan variantlardan 
birini o·chiradi. 

h ; 0 ~ /: ., .. ~:: ~ III ~ -_'~I.""" v 
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5.B-rasm. Property Bar paneli. 
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Purkash tartibi (Srau Order) obyektning kontur bo'ylab joylashish 
ro'yxatini taqdim etadi: tasodifan (Ramdom), ketma-ketli (Sequentially), 
yo'nalish bo'ylab (By Direction). 

Obyektlar ro'yxatiga qo'shish tugmasi (Add to SprayList) 
obyektlar ro'yxatiga yangi elementlarni qo'shish imkoniyatini beradi. 
U1ardan keyinchalik «Ijrochi» qatorini (play list) tashkil qilish 
mum kin. 

192 

Savol va tops/ririqlar: 

1. Imitatsiya uskunasi (Artistic Media) - deganda nimani tushunasiz? 
2. Kalligrafiya rejimi (Calligraphis)da qanday chiziqlarni chizish mum­

kin. 
3. Obyektlarni purkash nima? 
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VI-bob. FLASH DAST{;RI HAQIDA 

Flash MX - Web sahifalaridagi animatsiyalar, bezaklar va 
boshqa manbalarni o'z ichida saqlagan yuqori darajali dizaynlar 
yaratish uchun mo' ljallangan dasturiy vosita hisoblanadi. Flash MX 
dasturi Yllqori darajadagi imkoniyatlari mavjud bo'lgan texnologik 
vositalar sirasiga kirib unibir so' z bilan Flash texnologiyasi deb 
atashimiz mumkin. Flash texnologiya yordamida animatsiyalar, 
Web-saytlar va ular uchun bannerlar, har-xil multimediali prezen­
tatsiyalar yaratish mumkin. Flash texnologiyasi yordamida yaratil­
gan turli loyiha va mahsulotlar - har doim harakatni yorqin aks 
ettiri~, undagi tovush va vid.eo ko'rinishlar Internet loyihalarida 
harakatliligi bilan ajralib turadi. Shuning uchun bu texnologiya 
yordamida saytlar yaratish imkoniyati juda yuqori [5], [6], [7]. 
Lekin Flash texnologiyasining Internet tizim ida ishlashda ayrim 
kamchiliklari mavjud . lumladan: 

1. Flash elementlarini saytda tasvirlab berish uchun. brauzerda 
Flash-player o'rnatish zarur. Internet Explorerda esa dastlabki o'r­
natishdan keyin Flash-player o'rnatiladi. Agarda siz boshqa brallzerlarni 
qo'llaydigan bo' lsangiz, u holda Flash":playerni o'rnatishga to'g'ri keladi . 

2. Flash-saytlari HTML saytlariga qaraganda katta hajmni egal­
laydi , shuning uchun ularning yuklanishi birmuncha sekin. 

3. Flash-texnologiyani kO'pincha reklama maqsadida qo'lIaniladi . 
Shllning uchun informatsion portallarda qo'llashga tavsiya qilinmaydi . 
Chunki bunday portallar hajmi juda kattalashib ketadi. 

4. Flash-saytni yaratish biroz mehnat talab qiladi. Shuning uchun 
ham bunday saytlarning narhi, HTML saytlar narhiga qaraganda ancha 
yuqori baholanadi. 
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Ayrirn hollarda juda chiroyli saytlar o'zining tashrif buyuruvchilarini 
vaqtning hisobiga YO'qotadi. Ya'ni sayt kornpyuter ekranida to'liq 
tasvirlanib bo'lgunga qadar ketgan vaqtning evaziga foydalanuvchilarni 
yo·qotadi. Ammo bunday saytlar har qanday foy~alanuvchini o'zining 
yuqori darajali grafikasi, ko'pqirrali imkoniyatlari, rang-barangligi 
bilan foydalanuvchilarning asosiy qismini yo'qotgani yO"q. Natijada 
Flash dasturi Web - ish lab chiquvchilar orasida o'zining keng qamrovli 
o'rniga ega bo'lib bormoqda. 

Flash usulida tayyorlangan prezentatsion saytlar yuqori darajadagi 
grafik almashinuvlar, boy interfaol g'oyalari va rasmlarning yuklanish 
tezligi yaxshiligi bilan tashrif buyuruvchilarda katta taassurot qoldiradi. 
Bundan tashqari harakatlanuvchi panellar, dinamik harakatlar. 
sinxron tovushli kliplar ham har qanday foydalanuvchini diqqatini 
o'ziga tortadi. Siz xattoki informatsion sayt yaratayotgan bo' lsangiz 
ham. flash-texnologiyani qisman qO'lIash yo'li bilan ham, tashrif 
buyuruychilaringiz uchun yaxshi taassurot qoldiradigan Internet resurs 
yaratishingiz mumkin . 

Cmumiy ma'lumot va"j'ordamchi jihozlar • 
Flash dasturi bilan tanishishni boshlaymiz. Bu yerda roliklar ustida 

ish olib boradigan oynani kO'rish mumkin, shuningdek uskunalar 
paneli va bir necha yordamchi panellar mavjud. Bu yordamchi panellar 
obyektlarning turli xossalarini tanlashga yordam beradi (masalan, rang, 
qalinligi va kontur ko'rinishi va boshqa xususiyatlar). Flash dasturi 
boshqa dasturlar kabi o'zining yorlig'iga ega. 

Savol va topshiriqlar: 

I. Flash qanday tip dasturlarga kiradi? 
2. Flash dasturidan nima maqsadlarda foydaJanish mumkin? 
3. Flash texnologiyasini Internet tizimida ishlashining qanday kam­

chiliklari mavjud? 
4. Flash saytlari oddiy saytlardan nimasi bilan farqlanadi? 

6,1. Flash MX dasturining oynasi qismlari 

Flash dasturi oynasi bir nechta qismdan iborat . Ular bilan 
tanishib chiqamiz. Dastur oynasining asosiy qismlaridan biri uning 
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6.1-rasm. Flash daslUri oynasi ko·rinishi. 

ish maydonidir. Ish maydonida biz obyektlarni chizish, tahrirlash, 
hara~atlantirish imkoniyatini "amalga oshiramiz. Undan yugorida 
esa - vaqt diagrammasi yoki vagt shkalasi (timeline) joylashgan (6.1-
rasm). 

Uskunalar paneli 

Uskunalar paneli rasmda kO'rsati]gandek to'rt gismdan iborat. 
Yuqoridagi qismida Tools (uskunalar) obyektlarni yasash (chizish) va 
ularni transformatsiyalaydigan uskunalar joylashgan. Keyinroq ular 
bilan batafsil tanishib chiqamiz. Keyin tasvirni Viev (BHA) boshqaruvchi 
uskunalar keladi: bu qo'l (Hand tool) rasmi va lupa (Zoom tool). 

Lt' ~ < D "\) ~ ~ CJ t~ cf 

k ,,-aO ~ D~'-. l ~ 

6.2-rasm. Tools uskunalar paneli. 
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Bu uskunalar boshqa dasturlarda ham tez-tez uchrab turadi. Qo'l 
uskunasi yordamida ishchi sohani ko'chirish mum kin. Lupa uskunasi 
yordamida kattalashtirsa yoki kichiklashtirsa bo'ladi (kichraytirish 
uchun ishchi sohada ALT tugmasini bosish kerak). Bu uskunalar faqat 
rolik tasvirini boshqaradi uning mazmuniga ta'sir o'tkazmaydi. 

Endi dastur oynasining navbatdagi qismlari bilan tanishib chiqamiz. 

Vlar quyidagilar: 
Yorliq qatori: dastur nomi va faol fayl nomini tasvirlab turadi. 

Dasturning gorizontal menyu qatori 

Flash MX dasturining gorizontal menyu qatori quyidagilardan 
iborat: File, Edit, View, Insert, Modify, Text, Control, Window, Help. 
Endi menyulardagi asosiy buyruqlar k.etma-ketligi, ularning vazifalari 
va ularning mos funksional tugmalar bilan tanishib chiqamiz. 

6.1-jadval 

File menyusi illJyruqlari • 
Buyruqlar tugmalar (Windows) 

New Yangi film <Ctrl>+<N> 

Open Ochish <Ctrl>+<O> 

Close Yopish <Ctri>+<W> 

Save Saqlash <Ctrl>+<S> 

Import Import qiHsh <Ctrl>+<R> 

Export Movie Eksport qilish <Ctrl>+<Alt>+<Shift>+<8> 

Publish Settings Nashr o' lchamlari <Ctrl>+<Shift>~<FI2> 

Publish Preview Nashrni ko' rish <£12> 

Print Chop etish <Ctrl>+<P> 

Exit Dasturdan chiqish <Ctrl>+<Q> 
-
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davomi 

100% 100% <Ctrl>+<l> 

Show Frame kadrni kO' rsatish <Ctri>T<2> 

Show All hammasini kO'rsatish <Ctrl>+<3> 

Outlines Konturiar <Ctrl>+<Alt>+<Shift>+<O> 

Fast - tez <Ctrl>+<Alt>T<Sh ift>+<f > 

Timeline vaqt diagrammasi <Ctrl>+<Alt>T<T> 

Work area ish maydoni <Ctrl>+<Sh ift>+<W> 

Rulers chizgoich <Ctrl>+<Alt>+<Shift>+<R> 

Hide Edges qirrani bekitish <Ctrl>+<H> 

Hide Panels panelni bekitish <Tab> , 

6../-jadva/ 

lnsert menyusi buyruqla r i 

Buyruqlar t ugma lar (Windows) 

Convert to Symbol simvolni holatini o'zgartirish <F8> 

New Symbol yangi simvol <CtrJ>+<f8> 

Frame kadr - <F5> 

Remove Franles kadrlarni o'chirish <Shift>+<F5> 

Keyframe bog' langan kadr <F6> \ 

Blank Keyframe bo'sh bog' langan kadr <F7> 

Clear Keyframe bog' langan kadrni o'chirish <Shift>+<F6> 

Create Motion Tween harakat hosil qilish 
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6.5-jadval 

Modify menyusi buyruqlari 

Buyruqlar tugmalar (Windows) 

Layer ... qat lam parametrlari <Ctrl>+<F> 

Scane ... sahna parametrlari <Ctrl>+<M> i 
I 

Document hujjat parametrlari <Ctrl>+<Alt>+<Sh i ft>+<C> 
.. . 

Transform kO'rinishni o'zgartirish -

Scale o' lchamni o'zgartirish <Ctrl>+<A It>+<S> 
uchun belgilash 

Rotate Burish 

Frames kadrlar llstida amallar 

Lock bekitish (qulflash) <Ctrl>+<Alt>-r<L> 

Unlock All bekitish (qu lflash)ni bekor <Ctrl>T<A It>+<Shi ft>+<L> 

• qilish ~ 

Group Guruhlash <Ctrl>+<G> 

Ungroup guruhni bo'laklash <Ctrl>+<Shift>+<G> 

6.6-jadl'Ul 

Text menyusi buyruqJari 

Buy ruqJar tugmaJar (Windows) 

Font shriftni o'zgartirish -

Size shrift o'lchamini o'zgartirish <Ctrl>.l.<Shift>+<B> 

Style shrift stilini o'zgartirish <Ctrl>+<Sh ift>+<I> 

Align matnni tekislash -

Scrollable markerni o' rnatish <Ctrl>+<Sh i ft>+<C> 
--
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6.7-jadval 

eo.trol mcuyui nyraqa.ri 

Bayruqlar t ..... lar (Windows) 

Play ijro etish <Enter> 

Test Movie filmni ko'risb <Ctrl>"""<Enter> I 
Test Scene sahnani namoyish qilish <Ctrl>T<A It>-<Enter> , 

-

6.8-jadval 

WiBdow meoyusi buyruql.ri 

Buyruql.r tagm.tar (Wiadows) 

~ew Window yangioyna <Ctrl>+<A 1t>~<N> 

Toolbars Pane liar -
Tools ma'lumot -- <Ctrl>+<Alt>~<!~ 

Timeline tekislash • <Ctrl>..-<K> 

Propenies belgi <Ctrl>-+<T> 

Actions Protseduralar <Ctrl>+<Ah>~<A> 

Movie Explorer filmlarni boshqaruvi <Ctrl>+<AIt>..,.<M> 

Library Kutubxona <Ctrl>+<L> 
-----

6.9-jadval 

Help meoyusi buyruql.ri 

Buyruqlar tugm.lar (Windows) I 

What's new Yangi imkoniyatlar -
Lessons Flash bo'yicba darslar 

. 
-

Using Flash Yordam ma'lumotlari Fl 

Samples Flash faylga misollar -
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Buyruqlardan foydalanishni tegishli bo'limlarda batafsil ko'rib 
chiqamiz. 

Vaqt diagrammasi 

Ish maydoni llstida vaqt diagrammasi (Timeline) paneli joyJashgan. 
Vaqt diagrammasi, filmning aniq sahnalashtirilishiga xizmat qiladi. 
U yaratilgan qatlamlarni alohida-alohida sahnaga yozib qO'yishni 
ta'minlaydi. Sahllada namoyish qilinadigan obyektlarning o'zgarishi 
ketma-ketligini ifodalaydi. Vaqt diagrammasi shuningdek animatsiya 
yaratishda, film interfaol elementlari xatti-harakatini belgilashda asosiy 
uskuna hisoblanadi. Vaqt diagrammasi murakkab tuzilishga ega bo' lib, 
ko'p sonli boshqaruv elementlaridan iborat. Vaqt diagrammasi panelida 
quyidagi umumiy elementlar berilgan (6.3-rasmda): 

• filmning mavjud sahnasi uchun qatlamlar ro'yxati (ustma-ust 
ustun ko'rinishida) kO'rsatilgan. Qatlamlarning nomi va atributlari 
kO'rsatilgan: 

• vaqt diagrammasi har bir qatlam uchun kadrlar shkalasidan 
iborat; 

• "aqt diagrammasidagi kadrlarni formatini o'zgartirishning yig'ma 
me~yusi; 

• filmning ayrim parametrlarini ifodalaydigan vaqt diagrammasidagi 
holat qalori mavjud. 

Vaqt diagrammasining kadrlar shkalasi bilan tanishib chiqamiz. 
Shkala sahnaning barcha qatlamlari uchun umumiy bo'Jib, ammo har 
bir qatlam o'zining kadrlar qatoriga ega. Unda kadrlar o'sish tartibida 

6.3-rasm. Vaqt diagramrnasi. 

201 



nomeriangani tasvirlangan. Nomerlanish har 5 qadamda berilgan bo·lib. 
kadrlarning har qanday formatida o'zgartirib bo'lmaydi. 

Vaqt diagrammasi ko'rsatkichi (Play head) animatsiyaning faol 
kadrini ko'rsatadi. Qaysi kadr sichqon yordamida tanlansa. o'sha kadr 
ustida ko'rsatkich paydo bo'ladi. KO'rsatkich faol kadrning nomerini 
kO'rsatib turadi. Bu esa animatsiyaning tasvirlanayotgan jarayonga 
sinxronligini ta·minlaydi. 

Kadrlarni formatlash menyusidagi buyruqlar kadrning katakchasini 
gorizontal bo'yicha o' lchamini belgilaydi: Tiny (mayda); Small (kichik); 
Normal (odatdagi); Medium (o' rta); Large (katta). 

Boshqaruv elementlari paneli (Properties) 

Yuqorida boshqaruv elementlari panelida berilgan ma'lumotlarga 
qo'shimcha ravishda quyidagilarni aytish mumkin: 

• matnli maydonda VRL ish maydoni matnli qismini belgilaymiz 
va shu maydonda to'liq Web-manzilni kO'rsatamiz (URL - Universal 
Resources Locator). Bog'langan resurs uchun siz haqiqiy giperhavelaga 
ega bo'lasiz; 

Boshqa vizual tahrirlagichlardan farqli tomoni. gipermatn namoyish 
vaqtida ostiga chizilgan shrift bilan emas balki, shtrixli chiziq bilan 
beriladi. Flash texnologiyada giperhavola hosil qilishning ikkita 
kamchiligi bor: birinchidan. URLni noavtomatik (qo'lda) yo'l hilan 
kiritiladi va ikkinchidan, Flash URLning xatto lokal fayllar uchun 
aniqligini tekshirmaydi; 

• Target (U,eJleBoH) ro'yxati; u resursni qanday hrauzer oynasida 
namoyish qilinisbini (yuklanishini) ko' rsatishda qo' llaniladi (ko' r­
satilgan URL bo'yicha chaqirilgan resursni) . URL maydoniga hech 
bo' lmaganda bitta simvol kiritilgandan key in rO'yxat faollashadi , 
ya'ni o'nga murojaat qilish mumkin . RO'yxat quyidagi variantlardan 
iborat (ular HTML tilining TARGET atributi qiymatlari bilan 
o'xshash): 

o - blank - chaqirilayotgan hujjat har cloim yangi oynada yuklanadi 
(as] oynaning o'zida emas); 

o - self - chaqirilayotgan bujjat xuddi shu oynaning o'zicla yuk­
lanadi (qaysiki havola o'rnatilgan oynaning o'zida); 
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o - parent - chaqirilayotgan hujjat bosh oynada yuklanadi; agar 
bu oyna bosh oynaga ega bo'lmasa, u holda yuklanish xuddi self 
kO'rsatkichidagidek OO'ladi; -

o - top - chaqirilayotgan hujjat eng yuqori qismdagi oynada yuk­
lanadi (agar ushbu oynaning o'zi eng yuqori qismda OO'lsa, u holda _ 
self kO'rsatkichdagidek yuklanadi); 

• Selectable (Bbl.l.e;l:.IIeMblH) tugmasi: bu tugma xuddi bayroqchadek 
qo' lIaniladi: tugmani bosish bilan matnga tegishli xususiyatlar panelini 
o'rnatish yoki aksincha o'rnatilgan bo'lsa uni bekor qiladi; 

• Change Direction of Text (matn yO'nalishini o'zgartirish) foyda­
lanuvchi menyuni ochib matnning yo'naJishini tanlab olishi mumkin : 
gorizontal yoki vertikal. Menyu o'z ichiga quyidagi uchta buyruqni 
oladi: 

o Horizontal (rOp1130HTa.lb); 
o Vertical, Left to Right (BepTHKaJIb. chapdan o'ngga); 
o Vertical, Right to Left (BepTl1Ka.'Ib, o'ngdan chapga); 
Matnning vertikal YO'nalishini o'rnatishda formatlashning tugmalar 

tarkibi o'zgaradi va undan tashqari Rotation faollashadi : 
• Rotation (bur ish) tugmasi bayroqcha vazifasini bajaradi va 

mat~dagi simvol joylashuv holatini o'zgartirishni ta'minlaydi: 
• Use De\'ice Font belgisi - agar belgi o' rnatilgan bo'lsa, Flash -

pleyerda filmni namoyish qilish mobaynida o'quvchining brauzeri uchun 
o'rnatilgan shriftlar qo'llaniladi. Bu film fayli o'lchamini kichraytiradi 
va kichik shriftning qulay o'qilishini ta'minlaydi. 

Xususiyatlar paneJi o'ng chegarasi yaqinida Format (lI>opMaT) 
tugmasi joyJashgan. Uni bosish bilan, qo'shimcha muloqot oynasi 
ochiladi va undan foydalanib matn maydonini formatlash parametrlarini 
o' rnatish mum kin. 

Format Option oynasi to'rtta matnli maydondan tarkib topgan: 
• Indent - yangi qator uchun abzatsning o'lchami (pikselda); 
• Line Spacing - yon atrofdagi qatorlar bilan joylashuvi (satrlar 

orasidagi interval): vertikal matnlar uchun bu parametr matnning 
ustunlari orasida beriladi: 

• Left Margin (chap maydon) - matn maydonining chap chegarasi 
va qatorning birinchi simvoli orasidagi masofa; 
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• Right Margin (o'ng maydon) - mato maydonining o' ng tomon 
chegerasi va qatorning oxirgi simvoli orasidagi masofa. 

Format Option muloqot oynasi matn maydonining har qanday 
ko'rinishi uchun o·rinli. 

Dasturning ish maydoni va uning ko'rsatkichlarini o'zgartirish 

Agar ishchi maydonida birorta ham obyekt tan lab olinmagan bo' lsa 
yoki umuman mavjud bo' lmasa, u holda boshqaruv paneli xossalari 
filmning umumiy parametriarini ko'rsatadi . Qandaydir obyektni 
olsangiz uning formati avtomatik ravishda o'zgaradi. 

• Document (,lJ,oKYMeHT) matn maydoni, tahrirlanadigan fay I nomi 
tasv irlanad i; 

• Size (Pa3Mep) tugmasi , ish stoli o' lchamini tasvirlab beruvchi 
tugma; 

• Publish (TIy6JlHKaUHJI) tugmasi; uni bosish bilan avval o' rnatilgan 
parametrlar asosida film nashrini boshlaydi; 

• Background ($OH) tugmasi; unibosish bilan filmning fon ~ngini 
tan lash palitra oynasi hosil bo'ladi. Shu oynadan filmning kerakli foni 
rangi tanlab olinadi; 

• Frame Rate (CKOPOCTL KaD:poB) matnli maydon, animatsiyaning 
kadrlar almashish tezligini belgilaydi; 

• ? (so' roq) belgisi tasvirlangan tugma HTML-formatidagi kontekst­
li ma'lumotnomani chaqirib beradi; 

• Yulduzchalar tasvirlangan tugma. Bu tugmani bosish bilan 
Accessibility (,lJ,ocTynHocTb) panelini ochiladi. Bu panel filmning 
barcha elementlari uchun qo'shimcha xususiyatlarni o' rnatishga mo' ljal­
langan. 

Ish maydoni oynaning butun markaziy qismini egallaydi. Ish 
maydonida obyektlar ustida har qanday tahrirlash ishlarini amalga 
oshirish mum kin. Faqatgina montaj stolining tegishli kadriga obyektlar 
mos kelsa maqsadga muvofiq bo'ladi. Ish maydoni keng bO'lishidan 
maqsad: 

• sahnadan tashqari ishlarni bajarish; 

• obyektni sahnaga kirishidan oldin yoki chiqib ketgandan key ingi 
holatlarni hosil qilish uchun zarur bo' ladi; 
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• ish maydoni ostida unga tegishli uskunalar paneli joylashgan. 
Unda quyidagi interfeys elementlari joylashgan: 

• strelkali tugma butun sahnani tahrirlash rejimiga qaytishni 
ta'm inlaydi; agar siz alohida simvol ustida tahrirlash rejimida ish­
layotgan bo'lsangiz. tugma faollashadi; 

• tahrirlanadigan sahna nomli matnli maydon; 
• sahnani tan lash tugmasi; bu tugmani bosish bilan film sah­

nalaridan tashkil topgan ro'yxatli menyu ochiladi; 
• simvolni tanlash tugmasi; bu tugmani bosish bilan film tugma­

laridan tashkil topgan ro'yxatli menyu ochiladi; 
• masshtab, uning yordamida ish maydonini tasvirlash masshtabi 

tanlanadi. 
Ish maydonining ixtiyoriy joyida sichqon o'ng tugmasi bosilsa, ish 

maydonining parametrlarini o'zgartirishga mo'ljallangan buyruqlar 
to'plamini o'z ichiga olgari kontekstli menyu ochiladi. Bu menyu 
hammasi bo'lib yigirmaga yaqin buyruqlarni o'z ichiga oladi. 

Scene paneli yordamida siz quyidagi imkoniyatJarga ega bo'lasiz: 
• filmning sahnalari rO'yxatini ko'rish; sahnalarning filmda na­

moyish qilinish ketma-ketligi; 
\ filmning rO'yxatidagi har.qanday sahnasiga o'tish; 
• tanlangan sahnadan nusxa olish (asl sahnadan keyin nusxa hosil 

bo'ladi); 
• yangi (bo'sh) sahna qo'shish (tanlangan sahnadan keyin bo'sh 

sahna qo'shiladi); 
• tanlangan sahnani o'chirish. 

Ish maydoni ko'rsatkichlarini o'zgartirish 

Flash MXda ish maydoni kO'rsatkichlarini o'zgartirish uchun 
Modify menyusidan Document Properties buyrug'i beriladi. Xuddi shu 
vazifani ish maydoni ustida sichqonning o'ng tugmasini bosib kontekstli 
menyudan Document Properties buyrug'i tanlanadi. Natijada rasmdagi 
Document Properties muloqot oynasi hosil bo'ladi. 

Bu oynadan foydalanib. ish maydonining bo'yi (height). eni (width) 
peksillarda kO'rsatiladi. Ish maydoniga quyiladigan rang Background 
Colorni tan lash orqali o'rnatish, shuningdek kadrlar almashish chas­
totalarini (Frame Rate) belgilash mumkin. 
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FLASHda kutubxona bilan ishlash 

Flash dasturida kutubxonadan foydalanib quyidagi funksiyalarni 
bajarish mumkin: 

• import qilinadigan va hosil qilinadigan simvollarni avtomatik 
ravishda fi Im kutubxonasiga qo'shilishi; 

• fayllar tizimining butunligini nazorat qilish va avtomatik kuzatuv; 
• simvollarning nomlari bir xillarini YO'qotmaslik; 
• to'g'ridan-to'g'ri manipulyatsiya qilish texnologiyasi asosida yangi 

simvollar yaratish (drag-and-drop). 
Kutubxona oynasida simvollar bilan ishlashning ko'pgina imko­

niyatlari faqat kontekstli menyu orqali am alga oshiriladi. Masalan. 
simvolni nusxasini hosil qilish uchun, kontekstli menyudan tegishli 
buyruqni berish kifoya. 

Kutubxonaning yangi ko'rinishlari 

Flash MXda ikki ko'rinishga bo'lingan kutubxonalar mavjud 
(Shared Library): 

Author-time - kutubxonasi, simvol1ar qayta ishlash vaqti bo'~icha 
bo'lingan; 

Rim-time - qo'yilgan vaqti bO'yicha bo'lingan kutubxona. 

Savol vu lopshiriqlar: 

I. Dastur oynasi nechta qismdan iborat? 
2. Dastur oynasining vaqt diagrammasi nima vazifani bajaradi? 
3. Uskunalar paneli nima vazifalarni bajaradi? 
4. Dasturning kutubxonasi qanday imkoniyatlarga ega? 

6.2. Flash MXda qatlamlar bilan ishlash 

Boshqa dasturlarda bo'lgani kabi Flashda ham animatsiyalar hosil 
qilishda yangi obyektlar yaratilib, ularni alohida harakatlantirishga 
to'g'ri keladi. Flashda ushbu imkoniyatni ta'minlab berish, ya'ni 
obyektlar ustida ish lash, ularga alohida harakatlar. biriktirish uchun 
qatlamlardan (cno", - layer) foydalaniladi. Soddaroq qilib aytganda, 
har bir obyekt qO'yilishidan oldin unda alohida qatlam hosil qilinadi. 
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Buning uchun rasmda kO'rsatilgan Insert layer tugmasini bosish kerak 
bo·ladi. 

Tugma bosilgandan keyin qatlamlar orasiga yangi qatlam qo'shiladi. 
Yangi qatlamga foydalanuvchi xohishiga ko'ra chizish YO'li bilan 
yoki obyektlarni import qilish yo'\i bilan biror obyekt biriktiriladi. 
Obyektlarni har birini alohida vaqt mobaynida, bir-biridan keyin, har­
xii katta kichiklikda harakatlanishi. hosil bo' lishi yoki yo'qolib ketishi 
imkoniyatlarini ta'minlaydi. Bunga quyidagi sodda animatsiyani misol 
qilib beramiz: 

~ Flash ishga tushganda yangi ish maydonida bitta qatlam bo'­
ladi . 

., o'sha qatlamni birinchi kadrini belgilab biror aylana chizamiz. 
Hosil bo'lgan aylana shu qatlamga tegishli bo'ladi. Navbatdagi 
qatlamlarni qo'yganda adashib ketmaslik uchun qatlam nomini 
obyekt nomiga o'zgartirgan ma'qul. Buning uchun qatlamning layer 
matni ustida sichqonni chap tugmasini ikki marta bosish bilan 
nomini o'zgartirishga imkon beradi. Qatlam nomini aylana deb 
olamiz . 

,.. endi navbatdagi qatlamni qo'yamiz. Buning uchun Insert 
lay,," tugmasini bosamiz. H.~sil bo'lgan qatlamga endi to'rtburchak 
jonlantiramiz. 

-, Ikkala qatlamning ham birinchi kadrlari ustida sichqonning o'ng 
tugmasini bosib, menyudan Create Motion Tween (harakat hosil qilish) 
buyrug'ini beramiz. 

,. navbat bilan qatlamlarda bir necha kadrdan keyin Insert 
Ketframe buyrug'ini beramiz; qatlamlarda kadrlar orasida harakat hosil 
bo·ladi . 

., fa qat uni sezilarli bo'lishi uchun yangi qo'yilgan kadrni 
tan lab tegishli obyektni kerakli YO'nalishda harakatlantiriladi. Ya'ni 
koordinatalari o'zgartiriladi. Buning uchun Properties pane\idan X va 
U koordinatalari keraklicha o·zgartiriladi . 

., animatsiyani ko'rish vaqtida dastlabki kadrda obyekt joyida 
bO'ladi, oxirgi kadrga o'tguncha esa obyektning harakati hosil 
bo' ladi. 

Quyidagi rasmlarda yuqoridagi aylana pastga qarab harakatianib 
kattalishib boradi, to'rtburchak esa aksincha. 
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Savol va lopshiriqlar: 

1. Flashda qatlamlar va ularning vazifalari nimalardan iborat? 
1. Yangi qatlam qo'yish uchun qanday buyruq beri\1,\di? 
3. Qatlamning nomi qanday o'zgartiriladi? 
4. Qanday holatlarda yangi qatlam qO'yiladi? 

6.3. Obyektlarni chizish imkoniyatlari 

Dasturning grafik imkoniyatlari ham ko·pqirralidir. Dasturning 
barcha grafiklar bilan ish lash imkoniyatlari Tools uskunalar panelida 
joylashgan. Ushbu paneldan foydalangan holda turli xii rasmlarni 
chizish mumkin. Line Tool uskunasi yordamida to'g'ri chiziq, siniq 
chiziqlar, botiq chiziqlar va xatto ko'pburchaklar chizish mumkin. Oval 
Tool uskunasi yordamida oddiy aylana, ellipslar chizish va ulardan 
boshqa aylanaga o'xshash shakllar hosil qilish mum kin. Rectangle 
Tool uskunasi esa to' rtburchak, kvadrat kabi shakllarni chizish . uchun 
ishlatiladi. Pencil Tool oddiy qalam.kabi chizish vazifasini b~aradi . 

Brush Tool uskunasi aylana shaklidagi har xiI o' lcham bilan rasm 
chizish, bo'yash imkoniyatlarini beradi. Paint Bucket Tool uskunasi 
tanlangan rangni quyish imkoniyatini beradi. Eyedropper Tool ish 
maydoni boshqa qismidagi biror rangni tan lab berish imkoniyatini 
beradi. Eraser Tool chizilgan rasmlarni biror qismini o'chirish uchun 
ishlatiladi. 

Chizishdan oldin rang tanlash 

Uskunalar panelida Colors ranglarni tan lash vositalari joylashgan. 
Bu uskunalar yordamida osonlik bilan obyekt konturi rangi va uning 
ichiga quyiladigan ranglarini tan lash imkoniyati mavjud. 

Kontur rangini tan lash uchun Stroke color uskunasini tanlang. Agar 
sichqoncha tugmasin i darrov qo'yib yuborilsa rang tan lash palitrasi 
ochiladi va sichqoncha ko'rsatkichi pipetka ko'rinishini oladi. Palitra 
216 xii rangni o'zida saqlaydi. 

216 xii rang palitraning chap tomonida va o'ng tarafida esa 
qora ustunlar joylashgan. Chap yon ustun standart 6 ta kulrang 
gradatsiyalarni (qora va oqdan tashqari), shuningdek 6 ta kompyuter 
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ranglarini (qizil, yashil, ko'k, sariq, havo rang (eyan) va pushtirang 
(magenta» o'z ichiga oladi. Albatta bular 216 xii rang iehida bor lekin 
qUlaylik uehun ehap kolonkada nusxalari o'rnatilgan. 

Kontur rangini tanlash oynasi 

Rasmlarning katta elementlari va qalin konturlarini bo'yashda 
oldindan jarayonni obyektiY baholash kerak. 

Windows operatsion tizimi uehun rang tan lash standart oynasida 
16 million True Color ranglardan ixtiyoriysini tanlash mumkin. 
Bundan tashqari Color oynasining o'ngida ranglarni oeh yoki 
to'qligini belgiloyehi ehizg'ich mavjud. Shuningdek rangning sonli 
parametrlarini ham berish yoki «tur - to'yinganlik - oeh yoki to'qligi» 
(shunday nomlanadigan shkala HSB: Hue Saturation, Brightness), yoki 
kompyuterdagi RGB «standart» formatida, qizil, yashil, ko'k ranglarni 
tashkil qiladigan kattaliklarni ko'rsatadi. 

Masalan, qizil ranglarni tashkil qiladigan 255 (maksimum), yashil 
va ko'kdan - 0 (bo'larni qisqacha shunday yozish mumkin: RGB 255, 
O. 0). Natijada faqat qizil rangga ega bo'lamiz. RGB 0, 255, O-yashilni. 
RGIJ 0, 0, 255 ko'k rangni beradi. 

Har rangning ochiqligi 0 dan 255 gacha o'zgaradi. Masalan, RGB 
0, 0, 127 ifodani ko'rsatib biz to'q-ko'k rangga ega bo'lamiz. Qizil va 
yashil ranglarni teng proportsiyalarda aralashtirib (RGB 255, 255, 0), 
biz sariq rangga ega bo'lamiz. RGB shkala bilan ishlash juda nozik 
bO'lganligi uchun ko'pgina kompyuter dizaynerlari va rassomlari HSB 
shkaladan foydalanishadi. 

Windows operatsion tizimining standart ranglar tan lash oynasi 
odatda tus burchak ifodasiga ega (OC dan 360°), rangning to'qligi esa 0 
dan 1 oraliqdagi oraliqda o'zgaradi. Lekin Windows muloqot oynasida 
bu parametrlar 0 dan 240 oralig'ida o'zgaradi. 

Quyiladigan rangni taolasb 

Demak. yuqo'ri sifatli rang tan lash oynasi yordamida yangi kontur 
ranglarini ham hosil qilish mumkin. Obyekt ichiga quyiladigan rangini 
tan lash uchun (Fill color). 3aJIHBKa belgisi yonida sichqoncha tugmasini 
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bosiladi. Bunda deyarli shunday rang tanlash oynasi chiqadi. Rang 
tanlash xuddi yuqoridagidek amalga oshiriladi. 

Chiziqli gradient 

Agar bu oynaga diqqat bilan qaralsa bir qancha farqlarni sezish 
mumkin. Flashda rang quyish nafaqat bir ranglarni balki gradiyentli 
ham bo'lishi mumkin. Bu degani bir hil rang suzib boshqasiga o'tadi. 

Doiraviy gradiyent 

Gradiyentlar nafaqat chiziqli balki doiraviy ham bo'lishi mumkin. 
Quyiladigan rangni tanlash oynasi pastki qismida bir nechta tayyor 
gradiyent) to'plami bor: uchta chiziqli va 4 ta doiraviy. Bundan tashqari 
216 xii ranglar palitrasi oynasidan foydalanishingiz mumkin. 

Savol va topshiriqlar: 

I. Dasturda grafiklarni chizish uchun- qaysi panel uskunalaridaA foy­
dalaniladi? 

2. Line Tool. Oval Tool, Rectangle Tool, PenCil Tool. Brush Tool 
uskunalarining vazifalarini aytib bering? 

3. Grafiklar chizishda rang tanlashning qanday imkoniyatlari bor? 

6.4. Grafikli formatlarni konvertatsiyasi 

Flash - filmlari nafaqat harakatli fayllarni balki, oddiy rasm 
ko'rinishidagi fayUarni ham import, eksport qilish imkoniyatiga 
ega. Quyida Flashda qo'lIanilishi mum kin bo'lgan grafikli formatlar 
keltirilgan. 

6. lO-jadval 

Flashda qo'llanadigan ayrim grafikli formatlar 

Fayl turi Kengaytmasi Eksport I Import 

Adobe Illustrator (6.0-yoki .eps, .ai T 

i 
+ 

oldingi versiyalari ) 
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- -

-
Bitmap .bmp + + 

Enhanced Windows Metafile .emf + + ! 
I 

FreeHand I .ft7, .ft7, Jog, J8, + + 
.fli9, .ft9 

GIF .gif + + I 

I 

JPEG .jpg + + I 

I 

PNG .png + + 
I 

Flash Player .swf + + I 

, 

Windows Metafile .wmf + + i 

I 

Agar kompyuteringizda QuickTime 4 o'rnatilgan bo' lsa, I 
I 
I 

qo'shimcha ravishda quyidagi fayllarni qo' llash rnumkin: I 

PhotoShop .psd + + . 
QuickTime Image .qtif + + 

Silicon Graphics .sal + "t-

oo 

nFF .tiff + + 
- -- --- -

Flash - filmlarru eksport qilish 

Flashda yaratilgan filmlardan bosbqa dasturlarda foydalanish uchun 
ularni eksport qi lib, har xi i formatlarda saqlash mumkin. Buning uchun 
F ile> Export Movie yoki Export Image buyruqlaridan foydalaniladi. 
Bu yerda Export Movie fi lmni harakatli fayllarga (swf, avi, gif, spi, 
wav va boshqalar) aylantirish uchun isWatiladi. Export Image esa 
rasm li fay llarga (bmp. jpg, gif, png va boshqalar) aylantirish uchun 
lshlatdadi. 

Quyidagi ketma-ketlikda Flash -filmdan gif - animatsiya eksport 
qilish ketma-ketligini ko'rib chiqam iz: 

o avval yuqorida ko'rsatilgan misoHardan foydalanib, Flash - film 

yarating; 
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o uni saqlab bo'lgach. File > Export Movie buyrug'ini bering. 
Export Movie muloqot oynasi hosil bo'ladi. 

o oynada faylga nom berib, Tlm <paHna bandidan gif faylni 
ko'rsatib, «COXpaHHTb» tugmasini bosing. 

Natijada kiritilgan nomdagi va tipdagi fay I ko'rsatilgan joyda hosil 
bo'ladi. Hosil bO'lgan fayldan boshqa turli maqsadlarda foydalanish 
mumkin. Bu imkoniyatdan Web-tahrirlagichlar bilan ishlashda saytlarni 
chiroyini boyitishda keng foydalanish mumkin. 

Flash M.X obyektlarini boshqa dasturlarga 
qo'yisb va ulardan foydalanish 

Flashda yaratilgan swf filmlar yoki gif animatsiyalar Web­
sahifalarni yuqori darajadagi dizaynga ega bo'lishi uchun xizmat 
qilib kelmoqda. Qaysiki saytga qaramang. F1asb-filmlari yoki Gif 
animatsiyalari har qanday foydalanuvchini o'ziga tortadi. Web­
saytlarning nafaqat biror qismi, hattoki sahifaning butun qismi F1ashda 
tayyorlanayotgani dasturning keng qC!mrovli ekanidan dalolat .beradi. 
Flash-saytlarga bir nechta misollar keltiramiz: www.flash-art.ru. www. 
costroff.r-vision.ru. www.artflasher.com. www.rusmaster.com, www. 
Jasmm.ru 

Web-sahifalarda esa Flashning swf yoki Gif animatsiyalari oddiy 
rasmni joylagandek qo'yiladi. Swf faylini Dreamweaver dasturida 
qO'yish ketma-ketligi bilan tanishib chiqamiz: 

o buning uchun avval web sahifani yaratib olib kerakli joyiga 
ko'rsatkichni qo'yib Insert> Media> Flash buyrug'i beriladi; 

o Select File muloqot oynasi hosil bo'ladi. Oynadan qo'ymoqchi. 
bo'lgan swf faylni kO'rsatiladi; 

o Swf fay I web-sahifaga qo'yilganda, ya'ni tahrirlash vaqtida 
ishlamaydi. Web-sahifani saqlab, bekitgandan key in, faqat ko"rish 
rejimida. ya'ni Internet Explorer yordamida ko'rishimiz mumkin. 

Gif animatsiyani esa Dreamweaverda biroz osonroq. xuddi oddiy 
rasm qo'ygandek qO'yiladi. Buning uchun quyidagi ketma-ketlik 
bajariladi: 

o Insert> Image buyrug'i beriladi: 
o hosil bo'lgan Select Image Source muloqot oynasidan qO'yi­

ladigan fayl kO'rsatiladi: 
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o Web-sahifani saqlab yopiladi; 
e Web-sahifani ko'rish uchun Internet Explorer dasturida ochiladi 

va yaratilgan faylning ko'rinishi pay do bo'ladi. 

FLASHda tayyor fayllarni qo'yish 

Flashda obyektlarni chizish imkoniyatidan tashqari yana tayyor 
rasmlar, videolar va boshqa ma'lumotlarni fayllardan qo'yish 
imkoniyati bor. Ya'ni tayyor faylni import qilish imkoniyati mavjud. 
Buning uchun File menyusidan Import buyrug'i beriladi. Natijada 
Import muloqot oynasi hosil bo'ladi. Oynadan foydalanib import 
qilmoqchi bo' lgan faylni kO'rsatib, OTKPblTb tugmasi bosilsa. tegishli 
qatlamga tanlangan faylda saqlanayotgan rasm yoki boshqa obyektni 
qo'yib beradi. 

Import qilingan rasmlar ustida bir qancha amallar bajarish mum kin. 
Ekranda import qilingan rasmni belgilang. Insert > Convert to 
Symbolni yoki F8 ni bosing. Klipga nom bering. Uni klip (Movie clip) 
yoki gratik (Gratis) shaklida joylang va OK tugmasini bosing, 

Endi rasm ustida bir qancha tahrirlash ishlari olib borish imkoni 
bor. tEffektlar panelini oching Proporties > Colors va rO'yxatdan 
«Advanced» buyrug'ini tanlang. Bir qarashda bu qiyinday tuyulishi 
mumkin. lekin buning ortida matematik mantiq yotadi . U quyidagilarni 

anglatadi: 
-,. Flash har bir kanal uchun rang belgisiga ega bo'ladi. Masalan, R 

(qizil) va uning belgisi 255 (to'q qizil) . 
., Flash foizli belgisini tekshiradi va qizil rangni yangi belgisini 

hisoblaydi. Masalan. R uchun belgi -100% bu normal holat hisob­

lanadi. 
, Flash «qo'shimcha» maydonga yangi be1gi bilan qo'shadi. Bu 

misolda qO'shimcha maydon belgisi 0 ga teng, demak qizil rang belgisi 
R 255 ga teng bo' lib qolaveradi . 

., Analogik ravishda obyektning boshqa rang kanallari -
vashil (G), ko'k (B). Ko' rinib turibdiki bu misolda hamma kanallar 
~slidagidek qoladi. Agar ular o'rnatilishiga biroz o'zgartirish kiritsak 

nima bo'ladi? 
Keyingi bandlarda bu savolga javob topishingiz mumkin. 
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Rang kaoallarini saralaoisbi 

Ranglarni saralashning oson yo'llaridan biri kanallardan ba"zi 
birlarini o'chirish kerak. Masalan, quyidagi be\gilarni ishlatib ko'­
ring : 

Kanal Qiymat i , Qo' shimcha qiymatJari 
-

Red 100% 0 - ,.' 
Green . , 0% 

. 
0 

Blue 0% " . " 0 , 
~. .. . -

Alpha ," 100% 0 , " 
.. " 

Yashil va ko'k kanallarni saralab qizil tusdagi rangga ega bo'lamiz. 
Kanallardan birini qo'shsak bu ajoyib natijaga olib keladi : 
Masalan: 

Kana l f Qiym ati Qo'shimcha qiymatla r i 

Red • 100% c, 0 -

Green 100% 0 ' I 

Blue 0% .~ .' ,. 0 -
Alpha 100% 0 -, 

Bundan keyin sariq imidjga ega bo'lamiz. 

Rang kanallari manipulyatsiyasi 

Yuqoridagi kanallarni saralash har doim ham yaxshi natija 
beravermaydi. E'tiborli odam darrov olingan imidj kamchiliklardan 
holi emas ekanligini payqaydi. Bunda kontrast, yorug' lik va ba'zi 
chegara chiziqlari yo'qolib ketadi. Lekin kanal saralanishini bir necha 
manipulyatsiyalari mavjud. Misol uchun hamma kanallarni bir vaqtning 
o'zida o'zgartiramiz. 
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" 

" Kanal Qiymati Qo'shimcha qiymatlari 

Red 200% 0 -' 

Green 200% 0 

Blue 200% 0 

Alpha 100% 0 

Bu imidjni yorqinroq qilishga yordam beradi. 
Eslatma. % belgisi orqali 0% dan 100% gacha belgilarni o·r­

natish mumkin. Lekin tahrirlangan maydonda 200 ni ham o'rnatish 
mum kin. Yuqori darajali animatsiya foizlari 0% dan 100% gacha 
o·zgarishi mumkin. Kanallarni manfiy qiymatlarini ham berish 
mumkin. 

MasaLan: 

Kanal Qiymati Qo'shimcha qiymatlari 
.:.. 

Red -100% 256 

Green -100% 256 , 

Blue -100% 256 

Alpha 100% 0 

Amaliy misoIlar: 
«Haqiqiy» kontrast 

Kanal r 
Qiymati Qo'shimcha qiymatlari 

Red 600% - 5/2 

Green : 600% - 5/2 

Blue " 
. 

600% - 5/2 . .. 
Alpha 1O()% 0 
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«Haqiqiy» yorqinlik 

Kanal Qiymati . Qo'shimcha qiymatlari 

Red 100% 256 

Green 100% 256 

Blue 100% 256 

Alpha 100% 0 I 
- ---

Sariq 

Kanal Qiymati Qo'shimcha qiymatlari 

Red 200% -20 

Green 200% -90 

Blue 200% -256 

Alpha 100% 0 • -. 
Pushti rang 

Kanal Qiymati Qo'shimcha qiymaUari 

Red 250% -50 

Green 250% -183 

Blue 250% -50 

Alpha 100% 0 

Moviy rang 

Kanal Qiymati Qo'shimcha qiymaUari 

Red 250% -256 

Green 250% -200 

i Blue 250% -52 

Alpha 100% 0 
-
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lkki kanal aralashmasi - I 

Kanal Qiymati Qo'sbimcha qiymatJari 

Red 100% 256 

Green 100% 0 

Blue 100% 256 

Alpha 100% 0 
- - - --

Ikki kanal aralashmasi - 2 

Kanal Qiymati Qo'shimcba qiymatJari 

Red 100% 256 

Green -100% 256 

Blue -100% 256 

• Alpha , ·100% 0 
- -

Relef 

Kanal Qiymati Qo'shimcba qiymatJari 

Red -100% 256 

Green -100% 256 

Blue -100% 256 

Alpha 50% 0 
-

Vana rasmlar ustida olib boriladigan ishlardan biri bilan tanishib 
chiqamiz. Bu imkoniyat rasmni turgan joyidan yo'qolib ko'rinmay 
qolish yoki aksincha rasm yo'q joydan asta-sekin hosil bo'lishini 
ta'minlaydi. Buning uchun quyidagi ketma-ketlikni ko'rib chiqamiz: 
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• rasmni import qilib olib, Insert> Convert to Symbol buyrug·ini 
yoki F8 tugmasini bosing; 

• Proportles > Color > Alpba bandini tanlang. 
«Alpha>>ning ko'rsatkichini o'zgartirish natijasida rasm quyidagicha 

o'zgaradi: 

Kanal Qiym8ti Ko'rinish darajasi 

Alpha 0% ko'rinmaydi 

Alpha 50% 50% ga noaniq ko'rinadi 

Alpha 100% to'liq ko' rinadi 

Xuddi shu effektlardan o'xshash obyektlarni bir-biriga aylantirish­
da foydalanish mumkin. 

• 
Savol va topshir;qlar: 

1. Grafikli formatlar konvertatsiyasi deganda nimani tushunasiz? 
2. Fayllarni import qilish nima? 
3. Fayllarni eksport qilish nima? 
4. Flashda qanday formatdagi fayllarni import qilish mumkin? 

6.S. Flasbda oddiy barakatlar bosil qilish 

Flashda animatsiyalarni o'rganishni eng sodda harakatlarni ko'rish­
dan boshlaymiz. 

I-misol. Dastlab biror chizilgan obyektni bir koordinatadan boshqa 
koordinataga o'tish jarayoni bilan tanishib chiqamiz: 

o File > New buyrug'ini berish bilan yangi ish maydoni hosil 
qilamiz: 

o ish maydonidagi yagona qatlamning (layer) birinchi kadrini 
sichqon chap tugmasi bilan bosib belgilaymiz; 

o endi sichqonni Tools paneliga olib kelib chizish uchun 
mo'ljallangan ixtiyoriy uskunani tanlaymiz; 
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o sichqon yordamida ixtiyoriy rasm chizamiz; 

o qatlamning kadri ustiga sichqon ko' rsatkichini qo'yib, o' ng 
tugmasini bosamiz. Hosil bo'lgan menyudan Create Motion Tween 
buyrug'ini beramiz. 

o sichqon ko"rsatkichini bir nechta kadrdan keyinga qo'yib Insert 
Keyframe buyrug'i beriladi. Xuddi shu Keyframeni belgilagan holatda 
rasmni o'zini kerakli koordinataga o'tkazamiz. Buning uchun Properties 
panelidan X va Y koordinatalarini o'zgartiramiz. 

o harakatni ko'rish uchun Control> Test Movie buyrug'i beriladi. 
Natijada dastlabki nuqtada turgan rasm biroz vaqt ichida boshqa 

koordinataga o'tadi. 

2-misol. I-misolni biroz o'zgartirsak, shu obyektni kattalashganini 
kuzatishimiz mumkin : 

o yuqoridagi misolning 5 ta qadamini bajarib bo'lgach, rasmning 
koordinatasi o'zgargan kadr ustiga sichqon tugmasini bosish bilan 
belgi laym iz: 

o natijada rasm belgilanadi, rasmni kattalashtiramiz. Buning uchun 
Properties paneJidan W: va H: qiymatlarini kattalashtiramiz; 

• harakatni ko'rish uchun (::ontrol > Test Movie buyrug'i beriladi. 
~atijada aylana harakatlanib boshqa koordinataga o'tish bilan 

kattalashib boradi. 
3-misol. Navbatdagi misolda esa xuddi I-misoldagi chizilgan shar 

boshqa koordinataga o'tishi biJan rangi o'zgarib boradi. Buning uchun 

quyidagi ketma-ketlik bajariladi : 
o l-misoldagi birinchi 5 ta bandini bajarib bo'lgach, rasmning 

koordinatasi o'zgargan kadr ustiga sichqon tugmasini bosish bilan 

belgilay m iz: 
o natijada rasm belgilanadi, keyin Properties panelidan Color 

ro'yxatidan Advanced buyrug'i beriladi: 
o ekranda hosil bo'lgan Advanced Effect oynasidan o'zimizga 

kerakli rang kO'rsatkichlarini tan lab OK tugmasini bosamiz: 
o harakatni ~o' rish uchun Control> Test Movie buyrug'i beriladi. 
4-misol. Endigi misolda obyektlarni harakatlanish bilan biror 

burchakka buriJishi bilan tanishib chiqamiz. Buning uchun quyidagi 

ketma-ketlik bilan tanishib chiqamiz: 
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o I-misoldagi birinchi 5 ta bandini bajarib bo'lgach, rasmning 
koordinatasi o'zgargan kadr ustiga sichqon chap tugmasini bosish bilan 
be\gilaymiz; 

o natijada rasm belgilanadi, Modify > Transtbrm > Scale and 
Rotate buyrug'i beriladi; 

o ekranda hosil bo'lgan Scale and Rotate muloqot oynasida tegishli 
burchak qiymatini ko'rsatib, OK tugmasini bosamiz; 

o ko'rsatilgan burchakka rasm buriladi. 

Savol Vtl topshiriqlar: 

I. Oddiy harakat hosil qilish ketma-ketligini tushuntirib bering? 
2. Flashda oddiy harakat hosil qiling? 
3. Obyektning harakati natijasida kattalashishi animatsiyasini hosil qil­

ing? 
4. Obyekt harakatlanishi natijasida boshqa ranga o'tish animatsiyasini 

hosil qiling? 

• 
6.6. Dasturning tovusblar bilao isblash imkoni}'atiari 

Flashda filmlarga tovush ham berish mumkin. Kompyuterda 
saqlanayotgan tovush fayli yoki tovushni yozdirish orqali ham har xii 
tovush fayllarini import qilish yo'li bilan qo'yish mumkin. Buning 
natijasida Flashda tovushli film hosil bo'ladi. Ya'ni animatsiya namoyish 
qilinayotgan vaqtda harakat bilan birga unga mos yoki unga tegishli 
tovush ham ijro qilinadi. Buning uchun quyidagi ketma-ketlik am alga 
oshiriladi: 

• avval Flashda ixtiyoriy film yaratiladi: 
• filmga o'rnatilishi lozim bo'lgan tovushni maxsus dasturlar 

yordamida kompyuterga yoziladi yoki kompyuter xotirasida tayyor 
tovllsh saqlanayotgan bO'lsa, undan ham foydalanish mumkin; 

• tovushni tayyorlab olgandan so'ng, File menyusidagi Import 
buyrug'i beriladi; 

• natijada Import muloqot oynasi hosil bo·ladi. Oynadan foy­
dalanib o'rnatmoqchi bo'lgan tovush faylini ko'rsatamiz. Natijada 
tovush fayli import qilinadi. 
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Sichqon yordamida ixtiyoriy qatlamdagi birinchi kadrni tan lab, 
Properties panelidan Sound ro'yxatini ochamiz. RO'),xatdan o'zirniz 
import qilgan tovush faylini tanlaganimizda, o'sha qatlarnda tovush 
o'rn"iladi. 

Eslatma. Filmdagi tovush bilan animatsion harakat sinxron ravishda 
berilishi ustida test o'tkazish kerak. Agar ular sinxron bo'lmasa filmdagi 
animatsiya qatlamlaridagi kadrlar sonini ko'paytirish (buning uchun 
kadrlar orasiga sichqon chap tugmasini bosib, F5 tugmasini bosish yo'Jj 
bilan kadr qo'yiladi. Natijada animatsiyaning namoyish vaqti cho'zilib 
tovushga yaqinlashadi) yoki kamaytirish yo'li bilan sinxronlashtirish 
mumkin. 

Tovushli tugmalar yaratisb 

Yuqorida kO'rsatilgan misoldan foydalanib tugmalarga ham to­
vush berish mumkin. Buning uchun quyidagi ketma-ketlik amalga 
oshiriladi: 

• avval tugma qO'yiladi yoki Flashning o'ziga chizish yo'li bilan 
hosil qilinadi: 

, qo'yilgan yoki chizilg~n rasmni tugmaga aylantirish uchun 
uning ustida sichqon chap tugmasini bosish yo'li bilan belgilanadi. 
Sichqonchaning o'ng tugmasi bosilganda quyidagi menyu hosil bo'ladi; 

• menyudan Convert to Symbol buyrug'i beriladi. Convert to 
Symbol muloqot oynasi hosil bo'ladi. Oynadan Button bandi tanlanadi. 
Natijada tanlangan rasm tugmaga aylanadi; 

• tugma ustida sichqon chap tugmasi ikki marta bosiladi; 
• hosil bo ' lgan oynada Over ko'rsatkichi ostidagi katakka yangi 

kadr qo'yamiz; 
• shu kadrni belgilab olamiz; 
• File > Import buyrug'i yordamida tugmaga o'rnatmoqchi 

bo'lgan tovush faylini import qilamiz (import qilingan tovush avtomatik 
ravishda Properties panelining Sound ro'yxatida hosil bo'ladi); 

• Properties panelining Sound rO'yxatidan tovushni tanlaymiz 
(bu bilan biz tegishli tugmaga shu tovushni o'rnatgan bo'lamiz): 

• bo'lgan o'zgarishlarni saqlab, filmni ko'rish uchun Control 
> Test Movie buyrug"ini beramiz; film namoyishi vaqtida tugma 
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ustiga sichqon ko'rsatkichini olib kelsangiz o'rnatilgan tovush 
eshitiladi. 

Xuddi shu yo'l bilan tugma ustiga sichqon kO'rsatkichini olib 
kelinganda yoki bosilganda faqat tovush chiqishi bilan chegaralanib 
qolmasdan, balki tugma boshqasiga aylanishi ham hosil qilish mumkin. 
Bu bilan foydalanuvchi menyudan tanlangan tugmani boshqasidan 
ajralib turishini ta'minlaydi. Buning uchun yuqoridagi misolni biroz 
davom ettirish zarur. Ya'ni, vaqt diagrammasining Over katakchasiga 
kadr qo'yib, unga shu tugmaning boshqa ranglisini o'rnatamiz. Down 
katakchasiga esa boshqa rangli tugmachani o'rnatib, filmni ko'rish 
uchun Control> Test Movie buyrug'ini beramiz. Namoyish vaqtida 
tugma ustiga sichqon kO'rsatkichini olib borsak, tugmacha boshqa 
rangga o'tadi, uni bosadigan bo'lsak yana boshqa rangga o'tadi. 
Bu bilan biz menyudagi tugmalardan qaysi biri ustida ko'rsatkich 
turganini yoki qaysi tugma bosilganini osongina ajratib olishimiz 
mumkin. 

Savol vu lops!tiriqlar: • 
I. Chizilgan obyektni tugmaga aylantirish uchun qaysi buyruqdan 

foydalaniladi? 
2. Tugmaga tovush biriktirish ketma-ketligini aytib bering? 
3. Filmga tovush biriktirish uchun dastlab qaysi buyruqdan 

foydalaniladi? 
4. Filmga tovush berish ketma-ketligini sanab bering? 

6.7. Obyekt barakati trayektoriyasini bosbqarish 

Flashda asosiy qatlam - Guide Layer tushunchasi mavjud. Asosiy 
qatlamlar ikkita xususiyatga ega: 

• birinchidan, siz unga faqat tahrirIash rejimida ko'rinadigan izohlar 
joylashingiz mumkin. Bu izohlar SWF formatiga eksport qilinmaydi; 
shu ma'noda Guide so'zini «boshqarish», «ko'rsat~a» deb tushunish 
mumkin; 

• ikkinchidan, asosiy qat lam yordamida obyektning bir joydan 
ikkinchi joyga ko'chish harakati trayektoriyasini boshqarish mumkin 
(tweened-animatsiya harakati yordamida). 
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Guide qatlamni yaratish uchun quyidagi ketma-ketlikni amalga 
oshirish kerak: 

\. Vaqt diagrammasi pane lid a qatlamlar rO'yxatidan ixtiyoriy 
qatlam ustida sichqon o'ng tugmasini bosing va kontekstli menyudan 
Insert Layer buyrug'ini bering. 

2. Yangi hosil qilingan qatlam ustida sichqon o'ng tugmasini bosing 
va kontekstli menyudan Guide bandini tanlang. Natijada qatlamlar 
rO'yxatida qatlam nomi yaqinida bolg'acha ko'rinishidagi belgi hosil 
bo"ladi. Bu belgi faqat tahrirlash uchun mo"ljallanganini bildirib, 
foydalanuvchilar buni ko' rishdan mustasno. 

Yuqorida aytilganidek bosh qatlamning ikkinchi ko'rinishi 
harakatlanayotgan obyekt trayektoriyasini (bosib o'tishi kerak ba'lgan 
YO'lni chizmasini) belgilaydi. 

Obyektni ko'rsatilgan trayektoriyada harakatlantirish uchun quyidagi 
ketma-ketlikni bajarish kerak: 

l. Animatsiyalangan obyekt qatlamining nomi ustida sichqon o'ng 
tugmasini bosing. 

2. Kontekstli menyudan Add Motion Guide buyrug'ini bering. 
Na~jada qatlamlar ro"yxatid~. maxsus belgi ostida asosiy qatlam hosil 
bo'ladi. 

3. Asosiy qatlamni faollashtirish uchun uni nami ustida sichqoncha 
chap tugmasi bilan bosamiz. 

4. Chizishning ixtiyoriy uskunasi yordamida (Pen, Pencil. Oval, 
Brush, Rectangle) obyekt harakatlanish trayektoriyasini tasvirlang. 

5. Animatsiyaning birinchi kadri katakchasini sichqoncha chap 
tugmasi bilan belgilang va Properties panelidan Orient to Path 
(marshrut bO'yicha mo'ljal olish) bayroqchasini o'rnating. 

6. Animatsiyaning oxirgi kadri katakchasini sichqon chap tugmasi 
yordamida belgilang va kadrning Properties panelidan xuddi shu 

bayroqchani o·mating. 
7. Animatsiyalangan obyektdan belgilashni olib tashlab, filmni 

namoyish qilish uchun Control> Test Movie buyrug'ini bering. 
Eslatma. Agar siz kesishadigan trayektoriya hosil qilgan bo'l­

sangiz, u holda obyekt kesishish natijasida hosil qilgan yo'l bo'yicba 

harakatlanadi. 
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Savol va topshiriqlar: 

I. Asosiy qatlam nima va uning qanday xususiyatlari bor? 
2. Obyektni belgilangan YO'nalishda harakatlantirish uchun qaysi 

buyruqlardan foydalaniladi? 
3. Siror obyekt olib uni ixtiyoriy yo'nalish bo'ylab harakatlantiring? 

6.S. Flashda niqobli animatsiyalar yaratish 

Niqob o'z ichiga oddiy qatlam.\arni oladi. Faqat bitta qatlam niqobli 
(bekitadigan) qatlam bO'lib, u faqat o'zining ostidagi qatlamga tegishli 
obyektni bekitadi (niqoblaydi). Qatlamlardan niqob hosil qilish uchun, 
quyidagi ketma-ketliklarni bajarish kerak: 

1. Niqob qo'ymoqchi bo'lgan qatlamning nomi ustida sichqonning 
o'ng tugmasini bosilib, kontekstli menyudan Insert Layer buyrug'ini 
bering (qo'yilgan yangi qatlam endi niqob o'rnida xizmat qiladi). 

2. Niqob qatlamiga rang quying. Agar animatsiyali niqob 
yaratmoqchi bo'lsangiz, unda faqat bii-' marta rang quyilgan bo'lishi 
kerak. 

3. Niqob qatlami nomi ustida sichqon o'ng tugmasini bosing, 
kontekstli menyudan Mask (MacKa) buyrug'ini bering. Shu daqiqadan 
boshlab yangi qatlam niqobga aylanadi. Shundan keyin qatlamlar 
to'plamida quyidagi o'zgarishlar bo'ladi: 

o qatlamli niqob nomidan chapda niqobga tegishli belgi hosil 
bo'ladi; 

o niqoblangan qatlamning nomi o'ngga suriladi va uning yonida 
ham shuningdek yangi belgi paydo bo'ladi; 

o ikkala qatlam ham avtomatik ravishda bekitiladi (qatlamning 
nomidan o'ngda hosil bo'lgan qulf belgisi shundan dalolat beradi). 

Niqobga biriktirilgan rangning asli ko'rinmasdan, balki uning 
harakati natijasida ortidagi qatlamning ochilishi kuzatiladi. Bosh­
qacha aytganda bekitilgan obyekt niqob orqali harakat bilan ochiladi. 
Siz niqobning holatini, ko'rinishini har doim o'zgartirishingiz 
mum kin. Uni tahrirlash holatiga keltirish uchun qulf belgisi 
ustida sichqonni chap tugmasini bosish kifoya. Bu bilan siz qulfni 
avtomatik ravishda olib tashlagan bo'lasiz. Tahrirlash rejimini ishga 
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tllshirish uchun niqobli qat lam nomini sichqon o'ng tugmasi bilan 
bosish va kontekstli menyudan Show All (Hammasini kO'rsatish) 
buyrug' ini bering. 

Niqobni ko'rish rejimini yoqish uchun, sichqon o'ng tugmasini 
niqobli qatlam l10miga yoki niqob ostidagi qatlam nomiga bosish va 
kontekstli menyudan Show Masking buyrug'ini berish kerak. 

Savol va topshiriqlar: 

l. Niqob hosil qilish ketma-ketligini aytib bering? 
2. Animatsiyalashgan niqob hosil qiling? 
3. QO'shimcha fonli niqob hosil qilish ketma-ketligini aytib bering? 
4. Animatsiyalashgan niqob va qO'shimcha fonli niqoblarning farqlari 

nimada? 

• 
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XULOSA 

Xulosa qilib aytganda, jamiyatning barcha jabhalarida ro'y be­
rayotgan hamma yangiliklar, kashfiyotlar va rivojlanishning to'xtovsiz 
o'sishi zamirida ta'lim tizimida erishilayotgan yutuqlar yotadi. Bunga 
ta' lim tizimida erishilayotgan yutuqlar samaralari deb baho berish 
mumkin. Faqat ta'lim tizimidagina jamiyatning barcha jabhalari uchun 
zarur yuksak bilimli, iqtidorli kadrlar tayyorlanadi. Ta' lim tizimida 
samaradorlikka erishish uchun esa professor-o'qituvchilardan o'z ustida 
tinimsiz ish lash, fan-texnika yangiliklaridan o'z vaqtida xabardor 
bO'lish va ularni o'z mehnat faoliyatig~. tatbiq qilish, chet tillarin~ bilish, 
axborot texnologiyalaridan oqilona foydalana olishlari talab etiladi. 

Axborot texnologiyalari va uning eng sO'nggi yutuqlaridan xabardor 
bo'lish va ularni o'z sohalariga tatbiq qilib samarali mehnat faoliyatini 
tashkil qilish muhim ahamiyat kasb etadi. Yuqorida aytilganidek, ta'lim 
tizimida o'quv materiallarining vizuallashishi bilan ta' lim samaradorligi 
ortib boradi. Bunda esa elektron o'quv resurslaridan (EO'R) keng 
foydalaniladi. Turli fanlar bO'yicha EO'Rlarini yaratish va joriy qilish 
orqali ta' tim tizimida o'qitish samaradorligiga erishiladi. EO'Rlarini 
yaratish uchun esa avvalo boshlang'ich kompyuter savodxonligiga ega 
bo'lish, shu bilan birga maxsus dasturiy vositalardan foydalanish va bir 
qancha dasturlash tillarini bilish talab qilinadi. Boshlang'ich kompyuter 
savodxonligi informatika va axborot texnologiyalari fanlarini o'qitish 
orqali o'rgatilsa, EO'Rlarini yaratish esa Web-dizayn kabi fanlarni 
o'qitish orqali o' rgatiladi. Shu maqsadda ushbu qO' lIanmada ham 
EO' Rlari uchun turli illustratsiyalar tayyorlashga mo'ljallangan grafik 
muharrirJar, web saytlarni yaratishga mo'ljallangan dasturiy vositaJar, 
animatsiyalar tayyorlashga mO'ljallangan dasturlarni o'rgatishga oid 
ma' lumotlar keltirilgan. 
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